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WHAT'S NEW IN THE AWIPS CAVE-D2D USER'S MANUAL
OB 134.1
FEATURES, FUNCTIONALITIES, ENHANCEMENTS, AND/OR MODIFICATIONS

AWIPS |1 Software

e NPP Products: The discussion of the NPP Product options under the Satellite menu has been updated
to reflect the addition of the "NUCAPS Sounding Availability" product. Refer to Subsection 2.2.6.11.

e Thin Client: The discussion of the Thin Client component has been updated to reflect the addition of
the "Authentication" functionality for running Thin Client on an untrusted network outside the firewall.
Refer to Section 14.1.

AWIPS CAVE-D2D User's Manual

Content and Organizational Changes:

e kxxx Menu: The kxxx products menu has been rearranged in order to accommodate the addition of
dual-polarization products. The discussion of kxxx menu products in this manual has been revised to
reflect the changes to the menu. Refer to Subsection 2.2.6.12.

e txxx Menu: The txxx products menu has been rearranged to be consistent with the revised kxxx
products menu. The discussion of txxx menu products in this manual has been updated to reflect the
changes to the txxx menu. Refer to Subsection 2.2.6.13.

e Acronyms and Abbreviations: This appendix has been updated to include new acronyms that have
been added to the Manual. Refer to Appendix B.

e Password Management: The discussion of the requirements for "Password Authentication" for
accessing AWIPS has been updated to be in compliance with Department of Commerce Policy
CITR-021 Password Management (September 21, 2012). Refer to Appendix C.
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1.0 The AWIPS CAVE-D2D User's Manual

The AWIPS CAVE-D2D User's Manual provides the information needed to utilize the user interface of
AWIPS (Advanced Weather Interactive Processing System) for the retrieval and display of weather data. This
introduction provides an overview of the manual's scope, intended audience, and structure.

Note 1: The CAVE menus exhibited in this document include options that may not be available at all
field sites. When AWIPS is localized to your site, only those options that are available to your site will
be included on the menu.

The Online Navigation Page enables you to navigate easily and quickly throughout the online document.
Using the navigation page makes it easy to find information. It includes a button that links you directly to the
PDF version of the document, enabling you to perform a key word search. From this page you can look up a
term by accessing either NOAA's NWS glossary or the UM's glossary. It also provides a button
for accessing the Online Tutorial Index, making it easier to locate practice tutorials for your particular area
of interest. You can return to the navigation page from any page in the manual by clicking the
button.

A button is present at the beginning of a discussion if the discussion includes a tutorial. This will
make it easier for you to navigate directly to the tutorial. You can easily return to the beginning of the
discussion by clicking the button, located on the tutorial page. These navigation buttons will save
you several steps.

The symbol indicates that a separate manual is available for the AWIPS' application being discussed.

For more information about the application, click on the book symbol to open the application's user guide.
Also whenever the name of an iconified button is displayed and underlined in blue, such as Open
Perspective, it indicates a link to an image of that button.

Note 2: The AWIPS CAVE-D2D User's Manual is an online document that can be opened using any
Internet browser. However, no two browsers support online documents in exactly the same way, and no
browser totally supports a document's intended structure. Therefore, the appearance of pages within this
manual may differ from browser to browser. Mozilla Firefox best supports the structure of this manual
and is the recommended browser for viewing it.

If you find errors in this manual or would like to make a comment or suggestion, we welcome your feedback.
Please write to the AWIPS Documentation Team at: nws.hg.awips.smm.um@noaa.gov.
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1.1 Scope

This edition of the AWIPS CAVE-D2D User's Manual describes the AWIPS II implementation of the D2D
(Display 2-Dimensions) Perspective within the CAVE (Common AWIPS Visualization Environment), and the
user interface components (text and graphic displays) that comprise the AWIPS II workspace. The other
perspectives — GFE, Hydro, MPE, and Python (all of which are accessible from the CAVE main display) —
are outside the scope of this manual and are therefore not discussed in any detail.

AWIPS accommodates two complete desktops (graphical environments where you do your work): KDE (K
Desktop Environment); and GNOME (GNU Network Object Model Environment). The differences are
mainly cosmetic, with the choice of desktops being simply a matter of preference. The KDE desktop is more
Windows-like than GNOME. You would choose your preferred desktop from the Session menu on the login
screen before you log on. The system defaults to whichever desktop was active when the user logged off.
This version of the manual is configured to the more commonly used KDE.

AWIPS II is being implemented in a series of releases. This version of the AWIPS CAVE-D2D User's
Manual (OB13.4.1 - 31 July 2013) supports AWIPS II Software Operational Build 13.4.1. As subsequent
major releases of the software are implemented, the AWIPS CAVE-D2D User's Manual will be updated to
reflect the changes associated with the respective release. Every new edition of the Manual includes a
"What's New in the AWIPS CAVE-D2D User's Manual" page. Inserted after the Table of Contents, the
"What's New" page describes new and/or changed features, functionalities, enhancements, and modifications
associated with the newly implemented release. The "What's New" page also describes content and
organizational changes made to the Manual, and any formatting changes made to improve usability. If no
significant changes occurred in the new release, or the User's Manual, the "What's New" page will state that
fact.
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1.2 Intended Audience and Assumed User Skills
This online document is intended for users of the AWIPS workstation. It is assumed that users of this manual

have a basic understanding of how to use a mouse to navigate a graphical user interface (GUI). This includes
such operations as opening, resizing, moving, and closing windows, and selecting items from menus.
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1.3 Organization of the Manual

The AWIPS CAVE-D2D User's Manual is organized as follows:

The Online Navigation Page (Online Version Only) enables you to access needed information more
quickly, navigate throughout the online version of the manual more efficiently, and execute Acrobat's
search function in the PDF version of the manual. It also allows you to access two separate glossaries.
Every page in the online version of this manual has a button that links you back to the
Navigation Page.

The Online Tutorial Index (Online Version Only) enables you to easily locate practice tutorials for your
particular area of interest. To access the Online Tutorial Index, click the button on the top of
the Online Navigation Page. The Online Tutorial Index's easy to use subject tabs enable you to navigate
to a particular practice module or objective.

What's New in the AWIPS CAVE-D2D User's Manual describes the features, functionalities,
enhancements, and modifications that have been made to the newly released software Operational
Build (OB) since the last OB. It also describes any significant content and organizational changes to
the User's Manual, as well as any usability improvements, intended to improve readability and
comprehension on the part of the user. This section is included in the manual to inform the user of the
specific changes that occurred in the release, both in the software and in the document. If no changes
occurred to either, this section would state that fact.

Chapter 1 - The AWIPS CAVE-D2D User's Manual provides an overview of the scope, intended user,
and organization of this manual.

Chapter 2 - The AWIPS Workstation and Graphical User Interface provides an overview of the AWIPS
workspace and graphical interface; it includes descriptions of all the CAVE menus and functions for
setting up your display.

Chapter 3 - Getting Started Using AWIPS Graphical User Interface describes the menus used in CAVE
to work with graphic and image products and data; it also includes a series of practice modules
(tutorials) designed to step you easily and quickly through the basics of using CAVE. Chapter 3
concludes with tutorials that provide practice working with the AWIPS graphical interface.

Chapter 4 - The AWIPS Workstation and Textual User Interface provides an overview of the AWIPS
workspace and text interface, covering viewing, creating, editing, and transmitting text products.

Chapter 5 - Getting Started Using AWIPS Textual User Interface describes how to retrieve and edit text
products, and how to work with text scripts and the alarm/alert feature. The chapter also includes a
series of practice modules (tutorials) designed to familiarize you with the basics of using the Text
Workstation and AWIPS textual interface.

Chapter 6 - WarnGen covers the AWIPS Warning Generation (WarnGen) program.

Chapter 7 - The Interactive NsharpSkewt (NSHARP) Application covers the Interactive NsharpSkewt
application, including sampling and editing the Skew-T and hodograph.

Page 11



CAVE-D2D User's Manual AWIPS |1 Operational Build 13.4.1 - 31 July 2013

Chapter 8 - Radar Applications covers the radar applications, including dual-polarization technology.

Chapter 9 - Background Applications covers the background applications (the NOAA Climatological
Reports Formatter, and the Hourly Weather Roundup).

Chapter 10 - Local Data Acquisition and Dissemination covers the Local Data Acquisition and
Dissemination (LDAD) system.

Chapter 11 - AWIPS Quality Control and Monitoring System introduces the AWIPS Quality Control
and Monitoring System (QCMS).

Chapter 12 - AWIPS System Monitor provides information on the tool used to monitor AWIPS systems
and workstation CPU utilization. This chapter also includes information on how to access online
documents and provides links to important forecaster information.

Chapter 13 - MDL and OHD Applications introduces the NWS-developed applications that are
accessible from both the CAVE interface and the AWIPS Start-up menu.

Chapter 14 - Thin Client Remote Access introduces the two versions of the Thin Client component
implemented to support NWS enterprise requirements for remote access to baseline AWIPS
capabilities.

Chapter 15 - Alert Visualization provides information on the tool used to alert the user to malfunctions
and to signal and data loss. This chapter also includes information on how to configure alerts.

Chapter 16 - Applications within CAVE provides information on the four applications accessed from
the CAVE menu. The first three applications are options listed directly under the CAVE menu. The
fourth application is accessed under the CAVE menu via the Import option.

Appendix A - Glossary provides a glossary of relevant terms.

Appendix B - AWIPS Acronyms and Abbreviations provides a listing of AWIPS acronyms and
abbreviations.

Appendix C - Managing Your AWIPS User Account provides information on managing your AWIPS
user account, including how to manage your password according to DOC policy.

Appendix D - AWIPS Applications / Interfaces provides a list of AWIPS applications.
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2.0 The AWIPS Workstation and Graphical User Interface

Each AWIPS Workstation is comprised of three graphic displays (Graphic Workstation) and one text display
(Text Workstation), as shown in Exhibit 2.0-1. The three graphic displays share a common keyboard, mouse,
and central processing unit (CPU - LX). The text display has a dedicated keyboard, mouse, and CPU - XT.

Exhibit 2.0-1. The AWIPS Workstation
This chapter includes the following sections:

e Section 2.1: The AWIPS Graphic Workstation

e Section 2.2: The AWIPS Graphical User Interface
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2.1 The AWIPS Graphic Workstation

The AWIPS Graphic Workstation is located on the right side of the AWIPS Workstation, as shown in Exhibit
2.1-1. It includes the three graphic displays, all controlled by a single dedicated keyboard, mouse, and its own
CPU (LX).

Exhibit 2.1-1. The AWIPS Graphic Workstation
This section discusses the following topic:

e The AWIPS Workstation Input Devices - Subsection 2.1.1
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2.1.1 The AWIPS Workstation Input Devices — Mouse and Keyboard

Each AWIPS Workstation has two input devices: a three-button mouse and a keyboard. Both the Graphic Workstation
(LX), which is used to interact with CAVE via the Graphical User Interface (GUI), and the Text Workstation (XT),
which is used to interface with the Textual User Interface (TUI), include a set of the same input devices.

This subsection describes the hardware components (input devices) that comprise the AWIPS Workstation.

e Mouse: The three-button mouse, shown in Exhibit 2.1.1-1, performs a number of actions in CAVE. In this
manual, each mouse button is referred to by number: Button 1 (B1), Button 2 (B2), and Button 3 (B3).

Note 1: A two-button mouse with a clickable scroll wheel is also referred to as a three-button mouse. The
clickable scroll wheel is the second button (B2).

Exhibit 2.1.1-1. Right Handed Mouse (three-button mouse and a two-button mouse with clickable scroll-wheel)

Most mouse actions are invoked with mouse Button 1. It is the primary activator button for opening and closing
menus and making most menu selections. In this manual, subsequent references to a mouse click refer to Button
1 unless otherwise noted.

For a right-handed mouse (default), Button 1 is on the left. You can change the left-hand and right-hand
orientation of the mouse through the KDE Control Center.

o To change the left-hand and right-hand orientation of the mouse:
1. From the panel on the desktop, click the Red Hat button and select Control Center.
2. In the Control Center window, on the Index tab, select Peripherals > Mouse.
3. On the General tab, in the Button Order section, select Right handed.
4. Click Apply to accept the change and close the window.

On the GUI the mouse button functions are configurable from the Preferences dialog box under the CAVE
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menu, as shown in Exhibit 2.1.1-2. Additional mouse button functions are described in Subsection 3.3.4-
Obijective 6.5.

Exhibit 2.1.1-2. CAVE Preferences Dialog Box for Mouse Button Configuration

Table 2.1.1-1 lists the default legacy mouse button functions and user interface locations of each mouse
button action for all three mouse buttons (B1 through B3). Most of the mouse actions described are related
to features that are covered in detail in upcoming chapters. The procedures described in this manual are
written per the default mouse button configuration. However, you can change the mouse button
configuration or add your own shortcuts using the Preferences dialog box.

Note 2: The mouse buttons are user defined, linked to your log-in ID.

Table 2.1.1-1 B1. Legacy Mouse Button 1 (B1) Functions for the CAVE Workspace

\ Function | Mouse Action \ Cursor Location
‘Open Dropdown Menus |Click B1 ‘On Menu Bar
‘Create Tear-off Menus |C1ick B1 ‘On Dashed Line of Dropdown Menu
‘Activate Menu Buttons |C1ick Bl ‘On Toolbar
’Make Menu Selection |Click B1 ’In Menu
‘Iconify Dialog Box |C1ick B1 ‘In Little Square in Title Bar of Dialog Boxes
‘Zoom Out |C1ick B1 ‘In Main Display Pane and Smaller Monitor Panes
Zoom Out 1:1 Shift + Click  |In Main Display Pane and Smaller Monitor Panes
Bl
‘Toggle Product Legend |C1ick B1 ‘On Legend in Main Display Pane
Sample Data Click and Hold |In Main Display Pane and Smaller Monitor Panes with Image
Bl Data, METAR, Ceiling/Vis Plots, or Wind Vector Grids
Drag Slider to Desired Setting Click and Hold |On Slider Bar in Dialog Box
B1
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Move Point, Baseline, Distance Speed,  |Click and Hold (In Main Display Pane and Smaller Monitor Panes
WarnGen Vertex; Select Alert Area Bl
‘Pop (bring window to front) Click B1 In Title Bar or frame of Any Window or Dialog Box
Move Click and Hold |In Title Bar of Any Window or Dialog Box

Bl
Shade (roll up/unroll) Double-click  |In Title Bar of Any Window or Dialog Box

Bl

Table 2.1.1-1 B2. Legacy Mouse Button 2 (B2) Functions for the CAVE Workspace

\ Function

| Mouse Action

\ Cursor Location

Zoom In

Click B2

In Main Display Pane and Smaller Monitor
Panes

Pan Across Zoomed Product

Click and Hold B2, Drag
Mouse

In Main Display Pane and Smaller Monitor
Panes

Box

Toggle Product Between Contour and Image  |Click B2 On Product Name in Volume Browser
(or Barbs, Arrows, and Streamlines for Wind

Data)

‘Toggle Tools' Editability Click B2 On Tool Legend in Main Display Pane
Insert/Delete Vertices When Editing Warning  |Click B2

On Lines/Vertices of Warning Box in Large
and Small Display Panes

Expand or Compress Section of Color Bar

Click and Hold B2, Drag
Mouse, Release to see
change

On Color Bar in Image Colors Editor

Move Window or Dialog Box Without Popping

Click and Hold B2, Drag
Mouse

In Title Bar of Any Window or Dialog Box
That Is Partially Covered by CAVE Display

Table 2.1.1-1 B3. Legacy Mouse Button 3 (B3) Functions for the CAVE Workspace

\ Function | Mouse Action \ Cursor Location

Swap Smaller Monitor Pane with Click B3 In Smaller Monitor Panes

Main Display Pane

‘Pop/Push Dialog Boxes ‘Click B3 ‘In Title Bar of CAVE Display or Dialog Box

‘Toggle All Product Legends |Click B3 ‘Over Displayed Product in Main Display Pane

’Bring Up Color Table |Click B3 ‘On Legend in Main Display Pane

Open Respective Pop-up Menu Click and On Legends or Over Displayed Products in Main Display Pane and
Hold B3 Smaller Monitor Panes and in 4 Panel

Open Pop-Up Menu in Volume Click and On Product Name in Volume Browser

Browser Hold B3

’Toggle Alert Cells |Click B3 ‘In Radar Alert Area

e Keyboard: Exhibit 2.1.1-3 shows a typical AWIPS Workstation keyboard.

Exhibit 2.1.1-3. AWIPS Workstation Keyboard
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o Keyboard Shortcuts: Instead of using the mouse pointer for every workstation display manipulation,
some functions can be activated by pressing a combination of keyboard keys, called Keyboard Shortcuts.

Note 3: Keyboard shortcuts are not case sensitive, even though they appear in uppercase on the
menus; you can use upper or lowercase letters.

m Keyboard shortcuts for menu functions: Keyboard shortcuts can be found to the right of some
menu options listed on the CAVE menus. A list of available keyboard shortcuts for menu functions
is provided in Table 2.1.1-2.

Table 2.1.1-2. Keyboard Shortcuts for Menu Functions

Keys or Key
Combinations

‘ Menu Function

‘ File Menu Functions

‘New Procedure |Ctrl +n
’Open Procedure |Ctrl +o0
‘Delete Procedure - requires acknowledgment |Ctrl +d
‘Copy Display to Procedure(s) |Ctrl +b
‘Open History List ’Ctrl +h
‘Open Print Dialog Box |Ctr1 +p
’Exit CAVE - requires acknowledgment |Alt +F4
‘ View Menu Function

‘Clear Main Display Pane |Ctr1 +c
] Options Menu Functions

‘Turn on Time Options |Ctrl +1
‘Turn on Data Scale |Ctrl +s
‘Open Loop Properties Dialog Box ’Ctrl +1
‘Open Image Properties Dialog Box |Ctr1 +1i

] Miscellaneous Functions

Open first dropdown menu. Use arrows to scroll through every menu option of each menu. Press  [F10
Enter key on keyboard to make a menu selection.

‘Cursor Location |F 12

m Keyboard shortcuts for large display pane: For functions that manipulate the main D2D display
(the Main Display Pane), the keyboard shortcuts are entered using the arrow keys and the numeric
keypad. Table 2.1.1-3 identifies the keyboard shortcuts for the main D2D display functions. You
should become familiar with using these keys, because they provide convenient shortcuts to perform
routine display manipulations.

Table 2.1.1-3. Keyboard Shortcuts for Main Display Pane Functions

\ Functions | Key or Key Combinations
Navigation Functions

‘Step Back, Step Forward (at Current Tilt for All-Tilts Display) |Left Arrow, Right Arrow

Step Back, Step Forward Through All Frames Ignoring Any Tilt Considerations Shift + Left Arrow, Shift +
Right Arrow

First Frame, Last Frame in the Collection Ctrl + Left Arrow, Ctrl + Right
Arrow

‘Step Up, Step Down Through All-Tilts for the Currently Displayed Time |Up Arrow, Down Arrow

‘Increase, Decrease Loop Speed (Turns on Looping) ‘Page Up, Page Down
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‘Zoom Out 1:1 |Shift + Mouse Button 1
Toggle/Fade Functions - Num Lock Must Be On

‘Toggle Image |Keypad 0

’Toggle Overlays 1-9 |Keypad 1-9

‘Toggle Overlays 10-19

|Ctr1 + Keypad 0-9

‘Image 1/Image 2 Toggle

|Keypad . (Decimal)

- Single Image: Reduce Brightness, Increase Brightness Keypad -, Keypad +
- Combined Image: Fade to Image 1, Fade to Image 2
\ Legend Functions
Legend Cycle: Keypad Enter
1. Show Product Legends
2. Show Map Legends
3. Show Valid Time
Panel/Combo Rotate Functions
Enter panel/combo rotate mode, showing upper left product with most 'fade’; step to next |Delete
panel if already in rotate mode.
Enter panel/combo rotate mode, showing upper left product with most 'fade'; step to Backspace
previous panel if already in rotate mode.
Enter panel/combo rotate mode (also true for 2..8); show left-hand image of upper left 1
panel
‘Show left-hand image of upper right panel ‘2
‘Show left-hand image of lower right panel |3
’Show left-hand image of lower left panel |4
‘Show right-hand image of upper left panel ‘5
‘Show right-hand image of upper right panel |6
’Show right-hand image of lower right panel |7
‘Show right-hand image of lower left panel |8
‘Return to 4-panel display |End

m Keyboard shortcuts for loop and step functions: Table 2.1.1-4 lists the loop and step arrow keys
and keypad functions. For more information about looping and stepping through a display, see the
All-Tilts section in Subsection 2.2.6.12, or see the All-Tilts practice module in Subsection 3.3.4-

Obijective 7.6.

Table 2.1.1-4. Loop and Step Keypad Shortcuts

] Button

’ Function

‘Left Arrow

|Step Backward in Time at a Fixed Tilt (Single-Tilt Mode)

’Right Arrow

|Step Forward in Time at a Fixed Tilt (Single-Tilt Mode)

|Shift + Left Arrow

’Step Backward Through All Frames Ignoring Any Tilt Considerations (All-Tilts Mode)

|Shift + Right Arrow

|Step Forward Through All Frames Ignoring Any Tilt Considerations (All-Tilts Mode)

’Ctrl + Left Arrow

|Displays First Frame and Returns to the Default Navigation Mode

[Ctrl + Right Arrow

|Displays Last Frame and Returns to the Default Navigation Mode

‘Ctrl + Down Arrow

|Displays First Frame of a Tilt or Volume Scan (Single-Tilt and Single-Volume Display Mode)

’Ctrl + Up Arrow

’Displays Last Frame of a Tilt or Volume Scan (Single-Tilt and Single-Volume Mode)

‘Page Up

|Start/ Speed Up Loop

‘Page Down

|Start/ Slow Down Loop

‘Up Arrow

’Step Upward at the Currently Displayed Time (Single-Volume Mode)

‘Down Arrow

|Step Downward at the Currently Displayed Time (Single-Volume Mode)

’Shift + Up Arrow

|N0 Function

|Shift + Down Arrow

’No Function
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Notes:

If you hit the up or down arrow after a standard load, and then hit Page Up or Page Down to
start looping, you'll find that you have an 'uninteresting' loop - that is, a loop of one frame -
until you hit one of the step forward/backward keys. The reason is that using up/down puts you
in loop-within-a-volume (Single Volume) mode, and there's no vertical component to your data.

The default looping behavior immediately after loading is to loop ignoring any tilt
considerations until one of the arrow keys is used. Otherwise, the form of looping depends on
whether you most recently used the left/right or up/down arrows prior to starting the loop.

For All-Tilts, the meaning of first and last frame is bottom and top if you have been using the
up/down motion; oldest and newest if stepping by time; and oldest/lowest and newest/highest if
navigating all frames.
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2.2 The AWIPS Graphical User Interface

This section describes the AWIPS Graphical User Interface (GUI) that is displayed on the AWIPS Graphic
Workstation. The three graphic displays that comprise the Graphic Workstation share a common keyboard,
three button mouse, and central processing unit (CPU - LX), as shown in Exhibit 2.1-1. The GUI enables
forecasters to view many different types of meteorological data on one system.

This section discusses the following topics:

Color - Subsection 2.2.1

Layout of CAVE's Graphical User Interface (GUI) - Subsection 2.2.2

CAVE Perspectives - Subsection 2.2.3

Windows, Tooltips, Menus, Dialog Boxes, and Other CAVE Operational Features - Subsection 2.2.4

Reserved - Subsection 2.2.5

The Menu Bar - Subsection 2.2.6

The Toolbar and CAVE Perspectives Tab Bar - Subsection 2.2.7

Pop-up Menus - Subsection 2.2.8

Color Editors - Subsection 2.2.9
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2.2.1 Color

The Meteorological World of Color

Color is an important visual element of most user interfaces for conveying information. While black and
white, and various shades of gray are important to meteorologists, color depicts some very important specific
meteorological information. The visual world, the world as we see it, is filled with colors, but the colors we
see are very different from the meteorological world of colors. We see the "true colors" of the physical
properties of an object, the same natural colors that are viewed through the lense of a camera. In the
meteorological world of satellites and radar, color is viewed differently. Satellite and radar pictures display
"false colored" images, meaning the colors are assigned by a computer according to the amount of radiation
emitted by an object (satellite) or the energy reflected back (radar). These emissions collectively form the
Electromagnetic Spectrum that defines the different ranges of vision and describes color in terms of
frequency and wavelengths. Humans can only see a very small section of the Electromagnetic Spectrum,
known as the visible spectrum. Satellites, flying high above the earth, can view a much larger portion of the
overall spectrum, and build several images at varying wavelengths (called bands) of the same location.
However, unlike humans, satellites and radars don't see color; they only acquire images in black and white,
with the varying wavelengths supplying contrasting light and dark areas. Computers make it possible to
assign the "false colors" to these black and white images, with each wavelength (band) assigned a different
color. These bands are then combined to form a single brillantly colored meteorological image, supplying a
wealth of weather information to the meteorologist.

Color Map

Note 1: There is no official universal standard color map. Everyone uses their own color table, but most
are similar for common weather features.

When color was first introduced as a way to depict weather information, the mapping of colors to weather
features was largely determined by the local community weather station. Today, as a result of the growth of
interactive workstations targeted for weather analysis and forecasting, and televised weather broadcasts, the
meteorological community reached a consensus on a conventional color palette for depicting the most
common weather features. Specifications for all emissive display types, such as computer systems and
television displays, follow this conventional color scheme, and the naturally black and white images from
weather satellites and the WSR-88D Doppler weather radar now display images communicating weather
information using their respective conventional color palettes. Refer to Table 2.2.1-1 and Exhibit 2.2.1-1 for
satellite images, and to Table 2.2.1-2 and Exhibit 2.2.1-2 for radar images.
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Table 2.2.1-1. Consensus Color Palette for Common Satellite Weather Features

| Feature ] Description ‘ Color
‘Storms ‘Thunderstorms, tropical storms, tornados, hurricanes, warm fronts ‘ Red
‘High Moisture Saturation ‘Hurricanes, winter freeze ‘ Purple
‘Precipitation ‘Rain showers, solid or liquid or mixed solid and liquid ‘ Green
‘Precipitation ‘Snow showers, high cold clouds, thunderstorm clouds, winter blizzard ‘ White
‘Visual Obstructions ‘F og ‘ Yellow
‘Visual Obstructions ‘Low warm clouds ‘ Gray
Exhibit 2.2.1-1. Satellite Image (IR 13u Satellite Screen Capture)
Table 2.2.1-2. Consensus Color Palette for Common Radar Weather Features
| Feature \ Description \ Color
‘Lighter Precipitation ‘Not hitting the ground. "Ground clutter" indicating false echoes. ‘ Light Green
‘Light to Moderate Rain ‘Light, approaching moderate rain. ‘ Green
‘Moderate Rain ’ — ’ Yellow
‘Heavy Rain ‘ — ‘ Orange
‘Very Heavy Rain ‘Flooding rains, possibly hail or damaging winds and thunderstorms. ‘ Red
‘Freezing Rain ’Light freezing rain and/or sleet possibly mixed with rain or snow. ’ Light Pink
‘Icy Precipitation ‘Heavy icy precipitation ‘ Pink
‘Light Snowfall ‘ — ‘ Light Gray
‘Heavy Snowfall ’ — ’ White
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Exhibit 2.2.1-2. Radar Image (0.5 Reflectivity Screen Capture)

Note 2: Some broadcast meteorologists deviate from the conventional color palette by using blue
instead of green to indicate light rainfall, when their base maps are green.

Controlling Color in AWIPS

The "false colored" satellite and radar images shown on the AWIPS Workstation are colored according to an
unofficial, but conventional color palette. These colors cannot be changed by the user. However, the user is
able to control certain image properties for enhancing the visibility of a satellite image or enhance the
visibility of a radar image by changing the display screen's background color. Refer to Subsection 2.2.9. In
addition to controlling the image properties to enhance visibility, the Imaging dialog box enables the user to
obtain additional weather information from the selected satellite image, as shown in Exhibit 2.2.1-3.
Changing colors reveals additional weather information for the selected image.
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Exhibit 2.2.1-3. How Changing Color Reveals Additional Weather Information

In addtion to controlling a display's background color and a satellite's image properties, both of which are
used for obtaining weather information for analysis and forecasting, the user is able to configure the
workstation's properties for enhancing or customizing the usability of the workstation for themselves. For
example, the user can control the properties of the display or configure the colors for prioritizing alerts. Refer
to Section 12.3.
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2.2.2 Layout of CAVE's Graphical User Interface (GUI)

CAVE Display Components

This is an overview of CAVE's graphical user interface (GUI). From the system point of view, the entire
CAVE interface is a window. As such, it can be moved, minimized (iconified), restored, etc., in the same way
as any other window displayed by the system. It is also resizable. The display features introduced here are
covered more thoroughly in Subsection 2.2.4. Exhibit 2.2.2-1 illustrates the layout of the CAVE graphics
screen. All the perspectives have been selected, as indicated by the iconified tabs appearing on the CAVE
Perspectives Tab Bar. However, only the D2D 5 pane perspective is currently showing, as indicated by the
display, as well as by the highlighted tab.

Exhibit 2.2.2-1. CAVE Graphical User Interface (GUI)
The various sections of the graphics screen are described below.
e CAVE Screen Layout:

o Title Bar: The Title Bar is the top border of the CAVE Window. CAVE: followed by "ID", either
current site, as shown in Exhibit 2.1.2-1, or the username of the user that is currently logged on.

o Menu Bar: The first row of labels (menu buttons) is the Menu Bar. These menu buttons open
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dropdown menus that contain a large number of graphic or image products from various data
sources. The menus that display along the Menu Bar are determined by the perspective that is
selected.

o Toolbar: The second row of labels is the Toolbar, which contains buttons and option menus for
manipulating displayed data. The Toolbar can be hidden if desired. The button for WarnGen,
which opens the Warning Generation application, is also located on the Toolbar.

o CAVE Perspectives Tab Bar: The third row is the CAVE Perspectives Tab Bar. It always
contains the Open Perspective iconified button and at least one iconified tab for the currently
selected perspective (Refer to Subsection 2.2.3).

o Main Display Pane: The Main Display Pane is where all data selections are initially displayed
and where Toolbar manipulations take place. Products that you select for display always appear
in the large display pane.

o Smaller Monitor Panes: The Smaller Monitor Panes are located along the left side of the Main
Display Pane. They are only displayed with the D2D perspective (D2D 5 pane has 4 Smaller
Monitor Panes and D2D 3 pane has 2 Smaller Monitor Panes). They are used for both displaying
and monitoring data.

Note 1: Swapping Pane Contents: Clicking mouse Button 3 (B3) opens a menu with an
option for swapping the contents of the large display pane into the small pane. Data are
automatically updated in these small panes, and looping, zooming, and panning are also
possible.

Note 2: Pane Size: The size of all panes is adjustable. Click and hold mouse Button 1 (B1)
on the pane's border and drag either horizontally or vertically to resize the pane. The size of
the map background adjusts accordingly.

o AlertViz Status Bar: Floating along the bottom of the CAVE window is the AlertViz Status Bar.
Remember, AlertViz must be active to open CAVE, and therefore the AlertViz Status Bar is
always present. The AlertViz Status Bar contains two message windows for displaying an alert
when it occurs.

o Frames Status Window: The Frames Status Window displays the number of frames that are
open, which may or may not be the same number of frames that are selected from the Frames
button on the Toolbar. The window expands to accommodate the number of digits (1 - 64).

o System and CAVE Time and Date Status: The System Time and Date is located at the bottom
of the Panel on the left-side of the CAVE window. The CAVE Time and Date is at the bottom of
the CAVE window. System time is the current date and time of day, with the CAVE usually
reading the same. However, the forecaster can change the CAVE time and date in order to look at
past data and grid information.

o Product Requested and Wait Indicator: When a product is selected, the name of the product
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that is requested appears at the bottom of the screen with oscillating wait indicator. Once the
product appears on the display, the product name and wait indicator disappear.
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2.2.3 CAVE Perspectives

CAVE incorporates a collection of applications that are separate from the legacy AWIPS system. Each
application is contained in its own perspective, a user interface that contains different graphical layouts, tool
bars, and menu items unique to the application. The applications incorporated in CAVE consist of
applications from the legacy AWIPS system (D2D, GFE, Hydro, and MPE). Also included are Localization
and Other (XML).

The CAVE Perspectives Tab Bar includes the Open Perspective iconified button and at least one iconified
tab indicating the currently selected perspective. Selecting the Open Perspective icon drops down a list of
perspectives, as shown in Exhibit 2.2.3-1. When a perspective is selected from the list, an iconified tab for
the selected perspective is added to the tab bar to indicate the perspective is opened, and the tab remains on
the tab bar until the perspective is closed. The highlighted tab indicates the perspective that is currently
active. The tabs enable the user to move quickly between the different open perspectives by selecting the tab
for the respective perspective.

Exhibit 2.2.3-1. Open Perspective Dropdown Menu

Note: You can also access the list of perspectives from the CAVE menu (Refer to Section 2.2.6.1).

The CAVE perspectives and their respective display screens follow.

e D2D (Display 2-Dimensions): This perspective is used to derive gridded forecasts for various
meteorological variables and forecast products. There are two D2D display configurations: a 3 pane
perspective consisting of a Main Display Pane and 2 Smaller Monitor Panes (not shown) and a 5 pane
perspective consisting of a Main Display Pane and 4 Smaller Monitor Panes, as shown in Exhibit
2.2.3-2.
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Exhibit 2.2.3-2. D2D 5 Pane Perspective

e GFE (Graphical Forecast Editor): This perspective is used to derive gridded forecasts for various
meteorological variables and forecast products. The GFE perspective displays only a Main Display
Pane (Spatial Editor). Above the Spatial Editor is a GFE Toolbar and a Weather Element block (Grid
Manager), as shown in Exhibit 2.2.3-3.
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Exhibit 2.2.3-3. GFE Perspective

e Hydro: This perspective displays hydrological data. The Hydro perspective displays only a Main
Display Pane, as shown in Exhibit 2.2.3-4.
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Exhibit 2.2.3-4. Hydro Perspective

e Localization: This perspective displays localization data for the other perspectives and CAVE. The
Localization perspective displays a Main Display Pane in the middle of the screen to display mapping,
an area on the left side for selecting specific files, and an area on the right side for localization script
outlines, as shown in Exhibit 2.2.3-5.
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Exhibit 2.2.3-5. Localization Perspective

e MPE: This perspective displays hydrological data within the WHFS MPE Data Viewer. The Choose
Data Period dialog window enables filtering the information displayed. The MPE perspective displays
only a Main Display Pane, as shown in Exhibit 2.2.3-6.

Page 33



CAVE-D2D User's Manual AWIPS |1 Operational Build 13.4.1 - 31 July 2013

Exhibit 2.2.3-6. MPE Perspective

e Other: This option undocks the CAVE Open Perspective dropdown box and displays it as a floating
pallet, as shown in Exhibit 2.2.3-7.
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Exhibit 2.2.3-7. Floating Open Perspective Pallet

The Open Perspective floating pallet can be manually relocated to any desired location within the area
of the display screen. National Centers and XML are added to the list of perspectives. Selecting
National Centers opens the National Centers perspective, shown in Exhibit 2.2.3-8, and XML opens
the XML perspective, shown in Exhibit 2.2.3-9.

Exhibit 2.2.3-8. National Centers Perspective
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Exhibit 2.2.3-9. XML Perspective
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2.2.4 Windows, Tooltips, Menus, Dialog Boxes, and Other CAVE Operational Features

This subsection describes some distinctions among CAVE's windows, menus, dialog boxes, and other CAVE
operational features, such as the manner in which CAVE responds to system problems, etc. Understanding
these distinctions can help you become more comfortable navigating the CAVE interface. Remember that the
menus, tools, and other components that are displayed depend on the selected perspective.

e Special Feature

o Tear-off Menus: The parent menus and submenus on the CAVE menu bar, for all perspectives,
can be detached from the menu bar or the parent menu, as shown in Exhibit 2.2.4-1. Tear-off
menus are indicated, at the top of the menu, by the presence of a dashed line, or "perforation."

Exhibit 2.2.4-1. Tear-off Menus

Menus can be torn away by clicking on the dashed line. The system responds by making the
menu into a separate window, as shown in Exhibit 2.2.4-1. Then the torn-off menu can be
moved out of the way of your viewing area. As with all other windows, it can also be resized and
closed, or left open while you access other menus.
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Note 1: You can have multiple windows open at the same time, but you cannot make
multiple tear-offs of the same menu.

e CAVE Navigating Devices

o Dropdown Menus: The primary means of navigating CAVE is via the menus, with the majority
of those menus being the dropdown type, such as the example shown in Exhibit 2.2.4-2.

Exhibit 2.2.4-2. A Dropdown Menu

o Options Menus: Options menus, located on the Toolbar, behave like dropdown menus but
display the selected option's label in the menu button. Options menus are denoted with a small
down arrow, as shown in Exhibit 2.2.4-3.

Exhibit 2.2.4-3. An Option Menu (CONUS Selected)

o Cascading Options Menus: Some menus lead to other menus, and in turn these menus can then
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lead to additional menus, etc. This forms a cascading pattern, as shown in Exhibit 2.2.4-4. These
subsequent menus are called submenus, or pull-right second stage submenus. They are indicated
by a solid black right-pointing arrowhead located to the right of a parent menu option.

Exhibit 2.2.4-4. Cascading Options - Pull-right Second Stage Submenu

In order to remain displayed on the screen, pull-right menus don't always pull to the right as
indicated in Exhibit 2.2.4-4. Also, when these menus are attached to the parent CAVE menu bar,
you can open the next stage of a submenu by moving the mouse cursor over the option that
includes a right-pointing arrowhead. Then slide the cursor to the right or left to the submenu for
selecting an option. Detached menus (tear-off) require you to scroll to the option that includes a
right-pointing arrowhead and click mouse Button 1 to open the next stage submenu.

o Dialog Boxes: Dialog boxes are windows that are independent of the main CAVE window. They
are typically opened from a menu option containing an ellipsis (three dots after the menu option),
as shown in Exhibit 2.2.4-5.

Exhibit 2.2.4-5. Example of an Ellipsis for Opening a Dialog Box

An example of a dialog box is shown in Exhibit 2.2.4-6. Dialog boxes enable you to interact
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with the interface in a specialized way.

Exhibit 2.2.4-6. A Dialog Box

= Moving dialog boxes: Dialog boxes can be moved in the same way that other windows
are moved, that is, by pressing and holding mouse Button 1 over the window's Title Bar,
then dragging the window to the new location.

Dialog boxes can also be moved in front of other windows (popped) or behind other
windows (pushed). This means that it is possible (either intentionally or accidentally) to
pop or push a dialog box relative to the CAVE window. In the latter case, the dialog box
will seem to have disappeared. Should this happen, simply go to the parent menu and
reselect the item that has "disappeared," and either click on its icon on the Panel or click
with mouse Button 3 on the CAVE Title Bar to push CAVE back, revealing the dialog box.

= Minimizing or resizing dialog boxes: Dialog boxes can be minimized or resized in the
same way that other windows are minimized or resized, that is, by clicking the appropriate
iconified Minimize or Resize button (if available) in the upper right corner of the window.
When minimized, the dialog box "vanishes" from the screen. The dialog box can be
restored by clicking on its icon listed on the top portion of the Panel on the left side of the
screen (refer to Exhibit 2.2.2-1).

m Closing dialog boxes: Dialog boxes can be closed in the same way that other windows are
closed, that is, by clicking the iconified Close button in the upper right corner of the
window. If a Close, Exit, or Cancel button is present on the window, it should always be
used to close the dialog box. Some dialog boxes have a menu bar. When a menu bar is
present, the "close" or "exit" option is under the File menu. In this case, the dialog box
should always be closed from the File menu option.

¢ Navigation Tools and Rules

o Tooltips: Moving the mouse cursor over the items on the Toolbar displays "Tooltips," as shown
in Exhibit 2.2.4-7. Tooltips are helpful identifiers of the iconified buttons on the Toolbar. If you
do not want "Tooltips" to appear, they can be toggled off by going to the Help pull-down menu
and unchecking the Show tooltips option.

Exhibit 2.2.4-7. Example of a Tooltip

o Pop-up Menus: Pop-up menus contain options that are specific to a certain area of the CAVE
workspace (main display pane, smaller monitor panes, four-panel layout, or legends), and
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specific to the type of product being displayed (graphic plot, contoured graphic, or image).
Pop-up menus are built into the CAVE user interface, providing no visual cue of their presence;
they simply pop up when you perform a particular action. All pop-up menus in CAVE are
opened by pressing and holding mouse Button 3 in a specific area on the screen, such as the
window's title bar, a dialog box, or on a product legend. For a detailed description of CAVE
pop-up menus (refer to Subsection 2.2.8).

o General CAVE Menu Navigating Rules: Understanding the following general rules will help
you to become more comfortable navigating the CAVE menus:

Menu option selection: To choose a menu option, click the desired option. To close the
menu without selecting an option, click anywhere outside the menu. You can save mouse
clicks by pressing and holding mouse Button 3 over the menu button, dragging the mouse
cursor through the menu until the desired option is highlighted, and then releasing the
button. The requested action is initiated and the menu closes immediately.

Hovering mouse cursor (left-pointing arrow): When the mouse cursor hovers over the
display window or a dialog box, the window's title bar is highlighted, and the window is
said to have focus. Sometimes, when traversing the mouse cursor from screen to screen,
the display window fails to get focus; in this case, keyboard shortcuts will not work. You
may need to move the mouse cursor out of and back into the window, or even click on its
title bar, to regain focus.

Raised menu item text: If the text of a menu item appears raised from the plane of the
menu, that item is highlighted. A highlighted menu item is surrounded by a light gray or
purple box. An item can be highlighted, but it still needs to be selected, by clicking on it,
to initiate the action or to display the product.

Menu on-off check boxes: Some menus have small square boxes to the left of the items
on the menu. These are on-off checkboxes; that is, they are used to start or stop the
indicated action. If an action is on, the box is checked. To turn the action off, click the
checkbox. The checkmark is removed from the checkbox and the action is stopped.

Product data availability: The availability of data is not dependent on scale or projection.
All data-selection menus have a valid date and time adjacent to the product name. It means
the item is available and indicates the most currently available version of the product.
Whenever the Notification Server is updated, the "time" automatically updates. The format
is (dd.hhmm). When data is not available or is not updating, or the system has not been
notified that new data is available, dashes (--.----) appear in place of the date and time
(refer to Subsection 3.3.4 - Module 6: Working With a Single Graphic Product).

e Other CAVE Operational Displays

o Auto Update

As new versions of currently loaded products become available to the system, they are
automatically displayed. Auto Update functions in all five display panes. For example, if you are
displaying Meteorological Aviation Report (METAR) station plots and new data is received in
the database, the new METARSs are plotted on the screen.
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o Time Matching

By default, when you add overlays to a displayed product, the system matches the valid times to
those of the initially displayed product. This feature can be overridden by using the "Load
Modes" function (refer to Subsection 3.3.6 - Module 13: Load Modes). Time Options also allows
you to override standard time matching (refer to Subsection 2.2.6.4).

o CAVE Status Messages

When data is missing or incomplete, or there are other problems with the workstation, the Alert
Visualization Popup Message Dialog appears announcing an alert (refer to Chapter 15).

Note 2: There are three alert message priority levels: Routine, Significant, and Urgent.
Routine and Significant Radar status messages may include announcements from the Radar
Product Generator (RPG) and are often related to the radar applications (refer to Chapter 8).

Page 42



CAVE-D2D User's Manual AWIPS |1 Operational Build 13.4.1 - 31 July 2013

2.2.5 Reserved
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2.2.6 The Menu Bar

This section briefly describes the options available from the CAVE menu bar. The Menu Bar shown in
Exhibit 2.2.6-1 is that of the D2D Perspective. The D2D Perspective tab is highlighted, indicating the
selected Perspective. The menu bar consists of menu buttons that open dropdown menus applicable to the
D2D Perspective.

Exhibit 2.2.6-1. D2D Perspective Menu Bar Options

Note 1: The actions "Display" and "Load" are used interchangeably in this manual. Both refer to the
action(s) the system takes once you have selected one or more products. With the exception of the
Volume Browser, a product is loaded to the large display pane immediately after you have selected it. In
the Volume Browser, you must explicitly select Load to have your product(s) displayed. Refer to
Section 3.2 for more information.

Note 2: The descriptions of the D2D Perspective Menu Bar options are presented in the order in which
their buttons are displayed along the menu bar, moving from left to right. Keep in mind that some menu
button options require more detailed explanations, which you will find in subsequent sections of this
manual.

Note 3: Some dropdown menu (i.e., kxxx, txxx, etc.) vary from site to site.
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2.2.6.1 CAVE

Refer to Exhibit 2.2.6.1-1 for a display of the CAVE menu.

Exhibit 2.2.6.1-1. CAVE Dropdown Menu
The CAVE menu includes the following options:

e New: The "New" option opens the submenu shown in Exhibit 2.2.6.1-2. This submenu provides users
with the options to create a new Map Projection; open a new Map Editor (tab); start the Text
Workstation application; and initiate and configure the GUI of the AvnFPS application via the Aviation
submenu option.

Exhibit 2.2.6.1-2. CAVE New Option Submenu

e Perspective: The "Perspective" option opens the submenu shown in Exhibit 2.2.6.1-3, which lists the
CAVE Perspectives. A new Perspective can be opened from here, or from the iconic Perspectives
button.
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Exhibit 2.2.6.1-3. CAVE Perspective Option Submenu

e Data Browsers: The "Data Browsers" option opens the submenu shown in Exhibit 2.2.6.1-4. This
submenu includes one option: the "Product Browser." Click on "Product Browser" to display an
Explorer-type tree structure that lists products by category (GFE, Grid, Lightning, Maps, Precipitation
Rate, QPF, Radar, Redbook, and Satellite).

Exhibit 2.2.6.1-4. Data Browsers Option Submenu with Product Browser Categories

Note 1: The "Product Browser" can be used to view data that might be ingested but for which
CAVE is not localized. For example, it is possible for EDEX to ingest and store radar data that
does not appear on the normal CAVE menus, but can be accessed by the "Product Browser."

e Data Delivery: The "Data Delivery" option opens the Data Delivery application. Data Delivery is a
permission-based application, meaning that the System Manager or User Administrator controls the
user's access to the Data Delivery functionalities. If granted permission to access this application, Data
Delivery allows a user to subscribe to a data source or create an ad hoc request and have the data
delivered in near real time. Whether delivered by subscription or in response to an ad hoc request, the
data can be tailored to a user's specific temporal, geographic, and parameter needs. For a detailed
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description of the Data Delivery application, refer to Section 16.1.

e Collaboration: The "Collaboration" option offers two main functions: chatting and sharing displays.
Chat allows users to send and receive instant messages or chat with fellow forecasters and offices in a
chat room. Sharing displays adds to the chat room capabilities and allows the room's creator to show a
CAVE map display to other participants in the room. For a detailed description of "Collaboration" and
information on how to create a chat session and share displays, refer to Section 16.2.

e AWIPS User Administration: Some of the functionalities of certain CAVE applications (currently,
Data Delivery and Localization) are reserved for designated users. User Administrators choose the
"AWIPS User Administration" option to access the screens they use to set permissions and roles for the
reserved functions. Access to the "AWIPS User Administration" option is limited to User
Administrators. Other users who select this option will be denied access and receive the Alert Message
shown in Exhibit 2.2.6.1-5. More information on AWIPS User Administration is provided in the
System Manager's Manual.

Exhibit 2.2.6.1-5. AWIPS User Administration - Alert Message (**"Not a User Administrator')

o AWIPS Statistics: The "AWIPS Statistics" option offers two main functions: capturing system
performance and analyzing system performance statistics. The captured data is viewable via a graph or
.csv file. For a detailed description of "AWIPS Statistics," refer to Section 16.3.

e Import: The "Import" option opens the submenu shown in Exhibit 2.2.6.1-6, which allows the user to
import GIS Data, BCD File, GeoTIFF, LPI File, Shapefile, SPI File, or Displays.
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Exhibit 2.2.6.1-6. CAVE Import Option Submenu

The "GIS Data" option opens the GIS application, which provides the ability to import geospatial data
from varying GIS data sources. The GIS application has been incorporated into CAVE for use with
FX-Net. For a detailed description of the GIS Data application, refer to Section 16.4.

e Export: The "Export" option opens the submenu shown in Exhibit 2.2.6.1-7, which allows the user to
save, send, and print captured displays. The displays can then be used in other applications or sent to
other users for analysis.

Exhibit 2.2.6.1-7. CAVE Export Option Submenu

The "Export" submenu also includes a "KML" option, which allows users to save D2D displays in the
KML (Keyhole Markup Language) file format. When zipped (compressed), the KML file format forms
a KMZ file, which can be used in applications such as Google Earth. Selecting KML opens the Export
KML dialog box shown in Exhibit 2.2.6.1-8.
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Exhibit 2.2.6.1-8. Export KML Dialog Box

Note 2: The products loaded in the user's main D2D display pane will be listed in the "Products"
section of the Export KML dialog box. Only checked products will be exported.

The KML dialog box includes options to select frames to export, as well as the following "Other
Options":

o Export Hidden: When selected, all displayed and hidden products listed in the Product Legend
section of the Main Display Pane will be exported.

o Export Maps: When selected, all enabled maps displayed within the Main Display Pane will be
exported.

o Shade Earth: When selected, a shaded background is applied to the exported product. If loaded
in Google Earth, the earth will be overlaid with a black backdrop, and data will be displayed as it
would in D2D with a black background.

o Show Background Tiles: When selected, data (such as plot data) will display on top of black
tiles when loaded in Google Earth.

e | oad/Save Displays: The "Load/Save Displays" option opens the cascading submenu shown in
Exhibit 2.2.6.1-9, which provides the user with the ability to save or load displays to or from a given
path within the file directory of the workstation.
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Exhibit 2.2.6.1-9. CAVE Load/Save Displays Option Submenu

Note 3: The Editor Display references the Main Display Pane, while the Perspective Displays
reference all the display panes (3 or 5).

e Preferences...: The "Preferences" option opens the Preferences dialog box, which allows the user to set
the Base Maps and Server Data directories; set the Database Connection String, Config Directory, and
Log Directory for the Hydro applications; set the Localization Site and/or Server for the workstation;
configure the Mouse operations; change the Performance Levels; set the Radar Server; set the Font
Magnification; and set the Text Workstation hostname.

e Exit...(Alt + F4): The "Exit" option allows the user to shut down the CAVE workspace. (You can also
use the "Alt + F4" keyboard shortcut to exit.) When you choose this option, a dialog box appears in the
center of the display screen and asks you to confirm that you really want to quit.
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2.2.6.2 File

The File menu, shown in Exhibit 2.2.6.2-1, includes of the following options:

Exhibit 2.2.6.2-1. File Dropdown Menu

e Procedures: The Procedures pull-right submenu, as shown in Exhibit 2.2.6.2-2 enables you to define
and customize a sequence of routinely used products or products used for a particular forecast problem.
Refer to Subsection 3.1.1 for more information.

Exhibit 2.2.6.2-2. Procedures Pull-right Menu

Note 1: The Procedures that are under the File menu differ from the Procedures that are under the
CAVE menu.

e History List (Ctrl + h): A History List is a recall list of all the products loaded to the large display
pane since the last restart of the workstation. Products in the history list are used to build procedures.
The History List can also be opened with the "Ctrl + h" keyboard shortcut. Refer to Subsection 3.1.1

for more information.

e Print... (Ctrl + p): This option does not send anything to the printer, but rather allows you to setup the
printing options. The Print Dialog Box, as shown in Exhibit 2.2.6.2-3, can also be opened with the
"Ctrl + p" keyboard shortcut. To change the destination printer from the default (Ip1), type the desired
printer name in the Printer data entry field. Use Ip2 for the color printer.

Note 2: The Print Icon button on the Toolbar can also be used for default printing. Refer to
Subsection 2.2.7
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Exhibit 2.2.6.2-3. Print Options Dialog Box

e Capture Window... : This menu option allows you to create screen shots (in PNG format) of objects
contained in a framed window. When you choose this option, the Window Capture dialog box, as
shown in Exhibit 2.2.6.2-4, appears and requires you to enter a filename.

Exhibit 2.2.6.2-4. Window Capture Dialog Box

Once you type in a unique file name, press the OK menu button and the mouse cursor becomes a
crosshair cursor. Simply click on the desired window and wait a moment for the Window Capture
message box to appear, confirming that the screen capture is complete, and indicating where your file
can be found.
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2.2.6.3 View

The View dropdown menu, shown in Exhibit 2.2.6.3-1, contains nine options that control the display
layout and product animation. All, except the Toolbar option, have corresponding Icon buttons in the
second row of menu options called the Toolbar. Refer to Subsection 2.2.7 for additional information on
toolbar options.

Exhibit 2.2.6.3-1. View Dropdown Menu

e Clear (Ctrl + C): This option clears the large display pane but retains the map background. You
can also use the Ctrl + C keyboard shortcut to clear the large display pane, or the Clear button in
the Toolbar.

e Step Back (Left): This menu option reverses the displayed data by one frame. You can also use the
LEFT ARROW keyboard shortcut to step back, or the Step Back iconified button on the Toolbar.

e Step Forward (Right): This menu option advances the displayed data by one frame. You can also
use the RIGHT ARROW keyboard shortcut to step forward, or the Step Forward iconified button
on the Toolbar. If you hit the UP or DOWN ARROW keys in a standard (not All-Tilts) display,
stepping is disabled until you hit either the left or the right arrow key.

e First Frame (Ctrl + Left): This option displays the first frame of available data. You can also use
the Ctrl + LEFT ARROW keyboard shortcut or the First Frame iconified button on the Toolbar.

e Last Frame (Ctrl + Right): This option displays the last frame of available data. You can also use
the Ctrl + RIGHT ARROW keyboard shortcut or the Last Frame iconified button on the Toolbar.

e Looping (Up/Dn;L/R): Check this box to enable animation (Page Up/Page Down buttons turn
looping on, LEFT/RIGHT ARROWS turn looping off). You can also use the Loop Properties
Dialog Box or the Looping iconified button on the Toolbar. If you hit the UP or DOWN ARROW
keys in a standard (not All-Tilts) display, looping is disabled until you hit either the left or the right
arrow key.

e Default Pane Layout: This menu option arranges the display in the D2D 5 pane layout, with a
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Main Display Pane on the right side of the workstation display and four Smaller Monitor Panes of
equal size along the left side of the display. You can also set the display to the default (5 pane)
layout by clicking the 5 pane iconified button on the Toolbar. Refer to Exhibit 2.2.6.3-2 for an
example of the D2D 5 pane layout.

Exhibit 2.2.6.3-2. Default D2D 5 pane Layout

e Three Pane Layout: Refer to Exhibit 2.2.6.3-3. This option arranges the display to have one Main
Display Pane and two medium-sized Smaller Monitor Panes along the left side of the display. You
can also set the display to the 3 pane layout by clicking the 3 pane iconified button on the Toolbar.
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Exhibit 2.2.6.3-3. D2D 3 pane Layout

e Toolbar: Check this box to show the Toolbar, namely, the second row of options along the top of
the display. You can hide the Toolbar if you need more viewing space by unchecking this checkbox.
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2.2.6.4 Options

The Options menu, as shown in Exhibit 2.2.6.4-1, contains options that enable you to set display preferences
such as magnification (graphic font size), density (amount of data displayed), looping speed, color tables, and
time resolution.

Exhibit 2.2.6.4-1. Options Dropdown Menu

Most of these options are available on the Toolbar or in other areas of the user interface, but are redundantly
placed in this pull-down menu in case you want to hide the Toolbar. Refer to Subsection 2.2.7 for more
information on Toolbar options.

e Time Options (Ctrl + T): This check button enables/disables the ability to select the time interval
between frames of real-time or model data. This feature has the added benefit of allowing you to view
extended amounts of data (temporally) but stay within the limits of 64 frames. For example, METAR
surface plots, which typically display every hour, can be set to display every three hours via the Select
Valid Time and Time Resolution Dialog Box.

When the Time Options check button is selected, the next product you choose to display in the Main
Display Pane launches either the Select Valid Time and Time Resolution dialog box or the Select
Offset and Tolerance dialog box.

o When you are loading data to an empty display and the Time Options check button is enabled,
the Select Valid Time and Time Resolution dialog box opens.

m Valid Time: In this column of dates/times, you may choose the one that will be the first
frame loaded onto the Large Display Pane. The Default option is the most recent data.

m Time Resolution: This column contains various time increments in which the data can be
displayed. Once you make a selection, the Valid Time Column indents the exact times that
will be displayed. The Default resolution displays the most recent frames available.

o With the Time Options check button enabled for a display that already contains data, when you
choose the data to be overlaid in the Main Display Pane, the Select Offset and Tolerance dialog
box appears, providing the following options:
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m Offset: This column contains various time increments at intervals before, at, or after the
time you selected for the first product that is displayed in the Main Display Pane.

m Tolerance: The options in this column refer to how strict the time matching is. "None"
means an exact match, while "Infinite" will put the closest match in each frame, regardless
of how far off it is.

e Data Scale (Ctrl + S): This check button enables/disables the ability to display data on its native scale.
For example, if you enable Data Scaling and select a product from an alternate radar, the data will be
displayed with that radar in the center of the screen. Other data can be overlaid on this "dynamic" scale
until the Main Display Pane is cleared or a non-plan-view product is loaded. Refer to Subsection 3.3.4.

¢ Image Combination (Insert): This check button enables/disables the ability to display two images at
once. You can also enable/disable the ability to combine images by using the Toggle Image
Combination iconified button on the Toolbar.

Combined-image displays have been improved by removing the valid time for non-forecast products
and removing the date string (time is kept) from the left side of the legend. In particular, this makes
All-Tilts radar legends more usable.

Note 1: If the time of both images is the same, the day-month-year string is shown only for the
right-side image (unless it's not loaded, in which case the day-month-year is included on the left).

e Display Properties...: This menu option opens the Display Properties dialog box. All the options
available in this dialog box are also available on the Toolbar.

o Scale: The Scale menu, which defaults to CONUS scale when CAVE is first started is shown in
Exhibit 2.2.6.4-2. From this menu you can choose any of the scales defined for your location: N.
Hemisphere, North American, CONUS (Conterminous United States), Regional, State(s), and
WFO (Weather Forecast Office).

Exhibit 2.2.6.4-2. Scale Menu with Default CONUS Scale Selected

The selected scale is shown on the toolbar when the Scale menu is closed. In Exhibit 2.2.6.4-2
CONUS is displayed on the toolbar indicating the CONUS scale is currently selected.

Note 2: The Scale menu options vary based on local needs and requirements. Data is not
Scale dependent; it can be displayed on any scale.

Page 57



CAVE-D2D User's Manual AWIPS |1 Operational Build 13.4.1 - 31 July 2013

The CONUS Scale is displayed in the Main Display Pane, and other map backgrounds with
different scales are loaded into the four Smaller Monitor Panes. The Scale option menu affects
only the Main Display Pane. A swap is required to change the scale on a Smaller Monitor Pane.

Once data has been loaded, changing the scale will alter the map background. The data displayed
will remain displayed. You can also swap the Smaller Monitor Pane showing the desired scale
with the Main Display Pane to change scales (refer to Subsection 3.3.4, Module 6 for more
information).

o Load Mode: Also under the Display Properties option is Load Mode, shown in Exhibit
2.2.6.4-3, which provides different ways to display model or real-time data by manipulating
previous model runs and inventories of data sets.

Exhibit 2.2.6.4-3. Load Mode Option Menu

The selected load mode is shown on the toolbar when the Load Mode menu is closed. In Exhibit
2.2.6.4-3 Valid time seq is displayed on the toolbar indicating the Valid time seq load mode is
currently selected.

The Load Modes are defined here, and an example of their use is found in Subsection 3.3.6,
Module 13.

m L atest: Displays forecast data only from the latest model run, but also backfills at the
beginning of the loop with available frames from previous runs to satisfy the requested
number of frames.

m Valid time seq: Displays the most recent data and fills empty frames with previous data.
For models, it provides the product from the latest possible run for every available valid
time.

= No Backfill: Displays model data only from the most recent model run time with no
backfilling to fill out a loop. Using this Load Mode prevents the mixing of old and new
data.

m Previous run: Displays the previous model run, backfilling with frames from previous
runs at the beginning of the loop to satisfy the requested number of frames.

m Prev valid time seq: Displays the previous model run and fills empty frames with
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previous model data or analyses.
m Prognosis loop: Shows a sequence of n-hour forecasts from successive model runs.
= Analysis loop: Loads a sequence of model analyses but no forecasts.

m dProg/dt: Selects forecasts from different model runs that all have the same valid times.
This load mode is available only when there are no other products loaded in the large
display pane.

m Forced: Puts the latest version of a selected product in all frames without time-matching.

m Forecast match: Overlays a model product only when its forecast times match those of an
initially loaded product. This load mode is available only when another product is already
loaded in the large display pane.

m Inventory: Selecting a product when the load mode is set to Inventory brings up a Dialog
Box with the available forecast and inventory times from which you can select the product
you want. Inventory loads into the currently displayed frame.

m Slot: Puts the latest version of a selected product in the currently displayed frame.

Note 3: Default Load Modes -- Latest Run and Valid Time Sequence are "sticky" default
load modes. This means that the current load mode setting automatically defaults back to
either Latest Run or Valid Time Sequence, whichever you used before switching to another
load mode.

o Frames: Frames is used to select the number of frames of a product you want loaded. The
startup default is 12 frames, but whatever number you choose is used until you change it. The
maximum frame count has been increased to 64.

Exception: Family graphics (see Subsection 2.2.6.6) come with a preset frame count, to allow
you to see the entire model run.

Note 4: If no frames of data are available, the system sends a message to the General Status
Area of the Status Bar. You can also use the Frames Option menu in the Toolbar.

o Magnification: You can enlarge or reduce the size of text and symbols on a graphic product
using the Mag: option. As you increase magnification, the density of the data presented
automatically decreases. The purpose of this feature is to make text and symbols more visible.
Selecting Mag: O displays all the site locations without any visible data.
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o Density: The display features an automatic declutter function, which adjusts the density of
station plots and contours for clarity of view. You can override the default setting to adjust the
amount of data presented on the large display pane by using the Density: option. You can also
change the density setting from the Toolbar. Lower-density settings decrease the amount of data
displayed; higher settings increase the amount of data. The "Max" density setting displays all
available data and therefore disables declutter.

e Loop Properties... (Ctrl + L): Loop Properties is another dialog box that can be opened from the
Options menu or from the Loop Properties iconified button on the D2D Toolbar, or by using the
Ctrl + L keyboard shortcut. The dialog allows you to adjust the forward and backward speeds, with 0
= off and 10 = maximum speed. You can set the duration of the first and last frame dwell times to
between zero and 2.5 seconds.

You can turn looping on or off by checking the Looping check button. There is also a Looping button
located on the Toolbar that enables/disables the animation in the large display pane. Finally, you can
turn looping on and increase/decrease forward speed by pressing Page Up/Page Down on your
keyboard, and turn looping off with the Left or Right Arrow keys. On the toolbar, you can use the
button to start/stop looping.

e Image Properties... (Ctrl + 1): The Image Properties dialog box can be opened here or by using the
Image Properties iconified button on the D2D Toolbar, or using using the Ctrl + | keyboard shortcut.
This dialog box provides options that allow you to change the color table; adjust the brightness,
contrast, and alpha of either a single image or combined images; fade between combined images;
and/or interpolate the displayed data.

From this dialog box, you can also access the Image Colors Editor, which enables you to edit and save
Image Color Tables. This option is selectable if an image or combined image product is displayed. If a
single image is loaded, the second color table selector and edit button are dimmed. Refer to Subsection
2.2.9 for more information on the Image Colors Editor.

o Change Color Table of Image: The Color Table option menus are annotated with a color table
name and a small rectangle. These menus provide a list of predefined or default color tables
(enhancement curves) available for use with displayed images.

While any color table can be used with any image, some are specifically designed for use with
satellite imagery, some for use with radar imagery, and others for use with gridded data displayed
in image format. (Displaying gridded data as an image is covered in Subsection 3.2.4.)

o Brightness Control Slider: The Brightness control slider changes the brightness of the display.
Drag the slider (using mouse Button 1) to the desired level of brightness, and then release the
mouse to save and view the change in the display. To adjust the brightness one increment at a
time, click adjacent to the slider using mouse Button 1 (this is called a "single step" change). To
adjust brightness to a specific level on the slider bar, place the pointer at the desired location
along the slider bar and click mouse Button 2 (this is called a "snap to" change). Brightness can
also be adjusted using the "+" and "-" keyboard shortcuts on the keyboard after the Brightness
slider bar has been selected (note the box that appears around the slider bar).
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Note 5: All images have default brightness settings, but you may need to adjust them to
make overlaid graphics and map backgrounds easier to see against the image.

o Contrast Control Slider: The Contrast control slider changes the contrast of the display. Drag
the slider (using mouse Button 1) to the desired contrast level, and then release the mouse to save
and view the change in the display. To adjust the contrast one increment at a time, click adjacent
to the slider using mouse Button 1 (this is called a "single step" change). To adjust contrast to a
specific level on the slider bar, place the pointer at the desired location along the slider bar and
click mouse Button 2 (this is called a "snap to" change). Contrast can also be adjusted using the
"+" and "-" keyboard shortcuts on the keyboard after the Contrast slider bar has been selected
(note the box that appears around the slider bar).

o Alpha Control Slider: The Alpha control slider changes the alpha level of the display. Drag the
slider (using mouse Button 1) to the desired level, and then release the mouse to save and view
the change in the display. To adjust the alpha level one increment at a time, click adjacent to the
slider using mouse Button 1 (this is called a "single step" change). To adjust alpha level to a
specific level on the slider bar, place the pointer at the desired location along the slider bar and
click mouse Button 2 (this is called a "snap to" change). The alpha level can also be adjusted
using the "+" and "-" keyboard shortcuts on the keyboard after the Alpha slider bar has been
selected (note the box that appears around the slider bar).

Note 6: All images have default alpha level settings, but you may need to adjust them to
make overlaid graphics and map backgrounds easier to see against the image.

o Interpolate: The Interpolate checkbox is located at the bottom of the Image Properties dialog
box. To interpolate the displayed data, place the mouse cursor in the checkbox and click mouse
Button 1 to place a checkmark in the box. Then observe the change in the display. To revert the
display so that the data is not interpolated, click the Interpolate checkbox to remove the
checkmark. Again, observe the change in the display.

o Combine a Second Image: The check button in the lower right corner of the Image Properties
dialog box allows you to combine a second image with an image already loaded. (Refer also to
Subsection 3.3.4, Module 8: Combining Image Products.)

o Edit <product>: A click on the Edit <product> menu button brings up the Image Colors Editor
dialog box. The Image Colors Editor allows you to make changes to a default color table for a
displayed image and to save your edits into a new color table. (Default color tables cannot be
permanently changed.) Refer to Subsection 2.2.9 for details on how to use the Image Colors
Editor.

o Combined Images: If combined images are loaded, the name of one product is displayed above
the Fade Slider Bar, and the other name is displayed below the Fade Slider Bar.

m Fade Slider Bar: The Fade Slider Bar in the middle of the dialog box lets you adjust how
much of each image is visible on the screen. The Fade Slider Bar works the same way as
the Brightness Control Slider.
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Note 7: You can fade an image using the "+" or "-" keyboard shortcuts. You can also
toggle between the images using the "period" on the keyboard. Refer to Table 2.1-3 in
Section 2.1.

m Brightness: This control works in the same manner for combined images as for single
images. Refer to the Brightness Control Slider paragraph above.

m Contrast: This control works in the same manner for combined images as for single
images. Refer to the Contrast Control Slider paragraph above.

m Alpha: This control works in the same manner for combined images as for single images.
Refer to the Alpha Control Slider paragraph above.

= Change Color Table: Both Color Table option menus are selectable. The top Color Table
option menu corresponds to the product name displayed above the Fade Slider Bar.
Similarly, the bottom Color Table option menu corresponds to the product listed below the
Fade Slider Bar.

e Set Time... : This option allows you to set the CAVE clock, located on the bottom of the screen, to an
earlier time for reviewing archived data. Selecting this option opens the Set Time dialog box. The Set
Time dialog box, as shown in Exhibit 2.2.6.4-4, includes several options.

Note 8: All times are in Coordinated Universal Time (UTC), also known as Greenwich Mean
Time (GMT) or "Z" time.

Exhibit 2.2.6.4-4. Set Time Dialog Box

o Use current real time: This radio button switches the CAVE clock to the current System time.
The System clock, or current real time, is located on the bottom of the Panel, left side of the
screen. In this mode the Set time parameter windows on the Set Time dialog box are dimmed.

o Set time: This option allows you to set the CAVE clock to a different year, month, day, hour,
minute, and/or second. For each element, a pair of "step buttons" allows you to set the option.
You can also click on the entry box and use the keyboard to enter a new value.

m Freeze time at this position: This checkbox is only available when Set time is selected.
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Freeze time at this position stops the clock from ticking and is selected by default. If it is
unchecked, the clock will be set to the specified time and then advance normally.

o OK: Applies the newly-selected time to the CAVE clock. If Freeze time is selected, the clock

will display yellow text on a black background. If Freeze time is unselected, it will be white on
black.

o Cancel: This menu button enables you to close the Set Time dialog box without applying the
changes.

e Set Background Color...: You can now set the background display color on your workstation. You can
also set the background display color for a single pane via mouse Button 3. The "Set Background Color
for all Panes" dialog box is shown in Exhibit 2.2.6.4-5.

Note 9: The background color is affected by the image brightness setting. Also, the sample color
and color bar annotation are always white, so samples may be difficult or impossible to read if
you pick a very light background color.

Exhibit 2.2.6.4-5. Set Background Color for All Panes Dialog Box

Page 63



CAVE-D2D User's Manual AWIPS |1 Operational Build 13.4.1 - 31 July 2013

2.2.6.5 Tools

Refer to Exhibit 2.2.6.5-1 for a display of the Tools menu.

Note 1: The tools listed on the Tools menu are ordered alphabetically, except for "Feature Following
Zoom" and "Time Of Arrival / Lead Time," which are logically associated with "Distance Speed."

Note 2: Many of the tools listed under the Tools menu can be placed into an editable state. Do not
enable the "Hide Legends" feature if you want to place a tool in an editable state, because access to
editability is by clicking mouse Button 2 (B2) over the Product Legend.

Exhibit 2.2.6.5-1. Tools Dropdown Menu

e Az/Ran Overlay
This tool displays a movable azimuth/range radar map overlay. The overlay is in the "editable" state

when displayed, and can be relocated by positioning the mouse cursor to the center of the overlay and
clicking and holding mouse Button 1 (B1) to drag the map to the desired location.

e Baselines

Selecting Baselines displays 10 lines, labeled A-A' to J-J', along which cross-sections can be
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constructed from within the Volume Browser (refer to Subsection 3.2.2 for more information).
Baselines come up editable.

Note 3: "Snapping" an Interactive Baseline: If you are zoomed in over an area when you load
Interactive Baselines and no Baselines appear, press mouse Button 3 (B3) to "snap" a Baseline to
where the mouse cursor is. The system chooses a Baseline that has not been recently used. If you
are working with a Baseline, a second click with B3 will return you to the original Baseline, even
if you modified another Baseline in the meantime.

e Choose By ID...

Choose By ID, which is a function of DMD (Digital Mesocyclone Display), is a method of selecting
feature locations. The tool is used to monitor the same feature at a certain location. Without the Choose
By ID tool, a monitored feature (over a period of time) could move away from its monitored location
and another feature could move in its place. You can use Choose By ID to set points, baselines, and
"Home" for conventional locations like METARs and RAOBs (Radiosonde Observations), but its
primary use is for the WSR-88D-identified mesocyclone locations. Refer to Subsection 3.3.6, Module
14 for practice modules. You can also access the Choose By ID tool from the Tools menu on the
Volume Browser (refer to Subsection 3.2.2).

e Distance Bearing

Selecting this tool displays six editable lines, each of which shows the azimuth and range of the labeled
end of the line relative to the unlabeled end of the line. You can make the lines editable by clicking B2
over the legend at the lower right of the display. Once in edit mode, a line can be moved as a unit
and/or either of its end points can be adjusted.

e Distance Speed

This tool can be used to determine the speed and direction of a storm or any other meteorological
feature of interest. Selecting Distance Speed displays a Centroid Marker to move to the location of the
storm or feature of interest in any two or more frames of displayed imagery (e.g., a satellite or radar
loop). The system then displays a storm track with the direction (degrees) and speed (knots) of
movement.

When you select the Distance Speed option, the Distance Speed dialog box opens. It contains the
following options:

o Mode: You have the following selections from this option.
m Point: A radio button that allows you to set the Centroid Marker as a single point.
= Polyline: A radio button that allows you to set the Centroid Marker as a polyline.
o Legend: You have the following selections from this option.

= Time: A radio button that allows you to display time with the Centroid Marker.
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m Speed: A radio button that allows you to display speed with the Centroid Marker.
e Distance Scale
This tool can be used to determine the size of a storm or any other meteorological feature of interest.
e Feature Following Zoom

When you zoom in over a small area to be able to view a feature in detail, animation will often cause
the feature to move into and then out of the field of view. This tool allows you to follow a feature of
interest even when zoomed in to a small area.

To use this feature, first, you need to identify the location and motion of the feature, using Distance
Speed or the WarnGen tracker. Once satisfied that the tracking icon is following the feature of interest,
load this tool, and the center of the zoom area will track with the Distance Speed icon. Toggling the
overlay off will resume the standard zooming behavior, and toggling it back on will reinvoke the
feature following zoom.

e Estimated Actual Velocity (EAV)

A velocity (V) display from the radar shows only the radial component of the wind, so the indicated
speed depends on the direction of the wind and the azimuth (direction) from the radar. Consider, for
example, a north wind. Straight north of the radar, the full speed of the wind will be seen on the V
product. As one moves around to the east of the radar, the radial component gets smaller, eventually
reaching zero straight east of the radar. If the wind direction is known, then the actual wind speed can
be computed by dividing the observed radial speed by the cosine of the angle between the radar radial
and the actual direction. The EAV tool allows you to provide that angle and use the sampling function
of the display to show the actual wind speed.

Note 4: The EAV is modeled on VR - Shear, but in this case, the vector you draw serves primarily
to establish direction. While the data plotted at the endpoints and in the corner is valid, you'll use
sampling to gather most of the information you seek.

e 4-D Storm Investigator (FSI)

Using FSI, you can create and manipulate 3-dimensional radar displays. You'll find an overview of FSI
in Section 13.1.

e Time Of Arrival / Lead Time

Selecting the Time Of Arrival / Lead Time option displays a tracking line from a feature's initial
starting point in a past frame to its final position in the current frame. Once the final position is set, an
Arrival Point is displayed. You can drag this point anywhere along the line to get the Time Of Arrival /
Lead Time and Distance. You can also change the Mode from Point to Circular Front or Polyline
anywhere along the line to better represent the feature(s).

e Home

Page 66



CAVE-D2D User's Manual AWIPS |1 Operational Build 13.4.1 - 31 July 2013

Selecting the Home option displays a marker, which is an "X" with the word "Home" next to it.
Clicking on the Home Location Legend with B2 makes the marker editable; drag the "X" or click with
B3 to change its location. When the Home Marker is displayed, use the Sample feature (clock and hold
B1 while moving the pointer around the screen) to display the range in miles and azimuth (in degrees)
of the pointer location relative to the Home location. The Home tool is also useful when selecting radar
data that may be outside of your County Warning Area (CWA). Refer to Subsection 2.2.6.14 for more
details.

e L APS Tools...

Two LAPS tools are available from the LAPS Tools dialog box. The first LAPS tool is the "Data Used
by Current Analysis," and the second tool is the "Configure Analysis Domain."

o Data Used by Current Analysis: This tool allows you to select a given data type from the
Select Type Options Menu. Even though Surface is displayed as the Select Type, you still must
reselect it (or another item) to make it happen. After a moment, a report from the most recent
LAPS model run is displayed and provides detailed log information on what data was included in
that model run.

o Configure Analysis Domain: This tool provides information on the current map projection and
grid spacing of the LAPS program, and allows the user to relocate the LAPS domain
(constrained so as to contain your CWA). This tool has the following options:

m Projection: Only the center latitude and longitude are configurable on AWIPS.

m Grid: This area of the tool provides the horizontal and vertical LAPS grid spacing. It is
not configurable on AWIPS.

m Settings: This area consists of two reset buttons.

m Default: This menu button resets the LAPS model domain to the coordinates that
were used when the current AWIPS software was installed.

m Reset: This menu button resets the coordinate settings to those associated with the
current active analysis domain.

m L APS Relocator: Another way to change the domain is to drag the centerpoint using the
Graphical Relocator. By pressing the Load Menu button, the current LAPS grid domain is
displayed on D2D.

m Load: This menu button displays the graphical LAPS Relocator onto D2D. It is best
displayed on the State or Local scale. You can drag the centerpoint anywhere within
the dashed rectangular boundary. This boundary ensures that your CWA is still
covered in the LAPS run.

= Apply: When you click the Apply button, the display clears and the center location
you have selected is entered in the lat/lon boxes.

m Localize LAPS: This option initiates the process of relocalizing the LAPS run with the
newly defined domain coordinates. A message dialog box appears to warn you that the
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process can take about 10 minutes, and you may want to delay the localization to avoid
interrupting the next LAPS model run.

e Points

The Points option can be selected either from the Tools menu or from the Points iconified button on
the CAVE-D2D toolbar. When selected, the Points option initially displays a circular 10-point pattern,
labeled A through J on the Map display, as shown in Exhibit 2.2.6.5-2.

Exhibit 2.2.6.5-2. Points Display Pattern (10 Points A - J) and Product Legend

Points are used to generate model soundings, time-height cross-sections, time series, and variable vs.
height plots using the Volume Browser. As with the Baselines, the locations of these Points can be
edited in the following manner:

o "Snapping’ an Interactive Point: If you are zoomed in over an area when you load Interactive
Points and no Points appear, click B3 to "snap" a Point to where the mouse cursor is positioned.
The system chooses a Point that has not been recently used. If you are currently working with a
Point, then a second B3 click will place another Point at the location of your cursor.

o Dynamic Reference Map: When you generate a model sounding, a time-height cross-section, a
time series, or a variable vs. height plot, a small reference map indicating the location(s) of the
plotted sounding(s) is provided in the upper left corner of the Main Display Pane.

Points may be created, deleted, hidden, and manipulated (location, name, font, and color). Points are
not limited in terms of number, location, or designation. Points may also be assigned to different
groups to facilitate their use.

Once the Points tools have been loaded, the addition, deletion, or manipulation of Points can be
accomplished in three ways:

1. Create Point Dialog Box: The Create Point dialog box shown in Exhibit 2.2.6.5-3 is opened by
clicking and holding B3 on the map (but not on any exisiting Point) and selecting the "New
Point..." option.
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Exhibit 2.2.6.5-3. Create Point Dialog Box

The Create Point dialog box opens with the Lat and Lon text boxes populated with the latitude
and longiture values at the point where you had clicked B3. The latitude and longitude values
can be viewed in "Degrees : Minutes : Seconds," "Degrees : Minutes," or "Degrees Only" (N and
S refer to North and South; W and E refer to West and East).

In the Create Point dialog box, you must:

m Enter the Point's name

Modify the latitude and longitude values

Assign the Point's color and font use

Assign the Point to a group

Select whether the Point is movable or hidden

Note 5: By default, individual Points do not have an assigned color. They inherit the color
of the Interactive Points layer reflected in the Interactive Points product legend. You can
change the color of the Interactive Points layer by right clicking on the Interactive Points
product legend and selecting a color from the dropdown list. The selected color then
changes all points not having an assigned color to the new color.

Note 6: Points can be assigned to "<No Group>," which will organize them in the root
location containing the group names when accessed by the Edit Points dialog box (see
below).

2. Edit Point Dialog Box: The Edit Point dialog box shown in Exhibit 2.2.6.5-4 is opened by
clicking and holding B3 on a Point on the map and selecting the "Edit Point..." option. The
latitude and longitude values can be viewed in "Degrees : Minutes : Seconds," "Degrees :
Minutes," or "Degrees Only" (N and S refer to North and South; W and E refer to West and

East).

Page 69



CAVE-D2D User's Manual AWIPS |1 Operational Build 13.4.1 - 31 July 2013

Exhibit 2.2.6.5-4. Edit Point Dialog Box
In the Edit Point dialog box, you can:

= Change the Point's name

Change the Point's color and font

Change the Point's group

Change the Point's location

Select whether the Point is movable or hidden

Note 7: Besides the option of selecting the Edit Points dialog box, you also have the option
of selecting "Hide Point," "Delete Point," or "Move Point." Once hidden, the Point can be
unhidden using the Points List dialog box, where you would uncheck the checkbox under
the "Hidden" column adjacent to the Point that was hidden (see below). If "Delete Point" is
selected, a pop-up opens to confirm whether you want to delete the Point. Selecting the
"Move Point" option moves the Point to wherever you place the cursor on the map.

3. Points List Dialog Box: The Points List dialog box shown in Exhibit 2.2.6.5-5 is opened by
clicking and holding B3 on the Interactive Points product legend and selecting the "Edit
Points..." option.
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Exhibit 2.2.6.5-5. Points List Dialog Box

The Points List dialog box lists all the available groups and Points. Groups can be expanded to
review the list of Points assigned to that group by clicking the arrow next to the group name.
Initially, the default set of Points (A-J) are listed in the D2D Group, as shown above. In the
Points List dialog box, Points and groups may be dragged into and out of other groups to create
or disassemble subgroups.

The Points List dialog box also includes three columns.
m Point Name: Lists the group name and designated Points.

m Movable: Checking the checkbox adjacent to the Point disables the Point from being
moved.

m Hidden: Checking the checkbox adjacent to the Point hides the Point on the map.
Descriptions of the Points List dialog box buttons shown in Exhibit 2.2.6.5-5 follow.

m New Group: Creates a new group.

New Point: Opens the Edit Point dialog box.

Edit: Opens the Edit Point dialog box for the selected Point.

Delete: Deletes the selected Point or group.

Close: Closes the Points List dialog box.
e Put home cursor...

The Put home cursor tool provides an easy way to locate a METAR observation station, a city and
state, or a latitude/longitude coordinate. For Canada and Mexico, only the METAR observation stations
and latitude/longitude coordinates are accessible. When you select Put home cursor from the Tools
dropdown menu, the Home marker X is displayed and the Put Home Cursor dialog box opens.
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You can use the Home marker, as previously described in the Home Tool, and the new Home location
(station, city/state, or latitude/longitude) is identified in the Put Home Cursor dialog box.

Another way to use this tool is to type in the station, city and state, or latitude and longitude, and select
Go, or hit Enter on the keypad, to move the Home marker to the specified location. The new location's
nearest METAR site, city and state, and latitude and longitude appear in the Put Home Cursor dialog
box. The Put Home Cursor dialog box contains the following options.

o Location Selection: There are three ways to find a desired location. Once you choose the
Station, City/State, or Lat/Lon radio button, an Entry Box is activated next to the respective label
within the Put Home Cursor dialog box. Enter the desired location information.

o Go: This menu button initiates the search for the desired station, city/state, or latitude/longitude.
The Home marker jumps to the newly specified location.

e Radar Display Controls...
Refer to Section 8.5 for information on how to use the Radar Display Controls menu option.
¢ Range Rings

The Range Rings Tool displays adjustable range rings around locations of interest to your local office.
When you select Range Rings from the Tools dropdown menu, the Range Rings legend appears in the
Main Display Pane. The tool comes up editable, and the rangeRing dialog box (Exhibit 2.2.6.5-6)
opens. (Clicking B2 over the legend toggles tool editability and closes/opens the rangeRing dialog
box.) Within this dialog box, you can toggle on/off any of the target locations using the square
selectors. Adjust the size of the radii (in nautical miles) by typing a new value in the entry boxes
associated with each location and pressing the Apply button. You can also add labels at the center of
the range ring and/or at any of the radial distances using the Labels Options menu associated with each
location. Using the Movable Rings, you can add a new location at a specific point by using the
Interactive Points Tool, or by typing in latitude/longitude coordinates. There is no practical limit on the
number of new locations you can add to the display. The list of locations is pre-set but can be
customized at a field site.

Exhibit 2.2.6.5-6. rangeRing Dialog Box

e Sunrise/Sunset...
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By typing a date, as well as the latitude and longitude of a location into the Sunrise/Sunset Tool dialog
box, you can obtain the time (for any time zone) of sunrise and sunset, as well as the total length of
daylight for that date. Refer to Exhibit 2.2.6.5-7. Additional features include the ability to calculate the
sunrise/sunset in a different hemisphere, and the azimuthal angles, relative to true north, of the sunrise
and sunset.

Note 8: For an alternate method of entering latitude/longitude, set the location using Home, then
click Set at Home location.

Exhibit 2.2.6.5-7. Sunrise/Sunset Tool
e Text Window...

Selecting this option brings up a Text Display window that behaves in the same way, except for scripts,
as a window on the Text Workstation. Refer to Chapter 4 for more information.

e Units Calculator...

This handy tool, shown in Exhibit 2.2.6.5-8, converts the units of the first column into differing units
of the second column. The units are grouped into temperature, velocity, distance, time, and atmospheric
pressure. First, simply type the number and select the units of the value you wish to convert in the first-
column entry box. Then in the second column, select the desired units to which you want the original
value converted. The new value will appear in the second column entry box.
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Exhibit 2.2.6.5-8. Unit Calculator

e VVR - Shear

This tool is used in conjunction with Doppler velocity data to calculate the velocity difference (or
"shear") of the data directly under the end points. As with the Baselines, this feature comes up editable
and the end points can be dragged to specific gates of velocity data. When in place, the speed

difference (kts), distance between end points (nautical miles), shear (s'l), and distance from radar
(Nmi) are automatically plotted next to the end points and in the upper left corner of the Main Display
Pane. A positive shear value indicates cyclonic shear, while a negative value indicates anticyclonic
shear. If either end point is not directly over velocity data, the phrase "no data" is reported for the shear
value. This tool is also useful in determining gate-to-gate shear. Simply place the two end points
directly over adjacent gates of velocity data.

o "Snapping" VR Shear: If you are zoomed in over an area when you load VR - Shear, and the
VR - Shear Baseline does not appear, click B3 to "snap" the Baseline to where the mouse cursor
is located.

o VR - Shear in 4 Panel: You can use the VR - Shear Tool when the large display is in 4 panel
mode. The VR - Shear overlay is loaded in different colors for each panel. There are actually
four copies of the program running, and each behaves independently. This means that you can
get accurate readings in any one of the four panels — one VR - Shear panel is editable at a time.
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To activate, click B2 on the VR - Shear legend in the desired panel and position the query line to
the echoes of interest.

e \Warngen

Refer to Chapter 6 for information on how to use WarnGen.
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2.2.6.6 Volume

From the Volume Menu, shown in Exhibit 2.2.6.6-1, you can open the Volume Browser, access the Popup
SkewT function, or select a specific data model family product.

Exhibit 2.2.6.6-1. Volume Dropdown Menu
The Volume Menu is then divided into three additional sections as follows:

e Families: Families are preselected groups of model data that can be displayed with a single product
request.

Note 1: Model availability is not scale dependent. ETA grids are now referred to as NAM (e.g.,
ETA40 would be NAM40).

o Model Family Grids are titled with their delivered resolution (e.g., NAM40, GFS80). In some
cases, however, higher-resolution components are available, such as NAM precipitation, or
different resolutions are used at different time projections, such as >168 hours on the GFS. The
product label will show the actual resolution of each grid used.

o 4-Panel Families consist of four preselected products, or groups of products, each loaded into
one of the four panels into which the Main Display Pane is divided. In the case of 4-Panel
Families, eight fields from a model family are displayed, two per panel. One field is displayed as
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an image, the other as a contoured graphic.

e Comparison Families such as Surface Families for displaying forecast surface products, which allow
the user to overlay preselected models for comparison at 500 mb heights and mean sea level (MSL)
pressure.

e Std Env Data Package: You can customize a standard set of forecast products localized to your site, as
shown in Exhibit 2.2.6.6-2.

Exhibit 2.2.6.6-2. Std Env Data Package Submenu
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2.2.6.7 Obs

Refer to Exhibit 2.2.6.7-1 for a display of the Obs menu.

Exhibit 2.2.6.7-1. Obs Dropdown Menu

Several of the data sets in the Obs menu can be interrogated (sampled) for more detailed information
by clicking mouse Button 1 (B1) over a site. These data sets include METAR, Maritime, and Local.

The Obs menu is subdivided into sections that contain related products. These sections are described
below.

-« METAR: This section contains automatically updating METAR observations, ceiling and
visibility plots, wind chill and heat indices, precipitation plots at various time intervals, and
quality-checked MSAS observations. The 24hr Chg METAR plot provides the difference
between the observed temperature, dewpoint, pressure, and wind from those observed 24 hours
earlier. The calculation of the wind difference involves vector subtraction of the "u" and "v"
components.

. Synoptic: This section contains automatically updating Synoptic observations, and 6 hour and
24 hour precip plots. Note that this section of the menu is not present at most sites.

. Local Data: Under the Local data subheading are menu entries for local plots and precipitation
plots of various time intervals, as well as the LDAD Collection/Dissemination application. The
QC plot includes quality control information about LDAD-collected observations. Please refer to
Chapter 10 for more information on LDAD Collection/Dissemination.
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. Maritime: This section contains buoy and ship report plots, plus SAFESEAS for the Marine
WEFOs.

- MAROB displays include Station Plots.

- The Other Maritime Plots cascading menu contains options to display the Fixed and
Moving Sea State plots, MAROB Sea State and Cloud/Vis plots, Maritime Clouds/Visibility
plots, as well as the Scatterometer Winds.

= Sea State plots provide information on the wave period and height and swell period and
height. The wave type, whether a standard wave or a wind wave, is denoted at the origin
of the plot by a "+" or a "w", respectively. An "x" at the plot origin signifies that no wave
type was reported. If reported, the directions of the primary and secondary swells are
denoted with arrows labeled "1" and "2", respectively. The arrows point in the direction
the swell is moving. An annotated Sea State station model is shown in Exhibit 2.2.6.7-2.

Exhibit 2.2.6.7-2. A Moving Sea State Plot

= Maritime Clouds/Visibility plots contain a station circle denoting sky coverage and the
visibility along with standard symbols for obstructions to visibility.

= Scatterometer Winds are obtained from the ASCAT instrument on EUMETSAT's
MetOp-A polar orbiting satellite. This instrument sends pulses of radiation to the ocean
surface and measures the amount of energy, called backscatter, it receives back. When
you sample these observations, the time, satellite ID, wind direction, and wind speed are
provided. With the polar orbiting scanning, a given region will generally be sampled
about every 12 hours. ASCAT Winds (25 km retrieval resolution but interpolated and
displayed at 12.5 km resolution) can be launched from either the CAVE Obs menu or
from the Satellite menu.

As shown in Exhibit 2.2.6.7-3, you can access the Scatterometer Winds menu options by
selecting Obs > Other Maritime Plots > Scatterometer Winds. The ASCAT
Scatterometer Ocean Winds product is displayable on CAVE at all scales: N. Hemisphere,
North America, CONUS, Regional, State(s), and WFO.
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Exhibit 2.2.6.7-3. Obs Menu - Scatterometer Winds

o SAFESEAS is the System on AWIPS for Forecasting and Evaluation of Seas and Lakes. It is
a set of AWIPS applications that continuously monitor marine and adjacent overland
conditions for specific marine and weather hazards. SAFESEAS helps make faster, earlier,
and higher-quality decisions regarding marine watches and warnings. SAFESEAS is
primarily intended to support any WFO with marine forecast responsibilities; however,
non-marine WFOs also may find its monitoring capabilities to be of practical use.

The SAFESEAS menu option is available under the OBs menu's Maritime section; but only
available at marine WFOs; local WFOs can be reconfigured to include this option. Refer to
Exhibit 2.2.6.7-3, which shows the SAFESEAS menu option.

A table of values is displayed when sampling station plots. The SAFESEAS menu has two
Fog Monitoring products. These products include a Fog Monitoring Table tool and a Fog
Monitor Levels color table. For more information about the Fog Monitor, refer to the Fog
Monitor User's Guide. You can access the Fog Monitor from the Obs menu under the
Hazards section and also through the SAFESEAS monitor threat level CAVE icon on the
main menu. This guide opens in Adobe® Reader®.

Refer to the separate SAFESEAS User's Guide for more information by clicking on
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the book symbol.

. Hazards: The Hazards section covers local and regional plots, marine warnings, local storm
reports, lightning plots, and monitoring of fog and winter weather hazards.

o SNOW: the System for Nowcasting Of Winter weather (SNOW) is an application suite for
continuously monitoring surface observations for detecting winter weather threats.

Refer to the separate SNOW User's Guide for more information by clicking on the
book symbol.

- Lightning: This menu option plots cloud-to-ground (CG) lightning flashes for specified time
intervals. The data is then used to determine the intensity or frequency of CG lightning
accompanying a thunderstorm for a particular area.

- Fog: This menu option plots the fog threat level and displays the Fog Threat Level
Zone/County table. You can also access the Fog Monitor from the SAFESEAS monitor threat
level CAVE icon on the main menu, only available at marine WFOs.

Refer to the separate Fog Monitor User's Guide for more information by clicking on
the book symbol.

» Other Warning Displays: This section of the menu is defined locally, and may not be
present at your site.

» Local Storm Reports: Local Storm Report (LSR) plots are generated from spotter reports
that were entered into the LSR text database and decoded into the correct point data format.
The spotter reports can be displayed on CAVE on any scale, and use the symbols shown in
Exhibit 2.2.6.7-4. Refer to the NWS JetStream - Online School for Weather for a detailed list
of present weather meterological symbols.

The LSR graphical user interface (GUI) is a stand-alone AWIPS application designed to
provide forecasters with an easy and quick way to create, manage, and send the LSR public
text product. This text product contains noteworthy weather events for which the forecaster
has either received or sought out real-time observations.
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Refer to the separate LSR User's Guide for more information by clicking on the book

symbol.

Spotter Report Symbols
Description Symbol Description Symbol
Avalanche * Hurricane @

i =k S R
Blizzard = Ice Storm S
Downburst o '\ Lightning <
Drought DRY || Marine Winds -

Mo
Dust Storm §- || Microburst Ji
Excessive Heat HEAT || Non-Thunderstorm Wind :>
Extreme Cold COLD Rip Currents RIP
Extreme Wind Chill CHILL || Seiche SEICHE
Flash Flood FIFId || Sleet /AN -
Flood Fld Storm Surge SURGE
Fog — Thunderstorm Wind W _>
Freeze & 3 2 11 Tornado g;
. - . <
Funnel Cloud j L Tropical Storm (;
Hail Asize Waterspout X /
e ]
Heavy Rain Eiu Wildfire FIRE
Heavy Snow £ i # Wind Damage +W
High Astronomical Tides +Tide Wind Gust Gspeed
High Wind +Wspeed
O350

Exhibit 2.2.6.7-4. Spotter Report Symbols
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2.2.6.8 NCEP/Hydro

The NCEP/Hydro menu, shown in Exhibit 2.2.6.8-1, contains nine sections: SPC, TPC, NCO, HPC, MPC,
CPC, AWC, Hydro, and Local Analyses/Statistical Guidance. Each section is further subdivided into related
products, as described below. For more information on hydro products, refer to documentation prepared by the
NWS' Office of Hydrology.

Exhibit 2.2.6.8-1. NCEP/Hydro Dropdown Menu

e SPC: Storm Prediction Center (SPC) Watches, Severe Weather Plots, SPC Convective Outlooks, and
Fire Weather information. Severe Weather Plots are extracted from the STADTS and STAHRY text
products and plotted to time-match the current display. The Severe Weather Plots data set in the
NCEP/Hydro Menu can be interrogated (sampled) for more detailed information by clicking mouse
Button 1 (B1) over a site.

e TPC: Contains the hurricane submenu, which comprises graphic products that display the
Marine/Tropical Cyclone Advisory (TCM), the Public Tropical Cyclone Advisory (TCP), hourly
forecasts, and model guidance.

e NCO: Contains Precip & Stability, Temps & Weather, National Centers model, NGM MOS (NGM-based
MOS system), and the following Sounding-derived plots submenus.

o Precip & Stability: Contains precipitation, radar, and stability products.
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o Temps & Weather: Contains Max/Min temperature, freezing level, weather depiction, and surface
geostrophic wind and relative vorticity plots.

o National Centers Models: Contains model guidance from the National Centers.

o Sounding-derived plots: Contains options to display model soundings (sometimes called "BUFR
soundings" because they are packaged in BUFR format for transmission). These are soundings
extracted directly from the model, including all levels not generated from the pressure-level grids
used elsewhere in the system.

= Sounding Availability: This option displays the sounding locations (shown with asterisks)
available from the latest model run; typically these locations coincide with TAF (Terminal
Aerodrome Forecast) locations. The plot will update with each model run. Because the
sounding data is quite voluminous, only soundings over your State(s) scale are saved.

m Surface: The Surface Plots, which mimic the METAR Surface Plots, are taken from the
model-derived soundings and provide hourly forecast surface plots. Because you cannot see
all forecast projections in a 32 frame loop (e.g., displaying the entire North American Model
(NAM) or Global Forecasting System (GFS) run would require 61 frames), you will
probably want to use the Time Options Tool (refer to Subsection 2.2.6.4) to view a subset of
the forecast -- perhaps a continuous run of hours or every other hour for the whole run.

m Ceiling/Visibility: The "Ceil/Vis Plot" is illustrated in Exhibit 2.2.6.8-2. It shows weather
(rain, frz rain, snow) on the right, a stack of three cloud layers above, and visibility below
the METAR station. The cloud layers are defined as low (990mb-640mb), mid (640mb-
350mb), and high (<350mb). Each cloud layer shows a coverage circle with clear, sct, bkn,
and ovc options. Next to one of the circles, there may be a cloud base. The cloud base is sent
as a pressure, but is plotted in hft MSL based on a Standard Atmosphere conversion.
Because the cloud layers and the cloud base are generated from separate algorithms at NCEP
(National Centers for Environmental Prediction), it is possible to have broken or overcast
clouds indicated but no base; alternatively, the base may be shown with a high overcast,
while ignoring a mid broken layer. Also, a cloud base is reported if convective precipitation
is indicated, even for only 10-20% cloud cover. As a result, one can see a cloud base
associated with scattered clouds.

Exhibit 2.2.6.8-2. Example of a Ceil/Vis Plot

m 1 Hr and 3 Hr Precip Amt: This option shows hourly amounts for NAM and 3 hour
intervals for GFS at each location.

Page 84



CAVE-D2D User's Manual AWIPS |1 Operational Build 13.4.1 - 31 July 2013

= Cloud Layers: This option displays the amount of low, middle, and high cloud cover, each
as a standard sky coverage symbol, and weather type as a weather symbol.

e HPC: Contains 6-hour QPF (Quantitative Precipitation Forecast) data plus the submenus, described
below, for Precipitation and Temps & Weather products.

o Precipitation: Contains probabilities of daily precipitation, precipitation accumulation, and
probabilities of daily snowfall. In addition, this submenu enables you to display QPF projections
for 1 to 3 days in 6 hour increments, 4 to 5 days in 48 hour increments, and 1 to 5 days in 120 hour
increments. The HPC Excessive Rainfall product consists of a contour graphic and image of the
excessive rainfall for day 1 (with forecast times of 21, 24, 27, or 30 hours), and days 2 and 3 (both
with forecast times of 48 and 72 hours). The HPC product will update the selected forecast cycle
twice per day.

o Temps & Weather: Contains daily Max/Min temperature anomalies, daily heat index
probabilities, and pressure and frontal analysis.

e MPC: Contains the Marine Guidance submenu, which includes marine analyses and model guidance.

Note: The Marine Prediction Center (MPC) is now called the Ocean Prediction Center (OPC).

e CPC: Contains threat charts and outlook grids derived from these two submenus:

o Threat Charts: Contains drought monitoring data, daily threats assessment, and daily heat index
forecasts.

o Outlook Grids: Contains temperature and precipitation probabilities.

e AWC: Contains CCFP (Collaborative Convective Forecast Product), an aviation product. Formerly
located under the Aviation option on the Upper Air menu, CCFP is a strategic forecast of convection to
guide traffic managers in their system-wide approach to managing traftic. The forecast suite consists of 3
forecast maps with selectable lead times (4, 6, and 8 hours), as shown in Exhibit 2.2.6.8-3. The forecasts
are issued by the Aviation Weather Center (AWC) between March 1 and October 30, eleven times per
day.

Exhibit 2.2.6.8-3. CCFP Strategic Forecast Aviation Product on the NCEP/Hydro Menu

CCEFP is alpha-numeric information suitable for the graphical depiction of forecast areas of significant
thunderstorms. The CCFP message covers the CONUS area, and includes information on the location of
thunderstorm areas, and associated information such as storm tops, coverage, confidence, and
direction/speed of movement.

e Hydro: Contains QPE, QPF, and RFC Flash Flood Guidance submenus. Hydro Applications, such as
HydroView and MPE Editor, are loaded from the Perspectives dialog (Hydro and MPE, respectively) or
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from the HydroApps menu in the Hydro(View) Perspective (Hydrobase, RiverPro, XDAT, Forecast
Service, River Monitor, Precip Monitor, SSHP, and Dam Catalog).

o QPE: Makes available mosaic images of RFC-generated Quantitative Precipitation Estimator
(QPE) and the Multisensor Precipitation Estimator (MPE) grids, which are displayed using a
'truncated' grid color table that shows zero values in gray to let you see the limits of the
site-specified domain. These mosaic images are generated by the RFCs in 1, 6, and 24 hour cycles.
The MPE grids can be displayed as local contours or images.

m NESDIS produces two types of Satellite Precipitation Estimates (SPE) based on GOES
(Geostationary Operational Environmental Satellite) imagery series: Auto SPEs and Manual
SPEs. Auto SPEs, which can be displayed directly from the QPE submenu, are produced
hourly based on the most recent one-hour series of IR GOES imagery. This product is
displayable on any AWIPS scale. The Auto SPE estimates are displayed in units of inches of
precipitation that fell during the specified one hour period.

m Manual SPEs are accessible through the Manual SPE submenu. You can access the Manual
SPE submenu from the QPE submenu. Generation of these products requires substantial
manual intervention by NESDIS personnel; consequently, these products are generated and
distributed to AWIPS at variable frequencies, as significant precipitation events warrant (i.e.,
their frequency is variable). The duration (or valid period) of the Manual SPEs is also
variable. Whereas the duration of Auto SPEs is always one hour, the duration of the Manual
SPEs ranges from 1 to 12 hours. Furthermore, although each Manual SPE product is mapped
to a CONUS grid, the area of analysis is usually regional (focusing on the significant
precipitation event). Apart from these important differences, the Manual SPEs are very
similar to the Auto SPEs.

o QPF: Displays QPF, which indicate how much precipitation will occur in a particular grid. QPFs,
which are issued by the RFCs, display as contours by default. However, from the pop-up menu you
can convert them to image form.

o RFC Flash Flood Guidance: Displays County and Zone Flash Flood Guidance (FFG) grids on
any scale. The area for which the data is displayed is limited, but the site system manager may
configure a larger area. In addition, 1h, 3h, and 6h mosaic RFC-generated FFG grids can be
displayed for both local and other RFC locations.

¢ Local Analyses/Statistical Guidance: Model Output Statistical (MOS) plots derived from the MOS
BUFR and Text Bulletins display forecast data for GFS MOS, GFS-Extended MOS, Eta MOS, and NGM
MOS. The plots are accessed by selecting NGM or GFS-LAMP/MOS forecasts under the Local
Analyses/Statistical Guidance option.
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2.2.6.9 Local

The Local menu is shown in Exhibit 2.2.6.9-1. Each section is further subdivided into related products. A description
of each section follows.

Exhibit 2.2.6.9-1. Local Dropdown Menu
e LAPS/MSAS Analyses: Contains the LAPS and MSAS analyses described below.

o LAPS: The LAPS analysis grid is 10 km and covers an area slightly larger than the WFO scale. The
contour intervals are not specifiable, but you can use the Density function to increase/decrease the number
of contours.

1. To access the LAPS grids

= With any scale displayed, from the Local menu, select LAPS/MSAS Analyses > LAPS.

Note 1: You can also access LAPS grids from the Grid menu in the Volume Browser.

The LAPS application runs on px1 as a cron from 20 minutes to 45 minutes after the hour. Because of its
size, LAPS does not run if the application server is failed over.

The LAPS modules included in AWIPS are surface, temperature, humidity, cloud, wind, derived
parameters, and soil parameters. These modules use a mixture of required and optional data to prepare
their products. If a LAPS module's required data are not present, that LAPS module does not run. If a
LAPS module's optional data are not present, that LAPS module will still run.

LAPS uses the following data:

m Rapid Refresh (RAP) forecast model data

Satellite imagery (GOES-East or GOES-West)

METAR observations

Profiler data (only used by Midwest sites)

Surface buoy/ship reports
m Radar reflectivity

If the required data are present and the optional data are not, the LAPS module runs, creating the LAPS
products without the optional data. It is possible for LAPS products to vary from hour to hour, and from
site to site, depending on data availability. See Table 2.2.6.9-1 for further details of required and optional
data.
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Table 2.2.6.9-1. LAPS Modules With Required and Optional Data

\Module ’ Required ’ Optional

Satellite imagery (WV, 11 and 12 IR)
Model Background (RAP or NAM)
surface |Surface METAR Observations Completion of cloud module
Previous run of surface module
Previous run of wind module

Surface METAR Observations
Satellite imagery (WV, 11 and 12 IR)
cloud |Model Background (RAP or NAM) Completion of soil module
Completion of surface module
Completion of temp module

Model Background (RAP or NAM) Satellite imagery (WV, 11 and 12 IR)

humid Completion of temp module Completion of Surface Module
P p Completion of Cloud Module
tom Model Background (RAP or NAM)
p Completion of surface module
. Model Background (RAP or NAM) Profiler (Mldwest only)
wind . Completion of surface module
Surface METAR Observations .
Completion of temp module
. Completion of surface module . .
soil . Previous run of soil module
Completion of temp module
Surface METAR Observations
deriv Completion of temp module Completion of cloud module
Completion of cloud module Completion of humid module

Completion of wind module

o MSAS (MAPS): The Mesoscale Analysis and Prediction System (MAPS) Surface Assimilation System
(MSAS) was built to exploit the spatial density and temporal frequency of surface data by providing
timely and detailed surface analyses. It currently provides hourly analyses on a 40km grid covering the 48
contiguous states and neighboring areas of Canada and Mexico and uses persistence (the previous hourly
analysis) as the background for the current analysis.

One-hour persistence provides a fairly accurate forecast and allows for the incorporation of previous
surface observations into the analysis. More importantly, it assures continuity between analyses, especially
near stations that report less frequently than hourly. Persistence, however, cannot be used in data-void or
data-sparse areas such as oceans. In these regions, gridded data from NCEP's NAM model are used as a
background to ensure that the analysis does not stray far from reality. The NAM grids are linearly
combined with 1-hour persistence, using weights calculated to produce a persistence forecast over
data-dense areas, a model forecast over data-sparse areas, and a smooth transition between the two areas.

Because rough terrain can complicate the analysis of surface variables, MSAS attempts to obtain analyses
with improved spatial continuity from mountainous observations through careful choice of analysis
methods and variables. MSAS incorporates elevation and potential temperature differences in the
correlation functions used to model the spatial correlation of the surface observations. The resulting
functions help to take into account physical blocking by mountainous terrain and improve the
representation of surface gradients. In addition, MSAS analysis variables were chosen, whenever possible,
so as to minimize the effects of varying terrain. Potential temperature, for instance, is analyzed instead of
surface temperature because it varies more smoothly over mountainous terrain when the boundary layer is
relatively deep and well mixed.

The major MSAS pressure variable is sea level pressure, computed at each station from altimeter setting
observations. Station pressures calculated from the altimeter settings are reduced to sea level and the
700mb NAM temperature is used to estimate an effective surface temperature. This reduction generally
provides smoother regional, diurnal, and seasonal variation because it avoids the use of actual surface
temperatures, which are often unrepresentative of the surrounding conditions. Moreover, additional data
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are available for analysis of the MSAS reduction because more stations report altimeter setting than report
sea level pressure.

MSAS utilizes most surface observations contained in its domain. These include METARs, surface reports
from fixed buoys, and the NOAA Profiler Network, as well as surface observations from any local
mesonets ingested through the LDAD system (refer to Chapter 10). Observations failing the automated
quality control checks implemented by the Quality Control and Monitoring System (QCMS) (refer to
Chapter 11), or listed in the QCMS subjective reject list, are not ingested or analyzed by MSAS.

1. To access MSAS Grids:

» From the Local menu, select LAPS/MSAS Analyses > MSAS (MAPS).

1. To access MSAS Observations

m [n addition to MSAS gridded output, AWIPS has the ability to display the observations used
in each MSAS analysis. The displays consist of color-coded observation plots. Pressing
mouse Button 1 on any observation gives the station ID associated with the observation.
Observations ingested by MSAS, but not used due to Quality Control (QC) failures, are
distinctly colored. Pressing mouse Button 1 on these observations invokes the display of a
small QC table indicating which QC checks have failed. Exhibit 2.2.6.9-2 shows an
example of a MSAS QC table.

Exhibit 2.2.6.9-2. Example of a MSAS QC Table Accessible Through the CAVE NCEP/Hydro
Menu

The observation either failed (F) the automated checks or was labeled bad (B) through the
subjective intervention procedures. See Chapter 10 on the AWIPS QCMS for more
information on the QC procedures.

e LAMP/MOS Forecasts: Contains the IFPS, GFSLAMP, and MOS forecast options. Descriptions of these
options follow.

o IFPS: The Interactive Forecast Preparation System (IFPS) Station Plot, accessible from the Local >
LAMP/MOS Forecast submenu, allows you to view the forecast data stored in the PostGresql database
by IFPS. The two available plots are for 3 hour and 12 hour forecast intervals, each of which displays
slightly different data. Exhibit 2.2.6.9-3 illustrates the attributes that are rendered on the 3 hour and 12
hour station plots.

Note 2: These data are available for those sites using IFPS.
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Note 3: This station plot paradigm is not the standard METAR format.

Precipitation Type 1

Termpersture
Ob=scurad “Wisibility
Dewwpoint

Precipitation Type 2

Pracipitation Typa 2

3 Hr

Wiind Direction
and Spesd

Fracipitation Type 1

M=z Min. Temperature

Pracipitation Type 2
Ob=scured “isibility

Precipitation Twpe 3

12 Hr FoF
GFF
S
12 Hr
i md
Direction e T
and Speed

Exhibit 2.2.6.9-3. Three Hour and Twelve Hour IFPS Station Plots

o GFSLAMP: The Localized Aviation MOS Program (LAMP) is referred to here as GFSLAMP.
GFSLAMP consists of a series of programs to analyze hourly weather data, run simple numerical models,
evaluate statistical forecast equations, and display the resulting information. The statistical forecasts are
produced by multiple linear regression equations that combine information from the central GFS-MOS
guidance, local model output, and the most recent hourly surface observations. GFSLAMP guidance
updates each hour by using the latest observational information and also furnishes forecasts for hourly
projections for over 1500 stations in the CONUS, Hawaii, Alaska, Puerto Rico, and the Virgin Islands
with a record of hourly data.

GFSLAMP provides hourly forecasts for up to 25 projections at locations currently receiving GFS-MOS
guidance.

The three simple numerical models used in GFSLAMP provide advective forecasts of sea level pressure,
saturation deficit, and variables such as surface temperature and cloud amount. These models are driven
by NCEP's GFS model.

Two types of GFSLAMP plots are available within CAVE. They are GFSLAMP Station Plot and
GFSLAMP Ceiling and Visibility Station Plot. Each can be accessed by selecting a GFSLAMP option
from the Local > LAMP/MOS Forecasts submenu.

Each GFSLAMP plot displays its forecast data in station model plot format.

Page 90



CAVE-D2D User's Manual AWIPS |1 Operational Build 13.4.1 - 31 July 2013

Note 4: You can also access GFSLAMP grids from the Grid menu in the Volume Browser.
Refer to Section 3.2 for more information about accessing grids in the Volume Browser.

= Accessing the GFSLAMP Time Series: The GFSLAMP time series can be accessed through the
volume browser. See Subsection 3.2.2 for information on displaying time series plots through the
volume browser.

» Using Various Load Modes: All load modes are supported for the GFSLAMP station and
GFSLAMP ceiling and visibility plots.

o MOS: Model Output Statistics. These plots are derived from the MOS BUFR Bulletins. The previous
MOS plots were derived from the MOS Text Bulletins.

Note 5: The MOS Plots are accessed by selecting NGM or GFS-LAMP/MOS forecasts under the
Local Analyses/Statistical Guidance heading of the NCEP/Hydro dropdown menu.

» The plots display forecast data for GFS MOS, GFS-Extended MOS, and NGM MOS. Submenus
under each model reveal the element choices. These displays include:

m Station Model Plots (Wind, T, Td, Sky Cover, Wx)
® MaxT/MinT (°F)
m Ceiling (agl) / Visibility (ft X 100) (Categorical)

m Probabilities Submenu (6h/12h PoP, 6h/12h Tstorm, 6h/12h Svr-Tstorm, Conditional
precipitation types; %)

m QPF 12h (Categorical mid-points; inches)
® QPF 6h (Categorical mid-points; inches)
m Snowfall (6h/12h/24h, Categorical; inches)

You can access the MOS forecasts from the Volume Browser. Refer to Section 3.2 for more
information about accessing GFSLAMP guidance through the Volume Browser.

Page 91



CAVE-D2D User's Manual AWIPS |1 Operational Build 13.4.1 - 31 July 2013

2.2.6.10 Upper Air

The Upper Air dropdown menu, shown in Exhibit 2.2.6.10-1, is located on the CAVE menu bar. It provides
access to upper air plots, profiler data, radar plan-view and perspective displays of winds, and aircraft and
rawinsonde data. Nearby Radiosonde Observations (RAOB) are also included on the menu to provide easy
viewing of upper air data.

Exhibit 2.2.6.10-1. Upper Air Dropdown Menu
e Aircraft: The Aircraft option on the Upper Air menu provides access to the following products:

o PIREP plots: The Aircraft data includes Low-, Mid-, and High-level Pilot Weather Report
(PIREP) observations. The display plots the temperature, aircraft identifier, wind speed and
direction, significant weather, and the flight level (in feet). Pilot reports are critical for air safety.
Pilots reports on the conditions they are experiencing show up in a matter of minutes on AWIPS.
Weather conditions can change quickly, and there is nothing like having a pilot report to provide a
bird's eye view of what it is really like up there. PIREPs may validate forecast conditions, or they
may describe real-time weather that varies from them.

o MDCRS plots: Meteorological Data Collection and Reporting System (MDCRS) data includes
plan-view plots for various 5kft layers and ascent/descent soundings. Using the availability plots
(Upper Air menu under MDCRS plots) and ACARS Airports from the Maps menu button, as
shown in Exhibit 2.2.6.10-2, you can locate airports that have available soundings. ACARS
Airports provides an illustration of locations of airports, but it is not necessary to use it. The "+"
sign means a temperature sounding and the "*" means a temperature and dewpoint sounding. To
see a sounding at a location, simply press the Points menu button. Several points from letters of the
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alphabet will appear on the map display. To view a sounding, drag one of the points/letters to a "+"
or "*" location. From the menu bar press Volume and then Browser. From the Volume Browser
select MDCRS for Source, Sounding for Fields and select the letter/point on the desired location
for Points. Click on your selection in the Product Selection List and then press the Load button to
view the sounding.

Exhibit 2.2.6.10-2. ACARS Airports Option on Maps Dropdown Menu

A zoomable inset map (NW corner) is available to show the location of the sounding. When you
zoom in by clicking mouse Button 2 (B2), the flight track of the ascent/descent sounding is shown
on the map. In addition, you can sample the flight track to see the time and elevation. To zoom out,
click mouse Button 1 (B1). This inset map (and also those on var vs. height displays, cross
sections, and cell trends) can be suppressed by setting the global density (i.e., from the tool bar) at
less than 1.

o Aviation: The Aviation pull-right menu provides access to aviation products and qualifying
information:

= Convection SIGMET: SIGMET (Significant Meteorological Information) is an alpha-
numeric message describing specific aviation hazard conditions between the surface and
45,000 feet (FL450). A SIGMET includes information about the location of the hazard using
VOR locations. SIGMETs are produced on an as-needed basis at the AWC and are
distributed on the SBN. See Exhibit 2.2.6.10-3 for an example.

Exhibit 2.2.6.10-3. Example of a SIGMET Message

Plots associated with significant weather conditions include icing severity and significant
weather turbulence, as shown in Exhibits 2.2.6.10-4 and 2.2.6.10-5.
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Exhibit 2.2.6.10-4. Aviation Icing Severity Plot

Exhibit 2.2.6.10-5. Aviation Turbulence Plot

m AIRMET: AIRMET (Airmen's Meteorological Information) is an alpha-numeric message
describing specific aviation hazard conditions between the surface and 45,000 feet (FL450),
but not requiring the issuance of a SIGMET. An AIRMET includes information about the
location of the hazard using VOR locations. AIRMETs are produced every 6 hours at the
AWC for the CONUS area, and are distributed on the SBN. See Exhibit 2.2.6.10-6 for an
example.

Page 94



CAVE-D2D User's Manual AWIPS |1 Operational Build 13.4.1 - 31 July 2013

Exhibit 2.2.6.10-6. Example of an AIRMET Message

= NCWF: NCWF (National Convective Weather Forecast) is information suitable for the
graphical depiction of hazardous convection. The NCWF contains both GRIB and BUFR
output. The GRIB output delineates the current convection. The BUFR output includes
hazardous convection area polygons, movement arrows, and storm top and speed text
information.

e RAOB: RAOB data is plotted on the standard Skew-T log-p thermodynamic diagram. A small reference
map indicating the location(s) of the plotted sounding(s) is provided in the upper left corner of the main
display pane, as shown in Exhibit 2.2.6.10-7. If you overlay another Skew-T whose location is far from
the original sounding location, the reference map updates to show both locations, as shown in Exhibit
2.2.6.10-7.

Exhibit 2.2.6.10-7. Skew-T Reference Map Indicating Locations of Plotted Soundings

The Interactive NsharpSkewt Program plots and derives quantities on a Skew-T log-p diagram and on a
hodograph. You can edit the Skew-T and hodograph data and obtain instantaneous information on the
modified data. To start the Interactive NsharpSkewt Program refer to Chapter 7.

Also plotted on the standard Skew-T log-p thermodynamic diagram is the lifted parcel trajectory,
displayed on zoom factors greater than 1. For a 12Z sounding, the parcel trajectory is computed based on
a surface parcel temperature represented by the forecast maximum temperature for that sounding. At all
other observation times, the surface parcel temperature is represented by an average temperature and
dewpoint through the lowest 50 mb of the sounding. For the 00Z soundings, the temperature and
dewpoint are represented as a low-level (50 mb) mean. For the 12Z soundings, the forecast maximum
temperature is used as the "modified" parcel temperature, with the surface dewpoint temperature as the
parcel dewpoint. The parameters affected by these modified values are noted with asterisks in the second
column of the parameters list on the sounding plot.

The MDPI (Microburst-Day Potential Index) and the WINDEX (Wind Index) determine whether the
environment is favorable for microburst development. The MDPI utilizes vertical profiles of
environmental equivalent potential temperature, while the WINDEX predicts the maximum expected
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gust possible for a given environmental sounding. For a full description of these equations and the
optimal index values, refer to the following website:

http://www.wdtb.noaa.gov/workshop/psdp/Roeder/sec2.htm
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2.2.6.11 Satellite

The Satellite menu provides access to various types of satellite imagery received via the Satellite Broadcast
Network (SBN). Imagery products from both the Geostationary Operational Environmental (GOES) East/West
satellites and the Polar Operational Environmental Satellites (POES) imagery products are available from the
Satellite menu, which is shown in Exhibit 2.2.6.11-1.

Exhibit 2.2.6.11-1. Satellite Dropdown Menu

POES Imagery

The POES Imagery section of the Satellite menu contains selectors for IR Window, Visible, 3.7, and 11-3.7p
products. These are viewable on all scales.

Precipitation Products Submenus

Below the POES Imagery section of the Satellite menu are four submenus: Sounder Imagery; Derived Products
Imagery; Derived Products Plots; and NPP Products. Descriptions of the submenus follow.

e Sounder Imagery: The products available from the Sounder Imagery submenu, which is shown in
Exhibit 2.2.6.11-2, are based purely on the imager instruments aboard the GOES East (GE) and GOES
West (GW) satellites.
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Exhibit 2.2.6.11-2. Sounder Imagery Submenu

e Derived Products Imagery: A variety of precipitation products are accessible from the Derived
Products submenu, which is shown in Exhibit 2.2.6.11-3. These products are derived from one or more
of the various satellites (e.g., DMPS, POES, GOES, and GPS). Descriptions of the products follow.

Exhibit 2.2.6.11-3. Derived Products Imagery Submenu

o The Blended Rain Rate (formerly Rainfall Rate) product is produced hourly to gather recent rain
rate retrievals from passive microwave instruments on six polar-orbiting satellites. The blended
rain rate eliminates the bias between those data sets and provides a unified, meteorologically
significant rain rate field to weather forecasters.

o The GOES products derived from the GOES satellite include Lifted Index, Total Precip Water
(TPW), Cloud Amount, Cloud Top Height, Skin Temperature, and Low Cloud Base. Because the
imagery from these products is based on the GOES sounder instrument, several important
differences exist between these products and the other (imager-based) imagery. The main
differences are that the resolution is no finer than 10 km, the product update frequency is driven by
the sounder instrument (AWIPS receives a set of GOES East/West composite derived product
images once per hour), and the aerial coverage is based on that of the sounder scans, which is
somewhat less than the aerial coverage provided by the imager. Descriptions of the products
follow.
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m Lifted Index is a common measure of instability. Its value is obtained by computing the
temperature that air near the ground would have if it were lifted to some higher level
(usually around 18,000 feet), and comparing that temperature to the actual temperature at
that level. The more negative the value, the more instability there is.

m Total Precip Water is the vertically integrated water vapor content in a column extending
from the earth's surface to the top of the atmosphere.

m Cloud Amount provides an hourly update of cloud amounts within a geostationary satellite
field of view. You can loop through the display to identify increasing/decreasing cloud
conditions and trends.

m Cloud Top Height is the height of the cloud in thousands of feet (base - top).
m Skin Temperature is the sea surface temperature of the ocean surface water.

= Low Cloud Base provides nighttime images of fog and low stratus clouds derived from a
combination of two GOES IR channels. This product identifies cloud ceilings of <1000 feet
and is generated hourly starting between 2042 and 2142 GMT, and ending between 1510 and
1610 GMT the next day. This product is beneficial to the warning and forecast processes
specific to aviation and terminal forecasting.

o The Total Precip Water (TPW) value can also be derived from the data sources of DMSP, SSM/I
(Defense Meteorological Satellite Program Special Sensor Microwave / Imager), and POES
AMSU (POES Advanced Microwave Sounding Unit) satellites, which are accessed from the
DMSP SSM/I, and POES AMSU sections of the submenu.

o Variations of TPW ("Blended Total Precip Water" and "Percent of Normal TPW") are selectable
under the AMSU and SSM/I + GPS section.

m The Blended Total Precip Water product is a blend of the various data sources of AMSU,
SSM/I, and GPS satellites, and can be over water or land.

m The Percent of Normal TPW product is calculated at various times (hourly, monthly,
seasonally, etc.) to determine departures from the normal. From the information obtained,
forecasters can predict the chances of having a below average, normal, or above average
precipitation in the upcoming months.

¢ Derived Products Plots: Products and additional submenus for narrowing your product search are
accessible from the Derived Products Plots submenu, which is shown in Exhibit 2.2.6.11-4. Descriptions
of the submenus and products follow.
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Exhibit 2.2.6.11-4. Derived Products Plots Submenu

o The GOES High Density Winds submenu has options to display satellite-derived multi-layer
winds plots from the IR, Visible, and three Water Vapor channels. In addition, you can display
individual layers that display a composite of all the satellite channels.

o MTSAT High Density Winds cover the Western Pacific.

o Scatterometer Winds are obtained from the ASCAT instrument on EUMETSAT's MetOP-A polar
orbiting satellite. This instrument sends pulses of radiation to the ocean surface and measures the
amount of energy, called backscatter, it receives back. When you sample these observations, the
time, satellite ID, wind direction, and wind speed are provided. With the polar orbiting scanning, a
given region will generally be sampled about every 12 hours.

m ASCAT winds (25 km retrieval resolution but interpolated and displayed at 12.5 km
resolution) are launchable from both the CAVE Satellite menu, shown in Exhibit 2.2.6.11-5,
and the Obs menu, shown in Exhibit 2.2.6.11-6. The ASCAT instrument generates ocean
surface wind retrievals. The ASCAT Scatterometer Ocean Winds product is displayable on
CAVE at all scales.
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Exhibit 2.2.6.11-5. Satellite Menu - Scatterometer Winds
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Exhibit 2.2.6.11-6. Obs Menu - Scatterometer Winds

o The SSM/I Point Data plot displays data collected over the course of a day for calculating ocean
wind speeds.

o The GOES and POES Sounding Data Availability Plots displays the locations where GOES and
POES temperature and moisture profiles are available. These soundings are displayed on a
Skew-T/log P chart using the Points tool and the Volume Browser. Soundings from the GOES
satellites are made only in relatively cloud-free areas, whereas POES systems produce temperature
and moisture soundings in clear and cloudy atmospheres. Each hour, NESDIS provides the latest
soundings from GOES East and West. Although the GOES East and West sounders yield
soundings over a broad area, the default AWIPS configuration retains soundings only from within
each site's Regional CAVE scale domain. POES soundings are generated approximately every 12
hours and have more global coverage.

e NPP Products: NPP products are accessible from the NPP Products submenu, which is shown in
Exhibit 2.2.6.11-7. A description of NPP products follows.
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Exhibit 2.2.6.11-7. NPP Products Submenu with VIIRS CONUS Regional Imagery Product Selected

Note 1: NPP, which stands for National Polar-orbiting Partnership (formerly National Polar-orbiting
Operational Environmental Satellite System (NPOESS) Preparatory Project), is an earth-observing
NASA satellite. It is more precisely named Suomi NPP, named after Meteorologist Verner E.
Suomi.

The NPP Products submenu displays VIIRS (Visible Infrared Imager Radiometer Suite) and Soundings
products. A description follows.

o VIIRS Products: VIIRS is one of five instruments onboard the NPP satellite. VIIRS' mission is to
collect radiometric imagery in visible and infrared wavelengths of the Earth's surface; this includes
observing fires, ice, ocean color, vegetation, clouds, and land and sea surface temperatures, and
supplying high-resolution images and data used by meteorologists to assess climate change and
improve short-term weather forecasting.

The VIIRS submenu option provides VIIRS imagery and moderate band satellite displays for the
CONUS, Alaska, and Pacific regions. The same options, shown in Table 2.2.6.11-1, apply for each
of these regions.

Table 2.2.6.11-1. VIIRS Imagery Specs for CONUS, Alaska, and Pacific Regions

’ Bands | Wavelength | Type Product
‘Imagery Band 1 ‘0.64u ’Reﬂectivity
‘Imagery Band 2 |0.865u |Reﬂectivity
‘Imagery Band 3 ‘1.61u ’Reﬂectivity
‘Imagery Band 4 |3.74u |Brightness Temp
’Imagery Band 5 ‘11.45 ‘Brightness Temp
‘Moderate Band 6 ‘0‘746u ’Reﬂectivity
‘Moderate Band 9 |1.378u |Reﬂectivity
‘Moderate Band 13 ‘4.05u ’Brightness Temp
‘Moderate Band 15 |10.763u |Brightness Temp
’Moderate Band 16 ‘12.01 3u ‘Brightness Temp
‘Day/N ight Band ‘0.7u ’Reﬂectivity
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Note 2: The CONUS imagery is provided as overall CONUS imagery and focused on either
the East CONUS or the West CONUS regions.

Note 3: When opening NPP Products imagery data, you should set the appropriate scale for
viewing the selected region.

In addition to accessing the NPP Product VIIRS data via the Satellite menu, the VIIRS Imagery
data can also be accessed using the Product Browser. The Product Browser is accessed by selecting
CAVE > Data Browser > Product Browser, as shown in Exhibit 2.2.6.11-8.

Exhibit 2.2.6.11-8. Selecting VIIRS Imagery Data via the Product Browser

o Soundings Products: The Soundings submenu option enables the user to select the NUCAPS
(NOAA Unique CrIS/ATMS Processing Systems) Sounding Availability product. This product,
derived from processing of CrIS/ATMS data, provides cloud cleared radiances and trace gas that
enable increased accuracy in the development of the vertical profile of temperature and water
vapor retrievals. An example of this product is shown in Exhibit 2.2.6.11-9, which depicts the
NUCAPS sensor track for a typical path as it crosses the CONUS. By clicking on the individual
dots, the forecaster is able to retrieve the sounding for the selected point.
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Exhibit 2.2.6.11-9. NUCAPS Sounding Availability Track Over CONUS

Additional imagery products are available under the "NH/NA/US every image" and "4 Sat Composite" sections
of the Satellite menu, which is shown in Exhibit 2.2.6.11-1. Descriptions of the types of imagery products
available under these sections follow.

NH/NA/US every image

The NH/NA/US every image products are based on imagery from the current series of GOES satellites. This
menu section is oriented toward the larger scales (i.e., Northern Hemisphere [NH], North American [NA], and
CONUS [US])). Selecting satellite imagery from this menu section loads every available image for display. This
is a change from the legacy AWIPS system, in which data was scale dependent. Because data is not scale
dependent in AWIPS II, every available satellite image is available and displays on any scale. The satellite
products under the "NH/NA/US every image" section display the same data as the satellite products at the top
of the Satellite menu. Note that larger-scale imagery (i.e., from the NH and NA scales) is ultimately limited in
frequency not by AWIPS but rather by the availability of scans from the GOES satellites. Large-scale northern
hemispheric imager scans are produced only every 30 minutes. A complete "full disk" (i.e., most of the
Western Hemisphere) image is scanned only once every 3 hours per spacecraft.

GOES East and GOES West each feature a five-channel imager, and apart from the exceptions noted above, all
imagery available on the satellite menu is based on either one or two imager channels from one or both GOES
satellites. The current series of GOES satellites consists of nine spacecraft, with pre-launch designators I-Q and
post-launch designators of 8-16 (the latter designator assigned when the spacecraft achieves geosynchronous
orbit). At any given time, two satellites of this series will be operational, one situated over the equator at 75W
longitude (called GOES East) and the other situated over the equator at 135W longitude (called GOES West).
The imagers on this series of satellites are similar, but not identical. The primary differences involve the
availability of one of two long-wave channels (12u or 13u) and the resolutions of certain channels.
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The GOES imager instruments operate in various modes, which affect the frequency and coverage of some
imagery provided to AWIPS. The default mode is referred to as "Routine" mode, and the imagers most often
scan in this mode. The other common imager mode is "Rapid Scan" mode. NESDIS switches the GOES East
and West imagers (independently), chiefly between these two modes and usually in response to NWS requests.
In routine mode, the imager scans four CONUS sectors per hour; in rapid-scan mode, the imager typically
scans eight CONUS sectors per hour. Satellite imagery is generally displayed at all intervals for all scales (i.e.,
15-minute intervals in routine mode and generally 5-10 minute intervals in rapid-scan mode). A set of menu
options is available in the "NH/NA/US every image" section of the satellite menu.

4 Sat Composite

The 4 Sat Composite products are based on imagery from four geostationary satellites: GMS; GOES West;
GOES East; and METEOSAT. These composites are disseminated via the SBN's OCONUS channel and are
therefore unavailable to most CONUS sites.

A Water Vapor/Infrared (WV/IR) combination product is available in this menu. In this product, the IR
Window (11 micron) data replaces water vapor pixels where the cloud top temperature is below -35 C. Other
menu entries display images that are differences between two channel images. For example, the selection of the
11u-3.9u menu entry will display the temperature difference between a channel 4 image and a channel 2 image
(both from the same time period).
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2.2.6.12 kxxx

The kxxx is a site-specific menu that provides access to Weather Surveillance Radar-1988 Doppler (WSR-88D)
radar products. The menu is shown in Exhibit 2.2.6.12-1.

Exhibit 2.2.6.12-1. kxxx Dropdown Menu

Note 1: With the upgrade to dual-polarization technology, the kxxx menu options have been rearranged to
accommodate the dual-pol products. Note that all legacy options are still available but have been relocated
on the menu or moved to submenus.

Note 2: Variations in the menu options may exist because of your site configuration. However, all
WSR-88D radars are equipped with the dual-pol products.

e kxxx products:

o Best Res Z+SRMB8 and Best Res Z+V Combinations: The radar combination products Z+SRM
and Z+V are precombined formats of the reflectivity and storm relative motion or velocity,
displayed together via a single menu selection. SRM products include the storm motion vector
information, which is plotted in the upper left corner of the Main Display Pane.

o 4-Panel Z+SRM/ZDR+V/KDP+HC/CC+SW: This section of the kxxx menu enables you to load
multiple base and dual-pol products, which are then simultaneously displayed. The label of this
section of the menu describes the format for loading the products: Z+SRM in the upper left
quadrant, ZDR+V in the upper right quadrant, KDP+HC in the lower left quadrant, and CC+SW in
the lower right quadrant. Primary dual-pol base data analysis is best accomplished using the All
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Tilts base data option (4 panel all tilts with 8 products loaded), though you may use the single tilts
(e.g., 0.5 base data) for longer time duration loops.

To load 4 panel displays containing multiple elevation angles of the same product, you would
select the kxxx four panel option and then select the desired set of 4 panels from the kxxx four
panel submenu.

m All Tilts: The kxxx menu accommodates several radar tilt angles. Instead of having a menu
item for each tilt angle, "tilt bins" have been set up internally. Each bin includes a range of
tilts, as outlined in Table 2.2.6.12-1.

Table 2.2.6.12-1. Tilt Bins for Radar Menus
|Primary Tilt |Ti|t Range | Primary Tilt |Tilt Range

| o0 |o0-08| 75 |67-80
| o5 |o04-07 | 87 |81-95
| 0o |o8-11 | 100 |[96-110
| 15 | 12-16 | 120 [111-130
| 18 | 17-20 | 140 [131-156
| 24 | 21-26 | 167 [157-179
| 34 | 27-36 | 195 [180-220
| 43 | 37-48 | 250 [221-215
| 53 | 47-56 | 320 | 30-60

| 60 | 57-66 | |

All Tilts allows you to step or animate in either space or time. Selecting one of the All Tilts
buttons will load all the tilts available from the latest volume scan. It will continue to load
tilts from previous volume scans until it has loaded as many frames as indicated on the
frame count menu. Auto updates will add higher tilts from the latest volume scan, replacing
a tilt from the oldest volume.

After loading an All Tilts display, Shift + LEFT ARROW and Shift + RIGHT ARROW
and looping will take you through the frames in the order in which the system loaded them
(without regard to volume scan or tilt). The UP ARROW and DOWN ARROW will step the
display up or down in a volume scan allowing the tilts to change for a fixed time. The
RIGHT ARROW and LEFT ARROW will step the display forward or backward through
time at a fixed tilt. Once you have set the mode of motion (vertical or time), the

Page Up/Page Down keys will start and adjust loop speed. To switch from vertical to time
mode or from time to vertical mode, press the desired arrow key.

CAUTION: If you hit the up or down arrow key in a standard (not All-Tilts) display,
looping and stepping are disabled until you hit either the left or right arrow key or one of the
stepping buttons on the menu. Once an arrow key (Left, Right, Up, Down) has been pressed,
the stepping/animation controls on the main window toolbar and the Page Up/Page Down
keys will function in that same mode. For example, assume the UP ARROW or

DOWN ARROW key is pressed; the menu controls will now operate through the tilts at a
fixed time, e.g., you can go to the lowest tilt by selecting the First Frame iconified button.
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Note 3: Ctrl + LEFT ARROW and Ctrl + RIGHT ARROW are still the keyboard
shortcuts for First Frame and Last Frame; however, you will be returned to the
standard (not All-Tilts) display. To proceed to the first or last frame while in the
All-Tilts special mode, use Ctrl + UP ARROW or Ctrl + DOWN ARROW.

o Best Res Base Products: This section is divided into two parts, as shown on Exhibit 2.2.6.12-1.
The upper part lists individual kxxx products: four kxxx base products, as shown in Exhibit
2.2.6.12-2, and three dual-pol products (ZDR, CC, and KDP). Refer to Section 8.6 for a detailed
description of the dual-pol products.

Exhibit 2.2.6.12-2. Best Res Base kxxx Products

The lower part includes submenus for accessing multiple products and applications. The following
describes the submenus grouped in the lower part of the Best Res Base Products section.

m kxxx Precip: In addition to the QPE dual-pol products, this submenu includes the legacy
precip products, which include Storm Total, One Hour, Three Hour, and User Selectable
precipitation products. A suite of snowfall products is also available on the kxxx Precip
submenu. All are available for request (OTR, RMR), and the first four can be added to an
RPS (Routine Product Set) list. All of these products are available on any scale.

m kxxx Derived Products: The kxxx Derived Products submenu includes Layer Reflectivity,
Cross Section, and Other products displayed on any scale. Derived products include
precipitation, storm (mesocyclone, hail, tornado), and wind derivations.

m kxxx Algorithm Overlays: The kxxx Algorithm Overlays submenu includes legacy
algorithm overlays and the ML dual-pol overlay.

m kxxx four panel: The kxxx four panel submenu includes menu entries for Z+V, Z+SRM 8-
and 4-bit, and some other combinations that are presented in 4-panel mode, with a different
elevation angle or product in each panel.
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m kxxx Data Quality: The kxxx Data Quality products, accessible by a pull-right submenu,
include Clutter Filter Control and reflectivity and velocity clutter probability products.

m kxxx 4-bit/Legacy Prods: The kxxx 4-bit/Legacy Prods submenu uses generic selectors that
load 8-bit (256 level) data, with legacy 4-bit (16 level) and 3-bit (8 level) data filling in
when no 8-bit data is available.

m Radar Applications: The Radar Applications submenu is shown in Exhibit 2.2.6.12-3. It
provides access to all the radar applications and radar tools. All except VR-Shear are
discussed in Chapter 8. VR-Shear is described in this section.

Exhibit 2.2.6.12-3. kxxx Radar Applications Submenu Options (Applications and Tools)

VR-Shear: This tool is used in conjunction with Doppler velocity data to calculate the
velocity difference (or "shear") of the data directly under the end points. As with the
Baselines, this feature comes up editable and the end points can be dragged to specific gates
of velocity data. When in place, the speed difference (kts), distance between end points

(nautical miles), shear (s"), and distance from radar (Nmi) are automatically plotted next to
the end points and in the upper left corner of the large display pane. A positive shear value
indicates cyclonic shear, while a negative value indicates anticyclonic shear. If either end
point is not directly over velocity data, the phrase "NO DATA" is reported for the shear
value. This tool is also useful in determining gate-to-gate shear. Simply place the two end
points directly over adjacent gates of velocity data.

m "Snapping" VR-Shear: If you are zoomed in over an area when you load VR-Shear
and the VR-Shear Baseline does not appear, press mouse Button 3 (B3) to "snap™ the
Baseline to where the mouse cursor is located.

m VR-Shear in 4-Panel: You can use the VR-Shear Tool when the large display is in
4-panel mode. The VR-Shear overlay is loaded in different colors for each panel.
There are actually four copies of the program running, and each behaves
independently. This means that you can get accurate readings in any one of the four
panels; one VR-Shear panel is editable at a time. To activate, click mouse Button 2
(B2) on the VR-Shear legend in the desired panel and position the query line to the
echoes of interest.
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2.2.6.13 txxx

The txxx menu, as shown in Exhibit 2.2.6.13-1, is a site-specific menu that provides access to the displays for
a Terminal Doppler Weather Radar (TDWR). The TDWR is a high-quality, dedicated meteorological
surveillance radar that is deployed near many large airports in the United States. TDWRSs, in contrast to the
WSR-88Ds, provide a finer resolution, have more sweeps per scan, a maximum elevation angle up to 60
degrees, and repeated patterns and elevations within a scan. They also use multiple pulse repetition frequencies
(PRF). Each TDWR has a different set of elevation angles that depend on the distance between the TDWR and
the associated airport. TDWRs operate on the C-band wavelength, making the signal more susceptible to beam
attenuation, velocity aliasing, and range folding.

Exhibit 2.2.6.13-1. txxx Dropdown Menu

Note 1: Variations in the menu options may exist because of your site configuration, so you should spend
some time exploring the vast array of radar products within this menu.

e txxx Products

o Best Res Z+SRM8 Combo and Best Res Z+V Combinations: The radar combination products
Z+SRM and Z+V are precombined formats of the reflectivity and storm-relative motion or
velocity, displayed together via a single menu selection. Storm Relative Motion (SRM) products
include the storm motion vector information, which is plotted in the upper left corner of the Main
Display Pane. The "tilt bins" that have been internally set up apply to both the kxxx and txxx
radars. Thus, for All Tilts Z+SRM8 and the txxx Hi Z+SRMB8 tilts menu options, refer to
Subsection 2.2.6.12.

o Best Res Base Products: This section of the txxx menu is divided into two parts, as shown on
Exhibit 2.2.6.13-1. The upper part lists the individual txxx base products (Reflectivity (Z),
Velocity (V), Storm Rel Vel 8-bit (SRM8), and Spectrum Width (SW)). The lower part includes
submenus for accessing multiple products and applications. The following describes the submenus
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grouped in the lower part of the Best Res Base Products section.

m txXxx Precip: This txxx Precip submenu includes Storm Total, One Hour, Three Hour, and
User Selectable precipitation products. A suite of snowfall products is also available on the
txxx Precip submenu. All are available for request (OTR, RMR), and the first four can be
added to an RPS (Routine Product Set) list. All of these products are available on any scale.

m txxx Derived Products: The txxx Derived Products submenu includes Layer Reflectivity,
Cross Section, and Other products displayed on any scale. Derived products include
precipitation, storm (mesocyclone, hail, tornado), and wind derivations.

= txxx Algorithm Overlays: Opens the txxx Algorithm Overlays submenu for overlaying
multiple products.

m txxx four panel: The txxx four panel submenu includes menu entries for Z+V and
Z+SRMB8. It also includes specific elevation angles (for Hazardous mode), rather than the
standard bin-representing tags. Each TDWR's menu reflects the actual tilt angles in its
Hazardous mode VVCP. For Monitor mode, tilts are displayed from the closest Hazardous
mode angle menu selector.

m txxx Data Quality: The txxx Data Quality products, accessible by a pull-right submenu,
include Clutter Filter Control and reflectivity and velocity clutter probability products.

m txXxx 4-bit/Legacy Prods: The txxx menu uses generic selectors that load 8-bit (256 level)
data, with legacy 4-bit (16 level) and 3-bit (8 level) data filling in when no 8-bit data is
available.

m Radar Applications: The Radar Applications submenu is shown in Exhibit 2.2.6.13-2. It
provides access to all the radar applications and radar tools. All except VR-Shear are
discussed in Chapter 8. VR-Shear is described in this section.

Exhibit 2.2.6.13-2. txxx Radar Applications Submenu Options (Applications and Tools)

VR-Shear: This tool is used in conjunction with Doppler velocity data to calculate the
velocity difference (or "shear") of the data directly under the end points. As with the
Baselines, this feature comes up editable and the end points can be dragged to specific gates
of velocity data. When in place, the speed difference (kts), distance between end points

(nautical miles), shear (s"), and distance from radar (Nmi) are automatically plotted next to
the end points and in the upper left corner of the large display pane. A positive shear value
indicates cyclonic shear, while a negative value indicates anticyclonic shear. If either end
point is not directly over velocity data, the phrase "NO DATA" is reported for the shear
value. This tool is also useful in determining gate-to-gate shear. Simply place the two end
points directly over adjacent gates of velocity data.
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m ""Snapping’ VR-Shear: If you are zoomed in over an area when you load VR-Shear
and the VR-Shear Baseline does not appear, press mouse Button 3 (B3) to "snap™ the
Baseline to where the mouse cursor is located.

m VR-Shear in 4-Panel: You can use the VR-Shear Tool when the large display is in
4-panel mode. The VR-Shear overlay is loaded in different colors for each panel.
There are actually four copies of the program running, and each behaves
independently. This means that you can get accurate readings in any one of the four
panels; one VR-Shear panel is editable at a time. To activate, click mouse Button 2
(B2) on the VR-Shear legend in the desired panel and position the query line to the
echoes of interest.
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2.2.6.14 Radar

The Radar dropdown menu shown in Exhibit 2.2.6.14-1, allows users to access radar related products and
applications. With the exception of RCS, VCS, and SWA products, all products that can be requested from
your local radar can now also be requested from non-associated radars.

Exhibit 2.2.6.14-1. Radar Dropdown Menu
The Radar menu provides access to the following options:

e 10km Radar Coded Message: This mosaic is derived from the reflectivity information in Radar
Coded Messages (RCM). The mosaic is created centrally and disseminated via the SBN at
approximately 00:10 and 00:40 each hour. The reflectivity fields have been given automated quality
control to identify and remove echo features due to nonprecipitation targets, chiefly migrating birds,
aircraft, and insects. However, some small nonprecipitation features may pass all quality-control
checks, especially when they are located underneath cold, dense clouds or near actual precipitation.
True precipitation features are only rarely removed. Boxes within the mosaic grid that are more than
230 km from the nearest reporting radar are black with no data pixels at the out-of-range spots.

e FAA Radars: Most field sites have access to one or more FAA radars, which can provide fill-in
coverage for the WSR-88D network. If a field site doesn't have access to an FAA radar, the Radar
menu will not include the FAA radar options. FAA radars for this menu are set up as part of your
localization process.

FAA radar locations (along with WSR-88Ds and TDWRs) appear on the WSR-88D's map. There are
two kinds of FAA radars: (1) The ASR-11 (IDs beginning with 'e") has a fan beam spanning 4.5 deg in
elevation and 1.4 deg azimuth, making a product similar to an 88D composite reflectivity; and (2) the
ARSR-4 (IDs beginning with 'f") is a phased-array radar (the product we receive is somewhat like a
hybrid scan comprising the four lowest beams). These appear at the top of the Radar menu, just above
the Mosaic section. As shown in Exhibit 2.2.6.14-2, products for each radar include a reflectivity
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image (Z) and a unit status graphic; these generally update once per minute. The FAA radar data is also
included in the Hybrid Scan Refl mosaic.

Exhibit 2.2.6.14-2. ASR-11 and ARSR-4 FAA Radar Menus

e Mosaic: Mosaics available via this menu use data from up to nine nearby radars. Additional optional
mosaics on cascading menus provide a limited list of radar products from a predefined set of WSR-88D
radars within a given region. Your System Manager or site Administrator can set up such mosaics by:
/awips2/edex/data/utility/common_static/site//radar/radarInUse.txt. A mosaicInfo.txt table will
only work while logged on to an AWIPS workstation.

e Dual Pol: Dual-polarization radar data involves alternating between sending vertically and horizontally
polarized pulses. Whereas doppler allows the radar to be sensitive to the motion of the targets,
dual-polarization allows the radar to be sensitive to the shape of the targets. The greatest impacts of this
technology will be improved values for accumulated precipitation, improved hail detection, and
improved detection of non-meteorological targets. Refer to Section 8.6 for further details.

e Dial Radars: Dial radars for this menu are set up as part of your localization process. A
comprehensive menu of radar products is available for each dial radar, as shown in Exhibit 2.2.6.14-3.
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Exhibit 2.2.6.14-3. Dial Radars and Radar Products

e Applications: Radar applications are discussed in detail in Chapter 8. Radar tools are identified in
Exhibit 2.2.6.14-4.
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Exhibit 2.2.6.14-4. Radar Tools
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2.2.6.15 SCAN, Maps, and Help Menus

SCAN

The System for Convection Analysis and Nowcasting (SCAN) dropdown menu shown in Exhibit 2.2.6.15-1,
is located on the CAVE-D2D menu bar. SCAN is an integrated suite of multi-sensor applications that detect,
analyze, and monitor convection and generate short-term probabilistic forecast and warning guidance for
severe weather automatically within AWIPS. SCAN also provides forecasters with severe weather guidance
and supplements forecaster event monitoring with multi-sensor, automated event monitoring. Refer to
Subsection 13.1.2 for a more information on SCAN.

Exhibit 2.2.6.15-1. SCAN Dropdown Menu

The SCAN menu also includes the Flash Flood Monitoring and Prediction (FFMP) application, which allows
forecasters to compare precipitation accumulations derived from radar and other sources with flash flood
guidance. FFMP operates by accumulating precipitation over hydrologic basins on various spatial scales.
Refer to Subsection 13.1.3 for a more information on FFMP.

Maps

The Maps menu shown in Exhibit 2.2.6.15-2, is located on the CAVE-D2D menu bar. The Maps menu lets
you choose one or more map backgrounds for the displayed product. The content of this menu varies
somewhat from site to site.
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Exhibit 2.2.6.15-2. Maps Dropdown Menu
Help

The Help menu shown in Exhibit 2.2.6.15-3, contains a checkbox that enables/disables the Tooltips.
Information on the workstation software is also accessible from this menu.

Exhibit 2.2.6.15-3. Help Dropdown Menu

Page 119



CAVE-D2D User's Manual AWIPS |1 Operational Build 13.4.1 - 31 July 2013

2.2.7 The D2D Toolbar and CAVE Perspectives Tab Bar

This subsection contains brief descriptions of each menu and iconified button displayed along the second and
third rows of the CAVE GUI. The D2D Toolbar is along the second row, while the CAVE Perspectives Tab
Bar is along the third row. Refer to Exhibit 2.2.7-1, which displays the menu and options for the selected
D2D Perspective.

Note 1: Remember that the menus and the button included on the first and second rows of the CAVE
GUI are perspective dependent. Refer to Subsection 2.2.3.

Exhibit 2.2.7-1. D2D Toolbar and CAVE Perspectives Tab Bar

Certain iconified buttons on the toolbar are check buttons. These buttons are recessed when they are in the
"on" position, as shown in Exhibit 2.1.7-1 for the "Pan" button. If Tooltips is selected (a checkbox option
under the Help menu) tooltips appear as you slowly move the mouse pointer over the iconified Toolbar
button. Other buttons on the Toolbar dropdown provide a list of options. A description of each option
follows.

Toolbar Menus and Buttons

Load Modes

The Load Modes menu, shown in Exhibit 2.2.7-2, provides different ways to display model or real-time
data by manipulating previous model runs and inventories of data sets. Load Modes are defined in
Subsection 2.2.6.4.

Exhibit 2.2.7-2. Load Modes Menu with Default Valid Time Seq Mode Selected
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Scale

The Scale menu, shown in Exhibit 2.2.7-3, controls the viewing area of the Main Display Pane. You can
choose one of six scales: N. Hemisphere, North American, CONUS, Regional, State(s), and WFO.

Exhibit 2.2.7-3. Scale Menu with Default CONUS Scale Selected

Note 2: For River Forecast Centers the "State(s)" option on the Scale menu would be changed to
"RFC." The other options would remain unchanged.

Note 3: When CAVE is first started, the CONUS Scale (for CONUS sites) is displayed in the
Main Display Pane.

Note 4: Changing the scale affects the product graphically displayed on the Main Display Pane by
rerendering the image to the new scale.

Clear
The Clear button clears the Main Display Pane of all products. The map background remains.

The D2D Toolbar includes 14 iconified buttons, as shown in Exhibit 2.2.7-4. The function of each button is
described below.
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Exhibit 2.2.7-4. D2D Toolbar Iconified Buttons

(1) Pan

This iconified button, which resets when selected (as shown here), allows you to move freely around the
map background in the Main Display Pane. Click and hold down mouse Button 1 to move the map.

(2-5) Stepping

Stepping consists of four iconified buttons, which enable you to display the first frame in the loop (2),
display the previous frame in the loop (3), display the next frame in the loop (4), or display the last frame
in the loop (5).

(6) Loop

This iconified button automatically changes the display as it sequentially steps through each frame in the
loop.

(7) Loop Properties

This iconified button opens the Loop Properties dialog box, as described in Subsection 2.2.6.4.

(8) Toggle Image Combination

This iconified button enables/disables the ability to display two images at one time, combining the two
products as one in one product legend.

(9) Image Properties

This iconified button opens the Image Properties dialog box, as described in Subsection 2.2.6.4.

(10) Print

This iconified button prints the contents of the large display pane on the default printer. See Subsection
2.2.6.2 for guidance on how to change printer destination.

(11) Points

This iconified button displays the Interactive Points Tool, as described in Subsection 2.2.6.5.

(12) Baselines

This iconified button displays the Interactive Baselines Tool, described in Subsection 2.2.6.5.

(13) Five-Pane Layout

Clicking this iconified button arranges the display to have one Main Display Pane and four Small
Monitor Panes. Refer to Exhibit 2.2.6.3-2.

(14) Three-Pane Layout
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Clicking this iconified button arranges the display to have one Main Display Pane and two medium-sized
Smaller Monitor Panes. Refer to Exhibit 2.2.6.3-3.

Also located on the Toolbar are three additional menus and a WarnGen button. A description of each follows.

Frames

The Frames menu is used to select the number of frames of a product you want loaded. The default is 12
frames. The maximum is 64 frames.

Magnification

The Magnification menu enlarges or reduces the size of the text and symbols on a graphic product. As
you increase magnification, the density of the data automatically decreases. The purpose of this feature is
to make the text and symbols more visible. Magnification 0 is a special case. For station plots, only the
location of the station is shown, and stations with data are in the overlay color, while those without data
are gray. You can still sample the data in this mode. For grids, you can see the grid resolution by
displaying wind and setting magnification to zero.

Density

The Density menu adjusts the amount of data presented on the Main Display Pane. Higher density
settings increase the amount of data.

WarnGen

The yellow WarnGen button, located on the right side of the Toolbar, activates the Warning Generator
function. Refer to Chapter 6 for more information. The background color of the CAVE-D2D screen and
the WarnGen dialog box changes to reflect the mode setting for WarnGen's functionality: no color change
for Operational Mode; black for Test Mode; and yellow for Practice Mode.

CAVE Perspectives Tab Bar Menus and Buttons

Perspective Button and Tabs

Exhibit 2.2.7-4 shows the Open Perspective iconified button on the far left with the tabs for each
perspective, in the order selected, right to left. When a tab is showing, it indicates the perspective is open.
The highlighted tab (D2D in this case) indicates the active perspective, with the other perspectives,
non-highlighted tabs, running in the background. The forecaster can quickly switch to another perspective
by selecting the desired perspective's tab, which would then, in this case, change the D2D to
non-highlighted and the selected perspective's tab to highlighted.

Use the Open Perspective iconified button to drop down the list of perspectives, as shown in Exhibit
2.2.7-5. An iconified tab for the respective perspective that is opened is listed from right to left in the
order in which the perspective was opened. The iconified tab will remain displayed until the perspective
is closed. You can toggle between perspectives by selecting the desired perspective's tab. The D2D tab is
highlighted, indicating it is the active display, and no other perspective is open. The Other option undocks
the CAVE Perspecive dropdown box and displays it as a floating Open Perspective pallet, adding
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"National Centers" and "XML" to the list perspectives.

Exhibit 2.2.7-5. List of Perspectives with D2D Perspective Active
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2.2.8 Pop-up Menus

Pop-up menus contain options that apply to a specific area or a product in CAVE. In other words, the pop-up
menus are area- and context-sensitive and are used to make on-the-fly changes to displayed data.

Different options appear in the pop-up menu, depending on whether a graphic or an image is displayed and
whether the product is displayed in the Main Display Pane or Smaller Monitor Panes or in the four panel
layout.

Pop-up menus are opened by clicking and holding mouse Button 3 (B3) in a specific area, either over a
product legend or over the display area. Pop-up menus that are opened over a product legend contain options
that apply only to that product and do not affect any other overlay.

Pop-up menus that are opened over the Main Display Pane or Smaller Monitor Panes affect all the overlays
contained in the display pane. For example, when you toggle "Looping" on over a Small Monitor Pane, you
toggle animation for all the products contained in that pane.
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2.2.8.1 Pop-up Menus From Product Legends

A pop-up menu can be opened by clicking and holding mouse Button 3 (B3) on the product legend for every
product you display in the main display pane or the four panel layout. Simply clicking on the legend performs
the default pop-up action, which is the first option in the pop-up menu, as shown in Exhibit 2.2.8.1-1.

Exhibit 2.2.8.1-1. Example of Pop-up Menu

Keep in mind that the changes you make apply to that one overlay and not to all the overlays that are
displayed. Also, the pop-up menus are designed to be dynamic; that is, they respond to any changes you have
made and contain new options that pertain to the current state of the overlay.

Note 1: You can open pop-up menus on both the main and monitor display panes.

Descriptions of all possible pop-up menu options from the product follow.

Note 2: Keep in mind that the options available in the pop-up menus depend on the type of product
loaded in the display.

Set Color

The Set Color option allows you to change the color of a single-colored graphic overlay or map background.
Once you choose one of the nine colors from the pop-up menu, the selected overlay immediately appears in
the new color. If the overlay needs to be displayed in a color other than one provided in the pop-up, the Set
Backgroound Color option opens the Set Background Color dialog box.

e Choose Color: The Set Background Color dialog box, a pop-up that can apply to both the Main
Display Pane and the Smaller Monitor Panes, as shown in Exhibit 2.2.8.1-2, allows you to customize
the background color for a particular graphic overlay.
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Exhibit 2.2.8.1-2. Set Background Color Dialog Box

Note 3: Like the Image Color Editor (Subsection 2.2.9), the Set Background Color has a Color
Wheel, HSB and RGB radio buttons, RGB or HSB slider bars, and a Color Swatch.

Adjusting the Color Wheel Centroid or slider bars generates the desired color in the Color Swatch, or
you can enter specific HSB or RGB values.

e OK: Applies the chosen color to the selected overlay and closes the Set Background Color
dialog box.

e Apply: Applies the new color to the selected graphic overlay.

e Cancel: If you've applied a color, Cancel will revert to the original color.

Edit Colors...

If you click and hold B3 over an image legend, the pop-up menu contains the Image Color Editor, discussed
in Subsection 2.2.9, from which you can change the color table. This option is made available in the pop-up
menu whenever a single or combined image or multicolored graphic (e.g., time-series Profiler data) is
displayed. If a combined image is displayed, the pop-up menu will include the name of each image for which

you can choose to edit.
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Blinking

This menu option contains a check button that toggles the blinking of a graphic. It is possible to have several
graphics blink simultaneously.

Change Blinking...

This menu option opens the Image Blinking dialog box. It is used to set up the blinking parameters for a
single or combined image. If a combined image is displayed, the pop-up menu will include the name of each
image for which you can choose to change the blinking.

The blinking capability allows you to flash selected graphic(s), color(s), and ranges of colors. The blinking
rate is adjustable and you can blink several color ranges simultaneously. Blinking features are illustrated in
Subsection 3.3.2, Module 2 under Objectives 2.5 through 2.7.

The Image Blinking dialog box contains the following options.

¢ Blink Rate: An options menu that contains blinking rates from 0.1 to 2 seconds. Also included is the
option to have no blinking, or a zero blink rate. Once blinking is on, then a root (main display area)
pop-up will include a 'Blink Rate (seconds)' item.

o Enable Range: This menu button activates the blinking once you select the range of color values
you want to blink by dragging the arrows in the color bar to the upper and lower limits of the
desired range. You can enable blinking for several color ranges, which then blink simultaneously.

Note 4: Looping must be turned off for the specified range to blink.

Disable Range: Disables the blinking only for the range of values within the arrows.

Reset: Turns off the blinking for the entire color table.

OK: Applies the settings you have made and closes the Image Blinking dialog box.

Cancel: Closes the Image Blinking dialog box without applying the settings you have made.

Load as Image

This menu option overlays the selected contoured graphic overlay as an image. When you load a graphic as
an image with this option, the contoured graphic is still displayed.

Load as Image and Combine

This menu option displays the selected contoured graphic overlay as an image and combines the new image
with an already-displayed image. This option is available in the pop-up menu when there is at least one image
displayed. To better distinguish and manipulate the combined images, use the options available in the
Imaging... dialog box, which is opened from the Image Properties iconified button on the Toolbar.

Load as Arrows
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This menu option displays a gridded vector product (such as wind) using arrows and is available whenever
vector fields are displayed. When selected, the wind arrows product is overlaid on the display.

Load as Barbs

This menu option displays a gridded vector product (such as wind) using wind barbs. This option is made
available in the pop-up menu whenever vector fields are displayed. When selected, the wind barbs product is
added to the display.

Load as Streamlines

This menu option displays a gridded vector product (such as wind) using streamlines. This option is made
available in the pop-up menu whenever vector fields are displayed. When selected, the wind streamlines
product is added to the display.

Load as Contours
This option overlays the selected image field as a contoured graphic.
Line Style

This is a cascading menu that provides line style settings for a selected graphic overlay. The options are
Default, Solid, Dashed, or Dotted. By default, data with values less than zero is automatically displayed in
dashed lines. Any text or symbols contained in a graphic are not affected by the changes to line style.
However, wind barbs and arrows are affected.

Line Width

This is a cascading menu that provides four line-width settings for a selected graphic overlay. Any text or
symbols contained in a graphic are not affected by the changes to line style. However, wind barbs and arrows
are affected.

Magnification

This is a cascading menu that provides magnification settings for selected graphic overlays. These settings
are the same as those in the Magnification option menu in the Toolbar (see Subsection 2.2.7). However, the
magnification setting chosen from the Toolbar applies to all the overlays in the main display pane, while the
magnification setting chosen from the pop-up menu applies only to the one overlay on which you opened the
pop-up menu. The present magnification setting of the overlay is indicated with the check button turned on
(yellow).

Density

This is a cascading menu that provides data density settings for a selected graphic overlay. These settings are
the same as those in the Density option menu in the Toolbar (see Subsection 2.2.7). However, the density
setting chosen from the Toolbar applies to all the overlays in the main display pane, while the density setting
chosen from the pop-up menu applies only to the one overlay on which you opened the pop-up menu. The
present density setting of the overlay is indicated with the radio button turned on (yellow).

Sampling for this Product
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When you click and hold mouse Button 1 (B1) (using the Legacy AWIPS mouse functionality) over an
image and some plotted data (including METARs, LDAD, marine, severe weather reports, MSAS QC
information, and Skew-Ts), the data value or report will be displayed next to the pointer. You can disable this
sampling readout by unselecting the Sampling for this Product button from the product legend.

Display Product

This menu option contains a check button that toggles the visibility of the selected graphic or image overlay.
Clicking B1 on the legend performs the same action.

Unload

This menu option permanently removes a selected graphic or image overlay from the display. The product is
restored only by reloading.

Editable

This pop-up menu option applies to editing elements of WarnGen and any of the tools that require editing
(Baselines, Points, Home, etc.). You can also enable or disable editing of WarnGen and the tools by clicking
the legend with mouse Button 2 (B2).

Page 130



CAVE-D2D User's Manual AWIPS |1 Operational Build 13.4.1 - 31 July 2013

2.2.8.2 Pop-up Menus in the Main Display Pane
Click and hold mouse Button 3 (B3) over the Main Display Pane or over one of the panels of a four panel

layout to open the pop-up menu that contain options that affect all products in that display area. Most options
that are available on the menus are shown in Exhibit 2.2.8.2-1. All options are discussed in the following

sections.

Exhibit 2.2.8.2-1. Main Display Pane Pop-up for Single Panel and Four Panel Layouts
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2.2.8.3 Pop-up Menus in the Smaller Monitor Panes

Click and hold mouse Button 3 (B3) over one of the Smaller Monitor Panes to open the pop-up menu shown
in Exhibit 2.2.8.3-1. The menu contains options affecting all products in that display area. All possible
options that are available in this pop-up menu are described in this subsection and in Subsection 2.2.8.4.

Exhibit 2.2.8.3-1. Pop-up Menu That Affects All Products in the Smaller Monitor Pane Display Area
Swap with Large Pane

The Swap with Large Pane menu option exchanges the contents of a Smaller Monitor Pane with that of the
Main Display Pane. When the contents of the Main Display Pane are swapped to the Smaller Monitor Pane,
the Rotate Panels and Four Panel Layout options become available, as shown above.

Zoom

This menu option opens a cascading menu that contains eight zoom factors. The position of the cursor before
the pop-up menu was invoked determines the center of the display once you zoom in. When zooming on
plan-view data, the zoom factors are expressed as display widths in kilometers. For non-plan-view data
(skew-Ts, profiler time series, etc.), the zoom factors are given as magnification factors.

Set Background Color...

This menu option opens the Choose Pane Background Color dialog box, which allows you to set the
background display color. Note that the background color is affected by the image brightness setting, and that
the sample color is always white; therefore, samples may be difficult or impossible to read if you pick a very
light background color.

Lat/Lon Readout

This is a check button that toggles the ability to sample latitude and longitude coordinates at the mouse
pointer.
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2.2.8.4 Pop-up Menus for Display
Show/Hide Legends

This menu option reveals and conceals both product legends and map background legends and is the default
action if you click mouse Button 3 (B3) in the Main Display Pane or one of the panels in the four panel
layout.

Once you toggle off the product legends, the valid time and date of the first loaded product remain in the
lower right corner of the large display pane.

Show Map/Product Legends

This menu option toggles between making product legends or map legends visible on the Main Display Pane
or one of the panels in the four panel layout.

Load to This Panel
This menu option, available only in the four panel layout, allows you to choose one of the four panels for
your next product selection. When this option is selected, a large yellow "L" appears in the lower left corner

of the chosen panel, as shown in Exhibit 2.2.8.4-1 (see the upper right panel). Any subsequent product loads
overlay only in the chosen panel and not in the other three panels.
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Exhibit 2.2.8.4-1. Chosen Panel (Yellow L") of Four Panel Layout
Load to All Panels
This menu option is available when the four panel layout is displayed in the Main Display Pane and one of

the panels is enabled for loading (marked with a yellow "L"), as shown in Exhibit 2.2.8.4-2. It allows you to
load the next overlay into all four panels.

Exhibit 2.2.8.4-2. Pop-up Menu with Load to All Panels Option

N

Note 1: Observe that both product and map legends are hidden on Exhibits 2.2.8.4-1 and 2.2.8.4-2. For
that reason, the pop-up shown in Exhibit 2.2.8.4-2 has "Show Product Legends" and "Show Map
Legends" as options.

Control Color of This Image

This option, available only in the four panel layout, allows you to choose one of the four panels that may
contain an image and make changes to that image. When this option is selected, a large green "[" appears in
the lower left corner of the chosen panel, and the Image Properties dialog box appears automatically, as
shown in Exhibit 2.2.8.4-3. Within this dialog box, you can adjust the brightness using the slider bar or edit
the image by clicking on the image label within the Image Properties dialog box, which opens the Image
Controls Editor. To combine an image in this panel with another image, you need to click B3 over the panel
and choose the Load to this Panel option. Then select the additional image to combine into the panel.
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Exhibit 2.2.8.4-3. Control Color of This Image Panel Indicator (Green "'I'")
Control Color of All Images
This option is available when the four panel layout is displayed in the Main Display Pane and one of the
panels is enabled for controlling its image (denoted with a green "I"). This menu option allows you to make
changes to the images in all four panels.
Four Panel Layout
This menu option, available only in the Main Display Pane, divides the Main Display Pane into the four panel
mode, as shown in Exhibit 2.2.8.4-1. If you select this option when data is displayed in the Main Display
Pane, the data is redrawn in the upper left panel.
Single Panel Layout
This menu option, available only in the four panel layout, reverts the four panel layout to the single Main
Display Pane. Any products loaded in the panel where you selected this pop-up menu option are then
redisplayed in the single Main Display Pane. Products displayed in the other three panels are not redisplayed.

All-Panel Sample

This check button enables sampling of the current full-screen image (see Rotate Panels, below), plus up to
seven hidden images.

Note 2: The hidden images' samples show a reduced amount of information, while the in-view image
uses a standard sample preceded by an equals sign.

Rotate Panels

When in four panel mode, this option brings the upper left panel into the full main pane, with a large cyan
plus sign in the lower left corner as a cue. If you have combined images, the 'left-hand' image will be
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displayed. Subsequent selections of Rotate Panels cycle through the panels—UL, UR, LR, LL.

Note 3: This function is usually controlled by keyboard shortcuts. Delete is equivalent to Rotate
Panels, while End returns you to four panel mode. Keyboard keys 1 through 8 go directly to a
component of interest. (See Table 2.1.1-3.)

Skip This Frame

This menu option, available only over the Main Display Pane and only when the actual number of loaded
frames is greater than one, temporarily removes (skips) the currently displayed frame from the loop. You can
restore this frame by selecting the Restore Skipped Frames menu option. Keep in mind that once a frame is
removed from the loop, you can no longer step to it.

Note 4: Not available if looping is toggled on. ‘

Skip Previous Frames

This menu option, available over the Main Display Pane only, allows you to skip all previous (earlier) frames
of data from a loop. If the current frame is the first frame, then this option is not available.

Note 5: Not available if looping is toggled on. ‘

Skip Subsequent Frames

This menu option, available over the Main Display Pane only, allows you to skip all subsequent (later) frames
of data from a loop. If the current frame is the last frame, then this option is not available.

Note 6: Not available if looping is toggled on. ‘

Restore Skipped Frames

This menu option, available over the Main Display Pane only, recovers all frames that were temporarily
removed. This option appears in the menu once you have skipped any frames from the loop.

Zoom
This menu option, available in the Main Display Pane and the four-panel layout, opens a cascading menu that

contains eight zoom factors. The position of the cursor before the pop-up menu was invoked determines the
center of the display once you zoom in.

When zooming in on plan-view data, the zoom factors are expressed as display widths in kilometers. For
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nonplan-view data (such as Skew-Ts or profiler time series), the zoom factors are given as magnification
factors.

Sample

"Sample" is a menu option with a check button that toggles the capability for continuous sampling for all
image data, as well as METAR and ceiling/visibility plots and the Home Tool. Sampling 'on' is equivalent to
holding mouse Button 1 (B1) down all the time (using the Legacy AWIPS mouse functionality).

Lat/Lon Readout

This is a check button that toggles the ability to sample latitude and longitude coordinates at the mouse
pointer.

Unload All Products

This menu option removes all graphics and image products from the Main Display Pane. To redisplay a
product, it must be reloaded into the Main Display Pane.

Unload Graphics
This menu option removes all displayed graphics from the Main Display Pane. To redisplay a graphic, you

must reload it into the Main Display Pane. If one or two images are displayed with the graphics, they remain
in the Main Display Pane when the graphics are removed.
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2.2.8.5 Pop-up Menus for Editing

The following pop-up menu options apply to editing elements (baselines, points, home, etc.).
Delete Vertex

This menu option removes the vertex where the mouse pointer was located when you opened the pop-up
menu. This option is available only when a tool is displayed. This same action can be performed by clicking
mouse Button 2 (B2) on a vertex.

Move Vertex

This menu option lets you drag a vertex without clicking mouse Button 1 (B1). The cursor's position over a
vertex before the pop-up menu was invoked marks the vertex that moves. To terminate the move and fix the
location, click any mouse button.

Move Entire Element

This menu option lets you drag an entire element without clicking B1. The cursor's position over an element
before the pop-up menu was invoked marks the element that moves. To terminate the move and fix the
location, click any mouse button.

Add Vertex

This menu option lets you add a vertex without clicking B2. The new vertex is added at the cursor location in
the identified element segment. The cursor's position over an element before the pop-up menu was invoked
identifies the element. When you add a vertex using the pop-up, it is movable until you click B1.

Select Location

This menu option allows you to change the location of the selected element by clicking B3 on the desired
location. This option is available only when you are using WarnGen or the Alert Area Editor.

Select Area

This menu option, available only when you are using the Alert Area Editor, allows you to delineate an alert
area using a stretch box. The upper left corner of the box is located at the location of the cursor when the
Select Area option is chosen. Stretch out the box to the desired size and click any mouse button to finish
drawing the box.
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2.2.9 Color Editors

There are two color editors: The Image Properties Color Editor, which is used to change an images color
property; and the Set Background Color Editor, which is used to change the background color of the main
and/or monitor panes. The Image Properties Color Editor is also used to modify existing color tables, or
create new ones and save them for future use. There are four types of color tables:

1. AWIPS standard color tables, which come with the system as part of the baseline code and are
read-only (they cannot be changed unless you save them with different names).

2. Site-localized color tables, which are also read-only.
3. Office-customized color tables, which are available to the entire staff and can be edited.
4. User-customized color tables, which are saved and accessible under a specific user ID.

The menu from which to access all color tables is in the Image Properties dialog box. The Image Properties
dialog box labeled ""Imaging...”, is shown in Exhibit 2.2.9-1.

Exhibit 2.2.9-1. Image Properties Dialog Box
The Image Color Editor, as shown in Exhibit 2.2.9-1 can be opened in three ways:
1. From the Menu bar, select Options > Image Properties.

2. From the Toolbar, select the Image Properties iconified button.

3. On a4 Panel Map, by clicking and holding mouse Button 3 (B3) over one of the panels to pop-up
menu and selecting Control Color of This image as shown in Exhibit 2.2.9-2.

Page 139



CAVE-D2D User's Manual AWIPS |1 Operational Build 13.4.1 - 31 July 2013

Exhibit 2.2.9-2. Control of This Image Pop-up Menu

To change the background color of the main and/or monitor panes, you would open the Set Background
Color dialog box. This Image Color Editor is shown in Exhibit 2.2.9-3.

Exhibit 2.2.9-3. Set Background Color Dialog Box
The Image Color Editor, as shown in Exhibit 2.2.9-1 is opened by:

1. Clicking and holding B3 on the Main Display Pane or Smaller Monitor Pane until the pop-up window,
as shown in Exhibit 2.2.9-4 appears.

Exhibit 2.2.9-4. Pop-up Window to Open Set Background Color Dialog Box
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2. Select Set Background Color to open the dialog box shown in Exhibit 2.1.9-3.

For more information about the Image Color Editor, go to the next section, Subsection 2.2.9.1.
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2.2.9.1 Image Color Editing Features and Process

This section describes the image color editing feature and illustrates the image color editing process. For a
Practice Module on how to use the color editor function, see Subsection 3.3.3.

Refer to Exhibit 2.2.9.1-1 when reading this section.

Exhibit 2.2.9.1-1. Image Color Editing Process

e Use Color Model: Red, Green, Blue (RGB) and Hue, Saturation, and Brightness (HSB) radio buttons
allow you to choose the color model.

e HSB/RGB Slider Bars: These slider bars allow you to make incremental changes in the components
of the color displayed in the Color Swatch. These values can be set using the slider bar, typing a value
in the entry box to the right of the slider, or by using the up and down arrow keys.

e Color Wheel: The box on the right side of the dialog box contains the Color Wheel. The Color Wheel
Centroid (a circle with a dot in the middle) can be dragged anywhere within the circle to change the
color displayed in the Color Swatch (more on this later in this section). Moving the Centroid around
the circle also changes the HSB or RGB values. In HSB mode, brightness cannot be changed by
dragging the Centroid.
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o Red, Green, Blue: The red, green, and blue values in the RGB mode all range from 0-255 and
reflect the amount, or intensity, of each color present in the displayed color. Changing these
values moves the Color Wheel Centroid across the Color Wheel, but not necessarily along a
radial.

o Alpha: The Alpha values in both the RGB mode and the HSB mode range from 0-255 and
reflect the amount, or intensity, of blending of the displayed color. Changing the Alpha values
does not move the Color Wheel Centroid across the Color Wheel, but it modifies the contrasting
colors in the Color Swatch box.

o Hue: Values for hue range from 0-359 and determine the amount of color tint. Changing hue
values moves the Color Wheel Centroid around the circumference of the Color Wheel. Try
dragging the Hue Slider Bar (to change the hue value) and notice the movement of the Centroid.

o Saturation: Saturation values are given in percent (0-100) and determine the amount of white
(the higher the value, the less white) present in the color. Changing saturation values moves the
Color Wheel Centroid along a radial of the Color Wheel. Change the saturation values and note
the movement of the Centroid.

o Brightness: As with saturation, brightness values are also given in percent (0-100). Brightness
determines the amount of black present in the color. The higher the values, the less black present.
Brightness can also be thought of as the intensity of the color.

Color Swatch: To the right of the Color Wheel is the Color Swatch. Moving the Color Wheel Centroid
changes the color in the swatch. Also, clicking anywhere in the top half of the Color Bar (located in the
middle of the dialog box) fills the top Color Swatch with the corresponding color; clicking anywhere in
the lower half of the Color Bar fills the bottom Color Swatch.

Set: These buttons, located in both the upper and lower portions of the Image Colors Editor, insert a
narrow line of color into the current Color Bar at the location of the Color Pointer. The color inserted is
the one displayed in the corresponding (i.e., upper or lower) Color Swatch.

Fill: These buttons replace the colors contained within the range specified by the Color Pointers in the
Color Bar with the colors in the upper or lower Color Swatch.

Color Bar: The Color Bar contains the color table of the current image and is located in the middle of
the dialog box.

The arrowhead Color Pointers along the top and bottom halves of the Color Bar can be dragged to
delineate a range of the color table, that is, the portion of the Color Bar contained between the top and
bottom arrows. The Color Pointers move independently of one another, but they cannot move past each
other. When aligned, they move in unison and delineate a single point along the Color Bar.

As the Color Pointers are dragged along the Color Bar, they display the image values corresponding to
the color pointed to. For example, if an infrared satellite image is displayed, moving the Color Pointer
shows the temperature values corresponding to the colors in the Color Bar. As the Color Pointers are
moved, they are filled with the color they are pointing to.

To either side of the Color Bar are left- and right-pointing arrows. These are used to move the Color
Pointers along the Color Bar an increment at a time. The > and < move one image value at a time (i.e.,
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256 steps through the color bar), while >> and << move one color band at a time. In the case
illustrated, there is no difference in behavior between the two. For a 4-bit radar color table, the <<
moves to the next of the 16 colors.

e Edit Controls: At the bottom of the dialog box are the Edit Controls.

o Interpolate: This button fills the specified range of values with intermediate colors. In both
RGB and HSB modes, each component is interpolated. For RGB, the effect is more or less one
of moving across the color wheel in a straight line from the upper color to the lower; in HSB, the
centroid motion is along an arc or spiral. (In fact, the RGB interpolation is not necessarily a
straight line across the color wheel, as one can see from the example in Objective 2 of Module 5
in the next section.)

o Undo: This button allows you to successively undo changes made to the color table.
o Redo: This button successively redoes the last edit that was undone.
o Revert: This button returns the Color Bar (and the displayed image) to its original state.

o Save: This button saves changes that you have made to a color table. If you are editing a
read-only color table, or one that is owned by another user, this menu button is disabled.

o Save As...: This menu button opens the Save As dialog box in which you can enter a name for
your color table. The color table is saved in a folder containing the customized color tables for
the current user. If the new name of the color table is the same as the name of an existing color
table in this folder, a dialog box opens and asks you if you want to overwrite the existing color
table.

o Office Save As...: With this menu button, you can save a newly edited color table so that it is
accessible on every workstation in your office. A dialog box asks you to enter a name for your
color table and then lets you save it or cancel the command.

o Delete...: This button allows you to delete an edited color table. A confirmation dialog box opens
to confirm your request. This menu button is disabled if you are editing a read-only color table or
a color table that is owned by another user.
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3.0 Getting Started Using AWIPS Graphical User Interface

This chapter introduces you to the CAVE workspace for working with graphic and image products. It
includes practice modules for getting you familiar with the Graphics Workstation and the CAVE
environment.

This chapter includes the following sections:

e Section 3.1: Working with Graphic and Image Products

e Section 3.2: Working with Model Data Using the Volume Browser

e Section 3.3: Practice Modules (Tutorials) for AWIPS Graphical User Interface
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3.1 Working with Graphic and Image Products

Products are presented in two formats in the CAVE workspace: graphics and images. Graphic products are
presented as either contoured or plotted data. Image products are presented as continuous fields. Examples of
graphic products include contours of temperature or other model data, plots of METAR or local-scale
observational data, or Radiosonde Observation (RAOB) soundings. Examples of image products include
satellite and radar data, as well as image presentations of other (usually contoured) data fields such as
temperature, heights, and vorticity.
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3.1.1 The Procedures Cascading Menu

Procedures are user-generated lists of graphics and/or image products, which enable you to define, customize,
and save a sequence of products. Procedures provide a convenient way to display commonly used products or
products that are needed for a certain weather scenario. If, for example, you display 24 frames of IR satellite
imagery overlaid with METAR plots, you can save for future use this grouping of products (a "bundle"),
along with other bundles, as a Procedure.

Bundles contain not only all the products you overlaid onto the display, but also the display parameters
(frame count, looping speed, color tables, and graphics control settings). You can then label your Procedure
to reflect its contents or with your own name. This allows you to save your color, line width, and line style
preferences. When you display the bundle, your preferences are already applied.

When you use the Points or Baselines tools to generate model soundings, cross-sections, time series, etc., and
save these bundles in a Procedure for future use, you have the choice to display the data with the original
position of the point or baseline that you used when you set up the bundle, or you can use the current
position, which is likely to be in a different location than it was when you set up the bundle. You can also
alter the model grid, radar, or point/baseline at load time.

You open the Procedures cascading menu from the File button on the Menu Bar, as shown in Exhibit 3.1.1-1.

Exhibit 3.1.1-1. Procedures Cascading Menu

The New, Open, and Delete menu options each activate dialog boxes needed to open, build, edit, save, name,
and delete Procedures. These dialog boxes are described in the next section. The Copy Display to
Procedure(s) option copies the current bundle into any open Procedure.
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3.1.2 The Procedures Dialog Box

New... (Ctrl+N)

The File > Procedures > New... (Ctrl+N) option opens the Procedure - (untitled) dialog box, as shown in
Exhibit 3.1.2-1. When first opened, the dialog box's display window is empty. The buttons on the Procedure
dialog box are used to control the bundles in a procedure, as described below.

Exhibit 3.1.2-1. Procedure Dialog Box

e Up/Down: These buttons move the selected bundle up or down within the procedure. Movement
'wraps' from top to bottom and vice versa.

e Rename...: Clicking this button brings up a dialog box which allows you to type a new name for the
selected bundle.

e Original: This radio button allows you to display any cross-sections or point soundings or time-height
cross-sections that you may have in your procedure using the original location of the points and
baselines that you used when you initially set up your bundle.

e Current: This radio button allows you to display any cross-sections or point soundings or time-height
cross-sections that you may have in your Procedure using the present location of the baselines or
points.

e First/Next: This menu button loads the bundles sequentially from the top (first) bundle to the last (and
will wrap back to the top). The currently displayed bundle is highlighted.

e L oad: This menu button displays the highlighted bundle in the Main Display Pane. You can also
double-click on the bundle to load it.

e Alter...: This menu button opens the Alter Bundle On Loading dialog box, which contains options that
allow you to modify how an existing bundle displays. In each case, choosing an item from the option
menu will automatically select the associated check button. If the selection you want is already
showing, you can just click on the check button to activate it. In the case where an item does not apply
(e.g., point/line for a radar PPI), it makes no difference if it is selected or not.
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o Point/Line: These option menus allow you to modify an existing cross-section, point sounding,
or time-height cross-section bundle.

m | ast Edit (Point/Line): This option lets you load a cross-section or point sounding or
time-height cross-section using the most recently edited point or line, which is given in the
label.

m Original Location: Select this option to display data using the point or baseline location
in effect when the bundle was stored.

m Current Location: This option lets you display a cross-section or point sounding or
time-height cross-section using the present location of the baseline or point.

m Point/Line-[x]: You can choose to use any of the points or baselines with one of these
selections.

o Radar: Select this check button to display data from a different radar.

Note 1: The radars available to choose are those that appear on the menus - main menu plus
Radar menu.

o Grid: This menu allows you to select an alternate grid, for example, to display a time section or
cross-section.

Note 2: Once you alter a bundle and display it, you override the information in the bundle
with new information. The new information in the bundle can then be put into a procedure.

Note 3: Refer to Subsection 3.3.5 for a practice module on altering a Procedure.

Copy In: This button puts the current contents of the Main Display Pane into this procedure.

Copy Out: This button copies a selected bundle in one procedure into other open procedures. At least
one other Procedure dialog box must be open to enable this menu button.

Delete: This button deletes a highlighted bundle from a procedure.

Save: If this is a new, unsaved procedure, this button will open the Save Procedure As dialog box,
which provides a standard interface to name your procedure and store it in your personal directory. For
an existing procedure, Save will update it without any further interaction. The Save button becomes
enabled any time you make a change (add, delete, move, or rename bundles). It's a good practice to
save changes as you make them.

Save As...: This button opens the Save Procedure As dialog box to allow you to save a copy under a
different name.

Close: This button closes the Procedure dialog box. The Close button does not automatically save
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changes you may have made to your procedure but will prompt you to do so if appropriate. Use the
Save button to save a revised procedure.

Open... (Ctrl+0O)
The Open... (Ctrl+O) option opens the Open Procedure dialog box.

The Open Procedure dialog box contains a list of the selected user ID's procedures. To open an existing
procedure, double click on it or highlight it and press the OK button at the upper right of the dialog box. You
can also type the procedure name on the line provided in this dialog box. Once you select a procedure, it
appears in a dialog box labeled with the procedure's name.

Delete... (CtrI+D)

The Delete... (Ctrl+D) option opens the Delete Procedure dialog box, which allows you to delete any
procedure that you own.

e OK: Once you have identified the procedure you want to delete, click the OK button or you can
double-click to delete. A confirmation dialog appears and then the Delete Procedure dialog closes.

Note 4: Once deleted, a procedure cannot be restored.

e Cancel: This closes the Delete Procedure dialog box.
Copy Display to Procedure(s) (Ctrl+B)

This Copy Display to Procedure(s) option copies the products that are currently in the Main Display Pane
into any open procedure.

The History List Dialog Box

The History List dialog box is opened from the File dropdown menu or by using the "Crtl+H" keyboard
shortcut. It contains the most recent bundles that were displayed in the Main Display Pane with the most
recently loaded bundle appearing at the top of the History List.

Procedures may be built from the bundles contained in the History List. If you swap panes or clear the Main
Display Pane, a blank space appears temporarily in the History List.

The buttons on the History List dialog box are described below.

e Load: The Load button displays the highlighted bundle in the Main Display Pane; you can also
double-click on the name to load it. A copy of this bundle is added to the top of the History List.

e Copy Out: This button copies the selected bundle into any open Procedure dialog boxes.

e Alter Bundle...: This menu button opens the Alter Bundle On Loading dialog box, which contains
options that allow you to modify how an existing bundle displays. These options are as described
above.
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e Close: This button closes the History List.
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3.2 Working with Model Data Using the Volume Browser

The Volume Browser provides access to numerical models, other gridded data, and selected point data
sources, such as RAOB, METAR, and Profiler. Through the Browser interface, you can choose the data
source(s), field(s), plane(s), and point(s), and generate a customized list of model graphics or images for
display. This chapter introduces the features and functionality of the Volume Browser.
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3.2.1 The Volume Browser Dialog Box

The Volume Browser dialog box can be accessed from the Volume menu.
The Volume Browser window is divided into four areas:
e The Menu Bar along the top
e The Data Selection Menus
e The Product Selection List
e The Load Buttons (Diff and Load) to load items from the Product Selection List
Each area is then subdivided into menu components, described in Subsections 3.2.2 through 3.2.5.

The menu bar along the top of the Volume Browser window has dropdown lists that contain options for
controlling all the various menu choices of the Volume Browser. Exhibit 3.2.1-1 shows the Volume Browser
dialog box when initially opened.

Exhibit 3.2.1-1. Standard (Default) Volume Browser Dialog Box
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3.2.2 The Volume Browser Menu Bar

The dropdown menus in the Volume Browser menu bar contain options for controlling and manipulating the
\Volume Browser or the products chosen through the Volume Browser.

e File: The File dropdown menu, shown in Exhibit 3.2.2-1, contains the following options:

Exhibit 3.2.2-1. Volume Browser Menu Bar - File Dropdown Menu
o Clone: Duplicates the Product Selection List's highlighted products into a separate dialog box.

o Exit: Closes the Volume Browser dialog box. Any product selections you may have made in the
Volume Browser before exiting remain when you re-open the Volume Browser.

e Edit: The Edit dropdown menu, shown in Exhibit 3.2.2-2, contains the following options:
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Exhibit 3.2.2-2. Volume Browser Menu Bar - Edit Dropdown Menu

o

Clear All: Removes all list entries you have made in the Volume Browser.

o

Clear Sources: Removes any model sources from the Sources list.

o

Clear Fields: Removes any model fields from the Fields list.

o

Clear Planes: Removes any model planes from the Planes list.

o

Select None: Deselects and empties all of the products in your Product Selection List but leaves
the selections you made in the Source, Fields, and Planes menus.

o Select All: Generates a Product Selection List of all possible products based on the selections
made in the Source, Fields, and Planes menus.

o Find (Ctrl+F): Checking this box activates the search function.

e Tools: The Tools dropdown menu, shown in Exhibit 3.2.2-3, contains the following options:
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Exhibit 3.2.2-3. Volume Browser Menu Bar - Tools Dropdown Menu

o Baselines: Editable lines that determine the cross-section coordinates of the gridded model data.
These baselines are the same as those mentioned in Subsection 2.2.6.5 Tools and are available in
the Volume Browser for user convenience.

o Points: Editable locator dots that are used to generate model soundings, time/height sections,
and time series from gridded model data. These points are the same as those mentioned in
Subsection 2.2.6.5 and are available in the Volume Browser for user convenience.

o Choose By ID... : A function of the Digital Mesocyclone Display (DMD) and a method of
selecting feature locations. The tool is used to monitor the same feature at a certain location.
Without the Choose By ID tool, a monitored feature (over a period of time) could move away
from its monitored location and another feature could move in its place. You can use Choose By
ID to set points, baselines, and "Home" for conventional locations like METARs and RAOBS,
but its primary use is for the 88D-identified mesocyclone locations. Refer to Exhibit 3.2.2-3 and
to Subsection 3.3.6, Objective 14.1 for practice modules. You can also access the Choose By ID
tool and menu from the Tools menu on the Main menu; refer to Subsection 2.2.6.5.

e Settings: Settings allow you to choose whether you want the data to be presented in Plan view
(horizontal), Cross section (vertical slice), Time height, Var vs Hgt, Sounding, or in a Time series
perspective. You can also choose the temporal direction of Time-height Cross section.

The Settings category consists of a one, two, or more dropdown menus, which are labeled with the
selected menu option. The number of additional Volume Browser dropdown menus, if any, depend on
the setting that was first selected. For example, selecting Plan view adds the Time (Animate in Time or
Animate in Space) dropdown menu setting, as shown in Exhibit 3.2.2-4. However, selecting Sounding
does not add any additional dropdown menus.
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Exhibit 3.2.2-4. Volume Browser Menu Bar - Settings (Plan View and Time) Dropdown Menus

The Volume Browser is a dynamic dialog box. After you choose the first setting, additional option
menus specific to that setting appear to the right on the Volume Browser menu bar. The Fields and
Planes dropdown menus change with each setting as well. Because of this relationship, the additional
dropdown menus are listed here under the Settings general category.

o Plan view: The default option for the Volume Browser. From the Plan-view perspective, data are
plotted onto horizontal surfaces. The Plan view Planes are discussed in the planes section that
follows. The additional options menu that appears in the Volume Browser menu bar allows you
to choose whether you want the Plan view data to Animate in Time or Animate in Space.
Exhibits 3.2.2-1, -2, -3, and -4 show Plan view and Time (Animate in Time) settings. Exhibit
3.2.2-5 show Cross section and Time settings.

o Cross section: Allows you to view gridded data as vertical slices along specific baselines. You
need to use either the Interactive Baseline Tool or the predefined latitude/longitude baselines to
specify the slice you wish to see. One of the additional options menus that appear in the Volume
Browser menu bar allows you to choose whether you want the cross-section data to animate in
time or space, while the other options menu allows you to adjust the vertical resolution.
Descriptions of these options follows. (Note that the Fields and Planes submenu labels have
changed after selecting "Cross section.") Exhibit 3.2.2-5 shows the Volume Browser menus as
they appear when the Cross section setting is chosen.
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Exhibit 3.2.2-5. Volume Browser - Cross Section Menu State

o Time height: Used in conjunction with the Interactive Points Tool to enable you to view a time
height cross section of a full run of gridded model data for a specific location. Additional options
menus in the Volume Browser menu bar allow you to choose the direction in which you want the
data to be plotted, and to adjust the vertical resolution. Exhibit 3.2.2-6 shows the Volume
Browser menus as they appear when the Time height setting is chosen. (Note that this illustrates

the case of no local sources.)

Exhibit 3.2.2-6. Volume Browser - Time Height Menu State

o <left: Used when generating a time height cross section. Data are plotted with the latest data on
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the left and the earliest data on the right.

o >right: Used when generating a time height cross section. Data are plotted with the latest data on
the right and the earliest data on the left.

o Var vs Hgt: Enables you to view a profile of a meteorological model field as it changes through
height, which is displayed in millibars. By using the Interactive Points Tool, you can select one
or more locations from which to plot the data. Exhibit 3.2.2-7 shows the Volume Browser menus
as they appear when the Var vs Hgt setting is chosen.

Exhibit 3.2.2-7. Volume Browser - Var vs Hgt Menu State

o Sounding: Works in conjunction with the Interactive Points Tool to enable you to generate a
Skew-T chart for a specific location, as shown in Exhibit 3.2.2-8, no additional menus appear in
the Volume Browser when the Soundings setting is chosen.
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Exhibit 3.2.2-8. Volume Browser - Sounding Menu State

o Time series: Used in conjunction with the Interactive Points Tool to enable you to plot gridded
data on a time versus data value graph for a specified point. Exhibit 3.2.2-9 shows the Volume
Browser menus as they appear when the Time series setting is chosen.

Exhibit 3.2.2-9. Volume Browser - Time Series Menu State

o Animate in Time: The default option for the Volume Browser. It allows you to view model data
through time.

o Animate in Space: Allows you to loop through a series of predefined latitude or longitude cross-
sectional slices at a fixed time.
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3.2.3 Data Selection

All the data available through the Volume Browser are stored in gridded format and generated as graphic or image
presentations on the fly. The specific product you want to display graphically is defined by your selections from the
Volume Browser dialog box, as shown in Exhibit 3.2.3-1.

Note 1: The combinations of the selected menus, submenus, and options define the available Sources, Fields,
and Planes and thus define the specific product you want to graphically display. Refer to Subsection 3.2.2 for a
listing of menu options and their combinations and availability.

Exhibit 3.2.3-1. List of Volume Browser Product Sources

Note 2: Grids are named (titled) with their delivered resolution, such as NAM40 and GFS90. In some cases,
however, higher-resolution components are available, such as GFS precipitation, or different resolutions are
used at different time projections, such as >168 hours on the GFS. Once displayed, the product legend will show

the actual resolution of each grid used.

The product descriptions that follow will help you understand how the combination of menu selections displays

specific information.
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Note 3: Menus are not scale-dependent, which means that the contents do not change with a change in the
selected scale. Items listed in green font indicate that the items are available in the database. Once a Source is
selected the database is sorted and the available items in the Fields and Planes menus are shown in green. Once
an available product is selected, it appears in a dimmed gray color in the menu.

Sources submenus: The Sources section consists of three, and sometimes four submenus.

Note 4: The links provide a generic view of the type of items available for the selected combination. The
available options, defined by the green box, may vary depending on the specific Volume Browser
menu/submenu combination. Note that Volume and SfcGrid are only partial lists of the total options available,
denoted by the down-pointing arrow at the bottom of the list.

o Volume: The Volume menu encompasses everything traditionally thought of as grids, including model
output and ensembles, plus radar. Click here for Volume.

o SfcGrid: The SfcGrid submenu comprises surface or near-surface data, such as MSAS, winds and
waves, and sea surface temperature. Click here for SfcGrid.

= North American Mesoscale (NAM) Grids: The NAM model is a regional mesoscale model using
enhanced terrain and improved parameterization of surface and precipitation processes. It produces
forecasts out to 84 hours at 00, 06, 12 and 18UTC. The NAM Downscaled NWP (Numerical
Weather Prediction) Grid (DNG) products (NamDNGS) are available from the Volume Browser.
These NAM grid fields include T, Td, Tmin, Tmax, wind, precip, categorical rain, cloud, snow
water equiv, visibility, and geometric height for 3-hour to 84-hour incremental projections.

» Multisensor Precipitation Estimator (MPE) Grids: Grids produced by the MPE algorithm are
available for display from the Grid menu on the State(s) and WFO scales. MPE grids are displayed
using a 'truncated' grid color table that shows zero values in gray to let you see the limits of the
site-specified domain.

= Ocean Prediction Center and Tropical Analysis Branch (OPC-TAFB) Grids: On any scale you
can access the OPC grids from the Grid menu in the Volume Browser. The grids are generated
twice daily and cover the Northeast-Pacific (grid OPCWave-NE-PAC), the tropical Pacific
(OPCWave-TE-PAC), and the Western Atlantic/Caribbean (OPCWave-W-ATL). The grids consist
of analysis, 24-hr, and 48-hr forecasts of significant wave heights.

= TPC Tropical Cyclone Gridded Probabilistic Wind (TPCWindProb) Grids: On any scale you
can access cumulative and incremental TPCWindProb grids from the Grid menu. These fields
include cumulative and incremental probabilities of 34kt, 50kt, and 64kt surface winds. Selectors
for these probabilities are found in a TPC Guidance submenu on the Sfc/2D menu in the Fields
column. Also from the Grid menu, you can access GFS fields, which include Low, Middle, and
High Cloud Base pressure; 0.5, 1.0, 1.5, and 2.0 PV Surfaces; and ICEG (ice accretion). A GFS Ice
Accretion and Visibility Guidance NH lat-lon grid (232) dataset with 3h intervals from 3-24h, 6h
from 30-72h, and 12h from 84-168h, is available from the GFSGuide, located in the Grid menu.

= Graphical Forecast Editor (GFE) Grids: MakeD-2DFile is a feature offered by the GFE that
allows you to generate a file, which then can be viewed by D2D. To view GFE-generated grids in
D2D, select Products > Scripts... from the GFE's main menu bar. Once the dialog appears, select
MakeD-2DFile and click Run/Dismiss. After about 20 seconds, the file is available for display in
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D2D via the Volume Browser. To view it, select GFE as the model from the Sources menu on the
Volume Browser, any one of the scalar weather elements listed below as the Field, and Surface as
the Level followed by Load.

The program stores the first 24 hours of the gridded forecast by default. Currently, the set of GFE
weather elements stored in the file is limited to the following scalars:

m Temperature (T)

Dewpoint (Td)

Relative Humidity (RH)

Probability of Precipitation (PoP)

Minimum Temperature (MinT)
m Maximum Temperature (MaxT)
m Quantitative Precipitation Forecast (QPF)

» Rapid Refresh (RAP) Grids: On any scale level, you can access RAP13 and RAP40 grids from
the Grids menu on the Volume Browser. RAP replaced Rapid Update Cycle (RUC) for all models,
with the exception of RUC80, which had been decommissioned. RAPs cover a much larger
domain compared to RUCs. Like the RUC, the RAP will be run 24 times per day, once for each
hour.

= Real-time Global Sea Surface Temperature Analyses (RTG_SST and RTG_SST_HR) Grids:
On any scale, you can access the RTG_SST analysis grid. On all displayable scales, you can also
access the Real-time Global RTG_SST HR analysis grid found on the Grid menu of the Volume
Browser.

The RTG_SST analysis grid displays a 1/2-degree resolution temperature grid. The RTG_SST HR
analysis grid displays a 1/12-degree resolution temperature grid. The grids are transmitted via the
SBN. The high-resolution SST will make the grid an invaluable tool used to aid and improve the
digital marine forecasts.

= High-resolution Precipitation Estimator (HPE/BiasHPE): The High-resolution Precipitation
Estimator (HPE) provides approximately 1km x 1km rain rate and 1-hour rainfall amount mosaics
every 5 minutes over part of a 1/4 Hydrologic Rainfall Analysis Project (HRAP) grid covering a
WEFQ's (or an RFC's) area of responsibility in standard AWIPS format.
These gridded datasets can be viewed in D2D and used by the Flash Flood Monitoring and
Prediction Advanced (FFMPA) system. In the Volume Browser, HPE/BiasHPE data are accessible
from the SfcGrid > HPE/BiasHPE > Precip submenu.

Note 5: Applicable fields include Temperature, Model Terrain (RTG_SST only), Convective
Available Potential Energy (CAPE), and Convective Inhibition (CIN); the only applicable
plane is Surface. Although the Surface plane is automatically selected after clicking the
desired RTG grid, you can select Temperature or Model Terrain from the Basic menu in the
Fields column, and CAPE (Pos Buoy En), or CIN (Neg Buoy En) from the Sfc/2D >
Convective submenu.
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= Real Time Mesoscale Analysts (RTMA) Grids: The RTMA grids are available from the Grids
menu of the Volume Browser for all scales. The National Centers for Environmental
Prediction/Environmental Modeling Center (NCEP/EMC) produces hourly RTMA grids of T, Td,
u, v, sky cover, and precip. These are displayed via the Grid menu on the Volume Browser, and
also are integrated with GFE.

= WAVEWATCH Il (WW3) Grids: Enhancements to WW3 are designed to significantly improve
guidance near the shore. Specifically, the enhanced WW3 brings 5 to 10 km resolution wave
guidance to within 4 km (or less) of the shore, and includes shallow-water wave physics.
WCwavel0, WCwave4, WNAwave, WNAwavel0, and WNAwave4 are displayed via the SfcGrid
menu on the Volume Browser.

Note 6: WC (West Coast), WNA (Western North Atlantic)

= Short Range Ensemble Forecast (SREF) Products: The SREF product suite is available from
the Grids menu of the Volume Browser for all scales. NCEP will generate SREF products on three
grids — CONUS 212 (40 km), Alaska 216 (45 km), and Hawaii 243 (0.4 deg lat/lon) — four times
daily (0300, 0900, 1500, and 2100 UTC model cycles). Guidance is available for three-hour
projections of 3 to 84 hours after model run time. This implementation consists of guidance for the
means, spreads, and probabilities of several parameters.

o Point: Both surface, such as Metar, and Column (soundings, profiler, VWP) data populate the Point
menu. Click here for Point .

Fields submenus: The Volume Browser Fields submenus contain all available data fields and are divided into several
pull-down submenus. Related fields are grouped together within these submenus. Remember that as you change a
selection in the Settings options submenu, the options in the Fields pull-down submenus change as well. Each
possible Setting/Fields combination follows.

Fields submenus with Plan view - Time: When you choose Plan view and Time Settings, the data are
presented on a Plan-view surface and animate in time. The Plan view - Time submenus appear in the following
order:

o Basic: Basic fields are fields that can be calculated directly from state variables without finite
differencing. Click here for Basic.

o Wind: Wind-related fields are grouped here. Click here for Wind.

o Derived: Derived fields are atmospheric measures that require horizontal finite differencing calculations
before plots are made. Click here for Derived.

o Sfc/2D: The fields on this menu cannot be defined in three dimensions; they are mostly valid for the
earth's surface. Click here for Sfc/2D.

» European Centre for Medium-Range Forecasts (ECMWF) Grids: You can access the
ECMWF-HiRes grid or ECMWF-LowRes grid from any scale. In addition to standard heights,
winds, temperatures, etc., you can display 3-hour and 6-hour maximum and minimum
temperatures from the Sfc/2D > ECMWEF-HiRes submenu.
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Note 7: Redistribution of one-degree ("Hi-Res") ECMWF grids from AWIPS is prohibited.
The one degree ECMWEF grids are intended for use only in the conduct of official duties
within NWS offices and at designated AWIPS test and support sites.

Note 8: The ECMWF grids should be considered "data of opportunity,”" which means that the
availability and timeliness of the ECMWF grids could, at times, be somewhat inconsistent or
inferior (i.e., relative to other scheduled NOAA operational products). The potential for
somewhat-degraded availability and timeliness is related to the external nature of the data
source and the characteristics of some of the intermediate product dissemination legs.

m Gridded MOS Grids: You can access the Gridded MOS (GMOS) grids from any scale,
though the grids are clipped to your region. GMOS is a synoptic-scale guidance package
available on a meso-scale (i.e., 5 km NDFD) grid. The available fields found on the Sfc/2D
> MDL MOS menu consist of guidance for maximum and minimum temperature; 6- and
12-hr probability of precipitation (POP); 3-, 6- and 12-hr probability of thunderstorms; and
24-hr snowfall amount. Additional MOS fields include temperatures, winds, cloud cover,
and QPF. GMOS coverage for Alaska is shown in Exhibit 3.2.3-2.

Exhibit 3.2.3-2. Alaska Gridded MOS Coverage

o Other: This menu includes miscellaneous atmospheric fields that can be defined in three dimensions.
Click here for Other.

o Radar: Many of these fields will not be available until the WSR-88D dual-polarization capability is
enabled. Click here for Radar.

o Ensemble: The Ensemble menu contains options for selecting the ensemble model members output for
height, temperature, relative humidity, wind, mean sea level pressure, precipitation, and minimum and
maximum temperatures. In addition, you can display the mean and standard deviation of these model
fields. Click here for Ensemble.

Fields submenus with Plan view - Space: The fields available in these menus are presented in Plan view at a
fixed time, and animate through the volume. The Fields choices are reduced to Basic, Derived, and Other. Click
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here for Basic, here for Derived, and here for Other.

Fields submenus with Cross Section - Time or Space: When you choose the Cross Section option from the
Settings options menu, with animation in either Time or Space, the following fields are available:

o Basic: The Basic fields for Cross Sections are slightly different from those of Basic Plan view fields.
Click here for Basic.

o Derived: The Derived Fields submenu for Cross Sections is identical to the Plan view Derived Fields.
Click here for Derived.

o Other: The Other Fields submenu for Cross Sections is identical to the Plan view Derived Fields. Click
here for Other.

Fields submenus with Time Height - < left or right >: As with Plan view - Space, the Time Height Fields
choices are Basic, Derived, and Other. Click here for Left or Right.

Fields submenus with Var vs Hgt: The Var vs Hgt field choices are Basic, Derived, and Other. Click here for
Basic, here for Derived, and here for Other.

Fields submenus with Sounding: The Var vs Hgt field choices are Basic, Derived, and Other. Click here for
Basic, here for Derived, and here for Other.

o Thermo: The "Thermo" pull-down menu includes options to generate a sounding using model
thermodynamics and winds, model thermodynamics with profiler winds, or model BUFR data for all
model levels (up to 50 levels) and going through all forecast times for a specific BUFR sounding site.
GOES BUFR data can also be used to generate a sounding. The vertical resolution of a GOES BUFR
sounding is somewhat coarse, but the temporal resolution makes this a useful and more real-time
product. Click here for Wind.

Combined VAD Wind Profile (VWP)-model soundings (via the Volume Browser) are available for each
volume scan, with the model data time-interpolated to the Velocity Azimuth Display (VAD) winds time.
Model winds are used above the top of the VAD stack to complete the profile. (Note that the model data
are from the grids, not the point soundings.)

Fields submenus with Time Series: For Time Series, the Fields menus available are Basic, Derived, Sfc/2D,
and Other. Click here for Basic, here for Derived, here for Sfc/2D, and here for Other.

Planes submenus: The Planes submenus contain different surfaces onto which gridded data can be plotted. The
available menus depend on what is chosen in the Settings options submenu or the other options submenus on the
Volume Browser menu bar. Each possible Settings combination follows.

Planes submenus with Plan view - Time: When Plan view and Time are selected from the Settings options
menus in the Volume Browser menu bar, several submenus become available in the Planes menu.

o Pres: In the Pressure submenu, mandatory pressure levels are available, while significant pressure levels
are accessible at 25-millibar increments in two cascading menus. Click here for Pres.

o Theta: The Theta submenu contains potential temperature surfaces at 5K intervals between 250K and
350K, plus theta-e from 315 to 340K. Click here for Theta.

o Hgt: The Height submenu contains heights in meters or feet above ground level (AGL), including Flight
Levels (FL) for Aviation. Click here for Hgt.
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o Temp: Temperatures from -40C to +30C are available. This menu was designed to support
temperature-based radar CAPPIs, but many datasets can be interpolated to these levels. Click here for

Temp.

o Tilts: These tilt angles are used for radar displays. Click here for Tilts.
o Misc: The Miscellaneous submenu contains levels that do not fit elsewhere. Click here for Misc.
o Lyrs: The Layers submenu contains various layers of interest. Click here for Lyrs.

Planes submenus with Plan view - Space: If you select Plan view and Space from the Settings menus, only
one submenu becomes available in the Planes menu.

o Coordinate: From the Coordinate submenu you can choose all pressure (mb) or all isentropic (K) levels,
or all tilts. Plan-view data animated in space are plotted on all available pressure, isentropic, or tilt
surfaces, and animate through the stack at a fixed time.

Planes submenus with Cross Section - Time: When Cross Section and Time are selected from the Settings
options menus, three different submenus become available in the Planes menu. The Vertical Representation
pull-down menu is made available in the Volume Browser menu bar to adjust the vertical axis of a cross-
sectional plot.

o Lon: The Longitude submenu contains a selection of longitude lines. The contents of this submenu
change depending on the scale and the location. Click here for Lon.

o Lat: The Latitude submenu contains a selection of latitude lines. The contents of this submenu change
depending on the scale and the location. Click here for Lat.

o Specified: The Specified submenu contains the baseline labels that can be edited from the Tools
pull-down menu in the Volume Browser. Click here for Specified.

Planes submenus with Cross Section - Space: If you select Cross Section and Space from the Settings options
menus, two submenus become available in the Planes Menu. The Vertical Representation menu is made
available in the Volume Browser menu bar to adjust the vertical axis of a cross-sectional plot.

o Lon: The Longitude submenu has a single choice, All Lon, that lets you select all available longitude
lines. Cross-sectional data animated in space are plotted on all available longitude lines as vertical slices,
and animate latitudinally across the model domain at a fixed time. Click here for Lon.

o Lat: The Latitude submenu also has a single choice, All Lat, that lets you select all available latitude
lines. Cross-sectional data animated in space are plotted on all available latitude lines as vertical slices,
and animate longitudinally across the model domain at a fixed time. Click here for Lat.

Planes submenus with Time Height - < Left or Right >: For the Time Height setting, one submenu becomes
available in the Planes Menu. The Vertical Representation pull-down menu is made available in the Volume
Browser menu bar to adjust the vertical axis of a time-height cross-sectional plot.

Planes submenus with Points:

o The Point submenu contains labels for 10 different points (labeled Tsect A - J) from which time-height
cross-sections can be generated onto the display, and points (labeled Sounding A - J) for which model
soundings can be generated onto the display. The left or right settings determine whether the data are
plotted in increasing model valid times to the left (48 hr to O hr, for example) or the right (0 hr to 48 hr,
for example). Click here for Point.
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Planes submenus with Sounding: When you select the Sounding setting, one submenu becomes available in
the Planes menu.

Planes submenus with Time Series: For the Time Series setting, you can choose a point from the Points
options menu in the Volume Browser menu bar in addition to one or more levels from one of the Planes
submenus. Labels are included on the y-axis to identify the displayed parameter, and you can sample the data in
a time series.

o Pres: In the Pressure submenu, mandatory pressure levels are available, while significant pressure levels
are accessible at 25-millibar increments in two cascading menus. Click here for Pres.

o Theta: The Theta submenu contains potential temperature surfaces at 5K intervals between 250K and
350K, plus theta-e from 315 to 340K. Click here for Theta.

o Hgt: The Height submenu contains heights in meters or feet above ground level (AGL), including Flight
Levels (FL) for Aviation. Click here for Hgt.

o Temp: Temperatures from -40C to +30C are available. Many datasets can be interpolated to these levels.
Click here for Temp.

o Tilts: These tilt angles are used for radar displays. Click here for Tilts.

o Misc: The Miscellaneous submenu contains various levels and layers. You can generate Meteograms
using the METARs from the Source menu and choosing a point location with the Interactive Points Tool.
The result is a "stacked" time series with the observed variables plotted within each time series graph.
Note that variables with like units may be displayed together on the same graph, but with different
colors, as shown in Exhibit 3.2.3-3. Click here for Misc.

Exhibit 3.2.3-3. An Example of the Meteogram Time Series Plot

o Lyrs: The Layers submenu contains various layers of interest. Click here for Lyrs.
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3.2.4 Using the Volume Browser Product Selection List

Once you have made selections from the Sources, Fields, and Planes menus, the list of available products is
generated in the middle section of the Volume Browser, as shown in Exhibit 3.2.4-1. By default, the products
are highlighted and ready to load.

Exhibit 3.2.4-1. Volume Browser Product Selection List
With the pointer, you can select or deselect the products you want to display.

e Graphic or Image: By clicking on a product in the Product Selection List with mouse Button 2 (B2),
you can choose whether to display the product as a graphic or an image. When changing a graphic
product to an image, the abbreviation "Img" appears in the product label of the Product Selection List.
Refer to Subsection 3.3.6, Module 10 "Using the Volume Browser," for more information on displaying
graphic and image products. You can display one or more images at a time.

For vector data, such as winds, clicking B2 once on the product name in the Product Selection List
changes the depiction from wind barbs to streamlines. Clicking B2 on the product name of a vector
product a second time generates arrows.

Note: For products that can be displayed in only one format, clicking B2 has no effect.

You can display multiple graphics, and there is no practical limit to the number you can display at one
time. Refer to Subsection 3.3.6, Module 10 for more information on displaying multiple products.

e Components of the Product Selection List: The Product Selection List is divided into three columns.

o Times: Provides the date and model run time of selected products.
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o Product Selection List: Provides the names of the selected products, including the model name,
the plane, the field, and associated units.

o Inventory: Provides information on the completeness of selected products. The minus (-) and
plus (+) signs indicate the valid times of a model run (i.e., 0-hour, 6-hour, 12-hour, etc.). The
plus sign (+) indicates those valid times are in the database; the minus sign (-) indicates the valid
time is missing from the database. To obtain more detailed information about the inventory of a
product, as shown in Exhibit 3.2.4-2, select the Show Detailed Inventory option from the
Product Information pop-up menu.

Exhibit 3.2.4-2. Detailed Inventory Information

e Product Information Pop-up Menu: The Select Forecast Times window shown in Exhibit 3.2.4-2
was opened by clicking and holding mouse Button 3 (B3) over a product name in the Product
Selection List. This pop-up menu has several options besides Show Detailed Inventory:

o Change Product Graphic to Image: Another way to change the product from a graphic to an
image or vice versa. For wind products, you can display wind barbs, arrows, or streamlines.

o Load This Product Now: Another way to generate the product on the display. This is
convenient if you have a lengthy Product Selection List and wish to display a single product.

o Load as Graphic and Image: Generates the product on the display as both a graphic and an
image. For wind products, you can display wind barbs, arrows, or streamlines.

o Show Detailed Inventory: Opens a pop-up box containing inventory information about the
selected product. Refer to Exhibit 3.2.4-2 above.
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3.2.5 Manipulating the Product Selection List

The File and Edit menus in the Volume Browser menu bar provide several options, such as Clone (File
menu), and Clear and Select (Edit menu), that you should use to manipulate your Product Selection List.
Refer back to Exhibit 3.2.2-1 and Exhibit 3.2.2-2 respectively.

Along the bottom of the Volume Browser there are two buttons that are used to load the selected products.

Note: Products: <#> Selected for loading: <#>, located in the lower-left corner of the Volume
Browser, is not a menu button, but rather a label that tells you how many products you have in your
Product Selection List and how many you have selected for loading. Refer back to Exhibit 3.2.2-1,
which has no products listed and therefore Products: 0 and Selected for loading: 0; and Exhibit 3.2.4-1,
which lists 3 products that are all highlighted indicating they are all selected, thus Products: 3 and
Selected for loading: 3.

e Diff: The Difference (Diff) menu button generates a difference field between two (and only two) fields
that are highlighted in the Product Selection List. This new field can then be saved in a Procedure.

IMPORTANT: Beware! Using the Difference option can generate nonsensical fields.

e Load: The Load button generates the images or graphics you have selected from your Product
Selection List and displays them in the large display pane. Once the Load button is selected, the items
in the Product Selection List are deselected.
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3.3 Practice Modules (Tutorials) for AWIPS Graphical User Interface

This section gets you started (hands-on) working on the Graphics Workstation and with the Graphical User
Interface of the CAVE environment.

This section includes the following practice modules:

Starting Up and Exiting CAVE - Subsection 3.3.1

Using Pop-up Menus - Subsection 3.3.2

Using the Color Editor - Subsection 3.3.3

Working with Graphic and Image Products - Subsection 3.3.4

Using Bundles and Procedures - Subsection 3.3.5

Using the Volume Browser - Subsection 3.3.6
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3.3.1 Starting Up and Exiting CAVE

This module will be your first experience running CAVE.

Module 1: Starting Up and Exiting CAVE

This module steps you through the process of initial CAVE setup, logging in, and exiting the CAVE session.

Objective 1.1 - Logging into the Graphic Workstation

This Objective provides you with basic connectivity and localization information for when you FIRST
log into the AWIPS II Workstation. If this is not your first time logging into the workstation, go to
Objective 1.2.

l.

Prior to logging into an AWIPS II Workstation for the FIRST time, obtain the following information
from your System Administrator:

o Localization Server URL Address (Sample format: http://ec:9581/services)
o Three-character Site ID for your Site (Sample format: OAX)

If this is the FIRST time you are logging into the AWIPS II Workstation, the Connectivity
Preferences dialog box will appear after you enter your username and password. Enter the information
you obtained from your System Administrator. Then click the Validate button to validate CAVE
connectivity.

. After validation, click OK to close the Connectivity Preferences dialog box. You are now logged in

with the AWIPS login root screen displayed. Go to Objective 1.2, Step 2.

Objective 1.2 - Activating Alert Visualization

Note 1: Alert Visualization (AlertViz) MUST be active before starting CAVE.

This Objective shows you how to activate Alert Visualization (AlertViz).

1.

Enter your username and password to open the Red Hat root screen, as shown in Exhibit 3.3.1-1. The
Red Hat Enterprise Linux window and red background root screen will remain until the system is
ready for operation. Then the Red Hat Enterprise Linux window will close and the root screen's
background color will change to blue.
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Exhibit 3.3.1-1. AWIPS Login Root Screen

2. Make sure the AlertViz symbol is showing on the left-side panel, above the Red Hat logo, as shown in
Exhibit 3.3.1-2.

e [f the AlertViz symbol is showing, this means the AlertViz is active and you can start
CAVE. Go to Objective 1.2.

e [f the AlertViz symbol is not showing, continue to Step 3 of this objective.

Exhibit 3.3.1-2. AlertViz Active Symbol on Panel

Page 174



CAVE-D2D User's Manual AWIPS |1 Operational Build 13.4.1 - 31 July 2013

3. Place the mouse cursor anywhere on the root screen (colored background) and click mouse Button 1
(B1) to open the Start Menu, shown in Exhibit 3.3.1-3.

Exhibit 3.3.1-3. AWIPS Start Menu

4. Select AWIPS start-up menu to open the AWIPS start-up menu, shown in Exhibit 3.3.1-4.

Exhibit 3.3.1-4. AWIPS Start-up Menu - Apps Menu

Note 2: As you can see from viewing Exhibit 3.3.1-4, the AWIPS start-up menu is the same
menu that you would use to select other AWIPS-supported applications.

5. Select Start AlertViz to activate Alert Visualization. The AlertViz symbol will appear on the Panel,
as shown in Exhibit 3.3.1-2. You can now start CAVE. Go to Objective 1.3.

Objective 1.3 - Launching CAVE

This Objective shows you how to start CAVE.

1. Place the mouse cursor anywhere on the root screen (colored background) and click mouse Button 1
to open the Start Menu, shown in Exhibit 3.3.1-3 above.
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2. Select Start CAVE (Ix) / TextWS (xt). The CAVE start-up splash screen, shown in Exhibit 3.3.1-5
appears while the system is running-up.

Note: You can also start CAVE from the AWIPS start-up menu shown in Exhibit 3.3.1-4 by
selecting Start CAVE. The splash screen will then appear.

Exhibit 3.3.1-5. CAVE Start-up Splash Screen with Run-up Progress Indicator

3. Wait until the system is fully up and running before proceeding. The blue progress bar, located at the
bottom of the splash screen, appears a few seconds after the screen displays, indicating the run-up
progress.

CAVE starts immediately when the system is fully up and running by opening to the default screen of
the CAVE perspective being viewed prior to ending the session. The opening screen shown in Exhibit
3.3.1-6 indicates that the D2D perspective was active when the session ended.
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Exhibit 3.3.1-6. Default Screen of CAVE D2D Perspective
Objective 1.4 - Starting CAVE from a Terminal Window

This Objective shows you how to start CAVE using a Terminal window.
1. Follow Objective 1.2 - Step 3 to open the AWIPS Start Menu, as shown in Exhibit 3.3.1-3.
2. Select Terminal to open a Terminal window.

3. Change to the CAVE directory (/awips2/cave), then run the startup command (/cave.sh). The CAVE
start-up splash screen appears while the system is running up.

4. Refer to Objective 1.3 - Step 3.

Objective 1.5 - Exiting CAVE

Note 1: It is important to exit CAVE before ending the session and logging out of the system.

This Objective shows you how to exit CAVE.
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1. From the CAVE menu, select EXit. An exit confirmation box appears, as shown in Exhibit 3.3.1-7.

Exhibit 3.3.1-7. Exit Confirmation Dialog Window

2. Select Yes to confirm that you want to exit.

Note 2: At this point you have only exited CAVE. You are still logged into the session.

Objective 1.6 - Logging Out of the Session

This objective shows you how to log out of the session.

1. Click mouse Button 3 (B3) to open a menu containing the logout option, as shown in Exhibit 3.3.1-8.

Exhibit 3.3.1-8. Session Log Out

2. Select Log Out ""username™.... Then select the End Current Session button on the next window that
appears, ending the session and returning you to the Login dialog window. You can now leave the
workstation.

Page 178



CAVE-D2D User's Manual AWIPS |1 Operational Build 13.4.1 - 31 July 2013

3.3.2 Using Pop-up Menus

There are many pop-up menu options. The following three modules (2, 3 and 4) present selected options to
give you practice in using pop-up menus.

Module 2: Using Pop-up Menus Initiated Over Product Legends in the Main Display Pane

This module illustrates several options of the pop-up menu that are initiated over product legends in the Main
Display Pane only.

Objective 2.1 - Setting the Magnification, Color, and Density of a Graphic

1. From the Scale option menu, select the WFO scale.
2. From the Obs dropdown menu, select the METAR Station Plot.
3. From the Toolbar, click on the First Frame iconified button to go to the first frame.

4. Click and hold mouse Button 3 (B3) on the METAR legend to open the pop-up menu and select the
Magnification cascading menu. Then continue to click and hold B3 to select the 2 value. Notice the
font size has increased.

5. Click and hold B3 on the METAR legend to open the pop-up menu and select the Set Color
cascading menu. Then continue to hold B3 to select the yellow color. Notice the METAR plots are
changed from (default) green to yellow.

6. Click and hold B3 on the METAR legend to open the pop-up menu and select the Density cascading
menu. Then continue to hold B3 to select the 2 value. Notice that several more METAR observations
appear.

Objective 2.2 - Setting the Line Width and Line Style of a Contoured Graphic

1. Clear the main display pane.
2. From the Scale option menu, select the CONUS scale.

3. From the Volume dropdown menu, select the NAMB80 Family. Eight predefined NAMSO fields are
loaded, with the first two fields displayed.

4. From the Toolbar, click on the First Frame iconified button to go to the first frame.

5. Click and hold B3 on the 500 mb Height legend to open the pop-up menu. Select the Line Width
cascading menu, continuing to click and hold B3 to select the thickest line width. Observe how the
height contours become quite thick.
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6. Click and hold B3 on the 500 mb Height legend to open the pop-up menu and select the Line Style
cascading menu, continuing hold B3 to select the dashed line. Observe how the height contours
become dashed.

7. Keep these products displayed for the next objective.
Objective 2.3 - Loading a Contoured Graphic as an Image

1. From the previous objective, the Eta Family should be displayed.

2. Click and hold B3 on the NAM 700 mb Omega legend to open the pop-up menu. Select the Load as
Image option. It is not necessary to toggle on the NAM omega graphic before displaying it as an
image. Observe how the omega data become colored.

3. Keep these products displayed for the next objective.
Objective 2.4 - Unloading a Graphic

1. From the previous objective, the NAM Family should be displayed.

2. Click and hold B3 on the NAM 500 mb Height legend to open the pop-up menu. Select the Unload
option. This field is permanently removed from the display.

Objective 2.5 - Setting the Blinking Rate for a Graphic

1. From the Toolbar, clear the Main Display Pane.
2. From the Obs dropdown menu, select the METAR Station Plot.

3. Click B3 on the METAR legend to open the pop-up menu and turn on the Blinking check button.
After a short moment, the graphic starts blinking.

4. Click and hold B3 over the Main Display Pane to open the pop-up menu, and open the Blink Rate
(seconds) cascading menu and choose the 2 second rate. Observe the graphic as it blinks at the new
rate.

5. From the Toolbar, turn looping on while the graphic is blinking and observe that blinking is
suspended while the graphic animates. Blinking resumes automatically when looping is turned off.

6. Repeat Step 4 several times and choose other blink rates. The No Blink option disables blinking.
Objective 2.6 - Setting the Blinking Range for a Single Image

1. From the Toolbar, clear the Main Display Pane.

2. From the Satellite dropdown menu, select the IR Window.
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3. Click and hold B3 on the IR legend to open the pop-up menu and select the Change blinking...
option. This opens the US IR Sat dialog box that contains the controls to set blinking for an image.

4. Using mouse Button 1 (B1) in the US IR Sat dialog box, drag the upper arrow along the color bar to
-35C. Use the fine tuning buttons on either side of the color bar to adjust the placement of the arrow.

5. Now, using B1, drag the bottom arrow to -55C.

6. Press the Enable Range menu button. Within a moment, the chosen color range starts to blink.
7. Now, move the color bar arrows to select a second range from -65C to -75C.

8. Press the Enable Range menu button. Now two color ranges are blinking simultaneously.

9. Press the Disable Range menu button to disable the blinking of the color range selected in Step 7.

Note: The first range enabled in Step 6 is still blinking.

10. From the Blink Rate options menu in the US IR Sat dialog box, try several blink rates.
11. Select Reset to disable blinking.

12. Select OK to close the US IR Sat dialog box.

Objective 2.7 - Setting the Blinking Range for a Combined Image

1. From the Scale options menu in the Toolbar, select WFO.

2. From the kxxx dropdown menu (where KxxX is one of your dedicated radars), select 0.5 Z/V
combined product.

3. Toggle off the velocity by clicking B1 on the velocity half of the product legend.

4. Click and hold B3 over the legend to open the pop-up menu. Slide across Change blinking... and
select 0.5 Refl from the cascading menu. The Image Blinking dialog box opens containing the
Reflectivity Color Bar.

5. Using B1, drag the upper and lower color bar arrows to select a color range.
6. Select the Enable Range menu button.

7. Toggle off the reflectivity by clicking B1 on the reflectivity portion of the product legend. Select 0.5
Vel from the cascading menu. The Image Blinking dialog box changes from velocity to reflectivity.

8. Drag the upper and lower color bar arrows to select a color range.

9. Select Enable Range. Although you can't see it, both velocity and reflectivity color ranges blink
simultaneously.
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10.

From the Toolbar, click on the Image Properties iconified button to open the Image Properties
dialog box. Move the slider bar back and forth from Reflectivity to Velocity and notice how the radar
data display and dialog boxes respond. You can also use the keypad; press the minus key four or five
times.

Module 3: Using Pop-up Menus Initiated Over Displayed Products in the Main Display Pane

There are many pop-up menu options available for the single panel and the four panel layouts for the Main
Display Pane. The following objectives given here for practice will familiarize you with the use of pop-up

menus.

Objective 3.1 - Using Continuous Sampling of Imagery and METAR Plots

. Clear the Main Display Pane.

From the Scale option menu, select CONUS.

. From the Satellite dropdown menu, select IR Window.

From the Obs dropdown menu, select the METAR Station Plot.

Click and hold B3 anywhere over the Main Display Pane (but not over the legends) to open the
pop-up menu. Continue to hold B3 to select the Sampling option.

Move the mouse cursor slowly around the Main Display Pane to sample both the IR satellite data and
the METAR encoded reports.

Click and hold B3 over the Main Display Pane and disable the Sampling option from the pop-up
menu.

Objective 3.2 - Skipping and Restoring Frames

Being able to remove frames is useful when you have bad data.

1.

2.

Clear the Main Display Pane.

From the Frame Count option menu, select 4.

From the Satellite dropdown menu, select Water Vapor window.
Click on the Last Frame iconified button to go to the last frame.

Click and hold B3 anywhere over the Main Display Pane (but not over the legends) to open the
pop-up menu. Continue to hold B3 to select the Skip This Frame option. This frame of Water Vapor
imagery is temporarily removed.

Click the Last Frame iconified button on the Toolbar, then repeat... Step through the frames to see
the result.
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7.

Click and hold B3 anywhere over the Main Display Pane (but not over the legends) to open the
pop-up menu. Continue to hold B3 to select the Restore Skipped Frames option. The two frames
you skipped have been restored.

Objective 3.3 - Changing a Map's Background Colors

This objective incorporates the use of pop-up menus both from the product legends and over a product.

1.

2.

Clear the Main Display Pane.

From the Scale option menu, select Regional.

. From the Maps dropdown menu, select Interstates, Cities, and RFC boundaries. (It's possible that

your Maps menu does not have all of these choices. In this case, choose any three map backgrounds.)

Click and hold B3 anywhere over the Main Display Pane (but not over the legends) to open the
pop-up menu. Continue to hold B3 to select the Show Map Legends option. Observe the map legends
at the bottom of the Main Display Pane.

Click and hold B3 over the RFC boundaries legend and change the color to light blue.
Click and hold B3 over the Interstate Highways legend and change the color to red.

Click and hold B3 over the Cities legend, select the Set Color option, and then select the Choose
Color option. The Choose Color dialog box appears. From it, you can drag the Color Wheel
Centroid to any color in the Color Wheel.

Click the Apply button and observe the new color for the Cities map background. (Refer to
Subsection 2.2.9.1, "Image Color Editing Features and Process," for further information on using the
Color Wheel.)

Module 4: Using Pop-up Menus Initiated in the Smaller Monitor Panes

With a few exceptions, the options in the Smaller Monitor Pane pop-up menus are the same as those in the
Main Display Pane. The following objectives illustrate several of these exceptions.

Objective 4.1 - Zooming into a Small Monitor Pane

. Clear the Main Display Pane.

On the CONUS scale, load 12 frames of the IR Window Satellite into the Main Display Pane.

Over the top Small Monitor Pane, click B3 to swap the IR imagery from the Main Display Pane into
the Small Monitor Pane.

In the Smaller Monitor Pane, click and hold B3 over a state. From the Zoom cascading menu, select
the 933 km.
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5. Save these products for the next objective in this module.

Note: When the Smaller Monitor Pane swaps with the Main Display Pane, the zoom center and map
boundaries are preserved.
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3.3.3 Using the Color Editor

Refer to the color process diagram, Exhibit 2.2.9.1-1, as you do Practice Module 5.
Module 5: Using the Color Editor

This module illustrates using the Image Color Editor to edit and save the Image Color Tables.

Objective 5.1 - Filling the Color Swatch

This objective illustrates how to fill the Color Swatch.

1. In the Main Display Pane, load a Satellite IR on the CONUS Scale and apply the CIRA color table,
if necessary.

2. From the Toolbar, open the Image Properties dialog box.

3. From the Image Properties dialog box, press the Edit US IR Sat button to open the Image Color
Editor. You can also open this dialog box from the pop-up menu of the product legend.

4. Select the RGB Color Model radio button.

5. In the top half of the Editor Color Bar, click on the lime-green color.

Note 1: The Color Swatch is now filled with the lime-green color and the sliders and the Color
Wheel have changed accordingly.

6. In the Color Bar, drag the top arrow Color Pointer to align with the left edge of the bright pink portion
of the color table (about -50 C).

7. Now drag the bottom arrow Color Pointer and align it with the right-most edge of the bright pink
portion (about -55 C) of the color table. Use the incremental < and >, or the << and >> buttons for
fine tuning the location of the arrow Color Pointers.

8. Click the upper Fill button and observe that the lime-green color has replaced the pink both in the
Color Bar and in the displayed satellite data.

Note 2: The arrow Color Pointers turn lime green as well.

9. Now try to fill the bottom Color Swatch with a different color and make adjustments to the existing
IR Color Table. Notice the changes to the displayed image.
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Objective 5.2 - Using the Interpolate Function

This objective introduces you to interpolate commands of the Image Color Editor.
1. From the Toolbar, clear the large display pane.

2. From the Scale option menu, select CONUS.

3. From the Satellite dropdown menu, select IR satellite data.

4. The Image Color Editor dialog box and the Image Properties dialog box should already be open.
Notice that the IR Color Table 1s in the Editor's Color Bar.

5. Select the RGB Color Model check button.

6. Drag the top Color Wheel Centroid to bright red, and move the bottom Color Wheel Centroid to
dark blue. The top Color Swatch should be red and the bottom one blue.

Note 1: The easiest way to adjust brightness is to go to the HSB color model. You can also adjust
brightness by dragging the Centroid to a primary color, and then dragging that color in the slider.

7. Drag the upper Color Pointer all the way to the left of the Color Bar, and the lower Color Pointer all
the way to the right.

8. Click the Interpolate button. The new color table has a gradual transition from red on the left to blue
on the right.

Note 2: The IR Satellite Image in the Main Display Pane has this new Red-to-Blue Color Table.

9. Select the Undo button, which applies the previous color table.
10. Select the Redo button, which applies your newly made (red and blue) color table.
11. Select the Revert button, which resets to the original color table.

12. Now try moving the arrow Color Pointers and selecting different colors to interpolate. Also, try
changing the Color Model to HSB and practice different interpolations.

Note 3: Saturation must be set to a non-zero value to adjust the Hue slider.

13. Keep the CONUS IR Satellite display for the next objective.

Objective 5.3 - Changing the Color for a Specified Temperature Range

This objective illustrates how to change the color for a specific range of temperatures. It is equally
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applicable to other units (for example, reflectivity [dBZ]).

1.

2.

10.

Press the Revert button on the IR Satellite Image to set the color table to its default.

Fill the upper and lower Color Swatches with two different colors of your choice.

. In the Color Bar, in the middle of the dialog box, drag the upper arrow Color Pointer until it is

pointing to the color associated with 20C (this is somewhere in the gray scale).

Click on the upper Set button and notice how the Color Bar changes. This color now represents 20C
in the displayed image. Notice how the image has changed to highlight the 20C value.

. Drag the upper and lower Color Pointers in the Color Bar so that they delineate the range of

temperatures that fall between 10C and -15C.
Click on the upper and lower Fill buttons and notice how the Color Bar and the image change.

Click on Undo. This takes you back one edit. Click on Undo again. You are now back to the color
table status before your last two edits.

Click on Redo twice. This brings you forward two edits.
Select the HSB Color Model, and then click the Interpolate button. Observe the changes.

Keep the CONUS IR Satellite display for the next objective.

Objective 5.4 - Editing an Existing Color Table and Saving It as a New One

A simple way to edit an existing color table is to stretch or compress it using mouse Button 2.

1.

Make sure your personal ID is set in the CAVE title bar. If not, select your ID from the File > Select
User ID... menu.

Open the Image Color Editor. In the Image Colors Editor, press the Revert button to go to the
default Color Table.

. In the Image Color Editor, move the upper arrow Color Pointer all the way to the left, and the lower

arrow Color Pointer all the way to the right.

In the Image Color Editor, move the mouse cursor over the pink colors (about -50C). Click and hold
mouse Button 2 (B2), and then drag the cursor to the left along the Color Bar about 1 inch and
release. The original color table is redrawn and stretched to the newly specified boundaries. Then the
new color table is immediately displayed in the IR satellite imagery.

. Press the Save As... button and type a unique name for your new color table. The new name and your

user ID appear in the title bar of the Image Color Editor and appear in the Customized by
"username"... menu.

Objective 5.5 - Editing Color Tables for Four-Panel Image Products
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You can edit the color tables of a Four Panel Image product. This objective illustrates how.
1. From the Toolbar, select the CONUS scale.
2. From the Satellite pull-down menu, select 4 Panel. Four different satellite images appear.

3. Over one of the four panels, Click mouse Button 3 (B3) and select Control Color of This Image. A
large green "I" appears in the lower left corner of the panel, and the Image Properties dialog box
immediately appears.

4. Modify the color table as you wish, or replace the color table with a new one.

Note: You can delete a color table using the Delete button.
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3.3.4 Working with Graphic and Image Products

The Practice Modules presented here focus on working with graphics and images. They provide information
on working with a single graphic product, overlaying graphics on an image, and combining image products.

Module 6: Working with a Single Graphic Product

This module introduces you to the steps for loading and manipulating a single graphic product.

Objective 6.1 - Displaying a Single Graphic Product

This objective shows you how to display any graphic product. Follow the steps in this objective to load a
METAR station plot. Once you have this product loaded, you can use it for the objectives that follow.

1.

2.

From the Obs menu, use mouse Button 1 (B1) to select Station Plot. The METAR station plot
displays. If no data is displayed, click the Step Back iconified button on the Toolbar to step back one
frame, or click the First Frame iconified button to step back to the first frame.

With the current display unchanged, proceed to the next objective.

Objective 6.2 - Using the Loop Function

This objective illustrates how to animate (or loop) the METAR Station Plot product that is displayed after
completing Objective 2.1, and how to move through the loop one frame at a time.

1.

To begin looping the product, from the Toolbar, click the Looping iconified button, or press the
Page Up or Page Down keyboard shortcut.

To step forward through the loop one frame at a time, from the Toolbar, click the Step Forward
iconified button, or press the Shift + RIGHT ARROW keyboard shortcut. (Note: These keyboard
shortcuts are also listed on the View menu.) Repeated clicks move the loop forward a corresponding
number of frames.

To step backward through the loop one frame at a time, from the Toolbar, click the Step Back
iconified button on the Toolbar, or press the Shift + LEFT ARROW keyboard shortcut.

To move to the first frame in the loop, from the Toolbar, click the First Frame iconified button, or
press the Ctrl + LEFT ARROW keyboard shortcut.

To move to the last frame, from the Toolbar, click on the Last Frame iconified button on the Toolbar,
or press the Ctrl + RIGHT ARROW keyboard shortcut.

Keep the METAR Station Plot for the next objective.
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Objective 6.3 - Changing Loop Properties

You can adjust the forward and backward looping speeds. You can also adjust the amount of time the loop
pauses on the first and last frames in the loop. These are the steps necessary to change the way the
looping function behaves.

1.

9.

From the Options menu, select Loop Properties...; or, from the Toolbar, click the Loop Properties
iconified button.

. To turn on looping, in the Loop Properties dialog box, in the lower left corner, click the Looping

checkbox; or, from the Toolbar, click the Looping iconified button.

. To set the amount of speed and/or dwell that you want, use B1 to drag the slider bars.

To move the slider bar one increment in the direction of the pointer, click B1 anywhere to the left or
right of the Forward/Backward Sliders.

Note 1: The number displayed to the right of the slider increments according to the location of
the mouse clicks.

. Repeat Step 4, but click on the opposite side of the slider.

. To move the Forward/Backward Sliders by more than one increment at a time, place the pointer

anywhere within the slider bar and click mouse .

Note 2: The slider jumps to the location of the mouse cursor and the looping speed changes
accordingly.

. You can adjust the forward speed, one increment at a time, with the Page Up and Page Down

keyboard shortcuts. Notice that as you press these keys, the Forward Speed Slider Bar in the Loop
Properties dialog box changes.

Note 3: You cannot adjust the backward speed with keyboard shortcuts. ‘

Close the Loop Properties Dialog Box.

Note 4: If you are not familiar with setting looping parameters, you may want to experiment
with different settings to determine which are the most suitable for your viewing.

Note 5: The Looping toggle button turns animation on/off. ‘

Keep the METAR Station Plot for the next objective.
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Objective 6.4 - Changing the Frame Count

This objective illustrates how to change the number of frames that display for the selected product.
Within CAVE, do one of the following:

1. From the Toolbar, on the Frames option menu, select the desired number of frames.

2. From the Options menu, select Display Properties...

Note 1: If a product is already loaded and the number of frames you choose is smaller than that
currently displayed, the unneeded frames are dropped from the loop. Similarly, if you choose a
larger number, the additional frames, if they are available, are added to the display.

Note 2: If a product is not loaded, the new frame count takes effect with the next product loaded.

Note 3: The selected number of frames is shown in the Frame Count menu button; the actual
number available for display is shown on the right side of the Status Bar at the bottom of CAVE.

Objective 6.5 - Using the Zoom and Panning Function

With the METAR Station Plot from Objective 6.1 still displayed, this objective illustrates the effect of
zooming in and out on a displayed product and the effect of panning across a zoomed area. There are two
methods for executing zooming and panning operations. The first method uses the Legacy AWIPS Mouse
Button Functionality-AWIPS D2D; the second method uses the Modern AWIPS Mouse Button
Functionality-Default CAVE. Either option may be selected from the Preferences option under the CAVE
menu. Both settings are configurable.

Legacy AWIPS Mouse Button Functionality-AWIPS D2D

e To Zoom In:
1. Place the pointer over the area of interest.

2. Click mouse Button 2 (B2) for one level of enlargement. Subsequent clicks of B2 increases the
zoom ratio. Eleven (11) is the maximum number of clicks you can apply when zooming in (if
starting from the 1:1 ratio).

3. You can also zoom in by using the pop-up menu (refer to Subsection 2.2.8.1) over the Main
Display Pane or the Smaller Monitor Panes. Click mouse Button 3 (B3) over the main display
pane and slide the mouse cursor down to the Zoom cascading menu.

4. Select the 1471 km map size.
e To Zoom Out:

1. Again, center the mouse cursor over the area of interest.
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2. Click mouse Button 1 once for each level of decreasing zoom ratio. You can also use the pop-up
menu to zoom out. Just select a larger map size.

Note 1: Zooming in on a product narrows the geographic area of the displayed product and
progressively adds any available data with each level of zoom. This is called "Progressive
Disclosure." Conversely, zooming out widens the displayed geographic area and reduces

the density of the data in the display as more data is added. To zoom out completely, press
SHIFT + B1.

e To Pan:

1. With the display zoomed in, position the mouse cursor over the area of interest, click and hold
B1, and drag the pointer toward the center of the display.

2. When you have centered the area of interest, release the mouse button.

Note 2: You can pan in the main display pane and the small monitor panes; however, the
system limits you to panning within the data boundaries of the displayed product. For
example, you cannot pan past the edge of a product because there are no data beyond the
edge.

Modern AWIPS Mouse Button Functionality-Default CAVE

e To Zoom In:
1. Place the mouse cursor over the area of interest.

2. Click B2 for one level of enlargement. Subsequent clicks of B2 increase the zoom ratio. Eleven
(11) is the maximum number of clicks you can apply when zooming in (if starting from the 1:1
ratio).

3. You can also zoom in by using the pop-up menu (refer to Subsection 2.2.8.1) over the Main
Display Pane or the Smaller Monitor Panes. Click B3 over the Main Display Pane and slide the
mouse pointer down to the Zoom cascading menu.

4. Select the 1471 km map size.

5. You can also zoom in by using the scroll wheel (B2). Scrolling forward will zoom into the
display, centered on the position of the cursor.

e To Zoom QOut:
1. Again, center the mouse cursor over the area of interest.
2. You can use the pop-up menu to zoom out. Just select a larger map size.

3. You can also zoom out by using the scroll wheel (B2). Scrolling backward will zoom out of the
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display, centered on the position of the cursor.
e To Pan:

1. With the display zoomed in, position the mouse cursor over the area of interest, click and hold
B1, and drag the pointer toward the center of the display.

2. When you have centered the area of interest, release the mouse button.

Note 3: You can pan in the main display pane and the small monitor panes; however, the
system limits you to panning within the data boundaries of the displayed product. For
example, you cannot pan past the edge of a product because there is no data beyond the
edge.

Objective 6.6 - Magnifying and Changing Density

This objective illustrates how to enlarge or reduce the size of displayed text and how to increase or
decrease the amount of data displayed.

1. From the Magnification (Mag:) option menu in the Toolbar, select a magnification setting of 2.
2. From the Density option menu in the Toolbar, select a density setting of 1.5.

3. You can also change the magnification and density settings from the Display Properties Dialog Box,
opened from the Options menu.

4. Return both the Magnification and the Density settings to 1.

Note 1: The magnification and density settings of a graphic can also be changed by using the
pop-up menu derived from the product legend or display, as explained in Subsection 2.2.8.1.

Note 2: Increasing the magnification automatically decreases the number of data stations plotted.

Note 3: Changing the density affects contour intervals and wind barbs as well as plotted data. By
choosing the "Max" density setting, all available plots are displayed.

Note 4: The magnification setting of "0" turns off the legends of all displayed graphic
contours. It also removes all station-plotted data and wind barbs, leaving just dots at the station
or grid locations.

Note 5: These controls can also be used on a product that is zoomed in.
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Objective 6.7 - Swapping Panes

This objective illustrates how to move between the main display pane and the monitor panes. Swapping
panes is a convenient way to change the viewing scale.

1. Place the mouse cursor over the second monitor pane and click B3.

2. Observe that the METAR Station Plot appears in the Smaller Monitor Pane and that the map
background of the Smaller Monitor Pane is now in the Main Display Pane. The Scale displayed on the
Scale option menu in the Toolbar changes correspondingly.

3. Switch the product back to the Main Display Pane.
Objective 6.8 - Clearing the Main Display Pane

This objective illustrates how to clear the Main Display Pane.
1. Click the Clear button on the Toolbar to remove all displayed products from the Main Display Pane.

2. You can also use the "Ctrl + C" keyboard shortcut to clear the Main Display Pane.

Note: The Clear button removes all products from the Main Display Pane only. It does not
affect the Smaller Monitor Panes. You can clear the Smaller Monitor Panes by switching with
the Main Display Pane and again using the Clear button.

Objective 6.9 - Changing the Viewing Scale

This objective illustrates other ways (besides swapping panes) to change the viewing scale. The Scale
option menu, located on the Toolbar, does not have a "Scale" label, but rather shows the name of the scale
currently displayed in the Main Display Pane.

1. From the Scale option menu in the Toolbar, select the WFO Scale.

Note 1: The map background has changed to the WFO Scale Map.

2. From the Satellite dropdown menu, load an IR Window image.

3. From the Scale option menu, select the CONUS Scale. Notice that the scale changed to the CONUS
scale and the IR Window image remained displayed.

4. From the Obs dropdown menu, load the METAR Station Plot. The product is loaded on top of the
IR Window image.

Note 2: If a product is already displayed, the change of scale takes effect immediately and the
new product is displayed.

Page 194



CAVE-D2D User's Manual AWIPS |1 Operational Build 13.4.1 - 31 July 2013

Note 3: Any product can be displayed on any scale currently displayed in the Main Display
Pane.

Objective 6.10 - Setting the Time Resolution of Displayed Data

1. Clear the Main Display Pane.

2. From the Options menu, turn on the Time Options check button.
3. From the Scale option menu, select Regional.

4. From the Frames option menu in the Toolbar, select eight frames.

5. From the Obs menu, select the METAR Station Plot. We know that this product typically updates
every hour.

6. A dialog box appears in the center of the display that provides several time resolutions. Choose 3
hours. Click OK.

Note 1: The inventory in the left side of the dialog box changes to show which times will be
displayed and which will not. You can choose a different end time for the loop and it will adjust
accordingly.

7. Toggle the Looping iconified button on and observe the METAR plots as they are displayed and
verify that the plots have a 3-hour interval.

Note 2: Subsequent overlays onto a product that was displayed using the Set Time Resolution
option automatically time-match to the initial product.

Module 7: Loading and Displaying Graphics and Image Products

This module introduces you to the steps for loading and displaying image products.

Objective 7.1 - Loading Images and Overlaying Graphics

This objective sets up products that you need to use for the subsequent objectives in this module.
1. From the Toolbar, press the "Clear" button to clear the Main Display Pane.
2. From the Scale menu, change to WFO Scale.

3. From the Radar (kxxx) menu, load the 0.5 Reflectivity product (under the Radar (kxxx) Best Res
Refl. choose 0.5 Refl).

4. From the Obs menu, load the METAR Station Plot and one of the two Ceiling and Vis Plot
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products (under the "Other Plots" submenu).

Keep these products displayed for the next objective.
Objective 7.2 - Toggling Overlays

This objective illustrates toggling graphics overlaid on an image product. You can click the mouse pointer
on a product legend to toggle it, or you can use the keyboard shortcuts. The "0" numeric keypad key
toggles the displayed image(s). The keypad keys 1-9 toggle the first nine overlays, while using the "Shift"
key in conjunction with numeric keys 0-9 toggles overlays 10-19 (for example, Shift + 6 toggles the 16th
overlay). Both are illustrated in the following steps. Refer to Table 2.1.1-2 and Table 2.1.1-3 for
descriptions of all the keyboard shortcuts.

1. Click B1 on the product legend on the bottom of the screen for the Ceiling and Vis Plot.

2. Observe that the product is no longer displayed and that the legend for the product has been dimmed.
3. Click on the product legend for the METAR Station Plot to turn that overlay off.

4. Click on the product legends for both overlays to turn them back on.

5. Click on the 0.5 Reflectivity legend to turn it off.

Keyboard Shortcuts

The following steps are keyboard shortcuts for performing Objective 7.2, Steps 1-5.

1. Press the 2 numeric key (on the keypad) to toggle off the Ceiling and Vis Plot.

2. Press the 1 numeric key (on the keypad) to toggle off the METAR Station Plot.

3. Press both the 1 and the 2 numeric keys (on the keypad) to toggle on the plotted data.

4. Press the 0 numeric key (on the keypad) to toggle on the 0.5 Reflectivity.

Note: Clicking B3 anywhere in the Main Display Pane toggles (hides) the product legends for all
displayed products. Only the date and valid time remain visible. To bring the product legends
back, click B3 again in the Main Display Pane.

Keep these products displayed for the next objective.
Objective 7.3 - Changing an Image's Display Brightness

This objective illustrates ways to adjust the brightness of a displayed image.

1. From the Options dropdown menu, display the Image... dialog box, or from the Toolbar, click the
Image Properties icon.

2. Place the mouse cursor (left-pointing arrow) over the Brightness Slider Bar (Imaging... dialog box).
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Use B1 to drag the slider to the left until the percentage displayed to the right of the slider reads 10.

. Observe how the brightness of the radar image changes.

Place the mouse cursor anywhere on the slider track to one side of the Brightness Slider Bar and
click B1.

Observe that with each click of B1, the slider moves by 5% increments in the direction of the mouse
cursor (as reflected by the percentage displayed to the right of the slider.

Repeat Step 4, but click on the opposite side of the slider.

To move the slider by more than the 5% increment at a time, place the mouse cursor anywhere on the
slider track to one side of the slider and click B2. The slider moves to the mouse cursor location on
the slider and displays the percentage at that location.

You can use the "+" and "-" keyboard shortcuts on the numeric keypad to change the brightness of a
single image after the Brightness Slider Bar has been selected (note the box that appears around the
slider bar).

Note 3: Refer to Table 2.1.1-2 and Table 2.1.1-3 for descriptions of all the keyboard shortcuts.

Objective 7.4 - Changing an Image’s Color Table

This objective illustrates how to change the color table for displayed image products.

1.

2.

Clear the Main Display Pane.

From the Scale option menu in the Toolbar, select CONUS.

. From the Satellite dropdown menu, load the IR Window image.

. If the Imaging... dialog box is not still displayed, open it from the Toolbar.

Note: The name of the color table (enhancement curve) associated with the IR satellite image
[CIRA (IR Default)] is displayed in the upper Color Table options menu, in the Imag... dialog
box.

. Press this upper Color Table options menu to display a list of other color table choices.

Select several different color tables.

Close the Imag... dialog box by clicking the "X" in the upper right corner.

Objective 7.5 - Manipulating a Satellite 4-Panel Display

This objective illustrates how to display and manipulate Satellite 4-panel image products.
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1.

2.

10.

I1.

Clear the Main Display Pane, set the frame count to 8 frames, and change the scale to CONUS.

From the Satellite dropdown menu, load the 4 panel (GOES M-Q) product.

. You now have four pointers on the display. One is the mouse cursor (the standard left pointing arrow),

and the other three are small squares, each with a dot in the middle. This is known as a linked cursor.
The location and movement of the three square pointers track with the arrow.

Move the mouse cursor until it is over the Water Vapor satellite image. Notice how the other pointers
move accordingly.

. From the Obs dropdown menu, select the METAR Station Plot product. It overlays each panel.

In any one of the panels, toggle the METAR Station Plot by clicking on the METAR Station Plot
product label.

Note 1: The product is toggled off in all four panels. Toggle it back on by clicking on the
METAR Station Plot product legend.

Click on the product legend of the Visible image to turn it off.

Note 2: Only the Visible image is toggled. Click on the dimmed legend to turn it back on. Be
sure to use the arrow pointer.

Move the mouse cursor over a portion of one of the four images. If the Sample checkbox is checked, a
sample of the data values from both the satellite image and the encoded METAR observations will
display next to the mouse cursor.

From the Magnification (Mag:) option menu in the Toolbar, select "1.5."
Repeat Step 8, then return to Mag:1.

Open the Imaging... dialog box. Using the upper Color Table option menu, select a different color
table.

Note 3: The color table is applied to all images, as indicated by the "Edit all images..." notation.
It is possible to load a product or apply a color table to just one of the four panels by using
Pop-up menus. Please refer to Subsection 2.2.8.2 for more information.

Objective 7.6 - Using the All-Tilts Function

When you select the All-Tilts menu option, radar images of the tilts that make up the latest volume scans
load. Each volume scan, as well as the tilts that make up a given volume scan, is tagged with the date and
time the scan started. Each volume scan is composed of 6 or more tilts. The radar takes 5 to 10 minutes to
collect a full volume scan of data. In AWIPS, the volume scan is updated tilt-by-tilt as the radar makes it
available.
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Navigation between the different tilts and volume scans can be accomplished by using various keyboard
shortcuts. Table 3.3.4-1 lists the available keyboard shortcuts and toolbar buttons. This objective provides
instructions for navigating the tilts and scans using the following modes:

e All-Tilts Navigation Mode - radar images of all tilts for all volume scans
e Single-Tilt Navigation Mode - radar images of a particular tilt for multiple volume scans
¢ Single-Volume Navigation Mode - radar images of all tilts for a single volume scan.

To view radar images in All-Tilts navigation mode

1. Clear the Main Display Pane.

2. From the Scale option menu, select WFO.

3. From the kxxX menu, select "All Tilts Z+V."

4. From the Frames Menu, set the frame count to 64.
5. After the All-Tilts display loads, do the following:

e Press Shift + LEFT ARROW or Shift + RIGHT ARROW to sequentially step through each
frame in the collection of scans and tilts.

e Press Ctrl + UP ARROW or Ctrl + DOWN ARROW to display the first or last frame in the
collection of scans and tilts.

Note 1: The frame count is set to 64; therefore, 64 frames of tilts from volume scans will be
loaded. Auto updates will add higher tilts from the latest volume scan, replacing a tilt from
the oldest volume scan.

To view radar images in Single-Tilt navigation mode

1. While viewing an All-Tilts display, press the LEFT ARROW or RIGHT ARROW to locate the
volume scan you want to view.

2. After you have located the desired volume scan, do the following:
e Press UP ARROW or DOWN ARROW to step through the tilt sequence at a fixed time.

e Press Ctrl + UP ARROW or Ctrl + DOWN ARROW to display the frame containing the
highest or lowest tilt.

To view radar images in Single-VVolume navigation mode

1. While viewing the All-Tilts display, press the UP ARROW or DOWN ARROW to locate the tilt
you want to view.

2. After you have located the desired degree of tilt, do the following:
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e Press LEFT ARROW or RIGHT ARROW to step through the sequence of volume scans at a
fixed tilt.

e Press Ctrl + UP ARROW or Ctrl + DOWN ARROW to display the frame containing the
newest or oldest volume scan.

Note 2: It may be necessary to step back a volume and then move up or down the tilt
because in most cases, the most recent volume will be incomplete.

Note 3: To loop/animate through the frames of a particular navigation mode, press Page Up
or Page Down.

Note 4: At any time, you may return to the default navigation mode by pressing
Ctrl + LEFT ARROW or Ctrl + RIGHT ARROW, which will display the first or last
frame in the collection.

Table 3.3.4-1. All-Tilts and Volume Scan Keyboard Shortcuts and Toolbar Buttons

] Function ] Shortcut/Button
To step through frames in the order in which |Shift + LEFT ARROW / Step Back
they were loaded (All-Tilts mode) Shift + RIGHT ARROW / Step Forward
To step through the sequence of volume RIGHT ARROW / Step Forward
scans at a fixed tilt (Single-Tilt mode) LEFT ARROW / Step Back
To step through the tilts of single volume UP ARROW
scan (Single-Volume mode) DOWN ARROW
To st e sl e 45t Ao
Vo 8 ne Ctrl + DOWN ARROW
Volume mode)
To loop/animate through the frames of a Page Up
particular navigation mode (All-Tilts, Page Down
Single-Tilt, and Single-Volume mode) Looping

To return to the standard navigation mode
and the First or Last frame in the collection |Ctrl + LEFT ARROW / First Frame

(All-Tilts, Single-Tilt, and Single-Volume Ctrl + RIGHT ARROW / Last Frame
mode)

Note: The stepping/animation controls on the toolbar will function according to the
navigation mode you are in. For example, if you press the UP ARROW or the

DOWN ARROW after an all-tilts display loads, the menu controls will enable you to step
through the tilts at a fixed time, i.e., Single-Tilt mode.

Objective 7.7 - Using the Terminal Doppler Weather Radar (TDWR) Products

This objective illustrates how to use the Terminal Doppler Weather Radar (TDWR) products from the
XXX menu.
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1. Clear the Main Display Pane.

2. From the Scale option menu, select WFO.

3. From the txxx dropdown menu (where xxx is the local TDWR), load the 0.5 deg Refl, Vel, and
Spectrum Width products.

4. Observe that the products loaded.
Module 8: Combining Image Products

This module illustrates one method of combining two image products and ways to manipulate the display of
the combined products. There are two ways to combine images. Both are discussed in this module.

Objective 8.1 - Combining Two Images

This objective illustrates how to load two image products.
1. Clear the Main Display Pane.

2. From the Scale option menu, select WFO.

3. Set the frame count to 12 .

4. From the kxxx dropdown menu, open the kxxx Reflectivity cascade menu and select the 0.5
Reflectivity product. This is the first image.

5. Display the Imaging... dialog box.

6. From the Imaging... dialog box, select Combine Next Image (in the lower right portion of the dialog
box), or click the Toggle Image Combination iconified button on the Toolbar.

7. From the Satellite dropdown menu, load the IR Window Product. This is the second image in the
combination.

8. Observe that after the second image loads, the label in the lower right corner of the Main Display
Pane displays the names of both images and indicates that they are combined.

9. Notice also that in the Imaging... dialog box, both Color Table options menus display the name of a
color table, one for each image.

Note 1: The combining process is done automatically when you select a radar combo product
(Z+V, Z+SRM, etc.).

Note 2: Multiple images (2 or more) can be displayed in the D2D display of CAVE without
using the Combine Next Image option. Each image would be a separate layer (versus a
combined layer), as displayed in the product legend in the lower right corner of the D2D display.
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Keep this combined radar/satellite product displayed for the next objective.

Objective 8.2 - Toggling Between Image Products and Adjusting Display Brightness

This objective illustrates how to adjust the relative brightness of each of the combined image products
and ways of toggling between the images. Again, you may use either the mouse and menus or the
keyboard shortcuts.

1. Select "Image Properties" to open the Imaging... dialog box.

2. From the Imaging... dialog box, drag the fade slider to the left. Only the 0.5 Reflectivity image
(Image 1) 1s displayed.

3. Repeat Step 1, but move the fade slider to the right. Now, only the IR Window product (Image 2) is
shown.

4. Display both images by moving the fade slider back to the center.

5. Toggle off the Reflectivity product by clicking on 0.5 Refl in the product legend at the bottom of the
Main Display Pane.

6. Toggle off the Satellite product by clicking on IR Sat in the product legend. Notice that the 0.5
Reflectivity turns on again.

7. To toggle both images on or off, click on the "+" symbol in the product legend; then use the fade
slider on the Imaging... dialog box to see both images.

N

Note: The + symbol toggles images on and off. If only one image is visible, + toggles that image
off and on. If both images are visible, + toggles both images off and on.

Keyboard Shortcuts

The following steps are keyboard shortcuts for performing Objective 8.2 - Steps 1-6.

1. Press the - (minus) numeric key to fade to Image 1 (0.5 Reflectivity).

2. Press the + (plus) numeric key to fade to Image 2 (IR Satellite).

3. Press the - (minus) numeric key until both images are displayed.

4. Press the . (decimal) numeric key to toggle to Image 1. Press again to toggle to Image 2.
5. Press the - (minus) numeric key until both images are displayed.

6. Press the 0 numeric key to toggle off both images.
Objective 8.3 - Changing the Image's Alpha Setting

This objective illustrates how to adjust the Alpha level of combined image products. Again, you may use
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either the mouse and menus or the keyboard shortcuts.

1. Press the Clear button on the toolbar.

2. From the Scale option menu, select CONUS.

3. Set the frame count to 12.

4. From the Satellite dropdown menu, select the IR Window satellite product. This is the first image.
5. Display the Imaging... dialog box.

6. From the Imaging... dialog box, select Combine Next Image (in the lower right portion of the dialog
box), or click on the Toggle Image Combination iconified button on the Toolbar.

7. From the Satellite dropdown menu, load the Water Vapor satellite product. This is the second image
in the combination.

8. Observe that after the second image loads, the label in the lower right corner of the Main Display
Pane displays the names of both images and indicates they are combined.

9. Notice also that in the Imaging... dialog box, both Color Table options menus display the name of a
color table, one for each image.

10. From the Imaging... dialog box, drag the Alpha slider to the right. The Water Vapor image (Image
2) is displayed.

11. Repeat Step 10, but move the Alpha slider to the right. Now, a black image is displayed.
12. Display both images by moving the Alpha slider back to the center.
13. Toggle off the IR Window satellite product by clicking on IR Satellite in the product legend.

14. Toggle off the Water Vapor satellite product by clicking on Water Vapor Satellite in the product
legend. Notice that the IR Window satellite product turns on again.

15. To toggle both images on or off, click on the "+" symbol in the product legend; then use the Alpha
slider on the Image Properties dialog box to see both images.

Note: The "+" symbol toggles images on and off. If only one image is visible, "+" toggles that
image off and on. If both images are visible, "+" toggles both images off and on.

Steps 16 through 18 use numeric keyboard shortcuts to perform operations:

16. With the Alpha slider selected (note the box that appears around the slider bar), press the "-" (minus)
numeric key to fade to a black image.

17. Press the "+" (plus) numeric key to fade to Image 2 (Water Vapor Satellite).

18. Press the "-" (minus) numeric key until both images are displayed.
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Objective 8.4 - Changing an Image's Color Table

This objective illustrates changing the color tables of one or both of the combined images.

1.

2.

10.

I1.

12.

Clear the Main Display Pane.
From the Scale option menu, select WFO.

Set the frame count to 12.

. From the kxxx dropdown menu, open the kxxx Reflectivity cascade menu and select the 0.5

Reflectivity product. This is the first image.

. Display the Imaging... dialog box.

. From the Imaging... dialog box, select Combine Next Image (in the lower right portion of the dialog

box), or click on the Toggle Image Combination iconified button on the Toolbar.

From the Satellite dropdown menu, load the IR Window product. This is the second image in the
combination.

Observe that after the second image loads, the legend in the lower right corner of the Main Display
Pane displays the names of both images and indicates they are combined.

. Notice also that in the Imaging... dialog box, both Color Table options menus display the name of a

color table, one for each image.
Press the O numeric key to toggle on both images.

From the upper Color Table option menu in the middle of the Imaging... dialog box, select a color
table for Reflectivity image (first image).

Repeat Step 11 using the lower Color Table options menu to select a color table for the Satellite
image (second image).

Objective 8.5 - Manipulating a Radar 4-Panel Display

This objective illustrates how to display and manipulate Radar 4-Panel image products.

1.

2.

Clear the Main Display Pane.

Change the display to the WFO Scale and set the frame count to 8 frames.

Note 1: You want to load the Best Res Z+V.

. From the 4-Panel cascading menu of the kxxx menu, load the 0.5 1.5 2.4 3.4 4-Panel product. Notice

that the cursor is linked in all four panels.

Click on the legend of the 1.5 Refl image to turn it off.
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Note 2: The reflectivity images in all the panels are toggled. ‘

5. In the same panel, click on the legend of the 1.5 Vel image to turn it off.

Note 3: All the Velocity Products go off and Reflectivity comes back on. Click on the dimmed
product legend to toggle products back on.

Note 4: When you toggle a product in one panel, it is toggled in the remaining three panels. ‘

Note 5: Unlike the Satellite 4-Panel product, the Radar 4-Panel product loads four Z+V
combined products. For this reason, it has two color tables available, one for the reflectivity
portion of the Z/V product, and one for the velocity portion.

Note 6: Fading between images works the same way for a Radar 4 Panel as for a single Z+V
combined radar product.
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3.3.5 Using Bundles and Procedures

The Practice Module presented here includes information on how to use bundles; how to create, edit, and
save procedures; and how to copy bundles from one procedure to another.

Module 9: Using Bundles and Procedures

This module illustrates several options for working with bundles and procedures

Objective 9.1 - Using Bundles

A bundle can be any arrangement of graphics and/or images that are overlaid on one another in the Main
Display Pane. A bundle is represented as a single line in the History List. As you create bundles, they are
recorded in the History List dialog box.

1.

Use Ctrl+H to display the History List dialog box. You can also display the History List dialog box
by selecting History List dialog box from the File menu on the main menu.

On the Regional scale, load 12 frames of METAR Station Plot. Observe that "METAR Plot" is now
in your History List.

. From the Toolbar, clear the Main Display Pane and load six frames of Visible satellite imagery on the

Regional Scale. Overlay it with the 1hr Lightning Plot. Again, notice that a new bundle label has
appeared in the History List.

Keep the History List dialog box open for the next objective.

Objective 9.2 - Creating and Saving a Procedure

Now that you have seen how bundles work in Objective 9.1, you can build a procedure. In short, you
copy the bundles from the History List and put them into a Procedure dialog box.

l.

2.

Clear the Main Display Pane.

Use Ctrl+N from the keyboard or select File > Procedures > New from the main menu. An empty,
untitled Procedure dialog box appears.

On the CONUS Scale, load 12 frames of IR Window satellite imagery and overlay the METAR
Station Plot. Notice the new bundle you have made in the History List.

On the Regional Scale, display 12 frames of the Radar Summary and the Radar Legends, located
on the NCEP/Hydro Menu under Precip & Stability. This creates another bundle in the History
List.

. Load two frames of the Dodge City, Kansas (KDDC) Skew-T. Clear the Main Display Pane to

create a new bundle. It is not possible to copy the KDDC bundle until the display has been cleared or
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6.

10.

I1.

something else is loaded.

Click on the US IR Sat, METAR Plot bundle in the History List and then click the Copy Out button
on the History List dialog box. The selected bundle should be duplicated in the untitled Procedure
dialog box.

Repeat Step 6, but copy the Radar Summary, Legends, and KDDC bundles into the untitled
Procedure dialog box using Copy In. You have now created a procedure with three bundles.

To save your procedure, click on the Save As... button in the untitled Procedure dialog box. The Save
Procedure As dialog box appears.

In the line provided, use the keyboard to type a unique name for your procedure. Try your initials or a
brief descriptive name of the procedure.

Once you click the OK button in the Save Procedure dialog box or press Enter on the keyboard, this
dialog box is closed and your procedure is saved. Your procedure name appears in the open Procedure
dialog box Title Bar.

Select the Close button in the Procedure dialog box to close the procedure you just created. The
bundles that are included in your procedure are automatically updated with the most current data. Any
time you open your procedure, it has up-to-date information.

Objective 9.3 - Opening and Manipulating a Procedure

Now that you can build procedures, try using them.

1.

Use Ctrl+O from the keyboard or select File > Procedures > Open Procedure from the main menu.
The Open Procedure dialog box appears. Your new procedure is in this list.

Open your new procedure by double clicking mouse Button 1 (B1) on its name. The procedure you
have opened should contain three bundles.

Note: The second approach to opening a procedure is to click on the procedure name, which
then appears in the entry box. Select the OK button to view the procedure.

Click on the KDDC bundle to highlight it.

Click the Up and Down buttons and observe the behavior of the highlighted lines and bundle names.

. Highlight the US IR Sat, METAR Plot bundle and select the Load button. The data appear in the

Main Display Pane.

Click the Next button and observe that the Main Display Pane clears and the next bundle is selected
and loaded in the Main Display Pane.

Highlight the KDDC bundle in your procedure and click the Delete button. The KDDC bundle is
now removed from your procedure.

Now that you have made changes to your procedure, you need to save it by clicking the Save button.
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9. Click on the Close button in the Procedure Dialog Box to close your modified procedure.

Objective 9.4 - Renaming a Bundle within a Procedure

Frequently you may have a large number of overlays in a single bundle, which generates a lengthy bundle
name. You may want to give the bundle a short, meaningful name. This objective steps you through
renaming a bundle within a procedure.

1. Open the procedure you built in Objective 9.2. It should contain two bundles.

2. Click on the Radar Summary, Legends bundle, then click the Rename... button in the Procedure
dialog box.

3. The Enter Bundle Name dialog box appears. It contains the full bundle name. Use the keyboard to
rename this bundle something meaningful to you.

4. Select the OK button or press Enter on the keyboard and notice that the bundle name changed in your
procedure.

5. Now that you have made changes to your procedure, you need to save it by selecting the Save button.

6. Close your procedure.
Objective 9.5 - Copying Bundles from One Procedure to Another

If you want a bundle in one of your procedures to appear in another procedure, you can simply copy it.

1. Select the Open Procedures dialog box by using Ctrl+O and open the procedure you built in
Objective 9.2.

2. From the main menu select File > Procedures > New Procedure or use the Ctrl+N keyboard
shortcut to open the dialog box. An untitled Procedure dialog box appears.

3. From your procedure built in Objective 9.2, highlight the US IR Sat, METAR Plot bundle in your
procedure and click the Copy Out button at the bottom of your Procedure dialog box. The selected
bundle appears in the untitled procedure.

4. Click the Save button in the untitled Procedure dialog box and save this procedure with a new name.

5. Click the Close button to close the Procedure dialog box.

Note: You can simultaneously copy a bundle into several procedures by having several
Procedure dialog boxes open on the screen.

Objective 9.6 - Deleting a Procedure

1. From the File menu button, select the Procedures cascading menu and open the Delete Procedure
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2.

3.

4.

dialog box, or use the "Ctrl+D" keyboard shortcut to open this dialog box.
Select the procedure you built in Objective 9.2.

Click the OK button. The Confirm Deletion dialog box appears. Acknowledge this dialog box by
clicking the Yes button. The procedure is permanently removed from the procedure list.

Open the Delete Procedure dialog box again and double click on the procedure you built in Objective
9.5. Click Yes to delete it.

Objective 9.7 - Using Original and Current Options in Procedures

You can modify an existing cross-section, model sounding, time-series, or time height cross-section
bundle by changing either the baseline or the point, or you can select the baseline or point that you used
when you initially created the bundle.

1.

2.

3.

10.

I1.

12.

13.

14.

15.

16.

From the Toolbar, select the CONUS Scale from the Scale Options Menu.
From the Toolbar, select the Interactive Points Tool.
Move Point J to a desired location.

From the Volume menu, open the Volume Browser.

. In the Volume Browser, select Sounding from the Options menu.

In the Volume Browser, from the Sources menu, select NAMBS80 under Grid.

In the Volume Browser, from the Points menu, select Sounding J and press Load to display the
sounding.

Use Crtl+H to open the History List and Crtl+N to open a new procedure. NAMS0 ptJ should be in
the History List.

Clear the display pane.

In the History List dialog box, click on the NAMSO ptJ bundle and select Copy Out. The NAMS0
appears in the new procedure.

Save the new procedure and close it.

Now load the Interactive Points Tool again and move Point J to a new location.
Open the procedure that you saved in Step 12.

In the Procedure dialog box, select Current.

Your initial NAMBSO0 ptJ bundle is not selected. Click First to display it. Notice that the sounding is
from the new (current) location of Point J.

Now in the Procedure dialog box, select Original and reload the NAMS8O0 ptJ bundle. The sounding is
from the location you used when you initially set up the bundle.
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Objective 9.8 - Altering a Bundle

You can view cross-sections or other site-specific data that you have stored in your procedures from
different baseline or point locations without having to create a new bundle from scratch. You simply alter
the bundle. This objective steps you through this easy process.

1.

2.

10.

I1.

12.

13.

14.

15.

16.

From the Toolbar, select the CONUS scale from the Scale Options menu.
From the Toolbar, select the Interactive Baselines Tool.

Click mouse Button 3 (B3) over the Interactive Baselines legend and select Editable or click mouse
Button 2 (B2) to make it editable, if it is not already editable.

Move Line D to a desired location.

From the Volume menu, open the Volume Browser.

In the Volume Browser, select Cross Section from the Options menu.

In the Volume Browser, select NAMS0.

In the Volume Browser, select Fields > Basic, then select Rel Humidity and Wind.

In the Volume Browser, select Planes > Specified, and then select Line D and press Load to display
the cross-section.

Open the procedure you created in Objective 9.7.

Press Copy In. The NAMSO line D bundle is added to your procedure.

Save the updated procedure.

Now load the Interactive Baselines Tool again and note the location of another line, Line A.
In the Procedure dialog box, first click on the NAMSO0 lineD bundle, then select Alter....

In the Alter Bundle dialog box, select Line A from the Options menu, and then press Load. Notice
that the new cross-section has the Rel Humidity and Winds displayed from the Line A perspective.

Delete your procedure.
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3.3.6 Using the Volume Browser

The five Practice Modules presented in this section show you how to perform functions using the Volume
Browser. You should review Subsections 3.2.1 through 3.2.5 before using these modules.

Module 10: Loading and Displaying Model Data in the Plan View

This module contains step-by-step instructions on how to load and display model data in Plan view using the
Volume Browser. Refer to Exhibit 2.2.7-4 for the location of the Toolbar buttons referenced in this practice
module.

Objective 10.1 - Displaying a Single Graphic in the Plan View

1. In the D2D Perspective, on the Toolbar, click the Clear button.

2. From the Scale list, select CONUS.

3. From the Volume menu, select Browser.

4. In the Sources column, from the Volume menu, select the RAP40 Model.
5. In the Fields column, from the Basic menu, select the Height.

6. In the Planes column, from the Pres menu, select 850 mb. After you make this selection, the RAP40
850 mb Height (dam) appears highlighted in the Product Selection list.

7. At the bottom of the Volume Browser window, click the Load button to display the product on the
Main Display Pane.

8. Once the RAP40 850 mb Height (dam) Product is displayed, try looping and stepping through it.

Keep the Volume Browser open and continue to display this product for Objective 10.2.

Objective 10.2 - Displaying Multiple Model Graphics in the Plan View

After completing Objective 10.1, the RAP40 850 mb Height (dam) field should be displayed in the Main
Display Pane in the D2D Perspective and, in the Volume Browser window, the Product Selection list
should still contain the RAP40 850 mb Height (dam).

1. Inthe Volume Browser window, in the Fields column, from the Basic menu, select Temperature.
The Product Selection list should now display RAP40 850 mb Temperature (C) highlighted and
ready to load.

2. At the bottom of the Volume Browser window, click the Load button to view the RAP40 850 mb
Temperature (C) Field overlay the RAP40 850 mb Height (dam) Field.

3. Now try loading several additional RAP40 Fields from the Basic, Derived, Sfc/2D, and Other Fields
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menus.

Note: The system imposes no practical limit on the number of graphical products that can be
overlaid at one time. However, as you display more data fields, you may notice a slight degradation
in overall system performance.

Keep the Volume Browser open and continue to display these products for Objective 10.3.

Objective 10.3 - Displaying a Single Image Field

Gridded model data can be displayed as an image. Instead of graphical contours, the product is displayed
in graduated colors, each color representing a numerical value of the displayed field.

1. In the D2D Perspective, on the Toolbar, click the Clear button.

2. Using mouse Button 1 (B1), deselect all the products in the Product Selection list except the RAP40
850 mb Temperature (C) Field.

3. Place mouse cursor over the selected RAP40 850 mb Temperature (C) and click mouse Button 3
(B3) to open a pop-up menu.

4. From the pop-up menu, select Change to RAP40 850 mb Temperature Img (C).
5. At the bottom of the Volume Browser window, click the Load button to display the image field.
6. Try looping and stepping the displayed image.

Keep the Volume Browser open and continue to display this product for Objective 10.4.

Objective 10.4 - Overlaying Model Graphics onto an Image Field

1. With the Volume Browser opened as indicated in Objective 10.3, from the Product Selection list,
select RAP40 850 mb Height (dam), and then select Load.

2. Observe the graphic as it loads into the Main Display Pane of the D2D Perspective. Notice the
product legends and verify that they are time-matched.

Objective 10.5 - Displaying Two Image Fields

1. In the Volume Browser window, from the Edit menu, select Clear All.

2. In the D2D Perspective, on the Toolbar, click the Clear button to clear the Main Display Pane. Then
close the Volume Browser window.

3. From the Scale list, select CONUS.

4. From the Satellite menu, select the IR Window. The image displays immediately in the Main
Display Pane.
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5.

10.

I1.

12.

13.

14.

From the Options menu, select Image Properties, or from the Toolbar, select the Image Properties
iconified button to open the Imaging... dialog box and adjust the color table of the displayed image.
(The ""Ctrl + 1" keyboard shortcut also opens the Imaging... dialog box.) Refer to Subsection 2.2.9.1
for information on editing color tables.

In the Imaging... dialog box, check the box beside Combine Next Image Load to activate this
option. You can perform this same action from the toolbar, by clicking the Toggle Image
Combination iconified button.

From the Volume menu, select Browser....

In the Sources column, from the Volume menu, select RAP40.

In the Fields column, from the Basic menu, select Rel Humidity.

In the Planes column, from the Pres menu, select 500 mb.

In the Product Selection list, click B1 to select RAP40 500 mb Rel Humidity (%0).

Place the mouse cursor over the selected RAP40 500 mb Rel Humidity (%0) and click mouse Button
2 (B2) to change RAP40 500 mb Rel Humidity (%) to RAP40 500 mb Rel Humidity (%) Img.
This could have also been changed from the pop-up menu opened by clicking B3, as per Objective
10.3 Steps 3 and 4.

To combine the image with the satellite image, click the Load button. You may need to step to the
earlier frames to view the images displayed together.

To change the color tables or brightness of the display images, or to fade from one image to another,
change the Image Properties.

Objective 10.6 - Creating a Difference Field Using the Volume Browser

The Volume Browser enables you to calculate the difference between two fields. The "Difference" field is
then generated and plotted. The Diff menu button in the lower left corner of the Volume Browser is
disabled until you have at least two fields in the Product Selection list.

1.

2.

In the D2D Perspective, on the Toolbar, click the Clear button.

From the Scale list, select CONUS.

. In the Volume Browser window, from the Edit menu, click Clear All.

Select (but do not load) the RAP40 700 mb Temperature and the RAP40 500 mb Temperature.

Note 1: The order in which you select the fields or planes is important. The second product you
select is subtracted from the first product you select.

. Click the Diff menu button located in the lower left portion of the Volume Browser. The new file is

immediately loaded in the Main Display Pane with the RAP 40 [700 mb - 500 mb] Temperature (C)
Legend displayed across the bottom right edge of the display.
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Note 2: Keep in mind that it is possible to generate nonsensical fields. ‘
Note 3: At least two levels or fields must be chosen before the Diff menu button is enabled. ‘
Note 4: Other fields can be overlaid onto a difference field. ‘

Note 5: You can display the new difference field as an image. Click B2 on the product name in
the Product Selection list of the Volume Browser to overlay the displayed data as an image.

Note 6: If you have already loaded the product into the Main Display Pane, you cannot toggle
between image and graphic using B3 on the Product Legend.

Note 7: You can also calculate the difference of data fields that are displayed as cross sections,
time-height cross sections, or time series.

Note 8: It is possible to change the Load Mode before calculating a difference field.

Module 11: Loading and Displaying Gridded Data in the Cross Section View

This module provides step-by-step instructions on how to load and display model data in cross section view
using the Volume Browser. The Volume Browser allows you to specify a baseline (a straight line with two
endpoints) or polyline (a connected series of line segments that are not necessarily straight) within the data
domain when creating a cross section of gridded data.

The resulting cross section from a baseline represents the interpolation of the gridded data. The resulting
cross section from a polyline represents the interpolation of point (RAOB and Profiler) data. If you use a
polyline to generate a cross section, the vertices of the polyline automatically adjust to the nearest RAOB or
Profiler site.

The following objectives illustrate the use of baselines and polylines, along with other techniques for
displaying gridded data.

Objective 11.1 - Editing a Baseline for a Cross Section

1. In the Volume Browser, on the Edit menu, select Clear All.
2. In the D2D Perspective, on the Toolbar, click the Clear button.

3. From the Scale list, select CONUS.
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4.

5.

From the Tools menu, select Baselines. Ten baselines labeled A - J appear on the display.

Using B2, click the Baselines legend. The word "Editable" appears, signifying that you can now
modify any of the baselines.

Choose Baseline A to edit. The pointer changes from left-pointing to right-pointing when you move
an endpoint of Line A. By clicking and holding B1 on an endpoint, you can shorten, lengthen, or
change the line orientation.

To move the entire line, move the pointer over Line A. The pointer turns into a four-way arrow. Click
and hold B1 and drag Line A so that it is over Iowa.

Swap the baselines to a Smaller Monitor Pane for reference as you prepare to generate a cross section
in Objective 11.2.

Objective 11.2 - Displaying a Cross Section of a Single Graphic

. In the D2D Perspective, on the Toolbar, click the Clear button.

From the Scale list, select CONUS and zoom in over lowa.

. From the Frames list, select 12 as the frame count.

In the Volume Browser, from the Settings lists, select Cross Section and Time. Notice that the
Planes column menus change to Lon, Lat, and Specified.

. In the Sources column, from the Volume menu, select the RAP40 model.

In the Fields Column, from the Basic menu, select the Temperature field.
In the Planes column, from the Specified menu, select Line A.

To display the product, click the Load button at the bottom of the Volume Browser menu. Notice that
a small reference map appears in the top right-hand corner of the Main Display Pane indicating the
location of the cross-sectional slice that is displayed.

Note: Once the RAP40 Temperature (C) Field is displayed, try looping and stepping through it.
Continue to display this product for Objective 11.3.

Objective 11.3 - Displaying a Cross Section of Multiple Model Graphics

From Objective 11.2, the cross section of the RAP40 Line A Temperature (C) Field should be displayed
in the Main Display Pane and the Volume Browser Product Selection list should still contain the RAP40
Line A Temperature Label.

1. In the Fields column, from the Basic menu, select Relative Humidity.

2. At the bottom of the Volume Browser, click the Load button and watch the cross section of the

RAP40 Line A Relative Humidity (%) Field overlay the RAP40 Line A Temperature (C) Field.
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3. Now try loading several additional cross sections of RAP40 Fields on Line A.

Note: There is no practical limit on the number of graphic overlays that you can display at one time,
but they must all be loaded on the same cross-sectional slice (i.e., the same latitude, longitude, or
specified slice). Try toggling, looping, and stepping through the displayed fields.

Objective 11.4 - Displaying a Cross Section of a Railroad’s Data Using a Polyline

1. In the Volume Browser, from the Edit menu, select Clear All.
2. In the D2D Perspective, on the Toolbar, click the Clear button.
3. From the Scale list, select CONUS.

4. From the Maps menu, select Railroads. The Railroads Network locations map background appears
on the display.

5. From the Toolbar, select the Baselines iconified button. The baselines load in the Main Display Pane.

6. Click and hold B1 over Baseline B, the line between the B and B' vertices. mouse cursor (arrow)
changes to a 4-way arrow. Drag Baseline B to the State of Texas.

7. Click and hold B1 over the B vertex (endpoint). The mouse cursor (arrow) changes to a hand with
pointing finger. Drag the B vertex to approximately the center of Texas and put the B vertex near the
southernmost tip. You may need to zoom in using the mouse scoll wheel to easily find these locations.

8. Position the mouse cursor (arrow) over Baseline B and press mouse Button 2 to add a vertex to
Baseline B. This creates a polyline which interpolates itself to the sites.

9. Display the 3 or 5 Smaller Monitor Panes (if not already shown).
10. Using B3, click a Smaller Monitor Pane to swap its contents with the Main Display Pane.
11. From the Scale list, select CONUS.
12. In the Volume Browser, from the Settings lists, select Cross Section and Time.
13. In the Sources column, from the Point menu, select Profiler.
14. In the Fields column, from the Basic menu, select the Wind field.

15. In the Planes column, from the Specified menu, select Line B (if available).

Note: Available Baselines are indicated by a small green box.

16. Click B1 on the product label to select it.

17. At the bottom of the Volume Browser, click the Load button. Notice the baselines in the first Smaller
Monitor Pane. Baseline B jumped to the nearest Profiler sites. The cross section of the wind data are
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interpolated from these Profiler sites.

Objective 11.5 - Displaying a Cross Section of a Single Image Field

As previously mentioned, gridded model data can be displayed as an image. This objective shows you
how to display a cross section of a single image field.

1. In the D2D Perspective, on the Toolbar, click the Clear button.

2. In the Volume Browser, from the Settings lists, select Cross Section and Time.

3. Select the NAM Line A Relative Humidity (%) field.

4. Using B2, in the Product Selection list, select NAM Line A Relative Humidity (%b).

5. From the pop-up menu, select Change to NAM Line A Relative Humidity (%) img. This changes
the label to an image.

6. At the bottom of the Volume Browser, click the Load button to display the image field.

N

Note: Try looping and stepping the displayed image. Also, open the Image Properties dialog box
to adjust the color table of the displayed image ("Ctrl + I" keyboard shortcut also opens the
Image Properties Dialog Box). Continue to display this product for Objective 11.6.

Objective 11.6 - Overlaying Cross Sections of Model Graphics with an Image Field

1. Select the NAM Temperature (C) Field and load.

2. Observe the graphic as it loads.

Objective 11.7 - Displaying Cross Sections of Two Image Fields

1. In the D2D Perspective, on the Toolbar, click the Clear button.

2. In the Volume Browser, select NAM Line A Relative Humidity (%) and NAM Line A
Temperature (C).

3. Using B2, in the Product Selection list, do the following:
a. Using B2, in the Product Selection list, select NAM Line A Relative Humidity (%).
b. From the pop-up menu, select Change to NAM Line A Relative Humidity (%) img.
c. Repeat Steps a and b for the NAM Line A Temperature (C) field.

4. On the Toolbar, select the Toggle Image Combination iconified button.

5. At the bottom of the Volume Browser, click the Load button to display both images and observe the
combined images as they load.
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Note 1: You can toggle the images by clicking with B1 on the image name in the legend, or by
using the . (decimal) numeric key.

Note 2: You can fade from one image to another by using the slider bar in the Image Properties
dialog box, or by using the + (plus) or - (minus) numeric keys.

Note 3: Try to adjust color tables using the Image Properties dialog box.

Objective 11.8 - Animating Model Data in Space

The Volume Browser allows you to animate model data in space rather than in time. Objectives 11.8 and
11.9 provide step-by-step instructions on how to display and manipulate model data that animate spatially,
rather than temporally.

The Animate in Space perspective allows you to view model data at a fixed time vertically in a stack of
pressure or isentropic surfaces or horizontally across the model domain along longitude or latitude lines.

When animating Plan view data spatially, the data are plotted on either pressure or isentropic surfaces.
The first frame displays the lowest pressure or isentropic surface.

1.

2.

10.

I1.

12.

In the Volume Browser, from the Edit menu, select Clear All.
In the D2D Perspective, on the Toolbar, click the Clear button.

On the Toolbar, from the Scale list, select CONUS.

. In the Volume Browser, from the Settings list, select Plan view and Space.
. In the Sources column, from the Grid menu, select the NAM Model.

. In the Fields column, from the Basic menu, select Temperature.

In the Planes column, from the the Plane Menu, open the Coordinate menu and select All mb. After
you make this selection, the NAM *MB Temperature (C) appears highlighted in the Product
Selection List.

On the Toolbar, set the Load Mode to Prognosis Loop.
At the bottom of the Volume Browser, click the Load button.

From the Select Forecast Time dialog box that appears in the center of the display, select the desired
prognosis time.

Observe the legends as the product is displayed. Each frame is a different pressure level.

Using B2, in the Product Selection list, select NAM *MB Temperature (C).
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13. From the pop-up menu, select Change to NAM *MB Temperature (C) img and click the Load
button. Select the same prognosis time as you did in Step 10.

Objective 11.9 - Animating Cross Sections of Model Data in Space

When animating cross sections of model data in space, the data are plotted on slices along longitude or
latitude lines. The longitude slices animate from West to East (or from East to West depending on how the
Looping Controls are set), while the latitude slices animate from North to South (or from South to North
depending on how the Looping Controls are set).

1. Inthe D2D Perspective, on the Toolbar, click the Clear button.

2. In the Volume Browser, from the Edit menu, select Clear All.

3. From the Settings lists, select Cross Section and Space.

4. In the Sources column, from the Grid menu, select the NGM model.
5. In the Fields column, from the Basic menu, select Relative Humidity.

6. In the Planes column, from the Lon menu, select All Lon. After you make this selection, the NGM
allLONS Relative Humidity appears highlighted in the Product Selection List.

7. Set the Load Mode to Prognosis Loop.
8. At the bottom of the Volume Browser, click the Load button.

9. Select the desired prognosis time from the dialog box that appears in the center of the display.

Note: Observe the legends and the reference map as the product is displayed. Each frame is a
different longitude line. Notice the reference map in the upper right corner of the Main Display
Pane.

10. Using B2, in the Product Selection list, select NGM allLON Relative Humidity (%6).
11. From the pop-up menu, select Change to NGM allLON Relative Humidity (%) img.

12. Click the Load button and select the same prognosis time as you did in Step 9.
Objective 11.10 - Displaying a Model Sounding

The Volume Browser allows you to generate a model sounding of temperature, dew point temperature,
and winds from the grid point data.

1. In the D2D Perspective, on the Toolbar, click the Clear button.
2. From the Scale list, select CONUS.

3. In the Volume Browser, from the Edit menu, select Clear All.
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4.

5.

From the Settings list, select Sounding.
From the Tools menu, select Points. Ten points, labeled A - J, appear on the D2D display.

Choose Point C to edit. The pointer changes from left-pointing to right-pointing when you put it over
the point. Drag Point C over the Seattle location.

In the Volume Browser, do the following:
a. In the Sources column, from the Grid menu, select NGM-down menu.
b. In the Fields column, from the Thermo menu, select Sounding.
c. In the Planes column, from the Points menu, select Sounding C .

Load the NGM Point-C Sounding from the Product Selection list.

Note 1: A reference map appears in the upper left corner indicating the location of your
sounding.

Note 2: Change the frame count as needed to accommodate the number of forecast times for a
given model run.

Note 3: You can overlay other point soundings or RAOB soundings to compare models, or you
can overlay RAOB soundings to verify the model initialization.

Objective 11.11 - Displaying a Time Height Cross Section

The Volume Browser allows you to display a time height cross section of the model data, which
represents the data for a single grid point on a time versus height static plot. Forecast times are plotted
along the abscissa (x-axis) and the height levels are plotted along the ordinate (y-axis). The Points Tool
(described in Objective 11.10) is used to select the desired grid point.

1.

2.

In the D2D Perspective, on the Toolbar, click the Clear button to clear the Main Display Pane.

Open and clear the VVolume Browser.

. From the Tools Menu, open the Points Tool.

Click on the legend with B2 to make the points editable. Drag Point D to the Amarillo, Texas
location.

Clear the Display.

. In the Volume Browser, under the Settings dropdown menus, select Time Height and >Right.

In the Volume Browser, select the NGM Temperature (C) Field. Under the Points Planes Menu,
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choose Tsect D.

8. Set the frame count to 8.

9. Load the NGM Point D - Temperature (C) Product. Notice the reference map in the upper right
corner of the Main Display Pane.

10. Overlay the Relative Humidity (%) Field as an image at Point D.

Note 1: The frame count affects the number of forecast time intervals that are displayed along
the abscissa. A frame count of one means to display all available time periods.

Note 2: You can overlay time height cross sections from other grid point locations.

Objective 11.12 - Creating a Time Series Plot with Model Data

The Volume Browser allows you to display time series of model or other grid point data, which presents
the data for a single grid point on a time versus data units plot. For example, 500 mb relative humidity at
a specified location would generate a time versus relative humidity plot, with forecast times plotted along
the abscissa (x-axis) and the percentage of relative humidity plotted along the ordinate (y-axis). The
Points Tool (described in Objective 11.10) is used to specify the desired point.

1. Clear the Main Display Pane and the Volume Browser.
2. From the Scale option menu on the Toolbar, set the scale to CONUS.
3. From the Volume Browser Tools menu, select Points to load the Interactive Points tool.

4. Using B1, drag Point A to near Spokane, Washington. (If you need help locating Spokane, load the
RAOBSs map background from the Maps dropdown menu. The identifier for Spokane is KOTX in
eastern Washington.)

5. From the Volume Browser menu bar settings, select Time Series and Point A.
6. In the Volume Browser, select the Eta 700 mb Temperature.
7. Set Frame Count to 7.

8. Click the Load menu button in the Volume Browser and observe the time series plot.

Note: With the frame count at 7, the display includes the first seven time steps in the model run.

Module 12: Working with the Product Selection List

This module instructs you on the use of the Volume Browser manipulation actions.
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Objective 12.1 - Cloning the Product Selection List

1. Clear the Main Display Pane and the Volume Browser.
2. Under the Settings dropdown menus, select Plan view and Time.

3. Select several products for the Product Selection list using the Sources, Fields, and Planes
dropdown menus.

4. Deselect one or two products in the Product Selection list.
5. From the File dropdown menu in the Volume Browser, select Clone.

6. The selected products in the Product Selection list are duplicated in a new window.

Note: Only highlighted products in the Product Selection list are cloned. A cloned Product
Selection list can be closed only one time. You need to re-clone the Product Selection list to
restore it. You should continue to display the original Product Selection list for Objective 12.2
and Objective 12.3.

Objective 12.2 - Selecting None of the Products in the Product Selection List

1. From the Edit dropdown menu in the Volume Browser, choose Select none.

2. Each of the products is removed from the Product Selection list. The selections you made in the
Sources, Fields, and Planes menus remain but are not highlighted.

Note: The None button in the cloned Product Selection list un-highlights rather than removes the
products.

Keep this Product Selection List for the next Objective.
Objective 12.3 - Selecting All of the Products in the Product Selection List

1. From the Edit dropdown menu in the Volume Browser, choose the Select all option.
2. Each of the products is highlighted and ready to be displayed.
3. Click the Load button to display all the products in the Product Selection list.

Keep this Product Selection list for the next Objective.
Objective 12.4 - Clearing the Product Selection List

1. From the Edit dropdown menu in the Volume Browser, choose the Clear All option.
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2. Notice that all of the products in that Product Selection list are now removed.
Module 13: Using Load Modes for Loading Data and Products

This module explains the various modes for loading data and products. Recall that Load Modes provide
different ways to display model or real-time data by manipulating the valid times and forecast times of
previous model runs and inventories of data sets. The Load Modes apply primarily, but not exclusively, to
Volume Browser products. Except where noted, the Load Modes can be used when generating Plan views,
Cross Ssctions, Time height Cross sections, Model soundings, and Time series plots.

Objective 13.1 - Using Latest Model Run

Latest Run is a Load Mode that displays forecast data only from the latest model run, rather than mixing
in forecasts from previous model runs.

1. Clear the Main Display Pane.
2. Set Load Mode to Latest Run.
3. From the Volume Browser, select and load a model product.

4. Observe the valid times as you step through the data.

Note: If the frame count is set to a high value, the system does backfill with older data.

Objective 13.2 - Using the Valid Time Sequence

Valid Time Sequence is a Load Mode that loads the data for the most recent model runs, and fills empty
frames with older data for analysis.

1. Clear the Main Display Pane.
2. Set Load Mode to Valid Time Sequence.
3. Select and load a model product.

4. Observe the valid times as you step through the data.

Note: Latest Run and Valid Time Sequence are "sticky default" Load Modes. This means that, when
you clear the Main Display Pane, the current Load Mode setting automatically defaults back to
either Latest Run or Valid time sequence (whichever you had initially used before switching to
another Load Mode).

Objective 13.3 - Using No Backfill

No Backfill is a Load Mode that displays the data for the latest model run, but does not fill empty frames
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with older data for analysis.

1. Clear the Main Display Pane.
2. Set Load Mode to No Backfill.
3. From the Volume Browser, select and load any model product of your choice.

4. Observe the valid times as you step through the data.

Objective 13.4 - Using Previous Run

If your frame count is set to a high number, Previous Run uses data from a previous model run, and fills
empty frames with previous model data for analysis.

1. Clear the Main Display Pane.
2. Set Load Mode to Previous Run.
3. From the Volume Browser, select and load any model product of your choice.

4. Observe the valid times as you step through the data.

Objective 13.5 - Using Previous Valid Time Sequence

Previous Valid Time Sequence is a Load Mode that loads the data from the previous model run, and fills
empty frames with the previous model data for analyses.

1. Clear the Main Display Pane.
2. Set Load Mode to Previous Valid Time Sequence.
3. From the Volume Browser, select and load a model product.

4. Observe the valid times as you step through the data.

Objective 13.6 - Using Prognosis Loop

Prognosis Loop is a Load Mode that loads a sequence of n-hour forecasts from successive model runs.
For example, all of the 24-hour forecasts would be selected from the available model runs.

1. Clear the Main Display Pane.

2. Set Load Mode to Prognosis Loop.

3. From the Volume Browser, select and load a model product.

4. Select a forecast time from the Select Forecast Time dialog box.

5. Step through the displayed product and notice that the forecast projection stays the same, while the
valid time changes.
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Objective 13.7 - Using Analysis Loop

Analysis Loop is a Load Mode that loads a sequence of analyses from successive model runs, but
excludes forecasts. This is similar to the Prognosis Loop, but selects only the 0-hour analyses from the
available model runs.

1. Clear the Main Display Pane.
2. Set Load Mode to Analysis Loop.
3. From the Volume Browser, select and load a model product.

4. Step through the displayed product and notice that only the model analyses are displayed, not
forecasts.

Objective 13.8 - Using dProg/dt

1. Clear the Main Display Pane.
2. Set Load Mode to dProg/dt.
3. From the Volume Browser, select and load a model product.

4. Select a forecast time from the Select Forecast Time dialog box that appears in the center of the
screen.

5. Step through the displayed product and observe that the valid time is the same for each frame, while
the forecast time changes.

Note 1: dProg/dt provides a means for assessing the consistency of model runs.

Note 2: You are likely to see a status message regarding the number of frames, since the database is
necessarily limited.

Objective 13.9 - Using Forced Load

Forced Load is a Load Mode that puts a selected product in all frames of a previously displayed loop,
ignoring time matching.

1. Clear the Main Display Pane.
2. Set Load Mode to Valid Time Sequence.
3. From the Volume Browser, select and load a model product.

4. Set Load Mode to Forced Load.
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5. From the Volume Browser, select and load a model product.

6. Select a forecast time from the Select Forecast Time dialog box that appears in the center of the
screen.

7. The selection made in Step 5 is overlaid in each frame of the product selected in Step 3.

Note: With looping turned on, the overlaid product appears static, while the model product
animates.

Objective 13.10 - Using Forecast Match

Forecast Matching is a Load Mode that overlays a model product only when its forecast times match
those of an initially loaded product.

1. Clear the Main Display Pane.

2. Set the Load Mode to Latest.

3. Load the NGM 400 mb Height (dam) Field.
4. Set Load Mode to Forecast Match.

5. Load the NAM 400 mb Height (dam) Field.

6. Step through the frames and observe that the two products are displayed together only when the
products have matching forecast times.

Note: Forecast match can also be used when displaying real-time observational data with varying
update intervals.

Objective 13.11 - Using Inventory Load

Inventory Load is a Load Mode that allows you to retrieve and display an older version of graphical or
image data from a menu list.

1. Clear the Main Display Pane.

2. Set Scale to WFO.

3. Set Load Mode to Inventory.

4. From the kxxx dropdown menu, select the 0.5 Z/V Radar Product.

5. Select a time from the Select Forecast Time dialog box, which appears in the center of the screen.

6. Observe the loaded single frame and verify valid time.
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Note: Inventory Load can be used with model and real-time data sources. Inventory Load cannot be
used for time-height cross sections or time series plots.

Objective 13.12 - Using Slot Load

Slot Load is a Load Mode that loads (or overlays) a single frame of a selected product only in the
currently displayed frame, and ignores time matching.

1. Clear the Main Display Pane.

2. Set the scale to CONUS.

3. Set Load Mode to Valid Time Sequence.

4. From the Volume Browser, select and load a product.

5. Step to the desired frame of this newly displayed product onto which you want to overlay a product.

6. Then set Load Mode to Slot Load.

Note 1: Slot Load can be used with model and real-time data sources. ‘

Note 2: Slot Load cannot be used for time height cross sections or time series plots. ‘

7. Select and load a second product.
8. Select a valid time from the Select Forecast Time dialog box that appears in the center of the screen.

9. Loop the product to verify that the product loaded in Step 6 is only in the chosen frame.
Module 14: Accessing the Digital Mesocyclone Display (DMD)

This module contains practice modules for the Choose By ID Tool and step-by-step instructions on how to
display Time Height, Time Series, and Vertical Line Graphs of DMD data.

Objective 14.1 - Using the Choose By ID Tool (DMD available)

Choose By ID provides a method for selecting locations based on a feature ID rather than from a map.
While it can be used for standard point data (see Objective 14.2 for examples), its main function is to
select features that may move, such as 88D-identified mesocyclone circulations.

Note 1: The Return key mentioned in the following practice modules refers to the Enter key on the
main keyboard, while Enter refers to the Enter key on the numeric keypad. Press Return when you
want to keep/fix your entered ID. Press Enter only when you want to return to the original ID.
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1. Clear the Main Display Pane.

2. Set Scale to WFO.

Note 2: If available, the DMD Display appears and you can continue to the next step. If not
available, continue to the next Objective to practice using the Choose By ID tool on other
products like METARs and RAOBs.

3. From the Volume dropdown menu, select Browser. The Volume Browser menu appears.

4. Select the Choose By ID... tool from the Tools dropdown menu on the Volume Browser. The Choose
By ID dialog box appears.

Note 3: Once Choose By ID... is selected, you can use it to load point data from the Volume
Browser based on an ID rather than a location. The tool allows you to associate an ID with one
of the moveable Points, or the "Home" point, or a series of IDs with one of the moveable
Baselines.

5. Enter a radar location into the Home box in the Choose By ID dialog box and click Return to save
your changes.

6. Enter a feature ID from the DMD Display into the Points G box and click Return to save your
changes and generate the Plan view DMD display shown in Exhibit 3.3.6-1, which shows the feature
IDs mapping.

Exhibit 3.3.6-1. DMD Display Showing Feature IDs

Note 4: You can also generate the DMD display from the kxxx menu by selecting kKxxx > kxxx
Graphics > Digital Mesocyclone. Refer to Subsection 2.2.6.12, kxxx.

7. From the Settings dropdown menu, select Time series.
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Note 5: All of the Settings dropdown menu options will work with DMD except Plan view and
Sounding.

8. From the Volume Browser Settings dropdown menu, select Point G. The point chosen in the Point
Selection dropdown menu must match the Points box in the Choose By ID dialog box.

9. From the Volume Browser Sources menu, select Other > DMD.

Note 6: The DMD grids available are highlighted in green.

10. From the Volume Browser Fields menu, select Other > Radial Vel.
11. From the Volume Browser Planes menu, select Misc > MaxWind.

12. Verify the product selected appears in the Product Selection list and then click Load. Verify, in the
product legend, the DMD product has loaded for the correct feature ID location.

13. Clear the Main DisplayPpane.

14. From the Choose By ID dialog box, type 2 or more feature IDs from the DMD display into the
Baselines G box and press the Return key to save your changes.

15. From the Volume Browser Settings dropdown menu, select Cross section.
16. From the Volume Browser Sources menu, select Other > DMD.
17. From the Volume Browser Fields menu, select Basic > Height.

18. From the Volume Browser Planes menu, select Specified > Line G. The line chosen in the Specified
menu must match the Baselines box in the Choose By ID dialog box.

19. Verify the product selected appears in the Product Selection list and click Load. Verify, in the
product legend that the DMD product has loaded for the correct feature ID locations.

Note 7: You can hit the "escape" or "=" key to clear the entered ID. If you accidentally hit the
"escape" or "=" key, you can always go back to the ID by pressing the Enter key on the numeric
keypad. Entered IDs will automatically be converted to uppercase once the Return key is
pressed.

Note 8: Asterisks (*) appear in front of the entered IDs when an ID has changed its location.
Each entered ID is associated with a movable screen object, from the Points extension, the
Baselines extension, or the "Home" extension. If the screen objects move, then the location of
the new screen object will control what data is loaded. The graphical object on the screen will
acquire an (*) when not in control. To keep the location of the entered IDs the same and in
control, simply press the "lock" button or hit the Return key in one of the text entry fields.
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Note 9: Greater-Than (>) signs appear in front of the entered IDs when an ID has an error. You
must enter more than one ID for the Baselines box and a single ID for the "Home" and Points
box. The (>) sign does not check for validity of IDs.

Note 10: You can display the Choose By ID tool on several screens at the same time on the same
workstation. Once you have entered an ID on one screen, it will show up on the other screen, but
will not be in control. Also once an ID is locked on one screen, you cannot override it on another
screen. However, if an ID is overridden from a different screen before the "lock" button is
pressed, hitting the Return key will cause that ID to be recommitted, and hitting Enter on the
numeric keypad will sync up with the override ID.

Note 11: Whenever point data is successfully loaded from the Volume Browser, the associated
graphical object will snap to the location of the station/feature in question. However, even if the
graphical object has a leading asterisk, its location will still control the display of pure gridded
data. If you wish to compare grids to point data at Choose By ID-set locations, you must first
load the point data to get the object to move to the desired location.

Objective 14.2 - Using the Choose By ID Tool (DMD not available)

While Choose By ID was designed with moving targets such as DMD in mind, it can also be used to set
Points, Baselines, and "Home" for conventional locations like METARs and RAOBs. This Objective
illustrates its use with those datasets, and also provides useful practice if no DMD features are available.

N

Note 1: You must load a regular METAR or RAOB product first before loading a Grid product when
using the Choose By ID tool; otherwise the changes made will not be saved.

1. Clear the Main Display Pane.
2. From the Main menu, select Volume > Browser. The Volume Browser menu is displayed.

3. From the Volume Browser Tools dropdown menu, select Choose By ID.... The Choose By ID dialog
box appears.

4. From the Choose By ID dialog box, type kden in the Points A box and then press the Return key to
save your changes.

5. From the Volume Browser Settings dropdown menu, select Time series.
6. From the Volume Browser Point Selection dropdown menu, select Point A.
7. From the Volume Browser Sources menu, select Other > Metar.

8. From the Volume Browser Fields menu, select Sfc/2D > Misc > Meteogram.
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9.

10.

I1.

12.

13.

14.

15.

16.

17.

18.

19.

20.

21.

22.

23.

Observe your selection in the Product Selection list and click Load.
Verify, in the product legend, that the METAR product has loaded for the correct location.

From the Volume Browser Sources menu, select Grid > NAMSO0 and click Load. Verify, in the
legend, that the NAMSO product has loaded for the correct location.

Clear the Main Display Pane.

From the Choose By ID dialog box, type klbf kdnr kgjt in the Baselines E box and then press the
Return key to save your changes.

From the Volume Browser Settings dropdown menu, select Cross section.

Note 2: Choose By ID can be used to set baselines only for those datasets that allow cross
section generation, e.g., Raob, MDCRS, profiler.

From the Volume Browser Edit menu, select Clear sources.

From the Volume Browser Sources menu, select Other > Raob.
From the Volume Browser Fields menu, select Basic > Temperature.
From the Volume Browser Planes menu, select Specified > Line E.

Observe your selection in the Product Selection list and click Load. Verity, in the legend, that the
RAOB product has loaded for the correct locations.

From the Volume Browser Sources menu, select Grid > NAMBSO0 and click Load. Verify, in the
legend, that the NAMSO0 product has loaded for the correct locations.

Clear the Main Display Pane.

Note 3: The following steps of the practice module may not be available at most WFO sites.

From the Choose By ID dialog box, type a radar ID into the Home box and press the Return key to
save your changes.

From the Radar menu on the Main menu, select Home > Home 4 Bit Prods > Comp Ref 4bit (C2).
Verify, in the legend, that the selected Home radar product is displayed.

Objective 14.3 - Displaying Cross Sections of Radar Reflectivity or Velocity along Specified
Baselines

1.

2.

3.

Clear the Main Display Pane.
Select WFO or State(s) scale.

Either put Home near the radar of interest or bring up the Choose by ID tool and type the radar ID
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4.

5.

6.

into the Home box at the bottom.
Place a baseline across the area you would like to view.

Bring up the Volume Browser, select Cross section, Sources: Other > Radar, Fields: Other >
Reflectivity, and Planes: Specified > LineX.

Display as image and/or contours.

Objective 14.4 - Displaying the Time Height of DMD Data

10.

Clear the Main Display Pane.

Load the DMD product on the WFO scale.

Note: To load the DMD product, select kxxx > kxxx Graphics > Digital Mesocyclone (DMD)
from the main menu.

From the Volume dropdown menu, select Browser. The Volume Browser dialog box appears.
From the Volume Browser Settings dropdown menu, select Time height.

From the Volume Browser Sources menu, select Other > DMD.

From the Volume Browser Fields menu, select Basic > Shear Mag.

From the Volume Browser Planes menu, select Points > T sect A.

Enter the following into the Choose By ID dialog box (refer to Objective 14.1 above to open the
dialog box):

a. In Points A box, the ID of a feature on the DMD display.

b. In the "Home" box, the location for a particular radar.

. From the Choose By ID dialog box, select the lock button or press the Return key to fix the "Home"

location for the chosen radar in Step 8.

From the Volume Browser dialog box, select Load to display the Time height of DMD data.

Objective 14.5 - Displaying a Time Series of DMD Data

. With the DMD product still loaded, select Browser from the Volume pull-down menu. The Volume

Browser dialog box appears.

. From the Volume Browser Tools dropdown menu, select Points. Place Point B over a feature on the

DMD display.

. From the Volume Browser Settings dropdown menu, select Time series.
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4. From the Volume Browser Point Selection dropdown menu, select Point B.

5. From the Volume Browser Sources menu, select Other > DMD.
6. From the Volume Browser Fields menu, select Basic > StrmMot.
7. From the Volume Browser Fields menu, select Other > Feature Strength.

8. Select the Load button to display a Time series of DMD data.

Objective 14.6 - Displaying a Vertical Line Graph of DMD Data

1. With the DMD product still loaded, select Browser from the Volume pull-down menu. The Volume
Browser dialog box appears.

2. From the Volume Browser Tools dropdown menu, select Points. Place Point A over a feature on the
DMD display.

3. Open the Choose By ID dialog box and enter a feature ID from the DMD display into the Points A
box.

4. From the Volume Browser Settings dropdown menu, select Var vs Hgt.

5. From the default Log 1050-150 dropdown menu, select 0-5km MSL.

6. From the Volume Browser Sources menu, select Other > DMD.

7. From the Volume Browser Fields menu, select Other > Feature Diameter.
8. From the Volume Browser Fields menu, select Other > Gate2Gate Shr.

9. From the Volume Browser Planes menu, select Points > VarHgt A.

10. Select the Load button to display a Vertical Line Graph of DMD data. Observe that the Graph has
loaded onto the DMD display.

11. Close the Choose By ID dialog box and the Volume Browser dialog box.

12. Exit the DMD product display.

Module 15: Reserved

Page 233



CAVE-D2D User's Manual AWIPS |1 Operational Build 13.4.1 - 31 July 2013

4.0 The AWIPS Workstation and Textual User Interface

Each AWIPS Workstation is comprised of three graphic displays (Graphic Workstation) and one text display
(Text Workstation), as shown in Exhibit 4.0-1. The three graphic displays share a common keyboard, mouse,
and central processing unit (CPU - LX). The text display has a dedicated keyboard, mouse, and CPU - XT.

Exhibit 4.0-1. The AWIPS Workstation
This chapter includes the following sections:

e Section 4.1: The AWIPS Text Workstation

e Section 4.2: The AWIPS Textual User Interface
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4.1 The AWIPS Text Workstation

The AWIPS Text Workstation is located on the left side of the AWIPS Workstation, as shown in Exhibit
4.1-1. It has its own dedicated keyboard, mouse, and its own CPU (XT).

Exhibit 4.1-1. AWIPS Text Workstation

The input devices for the AWIPS Text Workstation function the same as those used for the AWIPS Graphic
Workstation. Refer to Section 2.1

Note 1: The mouse handedness of the Text Workstation can be set via Programs > Settings > Peripherals
> Mouse, which is available by clicking mouse Button 2 (B2) from the root (the colored background of
the display).

The Text Workstation allows you to retrieve, edit, and transmit textual information. It is also possible to send
and receive administrative messages with or without attachments. Like the CAVE graphical displays, the Text
display was developed with motif-style menus, windows, and mouse controls, but it also has an online editor
interface for editing text.

Note 2: The Text Workstation accommodates both WMO text products and AFOS text identifiers.
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If there are any problems, specific alert boxes appear. Once you send the product, a confirmation box pops up
asking you to verify the send or to abort the transmission.
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4.1.1 Starting the Text Workstation

The Text Workstation can be started from either the Text Workstation (XT) or the Graphic Workstation (LX).

To access the Text Workstation from the Text Workstation, simply log into AWIPS. The display shown in
Exhibit 4.1.1-1 will appear.

Exhibit 4.1.1-1. Text Workstation Display from XT Workstation
To access the Text Workstation display from the Graphics Workstation CAVE-D2D Perspective:
1. Log into CAVE.

2. On the Menu Bar of the CAVE-D2D Perspective, select CAVE > New > Text Workstation, as shown
in Exhibit 4.1.1-2.
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Exhibit 4.1.1-2. Accessing Text Workstation from CAVE

After selecting Text Workstation from the New submenu, the Text Workstation dialog box and the default
Text 1 window appear, as shown in Exhibit 4.1.1-3.

Exhibit 4.1.1-3. Text Workstation Display from LX Workstation (CAVE-D2D)
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4.2 The AWIPS Textual User Interface

When a text display is opened from the Graphics Workstation (LX) CAVE-D2D menu, two Text display
windows appear, as shown in Exhibit 4.2-1: the Text Workstation dialog box and the Text 1 display window.
Three windows open if the text display is opened from the Text Workstation (XT): Text Workstation dialog
box, Text 1 display window, and the Monitoring Controller dialog box. (Refer to Exhibit 4.1.1-1.)

Exhibit 4.2-1. Text Workstation Dialog Box and Display Window from LX Workstation
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4.2.1 Text Workstation Dialog Box

The Text Workstation dialog box, shown in Exhibit 4.2.1-1, contains top-level dropdown menus for the Text
display. It also displays the current GMT and UTC date/time.

Exhibit 4.2.1-1. Text Workstation Dialog Box

Text Workstation windows are numbered and each one can be opened simply by clicking on its button (Text
1, Text 2, etc.). If a text product has been loaded in one of the Text display windows, the product's
Automation of Field Operations and Services (AFOS) identifier appears on the window button.

A brief explanation of each button in the Text Workstation dialog box follows.

File
e Select User ID: This option opens a list of user names.

e Select: The Select submenu contains the Evaluation Log, End of Shift, and Questionnaire.

e Exit: This option closes the Text Workstation windows. A confirmation dialog box appears to confirm
the exit request.

Windows

e Hide All: All Text display windows are closed without icons.
e Show All: Each Text display window is restored.

e New Window: This option allows you to generate another Text display window. By default, four
windows are made available but up to eight are possible.

Alarm/Alert

This menu button opens the Current Alarm Queue. Refer to Section 5.4 for more information.
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Text 1-Text 4

These buttons open the individual Text display windows.
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4.2.2 Text Display Window

The numbered Text display windows are where you browse, read, and edit textual products. Exhibit 4.2.2-1
shows a Text display window as it appears when initially opened.

Exhibit 4.2.2-1. Text Display Window

The Text display window has a Menu Bar located along the top row of the window. The menu bar includes
standard menus for window controls, product retrieval, and editing.

The second row is called the Toolbar. It includes buttons for managing the information contained in the
window. The third row includes input fields that further identify the retrieved product information. The
control settings of one Text display window do not apply to any other Text display window. Descriptions of
the components found on the Menu Bar and the Toolbar follow.
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4.2.2.1 Text Display Window Menu Bar
File

The File menu, as shown in Exhibit 4.2.2.1-1, contains commands for viewing, printing, and editing text
data. Descriptions of each menu option follow.

Exhibit 4.2.2.1-1. Text Display Window File Dropdown Menu

AFOS Browser: A button that opens the Text Workstation AFOS Browser, which is discussed in
Subsection 5.1.3.

Print All (Ctrl+P): Creates hard copy of all text in that Text window.

Print Selection: Creates hard copy of highlighted text in that Text window.

Fax All: Opens the Fax Message dialog box, as shown in Exhibit 4.2.2.1-2, which allows you to create
a fax of all text in that Text window.
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Exhibit 4.2.2.1-2. Fax Message Dialog Box for Fax All

e Fax Selection: When a text product is displayed in the Text window and a portion of the text is
highlighted, this option opens the Fax Message dialog box, which allows you to generate a fax of the
highlighted text. The Fax Message dialog box, as shown in Exhibit 4.1.3-2, includes the following:

o File: A dropdown menu that contains commands that control the Fax Message dialog box,
including Exit, which closes the Fax Message dialog box.

o Help: A dropdown menu that contains useful information on the fax capabilities and version of
the software.

o LDAD Fax Recipient: An area of the Fax Message dialog box that contains entry lines used to
fill in the pertinent information on each fax site.

m Fax Number: An entry box in which to type the telephone number of the recipient's fax
machine. This entry box must contain an entry for the capability to function.

m Recipient: An entry box in which to type the name of the person to receive the fax.
= Company: An entry box in which to type the name of the company to receive the fax.
o Send: A menu button that initiates the transmission of the fax message.

o Cancel: A menu button that cancels the fax message operation and closes the Fax Message
dialog box.

e Configure Auto Fax: Opens the Fax Site Editor dialog box, as shown in Exhibit 4.2.2.1-3, which
contains commands that allow you to add or edit fax sites, as well as update the fax sites text database.
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Exhibit 4.2.2.1-3. Fax Site Editor Dialog Box

Once fax sites have been set up, the window area of the Fax Site Editor dialog box contains a tree-view
listing of the existing fax sites. (This area is empty if no fax sites have been set up.) The phone number
is denoted with a "+" symbol. Click on the "+" symbol next to the phone number to expand the
tree-view and view the AFOS product inventory lists (PIL) associated with each phone number.

Click on the "-" symbol next to each phone number to close the expanded tree-view listings.
o File: A dropdown menu, as shown in Exhibit 4.2.2.1-3, which contains the following options:
= Add Site...: Opens a dialog box containing commands for configuring a fax site.
m File: Dropdown menu with the following options:

m Update Database (DB): Updates the fax site text database to reflect all
changes you have made to the fax sites.

m Exit: Exits the Fax Site Editor dialog box.
m Recipient: Dropdown menu that contains the following options:

= Add Recipient...: Adds a newly defined fax recipient to the Fax Receipt list.
Remember, you must select the Update DB option to activate the new
recipient in the text database.

m Delete Recipient...: Removes a selected fax recipient from the Fax Receipt
list. Remember, you must select the Update DB option to activate the removal
of a recipient from the text database.
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= Help: Dropdown menu that contains useful information on the fax capabilities and
the software.

m | DAD Fax Recipient: An area of the dialog box that contains entry lines for you to
fill in the pertinent information on each fax site.

m AFOS PIL: The AFOS identifier is given here.

Fax number: This is the fax number of the recipient.

Phone number: This is the phone number of the recipient.

Recipient: This is the recipient's name.
m Company: This is the recipient's affiliated company.

m Edit Site: An option that allows you to modify an existing fax site. You must first select
the site and the AFOS PIL. The Fax Site Editor dialog box that opens is described above.

m Update DB: A command that updates the fax site text database to reflect all changes you
have made to the fax sites.

m EXit: Menu option used to close the Configure Auto Fax dialog box
o View: A dropdown menu with the following options:

m Sort by Fax Number: Rearranges the tree view so that the tree is organized by fax
numbers.

m Sort by AFOS PIL: Rearranges the tree view so that the tree is organized by AFOS PILs.

o Help: A dropdown menu that contains useful information on the fax capabilities and the
software.

o Site Information: An area of the Fax Site Editor dialog box that gives the following information
for a highlighted fax site:

® Fax Number

= AFOS PIL

= Company

m Phone Number
= Contact

o Update DB: A menu button that updates the fax site text database to reflect all changes you have
made to the fax sites. It is placed here for user convenience.

e Enter Editor: Opens the Text Editor, which is discussed in Section 5.2.

e Save: Stores the product that you are currently editing in the text database, but continues the edit
session.
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e Send & Exit Editor: Stores the text product in the text database, ends the edit session, and sends the
product for transmission.

e Cancel Editor: Ends the editing session without saving any changes made since the last save.

e Import From File...: Opens the Import From File dialog box, which allows you to select a file to bring
into your current document.

e Export To File...: Opens the Export To File dialog box, which allows you to place your current file in
another file or a different directory.

e Request From Remote Site (Request/Reply)...: A menu button that opens the Send Request dialog
box, which allows you to send a product request to another site. You specify the desired product by
filling in the WSFO Identification, the Product Category, and the Product Designator (9-character ID).
The Addressee can remain as DEF (Default), which sends the request to the hub. The hub is the WFO
colocated with the site's RFC.

Note 1: The colocated WFO may be itself. If the product is not available, a request is
automatically sent to the WNCF.

You may also specify a site from which You want the product. If that site does not have a product dated
more current than what is requested, the request is not forwarded to the WNCF.

If the product is available, there is no notification. Rather, the product is sent to your database and is
accessible from the Text Browser. If the product is not available, or there is some technical problem
with the request, an error message is logged.

Note 2: You can request only the most recent product. You cannot specify a product for a specific
time or date.

e Recover Edit Session: While you are in the edit session, the system automatically saves the text
product every minute.

If there is a system crash or an inadvertent Text window closure while you are editing, this button
restores the most recently saved text file.

e Close (Alt+F4): Closes the Text window.
Edit

Edit is the second Text display window menu. This menu, as shown in Exhibit 4.2.2.1-4 contains editing
functions that apply to text products in the Text windows and/or the Text Editor windows. Many of the
editing functions are the same as, or similar to, editing functions found in most word processing software.
Descriptions of each menu option follow.

Note 3: A number of these commands appear gray until you enter information in the Text Editor.
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Exhibit 4.2.2.1-4. Text Display Window Edit Dropdown Menu

Cut (Ctrl + x): Deletes a text selection.

Copy (Ctrl + ¢): Reproduces a text selection.
Paste (Ctrl + v): Places copied text at the cursor location.
Fill: Removes hard returns from selected text.

Select: A submenu that contains options for selecting (highlighting) text. Table 4.2.2.1-1 lists the

options. Keyboard shortcuts for each option are noted.

Table 4.2.2.1-1. Text Editing Options Keyboard Shortcuts for Selecting Text

Submenu Option

Keyboard
Shortcut

Description

‘To previous word ‘Ctrl+Shift+Left

‘Selects previous word

‘To next word ‘CtrlJrShiftJrRight ‘Selects next word

To beginning of  |Shift+tHome Selects from cursor location to beginning of line

line

‘To end of line ‘Shift—i-End ‘Selects from cursor location to end of line

To previous page |Shift+PageUp Selects from cursor location to beginning of
previous page

‘To next page ‘Shift-IrPageDown ‘Selects from cursor location to end of next page

‘To top of product ‘Ctrl+Shift+H0me

‘Selects from cursor location to first line of page

‘To end of product ‘CtrlJrShiftJrEnd

‘Selects from cursor location to last line of page

All

‘Selects all of the text

e Delete: A submenu that contains options for deleting text. Keyboard shortcuts for each option are
noted in bolded parentheses.

o Character (F6): Deletes the character after the cursor location.

o Word (F7): Deletes the word after the cursor location.

o Line (F8): Deletes the line after the cursor location.

e Undelete: A submenu that contains options for replacing text that was previously deleted. These
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Undelete functions work only on the last character, word, or line that was deleted. Keyboard shortcuts
for each option are noted in bolded parentheses.

o Character (Shift+F6): Undeletes the character after the cursor location.
o Word (Shift+F7): Undeletes the word after the cursor location.
o Line (Shift+F8): Undeletes the line after the cursor location.

e Clear Window (Ctrl+Shift+F4): Deletes the entire content of the Text window. This function cannot
be applied while the text window is in edit mode.

e Clear Selection: Deletes the highlighted section of text. This option is only available in edit mode.

e Edit Header: Opens Header Block of a text product for editing. This option is only available in edit
mode.

e Search (F2): A menu button or keyboard shortcut that invokes the Search and Replace dialog box
containing the following options:

Note 4: All of the keyboard shortcuts used with the Text Editor are listed in Subsection 5.2.2.

o Search For: An entry box used to type a word or character string for which you wish to search.

o

Replace With: An entry box used to type a word or character string that replaces the word or
character string in the above search.

Search: A button that initiates the search.

o

o

Replace: A button that substitutes the original word or string with the new word or string.

o

Replace and Search Again: A button that substitutes the original word or string with the new
word or string and then continues the search for the original string.

o

Replace All: Finds and replaces all occurrences of the original string with the new string.

o

Cancel: Closes Search and Replace dialog box.

e Spell Checker (Ctrl+F1): A menu button (or keyboard combination shortcut keys) that invokes the
Spell Check dialog box. This option is only available in edit mode. It employs features very similar to
spell check functions in most word processing software programs, as listed below:

o Not in Dictionary: Identifies the unknown word.
o Change To: An entry box used to type the correctly spelled word.

o Suggestions: The Spell Checker accesses online dictionaries for the correct spelling and
provides a list of suggestions. Click on or use the arrow key to select the correctly spelled word.

o Change: A button that replaces the misspelled word in the text with the correctly spelled word.

o Change All: A button that replaces all occurrences of the misspelled word with the correctly
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spelled word.

o Ignore: A button that passes over a word that the Spell Checker flags as incorrectly spelled.

o Ignore All: A button that passes over all occurrences of a word that the Spell Checker flags as
incorrectly spelled.

o Add to Dictionary: A button that puts a word into one of the online dictionaries.

o Dictionary: A menu that allows you to choose either the English Dictionary or the Weather
Dictionary. The English Dictionary accesses a standard online dictionary, while the Weather
Dictionary contains abbreviations and meteorological acronyms that are typically not accepted in
standard English dictionaries.

o Cancel: A button that closes the Spell Check dialog box.

e Clear Update Flags: Removes the highlighting from surface observations that are updating
automatically.

Options

The Text display window Options dropdown menu, as shown in Exhibit 4.2.2.1-5, contains text/font settings
for the text displayed in the Text display window.

Exhibit 4.2.2.1-5. Text Display Window Options Dropdown Menu
The options listed under the Options menu are defined below.

e Autowrap: A cascade menu that turns the character width off or sets it to 69, 72, 80, or Other. The
Other option initiates a dialog box that allows you to set a width between 69 and 80 characters.

e Font Size: A cascade menu that sets the type size to small, medium (the default), or large.

e Overstrike/Insert Mode (Ins): A check box that toggles between the Overstrike Mode and the Insert
Mode of the Text Editor. You can also toggle between the two modes using the "Insert" (Ins) keyboard
shortcut.

\Version

The Text display window Version dropdown menu, as shown in Exhibit 4.2.2.1-6, allows you to choose
which version of a text product you want to display.

Exhibit 4.2.2.1-6. Text Display Window Version Dropdown Menu
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Tools

The Text display window Tools dropdown menu is shown in Exhibit 4.2.2.1-7.

Exhibit 4.2.2.1-7. Text Display Window Tools Dropdown Menu
The menu options listed may vary from site to site. They are listed below.

e Create TAF template: This option creates and displays the TAF (Terminal Aerodrome Forecast)
template that users can fill in and then transmit using the "Transmit TAF" option. Cut, copy, and paste
functions are available. The template must be set up by the System Administrator before this option
can be used.

e Transmit TAF: This program takes the information in CCCWRKTAF, properly formats it in
accordance with Weather Service Operations Manual (WSOM) Chapter D-31, stores the output in the
appropriate product(s) in the AWIPS database, transmits the appropriate product(s) to the WAN, and
either creates or updates a disk file containing information on amendments, Requirements Traceability
Documents (RTD), and corrections.

e Print Latest METARs: OMA SNY VTN ARK: As stated, this option prints the "Latest METARs." In
the exhibit above, the latest METARs are: OMA, SNY, VIN, and ARK.

e Print Last Hour FTUS80 KOMA: As stated, this option prints the "Last Hour." In the exhibit above,
the last hour applies to FTUS80 KOMA.

Scripts

Text Scripts are macro-like programs that allow you to display a preselected set of text products. They are
very similar to procedures on the graphics display. Refer to Section 5.1 for further information.

Products
This is a dropdown menu of frequently used text products that can be configured for different sites. If no

products are listed in this menu, the menu will not dropdown. If you need to enter a product, a "-" sign is used
as a placeholder.

Help

The "Help" dropdown menu is shown in Exhibit 4.2.2.1-8.

Exhibit 4.2.2.1-8. Text Display Window Help Dropdown Menu
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The options listed under the Help menu are defined below.

e On Text Window... (F1): Connects you to the Mozilla Firefox home page.

e About...: Provides the date/version number of the Text display software.
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4.2.2.2 Text Display Window Toolbar

The Text Display Window Toolbar contains two rows of control options, as shown in Exhibit 4.2.2.2-1 .
Among the options are the AFOS (Automation of Field Operations and Services) Browser and the WMO
(World Meteorological Organization) Search buttons, which provide access to the text database. All of the
options in the Toolbar are described below.

Exhibit 4.2.2.2-1. Text Display Window Toolbar

e AFOS Browser: A menu button that opens the AFOS Browser, which is discussed further in
Subsection 5.1.3.

e Load History: A menu that contains a History List of text product identifiers from previously loaded
text products. Maximum list size is 20. If no products have been loaded, this menu contains a "-" sign as
a placeholder.

When a text product identifier is selected (click on the identifier with mouse Button 1), it appears in the
AFOS, WMO, or AWIPS entry box. Press the Enter key on the keyboard to load this text product to
the Text display window. For AFOS products, the -1:, -2:, or ALL: prefixes can be used.

e WWMO Search: A menu button that opens the WMO Search dialog box. If you click this "cold," a
warning dialog appears with a message that you must first enter the TTAAii and/or CCCC portion of
the WMO header (in the boxes in the second row) to perform the search. Refer to Section 5.1 for
details.

e Enter Editor: Enables the Text Editor, which is described in Section 5.2.

e Accum: A check button that enables or disables the capability to accumulate text by appending
subsequent text product retrievals to the display window.

e Update Obs: A check button that enables/disables automatic display of the most recent observations,
like METARSs, in the display window.

e Clear: Clears the Text display window.

e AFOS Cmd: An entry line which is used to type in an AFOS PIL. When you hit the Enter key on your
keyboard, the AFOS text product is displayed in the Text display window.

e WWMO TTAAIi CCCC: A two-part entry line that allows you to type in the WMO Data Type and Area
Indicator (TTAAII) and/or the International Location Indicator (CCCC) portion of the text product ID
that you want to display. If you enter only the TTAAII or the CCCC, and then press the Enter key, the
WMO Search dialog box will open containing the appropriate lists of WMO products. Refer to Section
5.1 Retrieving WMO and AFOS Text Products, for further details.
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e AWIPS ID: You can type an AWIPS ID (NNNXXX) in this entry line. When you hit Enter, the WMO
Search dialog box will open to allow you to select the specific version of the product you requested.
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5.0 Getting Started Using AWIPS Textual User Interface

This chapter introduces you to the Text Workstation for working with text products. It includes practice
modules for getting you familiar with the Text Workstation and the Textual User Interface (TUI).

This chapter includes the following sections:

e Section 5.1: Retrieving WMO and AFOS Text Products

Section 5.2: Editing Text Products

Section 5.3: Working with Text Scripts

Section 5.4: Working with Alarm/Alert Feature

Section 5.5: Practice Modules (Tutorials) for AWIPS Textual User Interface
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5.1 Retrieving WMO and AFOS Text Products

From the Text display window, you can retrieve WMO and AFOS Text products using the WMO Browser for
WMO products, or the AFOS Browser for AFOS products. The sections that follow describe how to use each
browser when searching for a particular Text product.

With AWIPS II, we are transitioning from AFOS to AWIPS text product identifiers. The AWIPS Product
Identifier is a two-line product identifier made up of the WMO ID on the first line and the AWIPS Identifier
(AFOS NNNxxx) on the second line. The WMO Header and the AFOS Header, as shown in Exhibit 5.1-1,
together make up the AWIPS Product Identifier.

Exhibit 5.1-1. Text Product Headers

The WMO Search feature allows you to look for and load WMO text products into the Text display window.
It is designed differently than the AFOS Browser because WMO text products generally do not have unique
IDs as do AFOS text products. To search for a WMO product, you must already know a portion of the ID,
such as the TTAAII (Data Type and Area Designator) or the CCCC (International Location Indicator), and
type it into the appropriate entry line of the Text window. Brief descriptions of the WMO IDs and the WMO
Search dialog box follow. You can obtain complete information on the format of WMO Headers from the
following website:

http://www.nws.noaa.gov/tg/head.php
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5.1.1 WMO Message Search

The entire WMO message, including the start and end lines, is often called the WMO "bulletin." The bulletin
structure contains the WMO Abbreviated Heading Line, sometimes called the "product ID," or more often
the "header," and the body, which is often called the "text" of the message.

e The Product Header Line Components: The AWIPS Product Identifier is composed of two lines: the
WMO Abbreviated Heading Line in the first row, and the AWIPS Identifier (Al) Line in the second
TOW.

WMO Abbreviated Heading Line: T1T2A1A2ii CCCC YYGGgg (BBB) (cr) (cr) (If)
AWIPS ID: NNNxxx (cr) (cr) (If)

Each component of the Abbreviated Heading Line is defined below.
o T1T2: Data type and/or form designators

» T1: This is an alpha character that designates the general code form of the contents of the
bulletin. Refer to WMO Manual 386 Table A in the following website for detailed
information: http://www.nws.noaa.gov/tg/table.html

m T2: This is another alpha character that designates the data type. Its definition depends on
the T1 designator in Table A, and can be found in Tables B1 through B6 of the WMO
Manual.

A useful cross-reference list between AFOS PILs "NNN" of the CCCNNNXXX used to
identify products in the AFOS system and the WMO abbreviated heading "TT" groups can
be found at http://www.nws.noaa.gov/datamgmt/x_ref/xr04_X ref by NNN.html

o A1AZ2: Geographical area and/or data type designators

= Al: Al is taken from WMO Manual 386 Tables C1 through C6 depending on the T1
designator in Table A. It is an alpha character that defines the geographical area that the
text of the bulletin covers.

» A2: This alpha character designates the geographical area, or may define the forecast
period. It is taken from WMO Manual Tables C1 through C5 depending on the T1 in Table
A.

o ii: These two numbers are used to differentiate between two or more bulletins that contain data
in the same code, originate from the same geographical area, and have the same originating
center. The set of "'ii"* numbers are used to indicate the bulletins for global, interregional,
regional, and national distribution. The national distribution may have further definition as in the

case of the U.S. National Weather Service.

Note 1: Refer to WMO Manual 386, paragraph 2.3.2.2, or to Table D1 or D2 depending on
the T1 designator in Table A.
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o CCCC: This four-letter ID is the international location identification of the processing center that
generated the bulletin. Once the bulletin has been originated or compiled, the CCCC must not be
changed even if the bulletin in question has to be edited at another center.

The NWS also has some special CCCC practices which are used to further define products
sources within the National Centers for Environmental Prediction (NCEP). Following
International Civil Aviation Organization (ICAO) standards, the first character is "K" for the
CONUS offices, followed by the three-letter FAA identifier. For offices outside the CONUS, the
first two characters are PA for Alaska, PH for Hawaii, and TJ for Puerto Rico followed by an
additional two characters. The national centers use a national practice form of the K<CCC> for
CCcC.

N

Note 2: The three-letter AFOS node identifier CCC is no longer valid in the AWIPS
environment and will not appear in the AWIPS headings.

o YYGGgQ: This is the International Date-Time Group, and is defined as follows:
» YY: This pair of numbers identifies the day of the month (01, 04, 10, etc.).

» GGgg: This is the Hour-Minute Group. For bulletins containing meteorological reports
intended for standard observation times, the time is the standard UTC observation time.
For aerodrome, route and area (acronautical) forecasts, the full UTC hour (the last two
digits are 00) preceding the transmission time is used. For other forecasts and analyses, use
the standard UTC observation time on which the forecast or analysis is based. For other
messages, use the UTC time of compilation to the nearest minute.

o BBB: This three-letter Indicator Group is used to define the type of message being transmitted,
whether it is a correction, an amendment, a delayed transmission, or a normal transmission. Refer
to Section 5.2, Editing Text Products, for more information.

o NNNxxx: This is the AWIPS Identifier (Al) Line and is composed of from four to six characters
of the AFOS PIL without the CCC.

Note 3: The one- to three-character XxX (product designator) is identical to the AFOS XxX.
If the xxx is less than three characters, the character(s) are left justified and filled with
blanks to fill the field. The field is expandable to accommodate five-character product
designators that are typical for some sites.
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5.1.2 WMO Browser Search

The WMO Browser (Search) dialog box, as shown in Exhibit 5.1.2-1, appears only after you have entered a
portion of the WMO ID in the WMO TTAAIi CCCC: field, and then selecting the WMO Search button on

the window's toolbar.

Exhibit 5.1.2-1. WMO Browser Dialog Box
The WMO Browser dialog box contains the following features:

e TTAAIi: A listing of the WMO Data Type and Area Indicators whose contents vary depending on what
is contained in the other lists within the dialog box.

e CCCC: A list of the International Location indicators. Its contents vary depending on what is
contained in the other lists within the dialog box.

e AWIPS ID: A list containing the AWIPS ID that corresponds to the WMO TTAAII ID. If there is no
corresponding AWIPS ID, then a dummy or blank ID appears in this column.

e DDHHMM: Contains an inventory of the issuance dates/times of the most recent versions of text
products. The DD signifies the date, HH the hour, and MM shows the minutes. If you search only for
the TTAAII portion of the WMO ID, then the DDHHMM list contains the latest issuances of that
product for every CCCC site.

e BBB: A column that indicates if a text product is an Amendment (AAX), a Correction (CCX), or
Delayed (RRX).

e Load and Continue: A menu button that displays the selected text product and leaves the WMO
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Search dialog box open.
e Load and Close: Displays the selected text product and closes the WMO Search dialog box.

e Close: Closes the WMO Search dialog box.
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5.1.3 AFOS Text Product Browser

The AFOS Text Product Browser, as shown in Exhibit 5.1.3-1, is opened from the AFOS Browser toolbar
button (see Exhibit 5.1.2-1).

Exhibit 5.1.3-1. Text Browser Dialog Box

The AFOS Browser allows you to look through and choose text products by AFOS ID to be displayed in a
text window. To make the selection faster and easier, products have been broken down into three parts: Node,
Ctgry (Category), and Designator, as illustrated in Exhibit 5.1.3-1. This mimics the nine-character AFOS
Identifier, CCCNNNXXX. Each component of the Text Browser dialog box is described below.

Origin: An options menu that allows you to select the geographical area (Regional, East, Central, or
West) of the United States or International locations whose text products you want to display.

Class: An options menu with a list of the types of text product you wish to retrieve (e.g., Public,
Aviation, or Hydrological).

Node Menu (CCC): A central forecast office, listed by its AFOS Node ID, where text products are
collected and stored. Also included at the bottom of this list are the identifiers for all radar
alphanumeric products.

Category Menu (NNN): The name of the text product.

Designator Menu (XXX): Provides the site or area for which the text product applies. Valid times are
also provided to the right of each designator.

Note: For CCC, NNN, and XXX, click mouse Button 3 (B3) over an item to see full
identification, or click the Help button to get information on each of the items in the associated
list.

Display: Shows prefixes used to select special groupings of text products. ALL: returns all versions of
a specific product from the database; A: retrieves all instances of a particular product type (e.g.,
LAXMTR) from the current hour.
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e Load and Continue: Displays the selected text product and keeps the AFOS Browser open for further
browsing.

e Load and Close: Displays the selected text product and then closes the AFOS Browser.

e Close: Closes the AFOS Browser.
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5.2 Editing Text Products

Editing requirements for CAVE are accommodated by the use of an online Text Editor. You can perform
simple editing by selecting the Enter Editor button on the Text display window Toolbar to open the AWIPS
Header Block GUI, as shown in Exhibit 5.2-1.

Exhibit 5.2-1. Enter Editor Toolbar Button to Open AWIPS Header Block

The AWIPS Header Block GUI shown above in Exhibit 5.2-1, contains a 9-character ID example of
WBCMTRDCA, which is the PIL for the DCA METAR oservation.

Note 1: The addressing of the text message can be accomplished either by filling in the top half of the
AWIPS Header Block GUI (TTAAii, CCCC, BBB, BBB Version), or by filling in the bottom half, as
shown in Exhibit 5.2-1. Which method to use is user-preference, based on which set of information is
more readily available to the user.

After you complete the AWIPS Header Block, clicking Enter closes the AWIPS Header Block GUI and
places the Text display window in the Editing Mode (Now Editing), as shown in Exhibit 5.2-2.
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Exhibit 5.2-2. Text Display Window in Editing Mode

Once in the Text Editor, several buttons on the CAVE Menu Bar appear in subdued text, while new editing
commands are activated in the File, Edit, and Options menus. In addition, a Toolbar containing editing

functions appears.

Note 2: The header lines can only be edited using the Edit Header button on the Text Editor Control Bar.

Note 3: Keyboard focus determines which Text window or which component (menu, entry box, etc.) of
a Text window receives the keyboard input. Only one window has focus at a time. Your account is
probably set with "Focus Follows Mouse", which means that a window gets keyboard focus when you
move the pointer into it. Notice that the Title Bar of the window with the focus is colored blue. (Dialog

boxes automatically receive focus when they appear.)

Note 4: Refer to Tables 5.2.2-1 through 5.2.2-4 in Subsection 5.2.2 for keyboard shortcuts.
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5.2.1 Toolbar Editing Commands

Once in the Text Editor, a second toolbar containing editing functions appears, as shown in Exhibit 5.2.1-1.

Exhibit 5.2.1-1. Toolbar Editing Commands

Descriptions of the editing functions follow.
Save

This menu button stores the product that you are currently editing in the text database, but continues the edit
session. The product is not transmitted outside your local site.

Cut

This menu button deletes a text selection. You can also cut text by clicking and holding mouse Button 3 (B3)
in the Editing window. This brings up a pop-up menu containing the Cut option.

Copy

This menu button reproduces a text selection. You can also copy text by clicking and holding B3 in the
Editing window. This brings up a pop-up menu containing the Copy option.

Paste

This menu button places copied text at the cursor location. You can also Paste text by clicking and holding
B3 in the Editing window. This brings up a pop-up menu containing the Paste option.

Fill

This menu button removes hard carriage returns from selected text.
Edit Header

This menu button opens the AWIPS Header Block dialog box, which contains text product header
information.

The AWIPS Header Block accommodates both WMO (upper section of the AWIPS Header Block) and
AFOS IDs (lower section of the AWIPS Header Block). The fields are defined below as they apply to WMO
and AFOS IDs:

e TTAA.Ii: This field contains the WMO Data Type and Area Indicators.

e CCCC: This field contains the International Location Indicator.
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e BBB: The three-character "BBB" defines the type of message or the Indicator Group. Most messages

will be sent with this field set to "NOR" (normal), which is the default. Other Indicator Groups include
Delayed, Correction, Amendment, and are described below:

o RRXx: This is the Delayed Indicator Group which is used to transmit a collection of one or more
weather reports that are normally contained in the initial bulletin, but which were received after
the initial bulletin has been transmitted.

o CCx: This is the Correction Indicator Group which is used to transmit a bulletin containing
corrections to a previously transmitted bulletin.

o AAX: This is the Amendment Indicator Group which is used to transmit a bulletin containing
amendments to processed information that had been transmitted in an earlier bulletin.

Note: The 'x' version is set with the BBB Version button, which is enabled if RRx, CCx, or AAx
is selected. For more information on the Indicator Group "BBB," refer to
http://www.nws.noaa.gov/tg/bbb.html

e WSFO ID (optional): This field contains the AFOS site ID of the main node of the State Distribution
Circuit (SDC) to which the office originating the message belongs. This field is automatically filled in
with the SDC node of your local site.

¢ Product Category: Products are identified by a three-character AFOS PIL (e.g., TOR for tornado). A
list of categories can be viewed from the AFOS Browser Help menu by clicking on the help button
adjacent to the category selector.

e Product Designator: This field contains the AFOS ID of the site the message applies to, or a regional
ID for messages that apply to a larger region (such as UT for Utah). Usually this field is set to your
local site, but occasionally a site issues a message for another site.

For example, Denver (DEN) can issue a message that applies to Colorado Springs (COS), in which
case the product designator is COS. A list of AFOS IDs can be viewed from the AFOS Browser Help
menu by clicking on the help button adjacent to the node selector.

e Addressee: This field defines the site(s) to which you want a text product or message sent. In this field
you have a choice of three buttons: 000, DEF, and ALL. If you want the product to be stored in the
text database, but don't want it to be distributed, press the 000 button. Use the DEF address to send
products to a predefined group of sites (which usually includes neighboring sites). Refer to the AWIPS
System Manager's Manual for information on setting up your local "DEF." Use the ALL address to
send products to all sites.

e Enter: This button saves the AWIPS Header Block information, closes the AWIPS Header Block
dialog box, and places the Text display window in Edit Mode.

e Cancel: This button closes the AWIPS Header Block dialog box without saving anything .
Send

This menu button ends the editing process, stores the text product in the text database, and sends it to the
communications processor for transmission.
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Cancel

This menu button ends the editing session without saving any changes.

Attach

This menu button, activated when you are editing an administrative text message, opens a dialog box in
which you can enter a file path name of an attachment to add to your message. Refer to Section 5.3 for further

information.

INS/OVR (Insert/Overstrike)

This pull-down menu that contains the Insert Mode and the Overstrike Mode radio buttons. The choice you
make appears as either "INS" or "OVR" to identify the current editing mode you are using. You can also use
the "Insert" keyboard shortcut to toggle between the two modes.

Page 267



CAVE-D2D User's Manual AWIPS |1 Operational Build 13.4.1 - 31 July 2013

5.2.2 Keyboard Shortcuts

Tables 5.2.2-1 through 5.2.2-4 contain keyboard shortcuts used with the Text Display Editor.

Table 5.2.2-1. Keyboard Shortcuts - Select Functions

| Key Combination | Select Function
’Shiﬁ +Home ‘extend selection to beginning of line

|Ctrl + Shift + Home |extend selection to top of document

’Shjﬁ + End ’extend selection to end of line

|Ctrl + Shift + End |extend selection to bottom of document

|Shjﬁ + Page Up |extend selection up one screen

|Shjﬁ + Page Down |extend selection down one screen

|Shiﬁ + Left Arrow |extend selection to previous character

’Ctrl + Shift + Left Arrow ‘extend selection to beginning of previous word
|Shift + Right Arrow |extend selection to next character

|Ctrl + Shift + Right Arrow |extend selection to beginning of next word
|Shift + Up Arrow |extend selection to previous line

|Shiﬁ + Down Arrow |extend selection to next line

Table 5.2.2-2. Keyboard Shortcuts - Delete Functions

| Key Combination | Delete Function
|Backspace |delete left character

’Shjﬁ + Backspace ‘delete selection

|Ctrl + Backapace |delete word

’Delete ’delete right character or selection
|Ctrl + Delete |delete to end of line

|F 6 |delete right character

|Shjﬁ +F6 |undelete character

|F7 |de1ete word

’Shjﬁ +F7 ‘undelete word

|F8 |delete to end of line

|Shjﬁ +F8 |undelete line
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Table 5.2.2-3. Keyboard Shortcuts - Edit and Application Functions

] Key Combination

| Edit and Application Function

|Esc |move back up one menu level

|Ctrl +F1 |start spell checker

|F2 |inv0ke search (and replace)

|Alt +F4 |close text window (no saving)

’FS |print contents of window

|F10 |bring up first submenu of the main menu
’Ctrl +C |copy

|Ctrl +P |print contents of window

|Ctrl +V |paste

|Ctrl +X |cut

|Insert |togg1e between insert and overstrike mode
’Shjﬁ + Insert |paste

|Ctrl + Insert |copy

|Shjﬁ + Delete |cut

Table 5.2.2-4. Keyboard Shortcuts - Cursor Movement and Position

| Key Combination

| Cursor Movement and Position

|Home |position to beginning of line

|Ctrl + Home |positi0n to top of document

|End |position to end of line

’Ctrl + End |positi0n to bottom of document
|Page Up |p0siti0n up one screen

’Page Down |positi0n down one screen

|Leﬁ Arrow |m0ve to previous character

|Ctrl + Left Arrow |position to beginning of previous word
|Right Arrow |move to next character

|Ctrl + Right Arrow |p0siti0n ot beginning of next word
’Up Arrow |move to previous line

|Down Arrow |move to next line
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5.3 Working with Text Scripts

Text Scripts are macro-like programs that allow you to create and save text products that can be recalled at
any time. The simple script commands (such as Load, Clear, Wait, and Accumulate) are used to control how
the textual information appears in the Text window.
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5.3.1 Text Script Menus
Text Script Menu

The Text Scripts dropdown menu, as shown in Exhibit 5.3.1-1 is only accessible from the Text Workstation (XT).

Note 1: Scripts are not available for the Text display window opened from a CAVE session.

Exhibit 5.3.1-1. Text Scripts Dropdown Menu
The Scripts dropdown menu includes the following functions:

e Edit...: A Scripts menu option that opens a Text Script Editor window, as shown in Exhibit 5.3.1-2.

Exhibit 5.3.1-2. Text Script Editor Window with Sample Script
The Text Script Editor window includes a Menu Bar with the following dropdown menus.
o File:
A dropdown menu that contains commands for viewing, saving, and printing text scripts.
= New (Ctrl+T): Opens a new script.

= Open (Ctrl+0): Opens the Open Script File dialog box.
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Note 2: You can open an existing script by double-clicking on the Script File Name or
selecting the Script File Name and pressing OK.

Save (Ctrl+S): A menu option that saves the current script.

Save As (F3): A menu button that opens the Save Script As dialog box, which allows you to save
a script under a different name.

Note 3: The Filename field contains a period (.) at the end of the path listing. To avoid
creating a hidden UNIX script file, type over the period when you provide a filename.

Rename: Used to select a script to rename. Another dialog comes up in which you enter the new
name.

Delete: A menu button that opens the Delete Script dialog box and enables you to delete a script.

Print (Ctrl+P): A menu button that makes a hard copy of a script.

m Close (Alt+F4): A menu button that closes the Script Editor dialog box.

o

Edit: A dropdown menu that contains standard editing options, which are nearly the same as the Text
display window in the Editing Mode. The keyboard shortcut options, as shown in Subsection 5.2.2, also
apply here.

o

Options: A dropdown menu with options that are also the same as the Text display window in the
Editing Mode.

o

Execute: A dropdown menu that contains the controls that operate the scripts.

@)

Help: A dropdown menu that contains the basic and advanced script commands, as shown in Exhibit
5.3.1-3. Highlight the desired command type. Each Basic Script Command is briefly defined in Table
5.3.1-1.

Exhibit 5.3.1-3. Basic and Advanced Script Commands from Help Menu

Page 272



CAVE-D2D User's Manual AWIPS |1 Operational Build 13.4.1 - 31 July 2013

Basic Script Commands: Table 5.3.1-1 lists the basic script commands and their definitions.

Table 5.3.1-1. Basic Script Command Definitions

| Script Command | Definition

|accum |Turns accumulate off or on when used with 0 or 1, respectively.

|clear |Clears the Text Workstation Window

|10ad |L0ads the specified product into the Text Workstation Window

|repeat |Repeats the commands specified within the loop body the specified "count”" number of times.

|run |Run a specified file (e.g., a script)

|Wait |Wait for the user to hit the "Continue" button or menu item.

|wait |Wait the specified number of hours, minutes, and seconds before continuing.

wait until Waﬁt until the specified number of minutes after the hour before continuing (e.g., "wait until 5" will
wait five minutes after the current hour, and if already passed, the next hour).

Advanced Script Commands: The advanced script commands are used when setting up macros and
other office programs and are intended for users with programming skills and an understanding of
UNIX. For additional help with each command, click the Help button in the lower left corner of
Command Help list. This opens Mozilla to a Universal Resource Locator (URL) that displays help pages
with fundamental information and examples of how to use this command. Each command has its own
Web page.

e Run...: A Scripts menu option that starts a Text Script, which runs in the Text display window. As a script
runs, status messages are given at the bottom of the Text display window, as shown in Exhibit 5.3.1-4.

Exhibit 5.3.1-4. Running Script and Status Message in Text Display Window

e Show Output: A Scripts menu option checkbox, which when checked opens the Script Output dialog box to
let you know if the script is running correctly.

e Continue: A Scripts menu option that resumes the running of a paused script.

e Skip Wait: A Scripts menu option that lets you ignore a "Wait" command in a script. When a script is running,
a Skip Wait menu button is available at the bottom of the Text display window, as shown in Exhibit 5.3.1-4.
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e Cancel: A Scripts option that interrupts a script that is running. When a script is running, a Cancel menu
button is available at the bottom of the Text display window, as shown in Exhibit 5.3.1-4.
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5.4 Working with Alarm/Alert Feature

The Alarm/Alert feature is initiated from the Text Workstation dialog box and allows you to set up and
receive Alarm/Alert messages. You may also select text products for which you want to be "alarmed" or
"alerted." You can specify a list of text products that are fetched from the database. A visible and/or audible
alarm alerts you when new versions have arrived. When new alarmed products are received, an observable
Bell, as shown in Exhibit 5.4-1, appears on the XT screen. The alarm bell remains on the screen until the
alarm is acknowledged.

Exhibit 5.4-1. Visible Alarm Bell Indicator

Note 1: The Alarm/Alert feature is workstation specific.

Current Alarm Queue

When you click on Alarm/Alert in the Text Workstation dialog box, the Current Alarm Queue dialog box
opens, as shown in Exhibit 5.4-2. The Current Alarm Queue dialog box provides information about the
products that are displayed in the Current Alarm Queue.

Exhibit 5.4-2. Current Alarm Queue
Three options are accessible from this dialog box.

e Open Display: A menu button that opens the Alarm display window. The Alarm display window
displays the alarmed or alerted text products.

The Alarm display window has the following capabilities.

o Print Window: Makes a hard copy of the alarmed or alerted text products displayed in the
window.
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o Print Entire Buffer: Makes a hard copy of all of the alarmed or alerted text products displayed
in the buffer.

o Clear: Clears the Alarm display window.
o Accumulate: Allows you to append incoming alarmed text products in the window.

e Display All: A menu button that opens the Alarm display window and displays all of the alarmed or
alerted text products.

e Product List: A menu button that opens the Alarm/Alert Products dialog box, as shown in Exhibit
5.4-3.

Exhibit 5.4-3. Alarm/Alert Products Dialog Box

Products with the word "Alarm" in parentheses send an audible signal. The Alarm/Alert Products
dialog box has the following capabilities:

o File: A dropdown menu that includes options Save, Save & Close, Close, Save as..., and
Load.... The first three options are discussed at the end of this section. The latter two allow you
to save and recall alarm settings that you might wish to apply at different times of the year or to
support different programs (e.g., public or aviation).

o New AA Entry: A menu button that opens the New Alarm/Alert Product dialog box, as shown
in Exhibit 5.4-4.
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Note 2: The Alarm/Alert feature does not allow you to set up alarms or alerts for text
products by WMO ID. You must still use the AFOS PIL.

Exhibit 5.4-4. New Alarm/Alert Product Dialog Box
The New Alarm/Alert Product dialog box has the following capabilities:

= Product ID: An entry box for a text product, identified by its AFOS PIL, that you want to
add to the Alarm/Alert Products list.

= Alarm: A toggle button that allows you to set an audible alarm for a product. If you do not
set this, the product is alerted but does not have an audible alarm. Products with the Alarm
toggle set will be listed in the Alarm/Alert Products list annotated with (Alarm).

m Optional Search String: A string that must be present in the product text in order to
trigger the alert. For example, you might be interested in a NOW product that mentions
fog.

m OK: Closes the New Alarm/Alert Product dialog box and adds the new Alarm/Alert
Product to the Products list.

m Cancel: Closes the New Alarm/Alert Product dialog box without making changes to the
list of alarmed products.

o New PA Entry: A menu button that opens the New Proximity Alarm Product dialog box, as
shown in Exhibit 5.4-5.

Exhibit 5.4-5. New Proximity Alarm Product Dialog Box
The New Proximity Alarm Product dialog box has the following capabilities:

m Product ID: An entry box for a text product, identified by its AFOS PIL, that you want to
add to the Proximity Alarm Products list. This feature allows you to be notified when a
specified product affecting a selected area is received.
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= Alarm/Alert: An option menu that allows you to set an audible alarm for a product. If you
select Alert, the product is alerted, but does not have an audible alarm.

m Action Cmd: This feature is not yet implemented.

= AOR: A check box to set notification for a product that affects your Area of
Responsibility (for a WFO, the CWA).

m AOR+Distance: Allows you to specify a distance in miles or kilometers beyond the AOR
where you wish to be notified.

m UGC List: List UGCs of interest here for notification of the specified product.
m OK: Saves the item to the Proximity Alarm list and closes the dialog box.
m Cancel: Closes the dialog box without making changes to the Products list.

o Change Entry: If you have clicked on a product in the AA or PA list, this button opens a dialog
box in which you can modify the product's alarm/alert settings.

o Delete Entry: A menu button that deletes a highlighted product from the AA or PA list.

o Save: A menu button that saves changes but leaves the Alarm/Alert and Proximity Alarm
Products dialog box open for additional work.

o Save & Close: A menu button that saves changes and closes the Alarm/Alert and Proximity
Alarm Products dialog box.

o Close: A menu button that closes the Alarm/Alert Products dialog box without making changes
to the Alarmed Products list. If you have made changes but have not saved them, you will be
asked to confirm.
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5.5 Practice Modules (Tutorials) for AWIPS Textual User Interface

This section gets you started (hands-on) working on the Text Workstation and with the Textual User
Interface.

This section includes the following practice modules:

e Starting and Exiting the Text Workstation - Subsection 5.5.1

Browsing and Displaying Text Products - Subsection 5.5.2

Requesting a Text Product from a Remote Site - Subsection 5.5.3

Editing a Text Product - Subsection 5.5.4

Working with Text Scripts - Subsection 5.5.5
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5.5.1 Starting and Exiting the Text Workstation
Module 16: Starting and Exiting the Text Workstation

This module starts you off in your use of the Text display (the single minitor attached to the XT CPU.
Objective 16.1 - Opening the Text Display from the Text Workstation

1. In the Account Box of the Login Window, enter your username.

2. In the Password Box, type your password.

Note: Your account may be configured to start the Text Workstation (XT) when you log in. If
not, click mouse Button 1 (B1) over the root (colored background) and select
Start CAVE (Ix) / TextWS (xt) from the Start menu.

3. After the Text Workstation software completes its start-up, three windows are displayed, as shown in
Exhibit 5.5.1-1.

e A Text Workstation dialog box
e A Text 1 display window

e A Monitoring Controller dialog box
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Exhibit 5.5.1-1. Text Windows that Appear Immediately Following Start-up - XT Workstation
Objective 16.2 - Opening the Text Display from CAVE

1. The Text display may also be started from the Graphic Workstation (LX) by selecting CAVE > New >
Text Workstation, as shown HERE.

2. After the workstation software completes its start-up, only two windows are displayed, as shown in
Exhibit 5.5.1-2.

e A Text Workstation dialog box

e A Text 1 display window
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Exhibit 5.5.1-2. Text Windows that Appear Immediately Following Start-up - LX Workstation
Objective 16.3 - Exiting the Text Display

1. Open the File dropdown menu from the Text Workstation dialog box and select Exit.

2. In the Confirmation dialog box, answer Yes. The Text Workstation dialog box and the Text display
window clear from the screen.
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5.5.2 Browsing and Displaying Text Products
Module 17: Browsing and Displaying Text Products

This module provides practice on browsing and displaying text products in a Text display window.
Objective 17.1 - Using the AFOS Browser to Locate a Text Product

1. In the Text window, on the Toolbar, click AFOS Browser.

2. In the AFOS Browser window, from the Origin list, select West.

3. From the Class list, select Public.

4. In the Node, Ctgry, and Designator columns, do the following:
a. In the Node column, select GTF (Great Falls, Montana).
b. In the Ctgry column, select NOW.
c. In the Designator column, select GGW.

5. Select the Load and Continue button and observe the Nowcast for Glasgow, Montana
(GTENOWGGW) as it is displayed in the Text window.

6. In the Text window, on the Toolbar, click the Clear button.

7. Now use the AFOS Browser to display other text products.

Note: The Text Display Product Browser menus respond to and change the selections you make. For
example, when you choose a Node, the Category menu lists only the categories available under that
Node.

Objective 17.2 - Using the AFOS Command to Display a Text Product

1. Clear the Text window that you used in Objective 17.1.

2. In the AFOS Cmd entry box, type ALL:BOSMTRBOS and hit Enter on the keyboard. Observe that
all the Boston METAR observations in the database appear in the Text display window.

3. Now load and display other text products using the AFOS Cmd entry box.

Objective 17.3 - Using a State's Abbreviation as a Shortcut for Displaying a Text Product
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1. Clear the Text display window.

2. In the AFOS Cmd entry box of a Text display window, type XX.MTR, where "XX" is the
abbreviation of your state. All METAR observations from your state appear in the Text window.

3. Now try to load other text products using this format.
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5.5.3 Requesting a Text Product from a Remote Site
Module 18: Requesting a Text Product from a Remote Site

Use this module to practice requesting a product from a remote site (Request/Reply). Request/reply is
initiated from the Text window. Request/reply is needed when a single product was either lost due to an
outage or not received due to other reasons.

Objective 18.1 - Requesting a Text Product from a Remote Site

1. On the Text Workstation bring up a Text window. Click on the File button.

2. Select "Request from Remote Site" from the dropdown menu. A "Send Request" header block
window will be displayed.

3. Enter the WFO ID, Product Category, and Product Designator of the product you want to request.
These are the three fields that make up the AFOS PIL. For example, WBCMTRDCA is the PIL for
the DCA METAR observation.

4. For the addressee, enter the three-character ID of the site where the request should be sent, normally
your neighboring site, or use DEF for default request routing (see Notes below).

5. Select OK.

Note 1: If DEF is used for the addressee, the request will be sent to the "hub" site. The hub is the
WFO colocated with the sending site's RFC. If the request cannot be satisfied there, it will
automatically be sent to the WNCEF.

Note 2: All fields must be entered as three-character IDs. If four characters are input, only the
first three characters will be used. There will be no error message.

Note 3: If no products have been returned within 1-2 minutes, an error message will be displayed
on the Text Workstation. If this happens, send the request to another site if the data are still
needed.

Note 4: If data are returned in response to a request, they are automatically added to the
database. The product time on the browser menu will be updated. This is the only product
notification the user will see.
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Note 5: You cannot specify a product time when requesting data from another site. The most
recent product in the remote site's database will be returned if it is more current than the product
in the requesting site's database. The remote site will not satisfy a request with an older product.
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5.5.4 Editing a Text Product
Module 19: Editing a Text Product

Use this module to practice editing a text product.
Objective 19.1 - Editing a Text Product

1. Load a text product into one of the Text display windows.

2. Press the Enter Editor button in the Control Bar to initiate an editing session.

3. A Header Block dialog box appears. Verify that the information is correct and click the Enter button.
4. In the text area, highlight a line of text and press the Cut button in the Control Bar.

5. Put the cursor at a different location in the text product and click the Paste button. The highlighted
text is inserted at the cursor.

6. Try some of the other edit functions, which perform much like a word processing program.

7. When you are done practicing with the Text Editor, click the Cancel button to end your editing
session.
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5.5.5 Working with Text Scripts

Module 20: Working with Text Scripts

This module provides practice in working with text scripts.

Objective 20.1 - Editing a Simple Text Script

This objective shows you how to edit a script using the basic script commands.

1.

2.

3.

7.

8.

Log into the Text Workstation (XT), open the File menu and select your User ID.
Open a Text display window.
From the Scripts menu, select Edit....

From the Help menu of the Script Editor window, select On Basic Commands. Keep this list to the
side for reference.

. In the Script Editor window, type the following:

clear()

accum(on)
load(*'okcmtr000™)
wait('00:00:10")
load("'okcrtpok™)
wait('00:00:10")
load(*"okcccfoun™)

Under the File menu, select Save As.... When the Save As dialog box appears, name the script
test.script. The complete path name is

/data/fxa/scripts/<your user ID>/test.script
Once you have saved your script, select OK in the Save As dialog box.

Close the Script Editor dialog box.

Objective 20.2 - Running a Text Script

Now that you have written a Text Script, this objective shows you how to run it.

1.

2.

From the Script menu, select Run. When the Run Script dialog box appears, double-click test.script.
The selected script should start running immediately.

Observe the OKCMTRO000 Product as it is displayed in the Text display window. Notice also the
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status messages at the bottom of the window.

3. The script pauses 10 seconds before loading the OKCRTPOK Product and again before loading the
OKCCCFOUN Product.

4. Once the script is done, the status message disappears and the three OKC Products are accumulated
in the Text display window.

Objective 20.3 - Displaying Output Messages

1. From the Script menu, toggle on the Show Output checkbox.
2. Repeat Steps 1-4 in Objective 20.2.

3. Observe the messages in the Show Output dialog box.
Objective 20.4 - Deleting a Script

1. From the Script menu, select Edit....

2. From the File menu of the Script Editor window, select Delete.... The Delete Script dialog box
appears.

3. Choose the test script that you wrote in Objective 20.1 and click OK. A confirmation dialog box
appears. Press Yes to delete the script.
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6.0 WarnGen

The CAVE Warning Generator function is handled by a system extension called WarnGen. WarnGen enables
you to issue flash flood, severe thunderstorm, tornado, and other short-term warnings for a single storm or a
line of storms. In addition, you can issue text products (follow-up statements) that update the progress of the
storm, cancel the warning if conditions change, re-issue another warning on the same storm, or note the
expiration of the warning. WarnGen also enables you to provide warning backup support to neighboring sites.

This chapter provides an introduction to WarnGen and explains how to use it to issue warnings and follow-up
statements.

This chapter includes the following sections:

e Section 6.1: Overview of Capabilities

Section 6.2: Operating Modes

Section 6.3: Starting WarnGen

Section 6.4: Automated Insertion of Dam Break Data into FFW/FFS

Section 6.5: Using WarnGen
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6.1 Overview of Capabilities
General Functionality

The WarnGen function utilizes both the CAVE Graphics display and the Text display. WarnGen is activated
from any of the graphics displays, and can be run on multiple displays simultaneously. Once started, WarnGen
lets you:

¢ Choose backup sites, if necessary.

Select to warn on a single storm or a line of storms.

Establish a storm track (if appropriate to the type of warning) and designate a warning area.

Designate the type and duration of the warning or follow-up statement.

Choose an option to be included in the warning or follow-up statement text.

Send the warning or follow-up statement information to the Text display where internal consistency
checks are performed.

Choose whether to send (Restart) or abort (Close) the warning or follow-up statement.
Text Display

WarnGen translates the storm path (if one is designated) into text describing the speed and direction of the
storm, identifies the counties and cities affected by the warning, and generates warning text, including any
selected options. From the Text display, you can review and edit the automatically generated text.

The draft text warning is checked for the following:

e Correct header information

Proper UGC and VTEC codes

Time and Time Zone consistency

Correct product type

Mass News Dissemination (MND) consistency
e Contents
e Presence of closing $$

If there are any problems, specific alert boxes appear to notify you. Once you send the product, a
confirmation box pops up asking you to verify the send or abort the transmission.
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Note 1: WarnGen can be run on any scale; however, because essentially all warnings are restricted to
your County Warning Area (CWA), the preferred scales are State(s) and WFO. The choice of scale is
entirely up to you and should be determined by what is most appropriate for the warning situation at
hand.

Note 2: You can overlay WarnGen on any data source, but the most useful data sources are radar and
satellite. You are most likely to zoom in on the threatened area using these data sources. The choice of
data source is entirely up to you and should be determined by what is most appropriate for the warning
situation at hand.

Warn by Polygon

WarnGen accommodates a polygon-centric approach to warnings generated on AWIPS. Users can provide a
better-quality warning to the public by defining a more specific area, thereby reducing the number of people
unnecessarily warned.

The following functionality is present in Warn By Polygon:

e The hatched area on the display, rather than the polygon you draw, will be described by the LAT...LON
coordinates in the text. Corollaries of this include the following:

o The warned area may not cross your CWA boundary.

o For non-marine products, the warned area will not extend over water, and for marine products,
the warned area will not extend over land.

¢ For follow-up statements, the area of the warning may be reduced but not expanded.
e The location and motion of the weather event will be encoded below the LAT...LON line.

e Warning templates can be configured to list affected basins, just as they historically have listed
counties.
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6.2 Operating Modes

WarnGen can be operated in three modes:
1. Operational Mode: Live communication that is broadcast to the public
2. Test Mode (Comms Live): Live communication with Test message that is broadcast to the public

3. Practice Mode (In-House): In-house communication that is not broadcast to the public.

The background color of the CAVE-D2D screen, as shown in Exhibit 6.2-1, changes to reflect the mode
setting.

Exhibit 6.2-1. Graphics Display Color for WarnGen Modes

Test Mode vs. Practice Mode

Operational Mode is the Default operating mode, where warning messages are sent out to the public. The
Test and Practice modes prevent errant test messages from being sent out to the public. Although the main
reason for using these two modes is to learn warning generation procedures, all generated text products are
affected, not just those created via WarnGen.

The specific differences between the Test Mode and the Practice Mode are described in Table 6.2-1.
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Table 6.2-1. Test Mode vs. Practice Mode
| Test Mode | Practice Mode

Products are created in test format with the
appropriate VTEC plain language modifications.

‘Products are stored in primary text database. ‘Products are stored locally in flat files.
‘Products are sent out over the WAN. ‘Products are never sent out over the WAN.
‘Triggers will fire. ‘Triggers will not fire.

Communications testing occurs to verify that the
dissemination paths to the outside world are working |  —ememeeee
correctly.

---------- Practice Mode allows offline testing of applications.

Changing Modes
To change from Operational Mode to either Test or Practice mode:

1. Ensure you are logged into both the LX and the XT workstations and that CAVE is not running on
either workstation.

Note 1: Offices with CWSU AWIPS remote display connections should not attempt Test or
Practice modes on the workstation running the CWSU AWIPS remote display without
coordinating with the associated CWSU. As long as the CWSU has the AWIPS remote display
running, the affected workstation cannot be placed in Test or Practice mode.

2. On the LX workstation, click mouse Button 1 (B1) over the background display to open the AWIPS
Start-up Menu.

3. From the AWIPS Start-up Menu, select Test Mode Control Program, as shown in Exhibit 6.2-2.

Exhibit 6.2-2. AWIPS Start-up Menu - Test Mode Control Program
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4. The Test Mode Control dialog box opens with Operational Mode active. To change to either Test or
Practice mode, select the appropriate button, as shown in Exhibit 6.2-3. When you are in Test or
Practice mode, the only eligible action you can take is to switch back into operational mode, indicated
by the mode button not being grayed out.

Exhibit 6.2-3. Test Mode Control Dialog Box - Selecting Mode

When switched to the Test or Practice mode, a flashing Mode Indicator, as shown in Exhibit 6.2-4,
appears in the lower-left corner of both the Graphics display and the Text display to indicate the mode
1s activated.

Exhibit 6.2-4. Mode Indicator
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Note 2: You can also run the command from a Terminal window. After navigating to the directory
where Test Mode Control Program (TMCP) is located (e.g., /ust/local/cave/caveEnvironment),
run the TMCP (e.g., /TMCP).

5. Start CAVE and note the background color of the Graphics display, as shown in Exhibit 6.2-1, which
indicates the selected mode setting.
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6.3 Starting WarnGen

Note 1: Make sure the appropriate mode is set before starting WarnGen. Refer to Section 6.2. The
exhibits shown in this chapter are representative of the Practice Mode.

Activate WarnGen by clicking the yellow WarnGen button, located on the right side of the CAVE toolbar, as
shown in Exhibit 6.3-1. The WarnGen dialog box opens and the “Drag me to storm” Centroid is shown on
the Graphics display, indicating that the CAVE display is in Editable Interactive WarnGen mode.

Exhibit 6.3-1. Starting WarnGen (Practice Mode Shown)

Note 2: The color of the WarnGen dialog box is determined by the mode setting. Refer to Section 6.2.
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WarnGen Dialog Box

The WarnGen dialog box, shown in Exhibit 6.3-2, is divided into nine sections:

Exhibit 6.3-2. WarnGen Dialog Box (Practice Mode Shown)

1. Backup

2. Track type

3. Edit

4. Redraw Box on Screen from, including Warned Area Visible

5. Product type, including Follow-up Statements or Re-Issuing Warnings
6. Time range

7. Options window (provides important detailed information)

8. Instructions

9. WarnGen Control Buttons

Each section of the WarnGen dialog box is described below.
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Backup

This section of the WarnGen dialog box contains an option menu to select a CWA for backup operations. To
use Service Backup, your Site Manager must run the localizations for your surrounding CWAs in advance of
a warning situation. When you select a CWA other than your own for service backup, the WarnGen dialog
box disappears for a brief moment. When it reappears, the option menu turns yellow, and any warning text
messages will include your site name as the issuing office in the text header.

Track type

The track type allows you to choose whether you want to warn on a single storm or a line of storms. The
appropriate storm or line location information is automatically mentioned in the warning message text.

Edit
This set of radio buttons allows you to choose to edit the warning box, the storm track, or both (default). An
example of when you might choose one of the alternates is a case where you are warning on a line of storms

and there are too many editing handles on the display to be managed easily.

Redraw Box on Screen from

These buttons redraw the warning area.
e Track: This button draws a trapezoid based on the storm track you have established.

e Warned/Hatched Area: This button draws a polygon around the hatched area. This is used, for
example, when you are creating a follow-up product (SVS, FFS, FSL, MWS) and you have expanded
the polygon beyond the allowable hatched area, or in a case where your polygon extends out of your
CWA.

e Dam Break Threat Area: This button is used only when you are creating a Dam Break product and
have selected a 'dam break' primary cause and a specific dam. If used in other cases, nothing happens
on the display, and you will see a note in the Instructions box at the bottom of the WarnGen dialog box.

e Warned Area Visible: This checkbox toggles the hatching that is used to highlight the warning area or
counties that are selected with mouse Button 3 (B3).

Product type

From the Product type section, select the type of warning to be issued.

The radio buttons are selectors for Severe Thunderstorm, Tornado Warning, SVS - Update Cancel Expire
SVR TOR, SPS - Special Weather Statement, Flash Flood Warning, and Other. The Other radio button is
toggled on when you select an option from the adjacent field's drop-down list, which in Exhibit 6.3-2 shows
“SMW - Special Marine Warning.” Other product types include: other types of warnings, watches, and
advisories. These watches, warnings, and advisories are configurable to your site.

Note 3: The Other button is selected automatically if you select an option from the adjacent field.
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e Follow-up Capability: When local severe weather warnings or extreme wind warnings are issued, it is
customary to issue additional text products that update the progress of the storm, cancel the warning if
conditions change, or note the expiration of the warning. These text products are known as follow-up
statements. WarnGen includes a capability to assist you in issuing follow-up statements for existing
warnings, to cancel or continue existing warnings, or to re-issue additional warnings based on existing
warnings. These follow-up products will at a minimum inherit key characteristics from the originally
issued warning, including UGC codes, list of counties/zones, Valid Time Event Code (VTEC) type,
VTEC number, VTEC expiration time, and area of warning. Other characteristics are inherited as
appropriate for the warning type. Table 6.3-1 lists warning types and their appropriate follow-up

Table 6.3-1. Text Warning Types and the
Accompanying Follow-up Statements

Warning Type

| Follow-up Statement

Severe Weather
TOR - Tornado Statement (SVS)
SVR - Severe Severe Weather
Thunderstorm Warning Statement (SVS)
FFW - Flash Flood Flash Flood Statement
Warning (FFS)
SMW - Special Marine Marine Weather
Warning Statement (MWS)
EWW - Extreme Wind | e Wind (SVS)
Warning

Note 4: After a follow-up product is selected, the Create Text control button is enabled, while the

time characteristics (Time Range section) are disabled.

e Update List / Follow-up Action List: This drop-down menu in the Product type area of the WarnGen
dialog box contains a dynamic list of available actions and warning IDs to issue follow-up statements
when warnings are currently valid, or have expired in the last two hours. The contents of this list

depend on which Product type you have selected.

Note 5: Notice that each warning is identified with a follow-up prefix, the text product type, the

VTEC number, and the time of / until expiration.

The Update List / Follow-up Action List can have the following options:

o Update List: This selection will cause WarnGen to regenerate the follow-up action list to reflect
the current state of available products. Because there is currently no automatic notification when
new warning products are issued, you should manually select this option before issuing a
follow-up statement to ensure that you have all of the current choices presented.

o Cancellation (CAN): This prefix identifies all current warnings that can be cancelled.
o Continuance (CON): This prefix identifies all current warnings that can be continued.

o Cancel Second Part (CA2): In the case of following a combined flash flood/severe
thunderstorm warning with a flash flood statement, the CA2 prefix is used. This means to cancel
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the second part of the warning (the SVR) but continue the first part (the FFW).

o Expiration (EXP): This prefix identifies those warnings that have expired within the last two
hours, but can still be used as the basis for a reissuance.

o Correction (COR): This prefix identifies the correction of recently issued warnings of the same
type in the text database. The times and calls to action are locked.

o Extension (EXT): This prefix identifies an extension in time. Extensions in time are
implemented only for hydrologic products.

o Reissue (NEW): This capability is meant to help with reissuing additional warnings for an
ongoing quasi-steady severe weather event. When an SVR, TOR, FFW, or SMW product type is
chosen, the follow-up action list will list all warnings of that same type that are active or have
expired in the last two hours. Choosing one will initialize WarnGen with the state it had when
that warning was issued, including the call to action and original bullet selections. Hitting the
Redo Box button once will then advect the box to the approximate location it would have now,
assuming constant storm movement. In contrast to followup products, the box and time
characteristics are fully editable, because this results in a whole new warning being issued.
Reissue is identified by the prefix NEW.

In a case where there are several active warnings at once, you may need some guidance as to which is
the correct VTEC number to select for the product you wish to follow up. To help with this, the Local
Warnings and Marine Warnings graphics display the VTEC number of the warnings.

Identifying Warnings Graphically

To help distinguish the correct VTEC numbers for multiple warnings, you may want to use the
geographic selection feature. If you have selected a product type for which a follow-up action is
possible, clicking B3 will select the nearest product, and display its track and box on the map. This will
also cause the follow-up action list to reorganize itself to be sorted by distance from the selected point.
This is based on the assumption that if you make this type of selection and do not get the desired
product, it is very likely that the product actually desired was nearby, and thus it will end up very near
the top of the follow-up action list. (Normally, the list is sorted from newest to oldest.)

Service Backup and Follow-up Statements

Service backup issues are handled seamlessly by this capability. All necessary information about how
to issue the followup products (as well as assigning VTEC numbers for the initial warning products) is
now obtained by decoding the warning products from the text database. As such, as long as the text
database is correctly storing warning products from neighboring sites, there are no coordination issues
for service backup.

Time Range

Within the Time range section of the WarnGen dialog box, select the Duration that defines how long the
warning will be in effect. The available options in this menu change depending on the type of warning.
Warning times can also be adjusted by editing the warning text using the Text display.

If you are issuing a warning that will go into effect at a future time, and it has a time range rather than just an
expiration time, then you can enter these times in the “time/date boxes.” Press the Change menu button to
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select different dates and/or times. Setting the Time Range applies to only certain text products. The Time
Range feature can also support the VTEC text system.

"Warning Options Panel"'

For some types of warnings, WarnGen provides additional options for automatic inclusion in the warning.
The highlighted selections are chosen by default; you can deselect them and/or select others by clicking on
them. Some warnings, advisories, and statements do not include these selectable options. However, your Site
Manager can set up or modified the options shown in the panel.

Instructions

WarnGen instructions are shown in this section of the dialog box. As you perform the instructions, new ones
appear to help you through the warning process. In Exhibit 6.3-1 you are instructed to “Move Centroid to
Storm in any Frame”. Click and hold mouse Button 1 (B1) on the “Drag me to storm” Centroid and drag

it to the storm. Then you are instructed to “Adjust box around Warning Area”.

"WarnGen Control Buttons"

These button, which are located at the bottom of the WarnGen dialog box, control WarnGen's basic functions.

e Create Text: A click on the Create Text button sends the warning to the Text display where it can be
edited, if needed, and then issued. This button is enabled once you have moved the Storm Centroid
marker from its default position, or, for a hydrologic warning (e.g., flash flood), once you have moved
the default warning box.

e Restart: A click on the Restart button resets the display to the default Storm Centroid marker or to the
default warning box, depending on which Warning Product type is selected, but leaves the dialog box
settings in their current state. You can use the Restart button to issue multiple warnings or, if necessary,
cancel a warning before it is sent to the Text display.

e Close: A click on the Close button closes the dialog box and leaves WarnGen in its current state,
including the Storm Centroid and warning box, if either is on the display. To reopen the dialog box,
simply click on the yellow WarnGen button on the menu bar.
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6.4 Automated Insertion of Dam Break Data into FFW/FFS

Sites have the capability to create Dam Break non-convective Flash Flood Warnings (FFW) and Flash Flood
Statements (FFS) using locally defined, dam-specific text in WarnGen. For this feature to work at a particular
site, the site must create a text file (LLL-dam_info.txt). This text file is referred to as a “dam info file.” This
section explains how to create the dam info file, and how to use this feature.

Note 1: The LLL in the LLL-dam_info.txt file should be replaced by your site ID, i.e., by the value of
environment variable FXA LOCAL_SITE.

WarnGen Dam Break Threat Button and Options

In the WarnGen GUI, the items listed in the "Options Information Pane" outlined by the green box, as shown
in Exhibit 6.4-1, apply to all sites and are retrieved from the WarnGen templates. The items listed in the
"Options Information Pane" outlined by the yellow box, as shown in Exhibit 6.4-2, are unique to the
particular site and are retrieved from the dam info file, i.e., LWX-dam_info.txt for this example.

Exhibit 6.4-1. Dam Break Threat - All Sites

Page 303



CAVE-D2D User's Manual AWIPS |1 Operational Build 13.4.1 - 31 July 2013

Exhibit 6.4-2. Dam Break Threat - Unique to Specific Site

"Warning Options Panel™

The "Warning Options Panel" is composed of four sections (refer to Exhibit 6.4-1 for the first two sections,
and Exhibit 6.4-2 for the last two sections).

1. Primary Cause: This section includes two dam break options, one of which must be selected for this
feature to work:

1. dam break - imminent failure
2. dam break - failure has occurred.

2. Dam Failure Reported By: This section, which appears below Primary Cause, includes six options
from which you must choose one (who reported the dam failure).

3. Dam & Dam Break Scenarios: This section displays dam name, dam break scenarios, and rule of
thumb. In the example (see Exhibit 6.4-2), there are two dams — Ada dam and Howard dam. There
are four scenarios for Ada dam and two scenarios for Howard dam, and there is one rule of thumb for

each dam.
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4. Calls to Action: As the name implies, this is an optional selection that is chosen after checking the
location and level of the threat to the Dam Break Threat Area.

Dam Info File

Site-specific information for the DAM & DAM BREAK SCENARIOS section is stored in the dam info file,
LLL-dam_info.txt. To use the new WarnGen feature, this file needs to be created in advance and stored in the
$FXA CUSTOM_ FILES directory. An example of such a file is shown in Exhibits 6.4-3 and 6.4-4. The
example file can be divided into 3 parts: Part 1, lines 1-3, contains commonAddInfo substitution text; Part 2,
lines 5-42, contains information related to Ada dam; and Part 3, lines 44-70, contains information related to
Howard dam. For each additional dam, a part similar to Part 2 or Part 3 should be added to the file.

Exhibit 6.4-3. LWX-dam_info.txt (Sections 1 and 2)
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Exhibit 6.4-4. LWX-dam_info.txt (Section 3)

e File Structure: The structure of a dam info file, i.e., LLL-dam_info.txt, is as follows:

<VAR lead=

{ <D AMNAME> =
<V AR lead=
<V AR lead=
<VAR lead=
<WAR lead=
<V AR lead=
<VAR lead=
<VAR lead=

}

{ <SCENARIO>=
<VAR lead=

b

{<SCENARIO>=
<V AR lead=

}

{<SCENARIO>=
<VIR lead=

b

{<ROT>= = |
VIR lead=

3

£&| wvar=comnoniddInfo>

=1
| var=river Info>
| var=damInfo>
| var=countyInfo>
| var=statelnfo>
| var=cityInfo>
| var=addInfo>
L&l var=coords>

| var=scenar io>

| var=scenar io>

| var=scenar io>

| var=ruleOf Thurad >

When creating a dam info file, the symbols and words in the above structure must be kept unchanged.
In the terminology of WarnGen, DAMNAME, SCENARIO, and ROT are bullets, VAR is a substitution,
and commonAddInfo, riverInfo, damInfo, countylnfo, stateInfo, citylnfo, addInfo, coords, scenario,
and ruleOfThumb are variable names into which the corresponding substitution text is directed.

Note 2: The variable addInfo is defined in DAMNAME and in several instances of SCENARIO as

well.
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The following is the format of a substitution: <substitution type | qualifier type = qualifier value | ...>.
VAR is a specific type of substitution. It allows the user to direct text into a variable, i.e., the text
following lead= will be directed to the variable following var=. For example, in VAR substitution,
<VAR lead=THE POTOMAC RIVER BELOW THE ADA DAM|var=riverInfo>, THE POTOMAC
RIVER BELOW THE ADA DAM is directed to riverInfo. Such text is referred to as <variable name>
substitution text hereafter, e.g., riverInfo substitution text.

In the bullet of each dam, there are seven VAR substitutions. The variable names into which the
substitutions text is directed are as follows: riverInfo, damInfo, countylnfo, statelnfo, citylnfo, addInfo,
and coords, respectively. All seven VAR substitutions must be included.

Refer to Text Templates [http://www-sdd.fsl.noaa.gov/~ramer/noaa/wgnDesign/TextTemplate.html] for
more details on bullets, substitutions, and variables.

e commonAddInfo, addInfo, and scenario:
o commonAddInfo substitution text precedes addInfo substitution text

The commonAddInfo is defined in lines 1-3 of LWX-dam_info.txt, which is used for all dams for
site LWX. The addInfo is defined in the DAMNAME bullet in (refer to Exhibit 6.4-3, lines
11-13), and in the SCENARIO bullets in (refer to Exhibit 6.4-3, lines 18-22, 23-27, 28-32, and
33-37) for the Ada dam). There could be no SCENARIO at all. Although commonAddInfo is
defined before addInfo in the dam info file, addInfo substitution text (marked in the black box)
precedes commonAddInfo substitution text (marked in the blue box), in the warning text, as
shown in Exhibit 6.4-5.

Note 3: Test mode was not used when creating the screen shots for this document. If it is
used, the following sentences will be inserted in the warning text: ... THIS MESSAGE IS
FOR TEST PURPOSES ONLY...”, “THIS IS A TEST MESSAGE”, and “THIS IS A TEST
MESSAGE, DO NOT TAKE ACTION BASED ON THIS MESSAGE”.
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Exhibit 6.4-5. AddInfo Substitution Text Precedes commonAddInfo Substitution Text

o scenario

The scenario substitutions are defined for the Ada dam (refer to Exhibit 6.4-3, lines 18-22, 23-27,
28-32, and 33-37). Having SCENARIO bullets in the dam info file is optional.

o addlInfo substitution text override

If a SCENARIO is defined in the dam info file and the scenario is selected, its corresponding
scenario substitution text overrides the addInfo substitution text defined in DAMNAME. For
example, when a threat level is increased and "*high fast™ is selected, the statement in the blue
box replaces the statement in the black box, as shown in Exhibit 6.4-5.

e ruleOfThumb: The ruleOfThumb (ROT) substitution is intended to provide the basis for the statements
in the scenarios. The substitution text (refer to Exhibit 6.4-4, lines 67-71) is such an example. Having a
ROT bullet in the dam info file is optional.

e coords:
o Format and unit

The coords substitution text is the coordinates, in latitude and longitude, of the vertices of the
polygon that outlines a dam break threat area. The coordinates are listed in hundredths of a
degree, with no minus sign for west longitude.
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WARNING: && must be placed at the end of the coordinates (refer to Exhibit 6.4-3, line
16) in order for them to be handled correctly by the software.

o Get coordinates of vertices of a polygon

If you know the dam break threat area and can outline it with a polygon, the existing D2D
capability of lat/lon readout can be used to get the latitude and longitude values of each vertex of
the polygon. Then, they can be stored in the dam info file. The procedure is as follows:

a.

b.

Select non-convective FFW (Dam Break) in WarnGen. A square will appear.

Manipulate the polygon to outline the threat area; drag it around, add or move vertices.

. When the threat area is well outlined by the polygon, activate the sampling capacity of

D2D by selecting Lat/Lon Readout from the button 3 pop-up menu, and then bringing up
the pop-up again and toggling on Sampling.

Open your dam info file, LLL-dam_info.txt, with vi or another editor.

Obtain the lat/lon values of each vertex by moving the cursor over the center of the vertex
one by one clockwise.

While moving the cursor, read latitude/longitude on screen and enter them in the dam info
file; enter latitude first, then longitude, and ignore the floating point. For example, enter
3820 for 38.20N and 7817 for 78.17W. Each datum should be separated by a space.

Note 4: If a dam break threat area, outlined by a polygon, covers more than one county, the
names of all counties must be included in the countyInfo substitution text. Otherwise, the
warning text will generate error messages when it goes through format checking. HOWARD
DAM is an example dam break threat area that covers both Montgomery County, Maryland
and Loudoun County, Virginia. The format for countylInfo that has more than one county is
shown in Exhibit 6.4-4, lines 44-48.

Note 5: IN CENTRAL VIRGINIA follows LOUDOUN COUNTY, the first of the two
counties; ...&~~ precedes the name of the second county; and the name of the state to

which the second county belongs is listed in the stateInfo substitution text, as shown in
Exhibit 6.4-4, line 49.

Creating a Dam Break FFW or FFS

CAUTION: As with any WarnGen testing, you should put the workstation in the Test or the Practice
mode before proceeding. Refer to Section 6.2.
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¥ To create an FFW or FFS warning product with the new options of PRIMARY CAUSE:

1.

Nownkw

o

In the WarnGen GUI, select non-convective FFW or FFS (Dam Break) from the Other Product
type options field.

Select either “dam break — imminent failure” or “dam break — failure has occurred” under
PRIMARY CAUSE.

Select one reporter in DAM FAILURE REPORTED BY.

Select a dam, e.g., Ada dam (Montgomery).

Optionally, select a SCENARIO, e.g., high fast under Ada dam.

Optionally, select rule of thumb under the selected dam (refer back to Step 4).

Click on the Dam Break Threat Area button and observe the location of the polygon in the D2D
main pane, as shown in Exhibit 6.4-6.

Optionally, select option(s) in CALLS TO ACTION.

Click Create Text. The warning product should appear in a pop-up Text WarnGen window on
the text workstation.

Note 6: The selection of a SCENARIO is not forced to be associated with the selected dam by the
current software design, so make sure a scenario under the selected dam is selected. Selecting a dam and
then a scenario under an unselected dam will result in incorrect warning text. The same is true for ROT;
1.e., the ROT selected should be under the selected dam.

Exhibit 6.4-6. WarnGen GUI and Dam Break Threat Area Outlined By a Polygon
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6.5 Using WarnGen
Module 21: Reserved
Module 22: Using WarnGen

This practice module illustrates the steps required to generate a warning using WarnGen.

Note 1: This practice module should be performed in the Test or the Practice mode. Refer to Section 6.2
for information about placing your workstation in either of these modes.

Note 2: Refer to the Exhibit 6.3-1 when performing the objectives included in this practice module.

Objective 22.1 - Opening the WarnGen Dialog Box
1. Display eight frames of the current 0.5 degree reflectivity radar on the WFO Scale. You can zoom in

over the area of interest if needed for better viewing.

2. Click the WarnGen button on the CAVE Toolbar row. The WarnGen dialog box appears along with
a Storm Centroid marker near the middle of the Main display screen. The marker carries the
annotation "Drag me to storm." Notice that WarnGen defaults to a Severe Thunderstorm warning.

3. If not already on, select the One Storm, Box and Track, and Warned Area Visible options.
4. The default Duration Time for a severe thunderstorm is 30 minutes. Change this time to 45 minutes.

5. From the ""WarnGen Options Panel™, select any text you would like included in your warning. The
warning options can be turned off or on by clicking on them. When the options are selected, they are
highlighted. Multiple options can be selected in some sections.

Note: The brief set of instructions at the very bottom of the dialog box is intended to serve as a
reminder of the steps involved in designating a storm track and warning area.

6. In order for you to have a clear view of the large display pane for the next objective, you may want to
iconify the dialog box, push it behind the CAVE window, or shrink the CAVE window. Continue to
display the reflectivity image for the next objective.

Objective 22.2 - Establishing and Editing the Storm Track

This objective illustrates how to set the storm track. In a sense, you are working backward from the latest
frame that shows the current storm to an earlier frame where the storm was first identified to obtain the
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storm track. It requires you to adjust both the frames in the loop and the Centroid marker.

1. Step the radar loop to the last (most current) frame of the radar loop.

Note 1: The quickest way to get to the last frame is to click the Last Frame iconified button on
the CAVE-D2D Toolbar.

2. Click and hold mouse Button 1 (B1) over the Storm Centroid marker and drag it to the location of
the storm for which you are issuing the warning and release B1.

3. The following events happen once you have moved the Centroid marker to its new location:
e A four-sided default warning box with hatching appears on the screen.
e The letter "W" appears in each of the counties located within the warning area.

e A default storm track, with time annotations for the first and last positions, also appears on
the screen.

Note 2: This storm track is arbitrarily set to point toward the northeast, as shown in
Exhibit 6.5-1, but is adjusted in Step 4.

Exhibit 6.5-1. WarnGen Graphic Display with Storm Track

4. Move the radar loop to the earliest (first) frame in the loop, or to the earliest frame in the loop where
the storm is visible--whichever makes the most meteorological sense. The default warning box
continues to appear in the same location as it does in the latest frame of the loop. (Changing the shape
and location of the warning area is covered in the next objective.)

5. Drag the Centroid marker to the location of the storm in this earlier frame. The length and direction of
the storm track vector are dependent on the distance and time covered between the location of the
Centroid marker in the earlier frame and its location in the latest frame of the loop. Increasing the
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frame count lengthens the storm track vector.

6. Turn the loop on and observe whether the storm track follows the approximate movement. Make
adjustments as necessary by stopping the loop and moving the Centroid marker.

Note 3: An X appears where you identified the storm location in the latest frame and designates
the pivot point for the storm track. This is the point relative to which WarnGen calculates the
direction of the storm vector if you edit the location of the Storm Centroid in any frame. WarnGen
linearly extrapolates the storm path forward and backward in time, based on the location of the
most recently created or edited Centroid marker. You may want to experiment with moving the
Centroid in several different frames and see how it affects the storm path generated by WarnGen.

Note 4: WarnGen places a Storm Centroid marker in each frame of a loop, regardless of whether
the storm is present in each frame or not. You can disregard those frames where the storm is not
present. The key is to ensure that the storm path is correct for those frames where the storm is
present.

Note 5: The Centroid cannot be deleted; it can only be moved.

Note 6: Once you have established a satisfactory storm track, press the Track button to redraw
the warning area to fit the new storm track.

Note 7: WarnGen translates the storm path into text describing the speed and direction of the
storm.

Tip: You can zoom or pan the image if you need to get a better look at a storm. Refer to Section
2.1 for help configuring the mouse buttons. Remember, the mouse buttons are user defined, linked
to your log-in ID.

Objective 22.3 - Adjusting the Warning Area

This objective describes how to adjust the WarnGen default warning area. Move to the most current frame
of the radar loop. You may want to Zoom the display to get a better view of the storm and/or warning
area.

1. To move entire warning area while retaining its shape

1. Position the pointer over a side of the polygon. Notice that the pointer changes to a finger-
pointing hand. This indicates that you are over or near a line of the polygon and can move
the whole shape.
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2. Click and hold B1 on the line (not a vertex), and drag the warning area to its new location.
Then release the mouse button. The hatching is redrawn to fill the new warning area
location.

1. To adjust a vertex of the warning area

1. Position the pointer over the vertex that you want to adjust. Notice that the pointer changes
to a finger-pointing hand. This change indicates that the pointer is now in edit mode and you
can move the vertex.

2. Click and hold B1, drag the vertex to its new location, and release the mouse button. Notice
that the sides of the shape adjust accordingly. The hatching is redrawn to fill the new
warning area shape.

1. To add a vertex

1. Position the pointer over the side of the warning area where you want to add the vertex.

Note 1: Again the pointer changes to a finger-pointing hand to indicate you are now in
edit mode.

2. Click mouse Button 2 (B2) to add the vertex. WarnGen places the new vertex under the
cursor position.

Note 2: You can also add a vertex by clicking and holding mouse Button 3 (B3) and
selecting "Add vertex" from the pop-up menu.

3. Repeat Steps 1 and 2 under "To adjust a vertex of the warning area" to adjust the location of
the new vertex.

1. To remove a vertex

1. Position the pointer over the vertex you want to remove. The pointer changes to the finger-
pointing hand.

2. Click B2 to remove the vertex.

Note 3: You can also remove a vertex by clicking and holding B3 and selecting "Delete
vertex" from the pop-up menu.

Objective 22.4 - Sending a Warning to the Text Workstation

This objective gives the concluding steps to creating a warning on the graphics/image display.

Note 1: Any county marked with a "W" is included in the warning message.
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Note 2: WarnGen does not permit creating a warning area with fewer than three sides.

Note 3: If a warning area crosses the CWA boundary when "Create Text" is selected, only the parts
of the warning in the CWA will be inside of the vertices.

1. Adjust and position the warning box so it crosses your CWA boundary.
2. If you have iconified or pushed the WarnGen dialog box, restore or bring it forward.

3. From the bottom row of the dialog box, select the Create Text button to send the warning to the Text
display. When you click on the Create Text menu button, a window automatically appears on the
Text display with the text of the warning displayed.

4. If the text warning message appears, proceed to Step 5; otherwise, type "WRKWG#" in the Text
window Entry box, where the number (#) is taken from the Text display's name (e.g., if the name is
"xt3-bou," the number you enter is "3") and the Header Block should come up with the correct
product ID. The Enter Editor function is already initialized and the Header Block dialog box is
open.

5. Verify that the header information is correct and press the Enter menu button in the Header Block
dialog box. You can now edit the text product as necessary, and then store and issue the warning.
Sending the warning from the graphics/image display of CAVE to the Text display does not
automatically issue the warning.

6. Compare the LAT...LON line in the warning text to the polygon and hatched area (use sampling with
Lat/Lon Readout enabled). Note that the warning description describes the hatched area and the
LAT...LON line describes the positions of the vertices.

N

Note 4: There may be places in the generated text that you must edit before issuing the warning,
depending on the options selected.

CAUTION: Review the warning text before transmitting it to the public.

Objective 22.5 - Creating a Second Warning Using the County Selection Function

WarnGen allows you to select entire counties to include in a warning area. This is especially useful when
generating watches or broad warning areas, or when you wish to prevent a tiny sliver (less than 5% of a
county) from being covered by a warning.

1. Click the Restart button at the bottom of the WarnGen dialog box.

2. From the Product type section of the WarnGen dialog box, select Flash Flood.
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Note: The Storm Centroid marker and the warning area from the previous warning are cleared
from the display.

3. From the Time Range Duration field, select a 3-hour warning duration time.

4. From the ""Warning Options Panel™, select any text you would like included in your warning.

5. Move the radar loop to the most current frame using the Last Frame iconified button in the Toolbar.
6. Drag the Centroid to a desired county. A default warning box is displayed.

7. Click B3 on three adjacent counties, as well as the county from Step 6. When you click on the county
from Step 6, the remainder of the county will become hatched. Each county contains a W to indicate
that it is included in the warning area.

8. Return to the WarnGen dialog box and click the Warned/Hatched Area button.
9. Adjust the warning area as needed.
10. Click on the Create Text button to send the warning to the Text display.

11. Keep this display for the next objective.
Objective 22.6 - Creating a Warning for a Line of Storms

1. Click the Restart button located at the bottom of the WarnGen dialog box.

2. Click the Line of Storms radio button in the upper portion of the WarnGen dialog box. The default
Product type is Severe Thunderstorm.

3. Move the loop to the earliest frame where the line of storms is visible. Drag the storm line to match

up with the actual line of storms. A hatched warning box appears along the trajectory of this line.
Refer to Exhibit 6.5-2.
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Exhibit 6.5-2. WarnGen Graphic Display with a Line of Storms

4. Use B1 to change the shape of the warning box and the orientation of the line. You may wish to add
vertices using B2, as illustrated in Exhibit 6.5-2

5. Turn looping on and observe the line movement.

6. Click on the Create Text button in the WarnGen dialog box to send the warning to the Text display.
Objective 22.7 - Creating a Warning for a Backup Site

WarnGen allows you to provide backup support to neighboring CWAs provided localization has been run
for the backup site.

1. Click the Restart button located in the lower portion of the WarnGen dialog box.

2. From the Backup section of the WarnGen dialog box, select a CWA other than your own. Note that
the WarnGen dialog box disappears and reappears with the backup site selected and in yellow.

3. If not already on, select the One Storm, Box and Track, and Warned Area Visible options. Observe
that counties in your CWA are not hatched; only those in the selected CWA are hatched.

4. From the Product type section of the WarnGen dialog box, Severe Thunderstorm is the default.
5. Adjust the storm track and warning area as described in Objectives 22.2 and 22.3.

6. Create the text message as shown in Objective 22.4. Observe that the text message is formatted as if it
were issued by the backup site, but it contains a line stating "issued by National Weather Service
<your site>" in the header.

Note 1: The WarnGen dialog box opens in the same state as when it was closed.
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Note 2: Closing the WarnGen dialog box does not quit WarnGen. The way to quit WarnGen is to
clear the display or select the "Unload" option from the WarnGen legend pop-up menu. These
actions revert WarnGen to its default settings.
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7.0 The Interactive NsharpSkewt (NSHARP) Application

The Interactive NsharpSkewt (NSHARP) program is integrated into the CAVE interface and allows you to
modify a sounding and/or hodograph to derive various thermodynamic quantities. This implementation
enables you to obtain a better understanding of the current and future states of the atmosphere.

Note: This discussion assumes that you have at least a fundamental understanding of both the Skew-T
log-p thermodynamic diagram and the hodograph.

Through NSHARP, you can modify the temperature, dewpoint, and/or hodograph profiles either by using the
cursor or by manual entry in a dialog box; lift a modified air parcel and immediately see a listing of the
modified convective parameters; and interactively sample the sounding itself. The basic premise of the
program is to assume constant pressure while interactively editing the data points.

Because the NSHARP program is integrated into the CAVE interface, you can perform display manipulations
such as looping, stepping, and swapping. Also, in the event that an incomplete sounding is plotted, but
mandatory and significant level data are available in the text database, you can enter the missing data points
using NSHARP and obtain the thermodynamic and stability variables.

This chapter includes the following sections:

e Section 7.1: Starting the NSHARP Application

e Section 7.2: The NSHARP Interface and the NSHARP(D2D) Functions Panel

e Section 7.3: Sampling and Editing Sounding Profiles

e Section 7.4: Using the NSHARP Application
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7.1 Starting the NSHARP Application
The NSHARP application starts when you display at least one sounding from the Upper Air pull-down menu,
as shown in Exhibit 7.1-1. Loading the sounding opens the NSHARP interface and the NSHARP(D2D)

functions panel, as shown in Exhibit 7.1-2. You can load other soundings from the Upper Air menu after the
NSHARP interface is open.

Exhibit 7.1-1. Selecting a Sounding from the Upper Air Menu
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Exhibit 7.1-2. NSHARP Interface with NSHARP(D2D) Functions Panel

You can close NSHARP and clear it from the Main Display pane by clicking the "*X"" on the NsharpEditor
tab, or by clicking the Clear button on the Toolbar. Both actions will close NSHARP. However, if you want
the NSHARP GUI and the NSHARP(D2D) functions panel to disappear from the Main Display pane and run
in the background, click on the Map tab (be sure not to click the "X" on the Map tab, which will close the
map). You can restore both the NSHARP GUI and the NSHARP(D2D) functions panel by clicking on the
NsharpEditor tab (be sure not to click the "X" on the NsharpEditor tab, which will close NSHARP
completely).

Note: If you inadvertently close the NSHARP(D2D) functions panel by clicking on the "'X" on the
NSHARP(D2D) tab while the NSHARP GUI is displayed, you can restore it without closing NSHARP
and losing your work. Click the Map tab and then click the NSHARPEditor tab to return the NSHARP
GUI to the Main Display pane with the NSHARP(D2D) functions panel restored. NSHARP will be
restored to the place it was when the panel closed.
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7.2 The NSHARP Interface and the NSHARP(D2D) Functions Panel

This section provides overviews of the NSHARP interface, shown in Exhibit 7.2-1, and operation of the
NSHARP(D2D) functions panel, shown in Exhibit 7.2-2.

Exhibit 7.2-1. NSHARP Interface with Only One Sounding Loaded

Exhibit 7.2-2. NSHARP(D2D) Functions Panel

Note: The NSHARP(D2D) functions panel shown above includes two rows of function buttons with
nine buttons on the top row and eight on the bottom row. The number of rows and the number of buttons
displayed on each row vary, depending on the width of your screen. Refer to Exhibit 7.1-2

The subsections that follow describe the NSHARP GUI and NSHARP(D2D) functions panel in greater detail.
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7.2.1 The NSHARP Interface

The NSHARP application interface is comprised of:

The Skew-T Diagram

The Hodograph Diagram

Selected Soundings and Time Lines (Frames)

Data Parameters
e Inset Diagrams

Skew-T Diagram

The NSHARP Skew-T diagram is shown in Exhibit 7.2.1-1. The temperature is represented by the solid red
line, the dewpoint by the solid green line, the by the solid line, the virtual temperature by the
dashed red line, and the lifted parcel profile by the dashed white line.

Exhibit 7.2.1-1. NSHARP Skew-T Diagram

Hodograph Diagram

The NSHARP hodograph diagram is shown in Exhibit 7.2.1-2. The hodograph is drawn with height color
coding: solid red line for below 3000 feet (3 Kft) above ground level (AGL); solid green line for 3 to 6 Kft
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AGL,; solid "Yellow" line for "6 to 9 Kft" AGL; solid line for AGL,; and solid purple line for
above 12 Kft AGL. The yellow rectangle represents the mean wind vector. The 30/70 and 15/85 storm
motion vectors are marked by small pink and dark red ellipses (not shown in Exhibit 7.2.1-2). The user
moveable storm motion vector is marked by a large white ellipse (also not shown in exhibit).

Exhibit 7.2.1-2. NSHARP Hodograph Diagram

Selected Soundings and Time Lines (Frames)

The stations (listed by Site ID) are derived from the soundings selected from the Upper Air menu. They are
listed in alphabetical order, and not in the order in which they were selected, as shown in Exhibit 7.2.1-3.

Exhibit 7.2.1-3. Identifying State and Status of Selected Soundings

Data Parameters — Next Data

A collection of calculated values is provided in text panels for the currently displayed station. The values are
grouped into five pages, as shown in Exhibit 7.2.1-4. You can cycle through the pages using the Next Data
button on the NSHARP(D2D) functions panel.

Note 2: The data parameters and value ranges are not defined in this document. It is assumed that the
meteorologists using this manual know the meaning and value ranges of these parameters.
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Exhibit 7.2.1-4. Data Parameters Pages 1 - 5

Inset Diagrams — Next Inset

There are two pages of Inset diagrams, as shown in Exhibit 7.2.1-5. You can cycle through the pages using
the Next Inset button on the NSHARP(D2D) functions panel.
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Exhibit 7.2.1-5. Inset Diagrams Pages 1 - 2
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7.2.2 The NSHARP(D2D) Functions Panel

The buttons on the NSHARP(D2D) functions panel, shown in Exhibit 7.2.2-1, enable the forecaster to
control the NSHARP environment for the selected interactive NSHARP sounding.

Exhibit 7.2.2-1. NSHARP(D2D) Functions Panel

Note 1: The buttons that have two mode positions — (off) or (on) — will show the current mode on the
button. For example, if EditGraph(off) is displayed on the button, it means the Skew-T and hodograph
diagrams are not editable at this time.

The buttons associated with all parts of the NSHARP(D2D) functions panel are described below.

Load

Selecting the Load button opens the Open dialog box where you can open a saved Skew-T that was edited in
the past.

Save
Selecting the Save button opens the Save Text Data dialog box, which allows you to save an edited Skew-T.

Configure

Selecting the Configure button opens the NSHARP Configuration dialog box, as shown in Exhibit 7.2.2-2.
As illustrated in Exhibit 7.2.2-2, the seven options allow you to control what is displayed on the Skew-T
diagram, changing the default setup to customize to your preference.
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Exhibit 7.2.2-2. NSHARP Configuration Dialog Box Options

Page 328



CAVE-D2D User's Manual AWIPS |1 Operational Build 13.4.1 - 31 July 2013

Reset

Selecting the Reset button restores the sounding to the original (initial) Skew-T and hodograph settings and
values.

Reset Display

This button is used when in interactive editing mode, set by the EditGraph(on) button on the NSHARP(D2D)
functions panel. When moving points to different locations and therefore changing the profile paths of the
temperature and dewpoint for the "Current" station, selecting the Reset Display button restores the Skew-T
display and hodograph diagram to their original (initial) profile path. The parameter data panels are restored
accordingly.

Parcel

Selecting the Parcel button opens the Parcels Display Configuration dialog box, shown in Exhibit 7.2.2-3,
which allows you to define the parcel display parameters that are shown on the data parameters page for
Parcel Data. (Refer to Exhibit 7.2.1-4 (Page 2), which reflects the “Most Unstable Parcel” radio button
selected in Exhibit 7.2.2-3.)

Exhibit 7.2.2-3. Parcels Display Configuration Dialog Box

Next Data

Refer to Subsection 7.2.1 for a description of this function.

Next Inset

Refer to Subsection 7.2.1 for a description of this function.

Interp(off)/Interp(on)

Switching from Interp(off) to Interp(on) populates the Skew-T diagram grid with the most current
temperature and dewpoint data traces.
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Note 2: The text values in the "Show Text" display will also change as you change the mode of the
interpolation button.

Ovrlay2(off)/Ovrlay2(on)

Switching from Ovrlay2(off) to Ovrlay2(on) overlays the current and previous sounding temperature and
dewpoint data time traces on the Skew-T diagram for the current station.

Note 3: Refer to Exhibit 7.2.2-4 for CompStn(oft/on) and CompTm(off/on).

Exhibit 7.2.2-4. CompStn(off) and CompTm(off) to CompStn(on) and CompTm(on)

CompStn(off)/CompStn(on)

Switching from CompStn(off) to CompStn(on) adds all the data paths (temperature, dewpoint, and wetbulb)
for all the active stations (shown in yellow text) to the current station's data paths on the Skew-T and
hodograph diagrams for comparing purposes, as shown in Exhibit 7.2.2-4. Inactive or unloaded stations will
not display.

Note 4: CompStn(off/on) only works with the Skew-T (S) display. The button is grayed out when
switched to the Turbulence (T) or Icing (I) displays.

CompTm(off)/CompTm(on)
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Switching from CompTm(off) to CompTm(on) adds the data paths (temperature, dewpoint, and wetbulb) for
all the active timelines (shown in yellow text) to the current station's data paths on the Skew-T and
hodograph diagrams for comparing purposes, as shown in Exhibit 7.2.2-4. Inactive or unloaded time lines

will not display.

Note 5: CompTm(off/on) only works with the Skew-T (S) display. The button is grayed out when
switched to the Turbulence (T) or Icing (I) displays.

Note 6: The overlay (Ovrlay?2), station comparison (CompStn), and time line comparison (CompTm)
functions cannot work at the same time. When one function is selected, the others will be grayed out.

Edit Data

Selecting the Edit Data button opens the Sounding Data Editor dialog box, shown in Exhibit 7.2.2-5. The
Sounding Data Editor dialog box allows you to change the values for atmospheric parameters.

Exhibit 7.2.2-5. Sounding Data Editor Dialog Box

EditGraph(off)/EditGraph(on)

Switching from EditGraph(off) to EditGraph(on) makes the Skew-T and hodograph diagrams interactive.
Observe the small circles along the data paths when the diagrams are in interactive mode, as shown in

Exhibit 7.2.2-6.
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Exhibit 7.2.2-6. Changing from EditGraph(off) to Interactive EditGraph(on) Mode
Show Text
Selecting the Show Text button opens a non-editable Show Text window listing the parameter values for the
active sounding for the current frame, as shown in Exhibit 7.2.2-7. Text values in the display will

automatically be updated whenever the sounding profile is altered. Clicking the SAVE button in the text
panel will output the data to a user-designated file in the current working directory.
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Exhibit 7.2.2-7. Show Text Window

Display Modes

There are three NSHARP display modes:
e S: Standard Skew-T Display
e T: Turbulence Display
e |: Icing Display

The different NSHARP display modes are illustrated in Exhibit 7.2.2-8.
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Exhibit 7.2.2-8. NSHARP Display Modes

Print

Selecting the Print button opens the Print dialog box.
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7.3 Sampling and Editing Sounding Profiles

The NSHARP Skew-T and hodograph diagrams use the same method for editing a sounding profile.

There are two ways to edit a sounding profile:

1. Interactively move or add data points on the temperature or dewpoint profiles, made interactive via the
EditGraph(on) button on the NSHARP(D2D) functions panel.

2. Manually by entering values in the Sounding Data Editor dialog box accessed from the
NSHARP(D2D) functions panel via the Edit Data button.

Sampling Data

Move the mouse cursor (arrow) over the Skew-T (or hodograph) diagram and observe the sampling data
readout displayed on the diagram next to the cursor, as shown in Exhibit 7.3-1.

Exhibit 7.3-1. Skew-T Sampling Data Readout

Interactively Editing a Sounding Profile

Follow the procedures below to perform the interactive editing function.

1. Select Edit Graph mode: On the NSHARP(D2D) functions panel, switch EditGraph(off) to
EditGraph(on).

2. Enlarge the Skew-T or hodograph diagram: Use the zoom function to obtain a better view of the
sounding profile. If you have a 2-button mouse with clickable scroll wheel, use either of the following
two methods to enlarge the diagram. If you don't have a clickable scroll wheel, use the first method.

o Position the mouse cursor (arrow) over the Skew-T or hodograph diagram and click and hold
mouse Button 3 (B3) to open the pop-up menu. Then select Zoom > 6.3X, or any other zoom
value from the list. You can then advance to the next highest value by incrementally clicking
mouse Button 2 (B2) with the mouse cursor positioned over the diagram. To zoom back out,
reopen the pop-up menu and select a lower zoom value.

o Position the mouse cursor (arrow) over the Skew-T or hodograph diagram and use the B2 scroll
wheel to zoom both in and out.

3. Relocate a Point: Move the mouse cursor (arrow) over a data point. Notice that, by clicking and
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holding mouse Button 1 (B1) on either the temperature or the dewpoint line, you can drag the point to
a new position. Remember that the data point is constrained to maintain its original pressure. The
software keeps the new temperature value but automatically keeps the point on the original pressure
level. The software also prevents you from crossing the temperature and dewpoint profile lines.

4. Add a Point: Adding a point to the temperature or dewpoint line is simple. Place the mouse cursor
(arrow) on the line. Then click B2 to create a new point. Then clicking B1 on that same point, you can
drag it to a new location. You are constrained to stay within the two neighboring data points. Once you
release B1, the new point remains at the new location. If you add a new temperature point, a
corresponding dewpoint value, interpolated from existing data points, appears on the dewpoint profile
automatically. To remove a point from the sounding, click B2 on a data point.

5. Move a Profile: Moving the entire temperature or dewpoint temperature profile is also simple. Move
the mouse pointer over the profile; notice that the pointer changes to a finger-pointing hand. Click and
hold B1, and drag the mouse to move the entire line.

Manually Editing a Sounding Profile

Follow the procedures below to perform the manual editing function.

1. Select Edit Data mode: On the NSHARP(D2D) functions panel, click the Edit Data button to open
the Sounding Data Editor dialog box. It is here that you change parameters.

2. Apply changes: When finished changing parameters, click the Apply button. The Skew-T display and
hodograph diagram profiles change accordingly and the parameter data panels also change to reflect
the manually changed parameters. The Sounding Data Editor dialog box closes.

3. Restore settings: On the NSHARP(D2D) functions panel, click the Reset button to return the data to
the original settings.
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7.4 Using the NSHARP Application
Module 23: Using the NSHARP Application

This module provides practice opening the NSHARP application, viewing multiple stations, and editing the
NSHARP GUI.

Note: Refer to Exhibit 7.1-2 when performing the objectives included in this practice module. For a
refresher on Sounding/Skew-T, refer to Understanding a Sounding/Skew-T.

Tip: You can zoom or pan the image if you need to get a better look at the display. Refer to Section 2.1
for help configuring the mouse buttons. Remember, the mouse buttons are user defined, and linked to
your log-in ID.

Objective 23.1 - Opening NSHARP

This objective gives you practice opening the NSHARP GUI.

1. From the Upper Air pull-down menu, choose the following rawinsonde station: US Eastern >
Jacksonville FL (KJAX), to open the NSHARP GUI displaying the NSHARP Skew-T sounding plot
and NSHARP hodograph diagram for the selected station.

2. Add the following stations: Tampa Bay, FL (KTBW); Miami, FL (KMFL); and Cape Canaveral,
FL (KXMR).

Note 1: The first sounding selected acquires the "Current" state (green text). All the rawinsonde
stations selected afterwards acquire an "Active" state (yellow text). The selected sounding list is
in alphabetical order and not in the order in which the stations were selected. The Skew-T
display reflects only the "Current" state for both station and time, unless the comparing function
is active.

3. From the Frames option menu on the toolbar, set the frame count to 2 to display 2 frames per
sounding.

4. Step to the latest 12Z data.

5. Move the mouse cursor to the list of rawinsonde stations and data times. You can zoom in to enlarge
the area for better readability.

6. Click mouse Button 1 (B1) on station KJAX to make it “Not Active” (text changes from green to
white). Since KJAX was at the top of the list, the next station (KMFL) becomes the “Current” station.
The Skew-T and hodograph diagrams also change.
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7.

10.

I1.

12.

13.

14.

15.

Note 2: The station at the top of the list is always the “Current” station unless that station is
placed as “Not Active” or in the “Active” state. However, once the station that is in the
“Current” state is placed into the “Not Active” state, the station at the top of the list
automatically becomes the “Current”, unless it is in the “Not Active” state.

You can now zoom back out to view the entire NSHARP GUI. Note that the Skew-T and hodograph
diagrams also changed to reflect the station and data time changes.

Click mouse B1 on station KMFL (zoom in as needed), changing it to “Not Active” (text changes
from yellow to white). Since KJAX, at the top of the list, is in the “Not Active” state, KTBW
becomes the “Current” station.

On the CAVE Toolbar, select the Step Forward button to change the Current Frame to the first
frame of the KTBW station. The NSHARP Skew-T and hodograph diagrams change to reflect the
newly selected data time. Note that the parameter data shown in the text panels also changes.

Click mouse B1 on station KMFL to change its state from “Not Active” to “Active” (text changes
from white to yellow). Then click mouse B1 on station KTBW to change its state from “Current” to
“Not Active” (text changes from white to yellow). Note that as soon as KTBW changes to “Not
Active”, KMFL, at the top of the list of stations, changes to “Current”. This is because KJAX is still
in a “Not Active” state. The Skew-T display and hodograph diagram and all the parameter data text
panels change accordingly.

Click mouse B1 on station KTBW to change it to an “Active” state.

On the NSHARP(D2D) functions panel, click the CompStn(off) button to graphically view the
Skew-T and hodograph diagrams for the remaining two active stations (KTBW and KXMR), for the
same selected time frame as the “Current” KMFL station. Note that the button now reads
CompStn(on) to indicate it is active. Also note that CP1, CP2, and CP3 now appear next to the three
site IDs to indicate the sites are being compared graphically.

Note 3: CP1, CP2, and CP3 are highlighted in different colors to distinguish between them. The
same colors are represented on the displays.

On the NSHARP(D2D) functions panel click the CompStn(on) button to remove the comparison.
Note that the button now reads CompStn(off). The displays return to displaying just the “Current”
station's data.

Repeat Steps 12 and 13 but replace CompStn(off) and CompStn(on) with CompTm(off) and
CompTm(on), which compares the times rather than the stations, with the number determined by the
number of “Frames” selected.

Keep your data and displays for the next objective.

Objective 23.2 - Editing NSHARP

This objective gives you practice editing NSHARP.
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Note 1: There are two ways to edit: a) interactively with the mouse cursor on the Skew-T or
hodograph profile; or b) manually by entering data into the Sounding Data Editor dialog box.

1. On the NSHARP functions panel, click the EditGraph(off) button to make the Skew-T and
hodograph diagrams interactive. Interactivity is indicated by data points (small circles) along the
temperature and dewpoint profile lines for the “Current” station (KMFL).

2. Move the mouse pointer to the 700 mb (or nearest to 700 mb) data point of the temperature profile.

3. Press and hold mouse Button 1 on the data point and drag the point to the 20 C temperature line.
Then release the mouse button to establish the new position. The point stays at this new position.

4. On the NSHARP(D2D) functions panel, click the Edit Data button to open the Sounding Data
Editor dialog box. Observe that the current values are the values that you set by interactively editing
the Skew-T and hodograph diagrams.

5. Randomly insert new values into the fields and click the Apply button. Note that the change in the
Skew-T diagram corresponds to the new parameters.

6. On the NSHARP(D2D) functions panel, click the Reset button. The original data points are restored.
Objective 23.3 - Closing NSHARP

This objective gives you practice closing the NSHARP GUI.

1. Click the Clear button on the CAVE Toolbar to remove the NSHARP GUI and the NSHARP(D2D)
functions panel, closing the NSHARP application.
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8.0 Radar Applications

The radar applications allow you to interact with the Open Radar Products Generator (ORPG) to schedule or
request radar data collection, provide automated interpretations of data, and modify some of the radar display
settings.

As you interact with the various radar applications, radar status messages appear on the AlertViz Status Bar.
Please refer to the AWIPS II System Manager's Manual (SMM) for further information on these messages.

This chapter includes the following sections:

e Section 8.1: Alert Request

Section 8.2: RPS List Editor

Section 8.3: One Time Request

Section 8.4: Radar Multiple Request

Section 8.5: Radar Display Controls

Section 8.6: Dual Polarization Radar Products

Section 8.7: Using Radar Applications
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8.1 Alert Request

The Alert Request application lets you request special notifications from the RPG when certain radar-derived
variables exceed user-specified thresholds. For example, you can specify a threshold of 50 decibels (dBZ)
within a 15-mile Alert Area surrounding a major city. Then, an Alert Visualization message notifies you
when the radar detects 50 dBZ echoes.

From the Alert Request dialog box, shown in Exhibit 8.1-1, you can select the desired radar, edit the Alert
Area, and define the categories and thresholds for the Alert Request messages.

Exhibit 8.1-1. Alert Request Dialog Box

This dialog box is opened from the Radar menu or the kxxx menu and has the following options:
Add

The Add menu button on the Alert Request dialog box opens the Add Request Definitions dialog box.
This dialog box contains the following options.
e Category: This option lists available Alert Adaptation Parameters.

e Threshold: This option lists Threshold Codes that can be set to flag the desired data. The threshold
options vary depending on the category chosen.

e Request Product: This option tells the RPG whether to generate a product (image or graphic) when
the threshold is exceeded. The product depends on the category in question.

Remove
This menu button removes a selected radar product from the Alert Request list.
RPG

This options menu opens a list of available RPGs. You can send a request to only one RPG at a time. There
are two Alert Areas for each radar. When a new RPG is selected, the main D2D display pane is cleared and
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the Alert Area and category/threshold settings for that RPG are displayed.

Clear

This menu contains options to clear products or Alert Areas for the currently selected RPG and Alert Area, or
to clear globally. A Global Clear operation clears all product and Alert Area settings for all radars.

Alert Area #1 and #2

These radio buttons are used to toggle on an Alert Area. Once you select an area, it is displayed in the large
pane, and the category/threshold settings for that area are displayed in the Alert Request dialog box.

Send Request

This menu button submits the alert request to the selected RPG and saves the current Alert Area and
threshold settings.

Status messages appear on the AlertViz Status Bar to notify you that your request was sent. When the radar
detects your specified thresholds, an Alert Visualization message automatically appears on the display.

Revert
The Revert menu button opens the Revert dialog box, which confirms your intent to restore the previous
Alert Areas and category and threshold settings to the display. When you select OK, the display clears and

the previously saved Alert Areas and category/threshold settings are restored and displayed.

Load/Edit Area

This menu button displays either Alert Area #1 or Alert Area #2, whichever radio button is selected. Once an
Alert Area is displayed, you can modify it using the following information.

e Editing the Alert Area: Editing the Alert Area involves the use of the pop-up menu over the large
display pane. (Refer to Subsection 2.2.8 for more information on pop-up menus.)

Once you have displayed Alert Area #1 or Alert Area #2, the legend indicates whether the graphic is
editable. Clicking mouse Button 2 (B2) on the legend makes the selected area editable. Clicking and
holding mouse Button 3 (B3) over the display opens the pop-up menu. In addition to the commonly
available options, the options specifically added for Alert Area editing are Select Location and Select
Area.

o Select Location: This option places an alert cell, as shown in Exhibit 8.1-2, at the cursor
location.
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Exhibit 8.1-2. Place Alert Cells with Mouse Button 3

Clicking mouse B3 in the Main Display Pane places alert cells over the graphic at the location of
the mouse pointer. To remove cells, click B3 over the cells you wish to remove.

o Select Area: The Select Area menu option allows you to choose an area using a Stretch
Rectangle tool (responds like a stretch "rubberband" tool), as shown in Exhibit 8.1-3, that is
activated from a pop-up menu. The rectangle automatically fills in or clears alert cells, depending
on whether the initial selection point is empty or has a dot in it.

Exhibit 8.1-3. Select Alert Area with Stretch Rectangle Tool

Note: Another way to select an area is by pressing and holding the Shift Key on the
Keyboard while clicking B3 to obtain the Stretch Rectangle tool.

Exit
Exit is the menu button that closes the Alert Request dialog box. If you have not sent a request, a Warning

dialog box appears and gives you the options to cancel and return to the editor, save before exiting, revert
before exiting, or send a request and save the settings before exiting.
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8.2 RPS List Editor

The primary function of the RPS List Editor is to create or edit a list of radar products (up to 50 for a 56 Kbps
line, up to 31 for a 14.4-Kbps line, up to 20 for a 9.6-Kbps line) and send the list to a WSR-88D RPG for
display in the next radar Volume Scan(s). The RPS List Editor is accessed from the D2D Radar menu, as
shown in Exhibit 8.2-1.

Exhibit 8.2-1. RPS List Editor Option on Radar Menu

Exhibit 8.2-2 shows the RPS List Editor dialog box as it appears when initially opened. The RPS List Editor
lets you view current RPS lists, open other lists, create new lists, and edit existing lists. For sites with more
than one radar, you need to select an RPG using the Select an RPG dialog box (see the discussion of the

RPS List Editor "View" option in this section).
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Exhibit 8.2-2. RPS List Editor Dialog Box

File

The File menu contains the following options:

e New...: This menu option lets you open a new RPS list.

Open...: This menu option opens a list of previously built RPS lists. Choose one from the list or type
the filename in the command line.

Save/Save as...: This option saves the current RPS list. If it is a newly created RPS list, a Save As
dialog box appears, where you can type a new name.

Delete...: This option opens a list of previously built RPS lists, from which you can delete a specific
list.

Exit: This option closes the RPS List Editor dialog box.
List

The List menu, as shown in Exhibit 8.2-3 contains the following options.

Exhibit 8.2-3. RPS List Editor List Dropdown Menu
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e Add product...: This option opens the Add Product dialog box (see the discussion of the RPS List
Editor "Add" option in this section).

e Edit product...: This option allows you to edit the selected product. (A selected product is one you
have highlighted by clicking on its name in the list.)

e Remove product: This option removes the selected product.

e Send list...: This option allows you to send the displayed RPS list to an RPG.
View

The View menu, as shown in Exhibit 8.2-4, contains the following options.

Exhibit 8.2-4. RPS List Editor View Dropdown Menu

Current List: This menu option displays the RPS list that is currently being used by the RPG. Most
offices can view lists from associated radars that are included in the Select an RPG dialog box.

Clear Air Lists: This menu option displays RPS lists that contain products used in Clear Air Mode.
Once you select one of these lists, the Select an RPG dialog box appears. From this dialog box, you
choose the desired radar.

Storm Mode Lists: This menu option displays RPS lists that contain products used in Storm Mode.
When selected, the Select an RPG dialog box appears. From it you choose the desired radar.

Add

Selecting the Add button brings up the Add Product dialog box.

This dialog box presents you with a list of products that may be added to the RPS list, along with relevant
parameters. For example, if you add a reflectivity product to the list, you are also asked to select elevation
angle, data levels, and resolution.
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Note 1: For Super Res products, there is only one choice of data levels and resolution, so you are not
asked for those.

Edit

This option allows you to edit a product selected from the RPS list. This dialog box behaves in the same
manner as the Add Product dialog box.

Remove
This option removes a selected product from the RPS list.
Send

Once you have created or edited an RPS list, you send it to the RPG by clicking on the Send button. A dialog
box appears, asking you to select the RPG you want to send the list to (that is, which radar).

Note 2: The RPS list that you send may be modified to meet the requirements for Central Radar
Collection. Verify your RPS by viewing the current list. You may need to edit your list to ensure the
highest priority products are present.
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8.3 One Time Request

The One Time Request (OTR) application enables you to specify a nonroutine radar product (image or
graphic) and send a request message to the RPG to generate this product for up to nine Volume Scans. It is
through this application that you can generate radar cross sections. You must specify which RPG is to receive
the request, and specify the relevant parameters of the desired product. Then you send the request message to
the radar.

A message appears in the Radar portion of your Alert Visualization Popup Message Dialog window
indicating that your requested product has been sent by the RPG.

The One Time Request dialog box, as shown in Exhibit 8.3-1, includes several options. A description of each
follows the exhibit.

Note: Exhibit 8.3-1 is valid for reflectivity. Different products will bring up other options.

Exhibit 8.3-1. One Time Request Dialog Box

Repeat count:

This menu button opens a list, numbered 1 through 9, which tells the RPG how many upcoming Volume
Scans should include the newly added radar product.

RPG:

This menu button opens a list of RPGs. You may send a request to only one RPG at a time. If you wish to
send a request to multiple RPGs, use the RMR application, which is covered in Section 8.4.
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Product:

This menu button opens a list of radar products, as shown in Exhibit 8.3-2. The radar products listed here
should be familiar to WSR-88D users. Each product has certain parameters that you must specify in your

request. Once you select a product, the One Time Request dialog box adjusts to make these parameters
available.

Exhibit 8.3-2. Radar Products

Priority:

This menu button allows you to select a normal or high priority for the request. The button is not available for
nonassociated RPGs.

Request interval:

This slider bar contains a range of numbers. Each number represents an interval of Volume Scans that can be
selected. For example, a "3" indicates that you wish to have your requested radar product generated every
third Volume Scan.

Elevation(s):

Elevation(s) includes two dropdown list boxes for specifying elevation angles, as shown in Exhibit 8.3-3.
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Exhibit 8.3-3. Elevation(s) List of Options
Variant:

This menu button opens a list of data levels and associated radar data resolutions/kilometers, as shown in
Exhibit 8.3-4.

Exhibit 8.3-4. Variant List of Options
Time:

There are three time settings that let you request and view older radar data. The product is generated by the
RPG from stored raw data.

e Current: The requested product will be from the most recent (real time) Volume Scan.

e | atest: The requested product will be from the latest Volume Scan, whether the data are current or
archived.

e Selected: This radio button activates the Change... button for opening the Set Time dialog box.

Change...:

This button opens the Set Time dialog box, as shown in Exhibit 8.3-5, where you can either set the current
real time or change the time, which lets you access radar data from earlier Volume Scans.
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Exhibit 8.3-5. Set Time Dialog Box with Set time Radio Button Selected
Close
This button closes the One Time Request dialog box.
Send

This button sends the requested products message to the RPG.
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8.4 Radar Multiple Request

The Radar Multiple Request (RMR) application allows you to specify up to eight consecutive hours of
automatic non-routine radar product requests from dedicated and/or dial-out radars. Not only are you able to
obtain and view non-routine radar products from various RPGs with this application, but you can also use
these data to generate Radar Mosaics. Refer to Section 8.7, Objective 26.4, for details on generating a Radar
Mosaic.

The RMR dialog box, as shown in Exhibit 8.4-1, is divided into two parts: Existing Requests, described in
Subsection 8.4.1; and Active Requests, described in Subsection 8.4.2.

Exhibit 8.4-1. Radar Multiple Request (RMR) Dialog Box
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8.4.1 Existing Requests

Once products have been requested, this area of the Radar Multiple Request dialog box contains a tree-view
listing of the existing RMR. (This area is empty if no radar products have been chosen.) The request name is
denoted with a book symbol. Click on the "+" symbol next to the request name to expand the tree-view and
view the contents of the request. If a request has a red "X" through the book symbol, it means that the request
is poorly formed. That is, the request is missing either an RPG or a product, making it unable to work

properly.

Each radar product within a request is denoted with a folder symbol. Click on the "+" symbol next to the
radar product name to reveal the list of RPGs from which the product is sent. The phone symbol next to an
RPG denotes a dial-out radar, while an arrow denotes a dedicated radar. Click on the "-" symbol next to each
product or request name to close the expanded tree-view listings.

New Request

This button opens the Edit Request dialog box, as shown in Exhibit 8.4.1-1. Both new requests and edited
requests use the same dialog box. It contains options for selecting and requesting a radar product from one or
more RPGs.

Exhibit 8.4.1-1. Edit Request Dialog Box for New Requests

The Edit Request dialog box has the following options (the Existing Request section of the RMR dialog box
also contains these options):

e Name: In this entry line you can type a unique name to identify your radar request.

Single Request: This radio button limits the radar request to one product retrieval.

Multiple Request: Choose this radio button if you want to repeat a radar product request.

Repeat every: You can choose the update frequency of your product request by using the
minute(s)/hour(s) option menus, or by typing the time interval in the entry boxes.

Duration: Within these entry boxes you can choose up to 8 hours of consecutive requests.
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e Cancel: This menu button closes the New Request dialog box without initiating any requests.

e OK: This button acknowledges the entry you have made, closes the New Request dialog box, and
immediately opens the Add Products dialog box.

Copy Request

This button opens the Copy Request dialog box, which allows you to copy the existing highlighted request
and give it a new name in the entry line provided. This button is disabled if nothing is currently selected in
the tree view.

Add Products

This button opens the Add Products dialog box. This button is disabled if nothing is currently selected in the
tree view.

The Add Products dialog box has the following options:

e Dial-out RPGs: This is a list of available dial-out radars. Click mouse Button 1 (B1) on the desired
RPGs.

Dedicated RPGs: This is a list of available dedicated radars. Click B1 on the desired RPGs.

Product: This option contains a list of radar-generated products that should be familiar to WSR-88D
users. Each product has certain parameters to specify in your request.

Request Interval: (1-9)

Add: This button adds the selected products to your request. The Add Products dialog box remains
open when you add a product so you may add multiple products without having to reopen it each time.

Close: This button closes the Add Products dialog box.

Note 1: The contents of the Add Products dialog box vary depending upon the products. Possible
options and parameters are listed as follows:
’1. Elevation Angle (0.5-19.5 degrees) ‘7. Contour Interval (2,000 - 30,000 ft)
’2. Data Levels (8 or 16) ‘8. Altitude (0-70 thousand feet [kft])
‘3. Resolution (1, 2, or 4 km) ‘9. End Hour and Time Span
‘4. Speed ‘10. Channel Map
‘5. Dir ‘1 1. Elevation Segment Number
‘6. Layer
Edit

This button is context sensitive. That is, what you edit depends upon what you select in the tree view. If you
highlight a request and press the Edit button, the Edit Request dialog box, shown in Exhibit 8.4.1-1 opens
(refer to the descriptions listed above under New Request).
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Note 2: If a product or RPG is highlighted in the tree view, selecting the Edit button opens the Edit
Product dialog box, which is similar to the Add Product dialog box except that it has OK and Cancel
buttons instead of Add and Close buttons. This allows you to edit the products or RPGs that were
selected in the tree view.

Delete
This button is also context sensitive. What it deletes depends on what is highlighted in the tree view.

e [farequest is highlighted and you select the Delete button, a Confirmation dialog box appears to
confirm your decision to delete the request.

e [fa product within a request is highlighted when you select the Delete button, a Confirmation dialog
box appears to confirm your decision to delete the product within the request.

e [fan RPG is highlighted in the tree view when you select the Delete button, the RPG is removed from
the request.

Submit

This button makes a highlighted request active. This button is enabled only if a request containing at least one
product is highlighted in the tree view. Observe the AlertViz Status Bar at the bottom of the CAVE-D2D
display for messages on your request.
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8.4.2 Active Requests

The Active Requests area of the Radar Multiple Request (RMR) dialog box contains a tree-view listing of the
radar product requests that are currently running (see Exhibit 8.4-1). There are two options associated with
this dialog box.

e Cancel: The Cancel menu button deactivates the highlighted active request. This button is disabled if a
request is not selected in the Active Requests Tree View.

e Close: The Close menu button closes the RMR dialog box.
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8.5 Radar Display Controls

The Radar Display Controls dialog box is derived from the Radar Tools submenu, as shown in Exhibit 8.5-1.
It provides options that control the appearance of the Storm Track Information (STI), the Hail Index (HI), the
Tornado Vortex Signature (TVS), and the Digital Mesocyclone Display (DMD) products, along with Storm
Relative Motion (SRM) options. The Radar Display Controls dialog box options are described below.

Exhibit 8.5-1. Radar Tools Submenu - Radar Display Controls Dialog Box

The Radar Display Controls dialog box is divided into six sections: STI, HI, TVS, DMD/MD/TVS, DMD, and
SRM. Each section has the following options:

STI (Storm Track Information)

This section has options to adjust the appearance of the STI graphic product.

e Number of storms to show: This slider bar lets you choose the maximum number of storms (0 to 100)
you wish to display on the STI product. The default value is 20 storms.

e Type of track to show: This options menu allows you to choose the type of storm track that you want
displayed.
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o no tracks: When you select this option, only the current storm location(s) are displayed.

o past: When you select this option, the previous location(s) of the storm(s) are plotted with small
dots.

o forecast: When you select this option, the extrapolated forecast positions(s) of the storm(s) are
plotted with small + symbols.

o past & fcst: When you select this option, both the previous and the forecast position(s) of the
storm(s) are displayed. The default track setting is to show both the past and the forecast tracks.

HI (Hail Index)

This portion of the Radar Display Controls dialog box contains options that alter the appearance of the HI
radar graphic product. You can set the low and high algorithm thresholds of the Probability of Hail (POH) and
the Probability of Severe Hail (POSH). Storms that meet the low POH threshold are indicated by small open
triangles, while small solid triangles mark those that meet the high POH threshold. Similarly, large open
triangles or solid triangles are plotted for the POSH low and high thresholds, respectively.

e Low hail probability (POH): The storms that meet or exceed the threshold are indicated by small
open triangles. The default setting is 30.

o Low severe hail probability (POSH): The storms that meet or exceed the threshold are indicated by
large open triangles. The default setting is 30.

e High hail probability: The storms that meet or exceed the threshold are indicated by small solid
triangles. The default setting is 50.

e High severe hail probability: The storms that meet or exceed the threshold are indicated by small
solid triangles. The default setting is 50.

TVS (Tornado Vortex Signature)

There is one option in this section of the Radar Display Controls dialog box.

e Show elevated TVS: This toggle button lets you control the appearance of the elevated TVS radar
graphic product.

DMD, MD, TVS

There is one option in this section of the Radar Display Controls dialog box.

e Show extrapolated Features: With this option, you can choose whether to show the time-extrapolated
features using DMD, MD, or TVS.

DMD (Digital Mesocyclone Display)

This section of the Radar Display Controls dialog box enables you to control what features are displayed. For
example, at the default setting of 3, only features with strength 3 (13) or higher will be shown on the display.
You can also choose to display the overlapping Mesos.
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e Type of track to show: This options menu allows you to choose the type of storm track that you want
displayed.

o no tracks: When you select this option, only the current storm location(s) are displayed.

o past: When you select this option, the previous location(s) of the storm(s) are plotted with small
dots.

o forecast: When you select this option, the extrapolated forecast positions(s) of the storm(s) are
plotted with small + symbols.

o past & fcst: When you select this option, both the previous and the forecast position(s) of the
storm(s) are displayed. The default track setting is to show both the past and the forecast tracks.

SRM (Storm Relative Motion)

This section has options to set the storm motion vector. The high-resolution version of the SRM product uses
the 8-bit velocity for a given tilt and applies a storm motion vector to the field. Options for specifying the
storm motion vector are:

e Storm Motion from WarnGen Track: The display uses the vector that was last generated from either
WarnGen or the Distance/Speed Tool. The storm motion vector that is used will be shown on the
display. If a vector has not been set within the last 24 hours, it will be deemed out of date and will not
be used. In this case, a zero movement will be used, and you will get an indication of this in the upper
left corner of the product.

e Average Storm Motion from STI: The display uses the storm motion calculated by the storm track
algorithm. This motion is available as part of the storm track (STI) product.

e Custom Storm Motion: Selecting this radio button enables the coordinated slider bars used to set the
direction and speed.

It is important to note that the user-specified motion vectors, as well as the other settings in the Radar Display
Controls dialog box, are workstation-specific. This means that changes to the number of storms, track types,
etc., affect all displays on that particular workstation. Once these settings are changed from their default
setting, they stay that way until changed again.

Page 359



CAVE-D2D User's Manual AWIPS |1 Operational Build 13.4.1 - 31 July 2013

8.6 Dual-Polarization

There are three types of radars for collecting data used in forecasting the weather: WSR-88D (Weather
Surveillance Radar - 1988 Doppler), TDWR (Terminal Doppler Weather Radar), and ASR (Airport Surveillance
Radar). The WSR-88D is the only type that has been equipped with the dual-polarization technology. WSR-88Ds
are only located at Radar Product Generator (RPG) sites, accessed via the CAVE D2D - kxxx menu. The CAVE
D2D - txxx menu supports Supplemental Product Generator (SPG) sites, which are equipped with TDWR radars,
and ASRs are FAA radars at airports, which only provide fill-in coverage for the WSR-88D network, and are
accessed via the CAVE D2D - Radar menu.

Dual-polarization Doppler radars simultaneously transmit and receive pulses that are polarized both horizontally
and vertically, which enables the radar to measure the horizontal and vertical dimensions of atmospheric targets.
Conventional Doppler radars transmit and receive only horizontally polarized pulses, which only allow the radar
to be sensitive to the motions toward and away from the radar. These systems can determine the location of
precipitative areas, pick up moving targets, and even filter out stationary objects such as buildings and terrain.
However, even moving targets can cause clutter, and unidentifiable non-weather objects such as birds and flying
debris compromise the radar data, which has a major negative impact on forecast and warning operations. Thus,
the conversion of all WSR-88Ds to dual-polarization is a major upgrade, which allows the radar to sense the size
and shape of objects in the atmosphere, making for reliable identification of weather and non-weather objects.

The WSR-88D with dual-polarization technology greatly improves forecasts and warnings for hazardous weather.
This capability not only affects meteorologists, but it also has significant impact for hydrologists, aviation users,
and society. How each of these groups is affected follows.

e Meteorologists:

o Improves accuracy in identifying precipitation types, which leads to more accurate winter weather
forecasts, especially during times of mixed and icy precipitation.

o Improves precipitation estimates, which leads to more accurate river forecasts and flash flood
warnings.

o Improves flash flood watches and warnings by distinguishing between very heavy rain and hail,
which contributes to increased lead time in flash flood and winter weather hazard warnings.

o Improves detection of non-weather artifacts, such as birds and ground clutter, which allows
forecasters to focus on real precipitation radar targets.

o Improves hail detection, which leads to increased confidence in the presence and size of hail in strong
to severe thunderstorms.

o Enables the detection of lofted tornado debris, which does not directly lead to improvements in
tornado warnings, but does provide a higher degree of confidence in a tornado's presence and track
when significant damage is occurring. This feature is especially beneficial at night, when tornadoes
are difficult to see. However, to detect the debris, the tornado must be either close to the radar, or if
far away, the tornado needs to be strong enough to lift debris to the altitude that the radar can see.
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¢ Hydrologists:
o Provides critical rainfall estimation information for stream flow forecasts and river flooding.
o Provides information useful in water management.
e Aviation Users:
o Detects aviation hazards such as birds.
o Detects aircraft icing conditions.
e Society:
o Improves rainfall estimates, which saves public funds.

o Improves forecasts and warnings, which reduces the impact of hazardous weather on our national
transportation systems.

o Provides improved forecasts, which help the public make wiser safety decisions.

Dual-Polarization Products

All dual-polarization products originate from the D2D kxxx menu shown in Exhibit 8.6-1.

Exhibit 8.6-1. Accessing Dual-Polarization Products

Note 1: The numbers shown on Exhibit 6.8-1 correspond to the descriptions of the dual-pol products
described below.
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Dual-polarization technology is comprised of six products. Descriptions of each product follow.

1. Correlation Coefficient (CC): Defined as the measure of how similarly the horizontally and vertically
polarized pulses behave within a pulse volume. CC is great at discriminating between non-meteorological
echoes and meteorological echoes. The possible range of values is from 0.2 to 1.05. CC has no unit of
measurement. It is used for identification of:

o Meteorological vs Non-meteorological Echoes

@)

Melting Layer

Rain vs. Snow

o

Tornadic Debris

o

@)

Large Hail

(@]

Irregular Hydrometeor Shapes
o Quality of Other Polarimetric Variables.

Exhibit 8.6-2 illustrates an example of how to access and display the dual-pol CC product.

Exhibit 8.6-2. Example of CC Product

Page 362



CAVE-D2D User's Manual AWIPS |1 Operational Build 13.4.1 - 31 July 2013

2. Differential Reflectivity (ZDR): Defined as the difference between the horizontal and vertical reflectivity
factors. ZDR is a good indicator of the mean drop size diameter of the dominant echoes. The possible range
of values is from -7.9dB to +7.9dB. ZDR is measured in decibels and is used for identification of:

o Hail

@)

Melting Layer

Rain vs. Snow

©)

Tornadic Debris

(@]

©)

Updraft (ZDR column)
o Different Types of Frozen Precip.

Exhibit 8.6-3 illustrates an example of how to access and display the dual-pol ZDR product.

Exhibit 8.6-3. Example of ZDR Product
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3. Specific Differential Phase (KDP): Defined as the range derivative of the differential phase shift along a
radial. KDP is similar to ZDR in that the shape of the target affects the differential phase shift, but unlike
ZDR, KDP is dependent on particle concentration. KDP is measured in deg/km and is used for identification

of:
o Heavy Rain only
o Heavy Rain mixed with Hail
o Cold vs. Warm Rain Processes.

Exhibit 8.6-4 illustrates an example of how to access and display the dual-pol KDP product.

Exhibit 8.6-4. Example of KDP Product

Page 364



CAVE-D2D User's Manual AWIPS |1 Operational Build 13.4.1 - 31 July 2013

4. Hydrometeor Classification (HC) or Hydrometeor Classification Algorithm (HCA): The purpose of
this product is to determine the most likely echo from a pre-defined list of echo classes. It makes its best
guess of precip type using the echo's Z, V, ZDR, CC, and KDP values and the quality and reliability of those
base products. The pre-defined list of possible echo classifications consists of 12 different classes of echoes
displayed on the AWIPS color bar shown in Exhibit 8.6-5. A description of the classes of echoes follows.

Exhibit 8.6-5. HC Color Bar
o BI (Biological Scatters): Includes things such as birds and insects.

o GC (Ground Clutter): Includes things such as buildings, trees, and cars, which appear normally or as
anomalous propagation.

o IC (Ice Crystals): Ice in the form of columns, needles, plates, etc.

o DS (Dry Snow): Includes snow flakes that are low-density.

o WS (Wet Snow): DS that begins to melt and become water coated.

o RA (Moderate Rain): Light to moderate rain.

o HR (Heavy Rain): Heavy rain.

o BD (Big Drops): Large rain drops (at least 3-4 mm in diameter) that appear in low concentration.
o GR (Graupel): Includes precipitation in the form of soft hail or snow pellets.

o HA (Hail): Includes pure hail or hail possibly mixed with rain.

o UK (Unknown): Includes bins where the algorithm could not decisively say what category that bin
could fit into, either because the confidence value was too low or because two categories were too
close to determine.

o RF (Range Folding): Another classification that will most likely never affect the HC product.

In an operational setting, the HC product is most useful for supplementing base data analysis. The HC
algorithm (HCA) can alert a forecaster to something possibly missed in base data analysis. It can help a
forecaster more quickly hone in on a feature of interest (most notably hail), or other subtle hint provided by
the base data. However, it could possibly misclassify a signature, so it is recommended that the HC product
be used in conjunction with the polarimetric base data and not as a stand-alone product. Exhibit 8.6-6
illustrates an example of how to access and display the dual-pol HC product.
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Exhibit 8.6-6. Example of HC Product

5. Melting Layer (ML) or Melting Layer Detection Algorithm (MLDA): The ML product is an
elevation-based radar product. The MLDA provides the height of the top and bottom of the melting layer
and is updated every volume scan, which is every 5 minutes. The product should always be used with
another elevation-based radar product that is being analyzed. Also, the elevation angle of the ML product
must match the elevation angle of the product being analyzed. The reason the angles must match is that the
ML products are radar centric and specific to radar elevation angles; thus they are meaningless unless
overlaid on matching elevation angle products. The ML product is best used with the elevation-based ZDR
and CC products. Both of these products are great in identifying the melting layer because the melting layer
has distinct signatures in these products. Exhibit 8.6-7 illustrates an example of how to access and display
the dual-pol ML product.
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Exhibit 8.6-7. Example of ML Product Overlay on CC Product

6. Quantitative Precipitation Estimation (QPE): The dual-pol QPE improves the accuracy of rainfall
estimation. Dual-pol adds 9 new precip products to the legacy precip products. The legacy precip uses the
hybrid scan reflectivity for a single R(Z) relationship. Whereas for dual-pol precip estimations, the hybrid
scan hydroclass product is used to assign a rainfall rate relationship. This means the rainfall rate relationship
used for a particular location is specific to the dominant hydrometeor type at that location, which potentially
improves the estimation of rainfall rate. Dual-pol QPE products are accessed via the kxxx Precip submenu
shown in Exhibit 8.6-8. Table 8.6-1 provides a description of each dual-pol QPE product, and Exhibit
8.6-9 illustrates an example of a QPE HHC product.
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Exhibit 8.6-8. Dual-Pol QPE Products

Note 2: The numbers shown on Exhibit 6.8-8 correspond to the numbers in Table 8.6-1.
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W| Product Type ] Product Name Abbreviation Description
This product is the hydrometeor classification used in rain rate
1. |Instantaneous  |Hybrid Hydroclass HHC relationship. The HHC product is the radar's best guess of the echo type
that is used as an imput into the dual-pol precipitation algorithm.
[ .. s This product displays instantaneous precipitation rate (new functionality
2. |Instantaneous E;%:al Precipitation DPR with dual-pol). One advantage of this product is that it can give you a
good idea of where there may be heavy rain right now.
Dicital Accumulation This product provides a 1 hour accumulation with no bias (bias=1.00)
3. |Accumulation Ar%a DAA applied ever. It is for users who want raw, unbiased 1 hour accumulation
Y data.
4 |Accumulation One Hour . OHA Thls.product is similar to the. legacy OHP product, providing the
Accumulation maximum | hour accumulation.
This product is similar to the legacy DSP product, showing the total
5 | Accumulation Digital Storm Total DSA accumulated rainfall since the beginning of an event. There is no DSA
' Accumulation label on the kxxx Precip submenu. Therefore, to load the DSA product,
select "Storm Total Accum (STA)."
6. |Accumulation Storm Total STA This product is the 2 km resolution, 4-bit version of the DSA product. It
’ Accumulation matches the resolution and data levels of the legacy STP product.
. Digital One Hour This product is gsed to compare legacy precip products to dual-pol precip
7. |Difference . DOD products. DOD is the difference between dual-pol and legacy 1 hour
Difference . . . .
accumulations, with no bias applied.
[ .. Like DOD, this product is used to compare legacy precip products to
8. |Difference Bi?;;?i:;grm Total DSD dual-pol precip products. DSD is the difference between dual-pol and
legacy storm total accumulations, with no bias applied.
This product provides accumulated precipation over a time period chosen
by the user. The time period can be as short as 15 minutes, or as long as
.. 24 hours. One advantage of this is that a precipitation product that most
Digital . o . .
suits the situation can be requested. A 1 hour DUA will be automatically
9. |User-selectable |User-selectable DUA . .
Accumulation generated every volume scan, and a 12 hour DUA will be automatically
generated every day at 12 Z. Note that the kxxx Precip submenu includes
6 pre-set duration entries, which will load any DUA product exactly
matching the duration given in the menu.
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Exhibit 8.6-9. Example of a QPE HHC Product

Note 3: For a detailed presentation on dual-polarization, refer to the NWS Warning Decision Training
Branch (WDTB) - Dual-Polarization Radar Training Course at http://www.wdtb.noaa.gov/courses
/dualpol/outreach/.
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8.7 Using Radar Applications

These modules guide you through the basic use of the radar applications.
Module 24: Creating an Alert Request

Sending an Alert Request (refer to Section 8.1) is a four-part process involving both the Graphics (LX) and
the Text (XT) displays. The parts of the process are listed below.

1. Select and edit the Alert Area

2. Choose a category(s) and threshold(s)
3. Send the Alert Request

4. Wait for a response

These parts are delineated in the following objectives.
Objective 24.1 - Editing an Alert Area

An Alert Area consists of small (16 x 16 km) squares (called Cells), as shown in Exhibit 8.7-1, that
delineate the Alert Area for the RPG. Cell locations for the radar must be within the 460-km scan range of
the radar to be valid. A valid Alert Cell is indicated by a small square.

Valid Alert Cell Invalid Alert Cell

Exhibit 8.7-1. Examples of Valid and Invalid Alert Cells
1. From the Scale option menu, select State(s) or RFC.
2. From the Radar dropdown menu, choose Alert Request....

3. Press the Alert Area #1 radio button. If there is a previously saved Alert Area, it is displayed with its
legend in the large display pane. If there is not a previously saved Alert Area, only the Alert Area
legend appears.

4. Click mouse Button 2 (B2) on the Alert Area #1 Editor legend to make the area editable.
5. Place the mouse pointer over the area of interest.
6. Click mouse Button 3 (B3) over the Main Display Pane to open a pop-up menu.

7. Choose Select Area. An anchor point with an attached stretch rectangle appears on the screen.
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Note 1: Another way to obtain the anchor point and stretch rectangle is to place the cursor over
the specific point of interest, hold down the Shift key, and click B3.

8. Stretch the rectangle to the desired location and release. Within a moment, Alert Cells fill in the
rectangle area. The anchor point appears wherever you open the pop-up menu in the Main Display

Pane, or wherever the cursor is when you press the Shift key and B3 simultaneously. Refer to Exhibit
8.7-2.

Exhibit 8.7-2. Rectangle Area with Valid Alert Cells

Note 2: The Select Area tool toggles all Cells within it on or off depending on the state of the
Anchor Point Cell. If the Anchor Point Cell is off, then all valid points within the selected
rectangle area are turned on, and vice versa.

9. You can remove or add individual Alert Cells by clicking B3. Try this option.

10. If you need to remove a larger block of Alert Cells, click and hold B3 over the Cells in the Main
Display Pane to open the pop-up menu and choose the Select Area option. Then stretch the rectangle

over the Cells you want to remove and release. The selected Cells are then removed. This is illustrated
in Exhibit 8.7-3.

Exhibit 8.7-3. Removing Alert Cells

11. Keep the display as is for the next objective.
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Objective 24.2 - Adding a Category and Threshold

1. Click the Add menu button in the Alert Request dialog box. The Add Request Defs dialog box
opens.

2. From the Product options menu, choose 7 Vol VAD.
3. From the Threshold Codes options menu, select 1 15Kts.

4. For the Request Product inquiry, select the ""No’* check button. The "*No"* selection means that the
Volume VAD radar product is not sent to AWIPS; only a text message is sent to the text display when
the 15-kt threshold is reached. A ""Yes' choice sends the Volume VAD product when the threshold is
met.

5. Press the OK menu button to add the Vol VAD product to your Alert Request list in the Alert
Request dialog box.

6. Save this list for the next objective.

N

Note: You cannot send Alert Requests to the RPG for both Alert Areas at the same time.

Objective 24.3 - Sending and Receiving an Alert Request

1. In Objective 24.2, the Vol VAD at 15Kts was selected.

2. Choose the desired RPG from the RPG options menu.

3. Press the Send Request menu button to send your request.

4. The Radar Ingest acknowledges your Alert Request with a message in the Radar status bar.

5. If the requested thresholds are reached (in our case, if the VAD profile winds reach 15 knots), then a
message appears in the message window of the AlertViz Status Bar.

Note 1: A message is generated when a threshold is reached. There are no alerts for a Volume
Scan, or if the alert is canceled.

6. On the text display, open the AFOS browser.
7. From the Class option menu, select Radar/Upper Air.
8. Under the Node menu, choose WSR (at the bottom of the menu).

9. Choose the desired Ctgry and Designator, then load the text product.

Note 2: You must be an associated user with a dedicated line to send an Alert Request to an
RPG.
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Module 25: Using the RPS List Editor

The products in the RPS List Editor (refer to Section 8.2) should be familiar to WSR-88D users. The interface
is designed to adjust based on the radar products you choose, so you can select the desired elevation angles,
resolutions, data levels, and other appropriate parameters. Changes to the RPS list are usually infrequent and
should be implemented according to office policy.

Objective 25.1 - Adding a Product to the RPS List

1. From the kxxx dropdown menu, select the RPS List Editor. This opens the RPS List Editor dialog
box.

2. From the View dropdown menu, select Current List. This opens the Select an RPG dialog box.
Choose the RPG you want and click the OK menu button. The current RPS list appears.

3. Scroll through the RPS list to review its contents and decide which product you would like to add.
4. Press the Add menu button, which opens the Add Product dialog box.

5. From the Add Product dialog box, select Velocity at 5.3 degrees (or other available elevation angle),
with 16 data levels at 0.25 km resolution.

6. Click the OK button. Notice that the product has appeared at the bottom of the RPS list.

7. If you do not want to make changes to the RPS list, from the File menu, select Exit to abort the RPS
list session; otherwise, make the necessary changes and proceed to Step 8.

8. Click the Send menu button. The Select an RPG dialog box appears once again. Choose the RPG
you want and click the Send button in this dialog box.

9. A message appears in the Radar status bar when the product addition is received by the RPG. The
new product should be available for display starting the next Volume Scan.

Module 26: Making a One Time Request

It is important to know that the One Time Request (OTR) application (refer to Section 8.3) does not change
the existing scan strategy to obtain a nonroutine radar product, but it does allow you to request a radar
product that is derived from the present scan strategy.

You can make an OTR from either associated or non-associated radars (the latter is achieved through the
dial-out capabilities) These methods are illustrated in Objectives 26.1 and 26.2. Objectives 26.3 provides
practice in generating a radar cross-section OTR, and Objective 24.4 provides practice in generating a Radar
Mosaic..

Each of these is illustrated in the following objectives.
Objective 26.1 - Making a One Time Request from an Associated Radar

1. From a kxxx dropdown menu, select One Time Request.... This opens the OTR dialog box.
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2.

3.

10.

11.

From the Repeat count options menu, select 4.
From the RPG options menu, select K(xxx).
From the Product options menu, choose Reflectivity (Z).

From the Request Interval slider bar, select 3. Based on Steps 2 and 4, you've requested that this
product be generated every third Volume Scan, and that this occur four times.

From the Elevation(s) options menu, select Single and 1.5.
From the Variant options menu, choose 16 levels with a resolution of 0.15 at 90.0km.
In the Time area of this dialog box, select the Current radio button (which is the default).

Click the Send menu button. A message appears in the Radar status bar to inform you that your
request was sent out.

If all the connections are up with the radar, your requested product should be available from the kxxx
refl dropdown menu in four upcoming volume scans.

The Repeat Count and Request Interval apply only to associated radars. For dial-out radars, Repeat
Count is set to 1, and Request Interval therefore has no meaning.

Note: Certain classes of radar products are available only through the OTR application.

Objective 26.2 - Making a One Time Request from a Non-associated Radar Using Dial-out

1.

From the kxxx dropdown menu for a non-associated radar, select OTR (Repeat Count will be grayed
out), and choose a different non-associated RPG than the one chosen in the previous objectives.

Objective 26.3 - Generating a Radar Cross Section One Time Request

From the Toolbar, set the scale to WFO.
From the kxxx dropdown menu, open the kxxx Refl cascading menu and select the 0.5 Refl product.

From the Toolbar, select the Baselines icon to display the Baselines tool. Turn on Edit mode for the
Baselines.

Edit Line C-C' somewhere in your CWA by pressing on C or C' and dragging towards the center of
the line. The line length needs to be between 0.54 and 124 nMi.

From the Radar dropdown menu, select One Time Request.... The OTR dialog box appears.
From the Product option menu in the OTR dialog box, select Ref X-Sect (RCS).

Choose Baseline C and confirm that the line length provided in the OTR dialog box is between 0.54
and 124 nMi.
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8.

9.

10.

Press the Send button at the bottom of the OTR dialog box. Monitor the Radar status area to see if
your request was properly received by the RPG.

From the kxxx dropdown menu, open the kxxx Derived cascading menu and select Reflectivity
(RCS) in the cross-section portion of the menu.

Observe the data as they are displayed in a Range Height Indicator (RHI)-like presentation.

Objective 26.4 - Generating a Radar Mosaic

The radar mosaic merges like radar data from multiple radars (dedicated and dial-out) into a single
composite product (refer to Section 8.4). To generate a radar mosaic, you must first dial out to various
desired radars, and then obtain a specified radar product from that radar. The OTR Radar application
fulfills these two actions. You can dial out and make one-time requests from as many radars as are in your
Radar dropdown menu. The data that are time-matched are then combined and made accessible from the
Mosaic portion of the Radar dropdown menu.

SBN delivery of data from all radars makes mosaics routinely available and obviates the need for this
exercise. However, it remains in this Practice Module. as an illustration.

1.

2.

From the Toolbar, clear the Main Display Pane.
From the Toolbar, set the scale to State(s).

From the kxxx dropdown menu, select the One Time Request... application. The One Time Request
dialog box is opened.

From the Radar Status Bar at the bottom right edge of the D2D display, open the Radar Status dialog
box, so you can easily read the messages.

Within the OTR dialog box, make the following selections:
o Select one of your dial radars.
o Choose Reflectivity at 1.5 elevation, 16 levels, with a 1-km resolution.
o Select Current as the time.

Press the Send button, and after a brief moment observe the messages that appear in the Radar
Status dialog box. These messages should tell you that a successful connection to the dial-out radar
was made and a successful delivery of the OTR was completed.

From the Radar dropdown menu, select the Mosaic 0.5 Reflectivity. The dedicated dial-out radar
data appear in the Main Display Pane. Keep the mosaic displayed for the next step.

Repeat Steps 5 through 7 for a couple other dial-out radars.

As the products are sent from the various RPGs, the data should display automatically on the
displayed radar mosaic, as long as the data are time-matched. If the radar do not display
automatically, clear the Main Display Pane and reload the 0.5 Reflectivity from the Mosaic section of
the Radar dropdown menu.
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Note 1: Radar mosaic is limited to those radar products contained in the Mosaic portion of the
Radar dropdown menu.

Note 2: When radar data overlap, each pixel in the frame can potentially be assigned a value
from any of the radars that are part of the mosaic. When this occurs, the largest value is one that
is used in the mosaic.

Note 3: A frame of the radar mosaic can contain only one scan per radar.

Note 4: One complication in creating radar mosaics is that some radars may be in clear-air mode
while others are operating in storm mode. The result is a difference in the relationships between
data level and reflectivity. Therefore, reflectivity mosaics are plotted as 8-bit images and have
their data levels rescaled to a color map that covers the entire range of reflectivities for clear-air
and storm mode imagery.

Note 5: Another complication is the timing of volume scan cycles for each radar in the given
mosaic. A time matching algorithm decides what times to create and which radar scans are
rendered into each frame of the mosaic. Generally, the maximum time difference allowed is
twice the minimum volume scan rate. So, if the volume scans are updating every 6 minutes, the
maximum time allowed is 12 minutes. If some radars are updating at different rates, there can be
occasions when a mosaic may not contain every radar.

Module 27: Using the Radar Multiple Request Application

Using the Radar Multiple Request (RMR) application (refer to Section 8.4), you can obtain radar products in
succession from one or several RPGs with one request.

Objective 27.1 - Making a Radar Multiple Request

1. From either the kxxx or the Radar dropdown menu, under the Applications heading, select Radar
Multiple Request.... The RMR dialog box appears in a few seconds.

2. Inthe RMR dialog box, click on New Request.... The New Request dialog box opens.

3. In the New Request dialog box, type a unique name in the Name entry field, and make sure that the
Multiple Request button is selected.

4. Also in the New Request dialog box, set Repeat every to 6 minutes, and the Duration to 2 hours.
5. In the New Request dialog box, select OK. The Add Products dialog box immediately opens.
6. Inthe Add Products dialog box, select two dial radars and one dedicated radar.
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7.

8.

10.

11.

12.

From the Product menu, select the VIL product.

In the Add Products dialog box, press the Add button. This adds your request to the Existing Requests
list.

Press the Close button at the bottom of the Add Product dialog box. Check your newly added request.

Click on the name of your new request and press the Submit button. This activates your request.
Now you should see your request in the Active Requests portion of the RMR dialog box.

Observe the D2D Radar status bar to see if your requests are being met by the RPGs. You should
see dial-out messages along with request messages. Select the Radar Status button to see all of the
radar status messages.

Once the RPG has sent back the requested products — in this case, the VIL product — you can display
this product from the kxxx or the Radar dropdown menus, in the Derived cascading menu. The
requested product should have an updated valid time within the menu.

Module 28: Obtaining and Displaying Cell Trend Information

Objective 28.1 - Obtaining and Displaying Cell Trend Information

Clear the Main Display Pane, and from the Toolbar, set the scale to WFO.

From the kxxx dropdown menu, open the kxxx Refl cascading menu and select the 0.5 Refl product.
From the Toolbar, press on the Interactive Points Tool icon to overlay onto the radar data.

If necessary, with mouse B2, click on the Interactive Points legend to make the tool editable.

Drag Point A until it is over the area of interest.

Swap the radar data to a Smaller Monitor Pane.

From the Toolbar, set the scale to WFO.

From the kxxx dropdown menu, open the kxxx Graphics cascading menu and select point A under
the Cell Trends heading. The Cell Trends graphic appears on the display. Notice the valid time
associated with this product. It should be from the latest radar volume scan.

Note 1: At times, the RPG may not identify storms in a very intuitive manner. The inset map in
the upper right corner of the Cell Trends graphic shows the RPG-assigned cell ID. Compare this
ID with the ST cell ID.

Note 2: You can display multiple cell trend plots simultaneously and toggle them from the
product legend.
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9.0 Background Applications

The AWIPS background applications are designed to run unattended in the background. Once they are set up,
they run independently and need only to be monitored.

The AWIPS background applications currently consist of the following two applications:
e The NOAA Climatological Reports Formatter
e The Hourly Weather Roundup (HWR) Application

Both applications are accessed by opening the AWIPS start-up menu shown in Exhibit 9.0-1, and selecting
Background WFO Apps.

Exhibit 9.0-1. AWIPS Start-up Menu - Background WFO Apps

The NOAA Climatological Reports Formatter and HWR applications generate products that you may wish to
review and edit before transmission. The status of these products is displayed in the Monitoring Controller
dialog box, which is automatically displayed when you log into the AWIPS text display.

Note: The NOAA Climatological Reports Formatter and HWR need to be set up for each site by the
site's System Administrator.

This chapter includes the following sections:

e Section 9.1: The NOAA Climatological Reports Formatter

e Section 9.2: The Hourly Weather Roundup (HWR) Application

e Section 9.3: The Monitoring Controller
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9.1 The NOAA Climatological Reports Formatter

The NOAA Climatological Reports Formatter formats Daily Climatological Reports (product identifier
"CLI"); Monthly, Seasonal, and Yearly Climatological Reports (product identifier "CLM") for AWIPS.

The Daily Climatological Report is used to summarize one or more stations' daily weather observations,
records, normals, departures from normal, and last year's values for that date. Similarly, the Monthly,
Seasonal, and Yearly Reports are used to summarize one or more stations' weather observations, records,
normals, departures from normal, greatest amounts and values, and dates of occurrence over the
corresponding period. The Formatter prepares tabular products to be disseminated over the NOAA Weather
Wire Service (NWWS) and voice-ready products for broadcast over the NOAA Weather Radio (NWR).
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9.1.1 Normal Operations

The Daily Climatological Reports Formatter application is normally scheduled for execution by a crontab twice
per day. If required, an intermediate product can be scheduled by a crontab also. Options for forecaster initiation
of the morning, intermediate, and evening Daily Climatological Reports are provided on the Climate Master
dialog box. An example of a Display Station Daily Climate Values dialog box is shown in Exhibit 9.1.1-1.

Exhibit 9.1.1-1. Display Station Daily Climate Values Dialog Box

The Monthly, Seasonal, and Yearly Reports Formatter application is normally scheduled for execution by a
crontab after the period of interest ends. Options for forecaster initiation of the Climatological Reports for each
period are provided on the Climate Master dialog box.

Once the formatter has completed the climate products, the eyeglasses notification symbol pops up and the word
"New" appears to the left of the Edit Climate Product button on the Monitoring Controller dialog box. You
would then press the Edit Climate Product button. If at least one NWR product has been produced, the
NWRWAVES Browser appears. The available products are displayed in the Delayed field. The forecaster now has
the following options:

e To view the product, highlight the product and select View.
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¢ To edit the product, highlight the product and select Edit.

e To send the product, highlight the product and select Send.
e Select Refresh to update the Delayed field.
e Select Close to terminate the program.

After the tabular product is formatted, it is sent to the correct directory for forecaster review and then transmission
over the NWWS. When the voice-ready product is formatted, it is sent to the correct directory for display by the
NWRWAVES Browser and transmission to the CRS.

If at least one NWWS product has been produced, the Review Climate Product GUI appears with a listing of all
NWWS products. Prior to transmission, this GUI allows the forecaster to view, edit, delete, and send the generated
NWWS products. The forecaster can also abort the transmission of the NWWS products if necessary.

If the forecaster chooses to send the NWWS product(s), a work copy (heading WRKALTCLI) of the product is
also stored in the text database. The user/forecaster has to configure the WRKALTCLI to alert. This will cause an
alert bell to appear. Upon clicking on the alert bell, the Alarm Display window will display the WRKALTCLI
product. If it contains errors, the forecaster can use the text editor window to edit the actual NWWS climate
product for retransmission.

The Select Climate Run Date Dialog Box

The Select Climate Run Date GUI is shown in Exhibit 9.1.1-2 and its fields are discussed below.

= I

" Latest Morning Climate

' Retrieve Climate for a Prior Period

Exhibit 9.1.1-2. Select Climate Run Date Dialog Box

The upper portion of the GUI provides two options: Latest
<Morning|Intermediate|Evening|Monthly|Seasonal| Annual> Climate and Retrieve Climate for a Prior Period.

e Latest Morning Climate: Choosing this option will execute the Daily Climatological Formatting
application for the previous calendar day.

o Latest Intermediate/Evening Climate: For intermediate and evening climate products, Latest
Intermediate/Evening Climate is the only available option for the GUI. This option will execute the Daily
Climatological Formatting application from midnight to either the execution time or a user-defined valid
time.

e Latest Monthly Climate: Selecting this option will execute the Monthly Climatological Formatting
application for the previous calendar month.
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e Latest Seasonal Climate: Selecting this option will execute the Seasonal Climatological Formatting
application for the previous 3-month season.

e Latest Annual Climate: Selecting this option will execute the Annual Climatological Formatting
application for the previous year.

¢ Retrieve Climate for a Prior Period: This option is available for Morning, Monthly, Seasonal, and Annual
Climatology products. Use this option if the desired climate report is other than the latest morning, monthly,
seasonal, and annual product.

o Morning: Enter the day, month, and year in their respective fields to produce a Daily Climatology
report for a specific date.

o Monthly: Enter the beginning and ending day, month, and year into their respective fields to produce
a Monthly Climatology report for a specific month.

o Seasonal: Enter the beginning and ending day, month, and year into their respective fields to produce
a Seasonal Climatology report for a specific season.

o Annual: Enter the beginning and ending day, month, and year into their respective fields to produce
an Annual Climatology report for a specific year.

e OK: This closes this GUI and executes the Climatology Formatting application that was selected.
e Cancel: This closes this GUI and shuts down the Climate application without making any changes.

There are two versions of the Display Station Climate Values dialog box that provide climate summaries, Daily
(refer to Exhibits 9.1.1-1) and monthly/seasonal/yearly. Both allow the forecaster to review the Daily Climate
Values, or Monthly, Seasonal, or Yearly Climate Values for a list of stations.

Display Station Daily Climate Values Dialog Box

The dialog box menus are discussed below.

e File: The dropdown File option allows the forecaster to Close this dialog box.

e Help: The dropdown Help option allows the forecaster to access help for this dialog box.
The dialog box fields are discussed below.

e Accept Values: The displayed values are stored into the hydromet (HM) database.

e Clear Values: The displayed data are removed from the dialog box so that the fields are blank. This option
does not affect data already stored in the HM database.

e Station: This field provides the user with the option to select the climatological station for which data are to
be displayed in this dialog box. When this Display Station Daily Climate dialog box is initiated, the first
station in the list is automatically highlighted and its daily observations are loaded in the data fields.

e Date: This field displays the observation date.

e Type of Summary: This field displays either "Morning daily climate summary," "Intermediate daily climate
summary," or "Evening daily climate summary."

The next section lists the category names: Temperature, Precipitation, Snow, Wind, and Sky & Weather. Choosing
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a category will display related values in the lower portion of the Display Station Climate Values GUI.

e The large group in the middle of the dialog box contains the maximum/minimum temperature and
humidity, maximum wind speed and direction, and maximum gust speed and direction as well as the time of
occurrence for each of these variables. It also contains the average wind speed.

e The bottom left group contains precipitation and snowfall amounts, percent sunshine, average sky cover,
and maximum/minimum SLP.

e The bottom right group contains all of the observed weather types reported for the day. The observed
types are identified by a check mark in these fields.

Tip: By positioning the mouse cursor over the maximum temperature, minimum temperature, maximum
wind direction and speed, wind gust direction and speed, daily precipitation, daily snowfall, possible sun, sky
cover, or observed weather fields, and then clicking and holding down mouse Button 3 (B3), the forecaster
can view the data retrieval method of the weather parameter. For example, for the maximum temperature, a
pop-up window will appear and indicate the data retrieval method was determined from the Daily Summary
Message, the 24-Hour Temperature Group, the 6-Hour Temperature Group, the Hourly Temperature
Observations, or the Rounded Temperature Observations.

The forecaster can change the values if needed but must select Accept Values before closing the dialog box.

Note 1: There is a high-level quality control check in the Display Station Daily Climate Values dialog box.
The user is unable to enter extreme values for each category. However, there is no comparison between two
fields at this time.

Display Climate Values Dialog Box for Monthly, Seasonal, and Yearly Formatter

The dialog box menus are discussed below.

e File: The dropdown File option allows the forecaster to Accept the Climate Values and Continue or Abort
the Climate Run.

e Help: The dropdown Help option allows the forecaster to access help for this dialog box.
The dialog box fields are discussed below.
e Save Station Values: The displayed values are stored into the hydromet (HM) database.

e Clear Values: The displayed data are removed from the dialog box so that the fields are blank. This option
does not affect data already stored in the HM database.

e Station: This field provides the user with the option to select the climatological station for which data are to
be displayed in this dialog box. When this Display Station Climate Values dialog box is initiated, the first
station in the list is automatically highlighted and its climate values are loaded in the data fields.

e Report Period: This field displays the beginning and ending dates for the period.
e Type of Summary: This field displays either "Monthly Climate Summary," "Seasonal Climate Summary,"

or "Annual Climate Summary."
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The next section lists the category names: Temperature, Precipitation, Snow, Wind, and Sky & Weather. Choosing
a category will display related values in the lower portion of the Display Station Climate Values GUI.

e The large group in the middle of the dialog box contains the maximum/minimum temperature and
humidity, maximum wind speed and direction, and maximum gust speed and direction as well as the time of
occurrence for each of these variables. It also contains the average wind speed.

e The bottom left group contains precipitation and snowfall amounts, percent sunshine, average sky cover,
and maximum/minimum SLP.

e The bottom right group contains all of the observed weather types reported for the day. The observed
types are identified by a check mark in these fields.

The forecaster can change the values if needed but must select Save Station Values before closing the dialog box.

The Review Climate Product Dialog Box

When an NWWS product is created, it can be viewed and modified before it is distributed over the WAN. After
the Display Station Climate Values GUI is closed and the values are written to the database, the forecaster can
actually view and edit the product through the Review Climate Product GUI shown in Exhibit 9.1.1-3.

File Edit {
NWWS Climate Reports Date A
oatput_mon_TST .nuus |F-i Feb 2§ 13:2€:24 2000 J
7
PITELMTS TOHA T Pa8d {47 141492 [
CLIMATE REFORT
NATIONAL WEATHER SZ3VICI TITTSEURCH Ta

225 PM EST FRI FEB 13 2008

THE PITTSBURSH CLIMATZ 3JMMARY FOR THE HOWTH OF JAWUARY ZzZ@@q.

CLIMATE NORMAL FERIOD: 1335 TO 1993
CLIMATE REZZRD CERIOD: 1330 TO 1998

WEATHER ACTIAL NORMAL DEPART LAST YEAR’S
WAL 14 JATE(N) VALIE  FHROM VALIE DATKIS)
HORMAL

TEMPERATURE (F)
RECORD

HIGH 5 91725719350
a81/08/1932
142 190 h
LoW -22 811971994
HIGHEST 57 01/83 71 -a 4
CLEAR DELETE | SAVE | SEND |

Exhibit 9.1.1-3. Review Climate Product GUI
The dialog box menus are discussed below.
e File: The dropdown File option allows the forecaster to accept or abort the climate run.
e Edit: The dropdown Save option allows the forecaster to save or delete the climate product.
The dialog box fields are discussed below.

e NWWS Climate Reports: This field displays the name of the output file for the NWWS Climate Report.
The files are named according to the type of Climate run. See Table 9.1.1-1 for more information. Single
clicking on the file name will display the output file in the lower frame of the GUI. At this time, the
forecaster can add text, edit values, or delete the product.
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Type of Climate Run

Output File Name

| |

’ Morning ‘ output_am_<station ID>.nwws
’ Evening | output_pm_<station ID>.nwws
‘ Intermediate | output_im_<station ID>.nwws
‘ Monthly | output_mon_<station ID>nwws
‘ Seasonal | output_sea_<station ID>nwws
‘ Annual ‘ output ann_<station ID>.nwws

e Date: This field displays the date and time that the Climate product was created.

The dialog box buttons are discussed below.

e Clear: This button clears the bottom portion of the GUI.

e Delete: This button will delete the product that is selected in the NWWS Climate Report field.

e Save: This button saves the product that is selected in the NWWS Climate Report field.

Note 2: If any products are modified, they must be saved before the product is sent. Otherwise, the

original product will be sent.

e Send: This button will distribute for broadcast over the WAN all of the products listed in the NWWS

Climate Report field.

Note 3: It is very important to maintain a specific Font size when running Climate.

canceling that dialog box.

Note 4: Most Climate dialog boxes are initiated with the Cancel button as the default. Therefore, if the
space bar or the Return key is hit within a particular dialog box, it will follow the procedures for
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9.1.2 Manual Operation of the NOAA Climatological Reports Formatter

Any forecaster may initiate a manual run of the Morning or Evening Climate products via the Climate
Master dialog box, as shown in Exhibit 9.1.2-1.

Climate

" Configure Climate Parameters
" Set Up/Edit Climate Products
Execute Morning Climate
" Execute Intermediate Climate

Execute Evening Climate

Execute Monthly Climate
Execute Seasonal Climate
Execuite Annual Climate
" Create F6 Products
Initialize Climate Database
" Quality Control Climate Database

OK Cancel

Exhibit 9.1.2-1. Climate Master Dialog Box

Climate Master Dialog Box

The dialog box menus are discussed below.
e File: The dropdown File option allows the forecaster to Close the Climate Master dialog box.

e Help: The dropdown Help option allows the forecaster to access help on the Climate Master dialog
box.

The dialog box Climate Field options are discussed below.

e Configure Climate Parameters: This selection displays the Climate Preferences GUI.

Set Up/Edit Climate Products: This selection displays the Report Format GUI.

Execute Morning Climate: This selection executes the Daily Climatological Formatting application
for the previous calendar day.

Execute Intermediate Climate: This selection executes the Daily Climatological Formatting
application for the current day, from midnight to either the execution time or a user-defined valid time.

Execute Evening Climate: This selection executes the Daily Climatological Formatting application
for the current day, from midnight to either the execution time or a user-defined valid time.

Execute Monthly Climate: This selection executes the Monthly Climatological Formatting application
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for the previous month. Monthly climatology can be run in the middle of a month to create a product
through the previous day of the month.

e Execute Seasonal Climate: This selection executes the Seasonal Climatological Formatting
application for the previous season.

e Execute Annual Climate: This selection executes the Annual Climatological Formatting application
for the previous year.

e Create F6 Products: This selection displays the F6 Product Date and Stations GUI.

e Initialize Climate Database: This selection displays the Climatology Normals, Means, Extremes GUI;
the Import Climate GUI; the Daily Normals, Means, Extremes GUI; and the Monthly Normals, Means,
Extremes GUI.

e Quality Control Climate Database: This selection displays the Edit Daily Climate GUI and the Edit
Daily Climatological Data GUI.

The dialog box buttons are discussed below.
e OK: This button initiates the selected option from the above list.
e Cancel: This button closes this GUI.

Select an option and then select the OK button to initiate the option.
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9.1.3 Climate Record Report Formatter

AWIPS automatically produces a basic Climate Record Report (product category RER) for the NOAA
Weather Wire Service (NWWS). The RER will be created whenever a Daily Climate Report is run and the
climate program detects that a new daily climate record has been set, or an existing record has been tied, for
one or more of the following climatological variables:

¢ Daily Maximum Temperature

¢ Daily Minimum Temperature

¢ Daily Precipitation (liquid equivalent)
e Daily Snowfall.

There is no need or capability to configure the RER product. The station setup of the NWWS Daily Climate
(CLI) products determines the configuration of the RER products. The RER product has a one-to-one
correspondence with an associated CLI product in regard to the stations included in the products, and with
the node (CCC) and location identifier (XXX) of the text products full AFOS IDs (CCCNNNXXX, where
NNN is RER or CLI). Outside of that, the only thing that controls the RER product's contents and creation is
the presence or absence of daily climate records in the AWIPS climate database, for the variables listed
above, for the stations contained in the paired CLI/RER products.

Note 1: There is no automated NOAA Weather Radio (NWR) product capability for climate record
reporting,

The wording of the RER varies slightly between the morning CLI runs (based on yesterday's complete daily
observational data) and the intermediate or evening CLI runs (based on today's data so far). The RER
wording also indicates whether a new record was set or an old record was tied.

The RER formatter does no checking of the values it receives as input from the daily climate program. The
new values are those taken from an untouched daily climate run, if it runs to completion without manual
intervention, or those daily data modified and accepted by the user in the Display Station Daily Climate
Values editor, if manual Quality Control (QC) of the daily climate run is performed. The old records reflect
those record values in the climate database at the time daily climate is run. If the existing climate record value
for the day has a value of MISSING (9999), no new climate record can be established for the variable and no
RER will be created. When a given record has occurred in more than one prior year, only the latest year in
which it previously occurred will be noted in the RER.

Usage

The Climate Record Report Formatter stores the output RER product(s) in the AWIPS Text Database. It also
provides a visual notification on the D2D whenever an RER product has been created and stored. A new
Alert Visualization message will appear, indicating that one or more climate records have been reached and
listing the AFOS ID under which the corresponding RER product has been stored in the text database. A
separate notification message will be provided for each RER product that is formatted. The appearance of the
Alert Visualization message for the RER is the last automated action that the Climate Record Report
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Formatter performs and is the only visible indication that an RER has been created in the Daily Climate
program run. Unlike the CLI, the output NWWS RER products will not be listed and will not be able to be
loaded, edited, or transmitted from the Review Climate Product user interface that appears as part of the
normal climate program sequence. Also, the RER will not be automatically transmitted over the NWWS after
a time-out period. All user interactions with the RER product, including viewing, editing, and product
dissemination, must be performed manually via the AWIPS Text Browser on the text workstation.

Software and Data Files

The Climate Record Report Formatter consists of a single executable program (recordClimate), which runs
as a persistent process on the Data Server (DS) platform, under user fxa, and a script
(catRecordClimateData.sh) that feeds climate record data to recordClimate when called by the daily
climate control script. The recordClimate process is automatically started whenever the startingest script is
executed on the DS and stopped whenever data ingest is stopped by stoplngest. Whenever recordClimate is
started, it automatically creates a pair of FIFO pipe files that it continually listens to and from which it
receives its input data. These pipe files, named RecordClimateStationInfo.dat and
RecordClimateRawData.dat, are located under the /awips/adapt/adapt_apps/tmp directory.

Note 2: The user should make no attempt to delete or otherwise interact with these two FIFO pipe files.

The recordClimate process does not determine whether or not climate records have been reached. This
determination of climate records is performed by the format_climate executable of the basic suite of AWIPS
Climate Reports programs. Whenever the daily climate is run, the program format_climate will write climate
setup and record data to a pair of ASCII text files named RecordClimateStationinfol.dat and
RecordClimateRawDatal.dat (overwriting any existing files of the same name) located under the /awips
/adapt/adapt_apps/tmp directory. These files are not removed after format_climate and recordClimate
have completed.

The file RecordClimateStationInfol.dat will list the AFOS IDs of the RER products that may be produced
and the station(s) whose data are to be included in the RER if a record occurred at the station. This file
changes only if the station setups of the RERs matching CLI products are modified and lists all stations for all
configured CLI/RER products, whether or not a climate record was set for the station in the current run. The
file RecordClimateRawDatal.dat contains the old and new climate record data for stations and variables
where records have been reached for the date for which Daily Climate is being run. The combination of the
data from the two files determines which (if any) RER products will be formatted and the data type and
station location of climate records included in each RER. Note that if there are additional climate stations that
are configured for the daily NWR climate products but not included in a CLI product, any new climate
records for these stations will be included in the RecordClimateRawDatal.dat file, but no RER will be
formatted based on these climate records since no matching station entry will be found in the station/product
file RecordClimateStationInfol.dat.

Once format_climate is complete, the climate control script will execute the script
catRecordClimateData.sh to pipe the data in the ASCII text files to their corresponding FIFO files, where
the recordClimate executable receives and processes the data, creates and stores any required RER
products, and provides the Alert Visualization notifications.
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9.1.4 Create F6 Products

Selecting Create F6 Products from the Climate Master GUI will bring up the F6 Product Date and
Stations dialog box, as shown in Exhibit 9.1.4-1.

=] [ A

Select g nniD Mame
" Generate Current F& station i
_» Previous Month : [ |]KELC |H[LL¢!I‘! i i

Month:  May | Yeur: [F000 [KMCK | MCCOOK
| [KGLD  [GOODLAND 4505

[KITR  [BURLINGTON

I I

I

i I

] |

I i

I f

_| Print selected FGs

I e e e e m B e s B

OK Cancel |

Exhibit 9.1.4-1. F6 Product Date and Stations GUI

The GUI default is to generate the F6 product for the current month. The forecaster can also select a previous
month by clicking the button beside the Previous Month: option. Use the dropdown menu to select the
month and type in a desired year. Clicking OK will send the F6 products for all stations to the printer and
also to the text database.

To view the product in the text database, bring up a Text window on the Text Workstation. In the Load cmd:
area, type SSSLCDMMM where SSS is the three-letter station identifier and MMM is the abbreviation of
the month. Press Enter. For example, the F6 for Pittsburgh for March would be stored under PITLCDMAR.
The last generated F6 product for Pittsburgh would then be displayed.

e Select station: Individual F6 products can be produced by clicking on the checkboxes beside the
station name.

e Print selected F6s: Clicking this checkbox will send all selected F6 products to the printer for a hard
copy of the product(s).

e OK: This will execute the build {6 program with specified forecaster options.
e Cancel: Pressing this button will close the build {6 program without producing any F6 products.

The F6 generation can also be run by a cron so that the products can be produced automatically at certain
times of the day. Cron setup should be accomplished during site installation but can be changed as
requirements dictate.

Two command line arguments can be used, both of which can have values of "1" or "0":
e The first argument determines whether or not the F6 Product Date and Stations GUI pops up. A value

of "1" results in the GUI popping up while a value of "0" results in it not popping up.
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e For the second argument, a value of "1" results in the F6 product being printed while a value of "0"
does not. When neither argument is used, the GUI will not pop up and the product will not print, as if
both arguments were assigned values of "0".

Page 392



CAVE-D2D User's Manual AWIPS |1 Operational Build 13.4.1 - 31 July 2013

9.1.5 Record Climate

The following sections provide an overview of the Record Climate process and the steps required to create a
record report.

Note: The sections that follow assume the user has a knowledge of climate.
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9.1.5.1 Record Climate Process Overview

The Record Climate process performs the basic "Record Report" (RER) functionality required by AWIPS.
Record Climate is an extension to the Current Climate functionality. If a record is set in the climate process,
Record Climate will recognize this and produce a formatted RER, and store it in the fxa text database. A
forecaster can then retrieve this product from the database via the Text Workstation or the nwrEditor for data
verification and subsequent off-site dissemination.

Note: Distribution and verification of products from the AWIPS fxatext database are manually
accomplished via the Text Workstation (WAN) and nwrEditor (CRS).

Record Climate performs three basic operations:
e Formatting of Record Climate Reports
¢ Storage of Record Climate Reports in the fxa text database (CCCRERXXX)
e Forecaster notification (local/system) that a record has been set:
o Local workstation notification via a pop-up message box (Tcl/Tk) and system notification

o System via D2D the task bar and an audible alarm (uses Announcer objects).
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9.1.5.2 Creating a Record Report (RER)

1. To Create a Record Report

1. Run climate and create a record, or wait until a climatic record normally occurs; then validate
the climate data.

2. If arecord has occurred, Record Climate will recognize this and do the following:
1. Create a Record Report (RER).

2. Display a text message box on the local workstation notifying the forecaster that a
climatic record event occurred.

3. If set in the Record Climate configuration file, notify all other workstations via the D2D
status bar.

4. Store the RER product in the fxatext database under the id CCCRERXXX, where CCC
and XXX are site dependent.

Note: If more than one record occurs during a single climate run, RER products will be
stored to the fxatext database under the same RER ID. This means that records are stored
as previous versions; e.g., if a min-temp and a max-snowfall occurred in the same climate
run, a separate RER would be created for each climatic event. Then these RERs would be
stored to the fxatext database in turn. To retrieve them, the forecaster would use the Text
Workstation text window to retrieve the multiple versions of the product stored under the
RER ID.

3. Verify the Record Report and disseminate it off-site using the Text Workstation text window
and nwrEditor. The text window can be used to verify and disseminate the product off-site. To
disseminate the product to the NOAA Weather Radio (NWR), use the nwrEditor to create a new
voice-ready RER product. If more than one record occurred in a single climate run, the
forecaster will need to pull up the previous versions using the text window and paste them into
the body of the voice-ready RER product. This is because the nwrEditor will retrieve only the
latest RER stored in the fxatext database.
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9.2 The Hourly Weather Roundup (HWR) Application

The Hourly Weather Roundup (HWR) is a summary of the current weather observations for locations in and
around the local area, including marine observations for those WFOs with coastal responsibilities. The
application is used to prepare the products sent to the NWR and the NWWS.

The HWR consists of two applications.

e The Hourly Weather Roundup NOAA Weather Radio (HWR NWR) application prepares
voice-ready products, as shown in Exhibit 9.2-1 for broadcast over NWR. The products are
automatically sent to the NWR, but the forecaster has an opportunity to review and edit them before
broadcasting.

[2T_ENGTDLHWRTP158051115115805111300 AD NMDCO01lcS805112000

These are the 3:00 PM Eastern Daylight Time observations for the
local area, on Friday, June Z2&. At Reagan National Airport, haze was
reported. The temperature was 84 degrees, the dewpoint 76, and the
relative humidity 76 percent, producing a heat index of 93. The wind
was south at 10 mile= an hour. The pressure was 29,53 inches and
steady. At Fort Belvoir, haze was reported, reducing the visibility
to 4 miles. The temperature was 951 degrees, the dewpoint 73, and the
relative humidity 55 percent, producing a heat index of 100. The
pressure was 29,53 inches and steady. At B W I Airport, haze was
reported. The temperature was 88 degrees, the dewpoint &6, and the
relative humidity 51 percent. The pressure was 29.91 inches and
ri=ing. At Andrews Air Force Base, haze was reported. The
temperature was 88 degrees, the dewpoint 73, and the relative
humidity 62 percent, producing a heat index of 56. The wind was
zouthwest at 9 miles an hour. The pressure was 29.94 inches and
steady. Here are some observations outside the metro area

Throughout the region, temperatures were between 85 and 90 degrees.
At Dover, fog was reported. Haze was reported at Patuxent River,
Wilmington, and Salisbury. At Martinsburg, it was sunny. Here are
some CMAN reports. Bligh Reef recorded northwest winds at 4 knotsa.
Pressure waz 29,55 inches. Air temperature 53. At Tatoosh Island,
winds were southwest at 10 knots. Air temperature 53 degrees. At
Matinicus Isle, winds were northwest at 2 knots., Air temperature 58
degrees. Here are some buoy reports. Buoy 4600& recorded
northwest winds at 12 knots. The air temperature was 56 degrees,
Buoy 44014 recorded air temperature of 78 degrees. 3ea surface
temperature was 76 degrees. Buoy 42019 recorded air temperature of
80 degrees. Sea surface temperature was 83 degrees. [b

Exhibit 9.2-1. Sample Output for Broadcast on the NWR

e The Hourly Weather Roundup NOAA Weather Wire Service (HWR NWWS) application prepares
tabular products that are automatically sent to the NWWS, as shown in Exhibit 9.2-2 for broadcast
over the NWR.
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The HWR uses:

Exhibit 9.2-2. Sample Station List for the NWWS

o METAR observations

o Marine observations

o Supplementary Climatological Data (SCD) (snowfall only)

o Satellite Cloud Product (SCP) data
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9.2.1 HWR Routine Operations

Both of the HWR applications (HWR NWR and HWR NWWS) are normally executed automatically via the
crontab utility (see Subsections 9.2.2 and 9.2.3); however, both may be executed manually as needed (see
Subsections 9.2.4 and 9.2.5).

Refer to the separate NWRWAVES User's Manual for more information by clicking on the book
symbol.
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9.2.2 Automatic Execution of the HWR NWR Application and NWRWAVES Browser

The Hourly Weather Roundup (HWR) NOAA Weather Radio (NWR) application uses METAR and marine
observations, the Satellite Cloud Product (SCP), and Supplementary Climate Data (SCD) (snowfall only) to
perform required calculations, build phrases, and add instructions for the Console Replacement System
(CRY). The output product is stored temporarily and the WFO is notified of its completion via the
"eyeglasses" icon, as shown in Exhibit 9.2.2-1 on the Text Displays for all workstations and the appearance
of the word "NEW" next to the "Hourly Weather Roundup" button on the Monitoring Controller. Refer to
Exhibit 9.3-1.

Exhibit 9.2.2-1. ""Eyeglasses™ Icon for the HWR NWR Product

Note 1: If the Monitoring Controller is iconified at the time of the notification, it will be restored at the
mouse click.

By clicking on the "Hourly Weather Roundup" button in the Monitoring Controller, the NWRWAVES
Browser, as shown in Exhibit 9.2.2-2, appears.

Exhibit 9.2.2-2. NWRWAVES Browser
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Note 2: The NWRWAVES Browser can also be opened by selecting NWRBrowser from the AWIPS
start-up menu's list of applications.

NWRWAVES is a comprehensive formatter for NWR products. Its purpose is threefold. First, it is designed to
replace all existing formatter capabilites found in the AWIPS WWA program and also the capabilities found
in CAFE. Second, NWRWAVES utilizes VTEC coding found in an increasing suite of NWS products to better
identify, produce, and manage outbound Console Replacement System (CRS) weather messages. The use of
the Message Reference Designator (MRD) number will allow sites to better automate their CRS broadcast
cycle management. Third, NWRWAVES is designed to be easier to mainting and enhance than CAFE.

NWRWAVES Browser Menus

The NWRWAVES Browser menus include File, Sort, Filter, Options, and NWRWAVES. Descriptions of each
menu follow.

File (Keyboard Shortcut Alt-F)
e Print: Prints highlighted items items from Pending/Sent lists.
e Exit: Closes the browser.
Sort Keyboard Shortcut Alt-S): Allows quick location of outbound or transmitted CRS messages.

e None: No sorting, browser will function in a manner similar to the old NWR Browser.

Alphabetical (Default): Sorts files in the Pending and Sent list boxes in alphabetical order.

Expiration Time: Sorts files in the Pending and Sent list boxes in the order in which CRS messages are
scheduled to expire.

Creation Time: Sorts files in the Pending and Sent list boxes in the order in which the CRS messages
were added.

Decreasing Sort: Sorts the list boxes in either reverse alphabetical order (Alphabetical sort applied) or
in the reverse order in which CRS messages are scheduled to expire (Expiration Time sort).

Filter (Keyboard Shortcut Alt-i): Filters items in the NWRBrowser to help you locate products in the Pending
and Sent lists quickly.

e Filter by Transmitter: Displays outbound/Transmitted products that are applicable to the selected
transmitter.

e Filter by Product Type/WFO: Filters the lists to display only requested product types/WFOs.

Note 3: The "output" item filters the AWIPS climate program CRS messages. You can apply a combined
filter by selecting an item under both the Filter by Transmitter and Filter by Product Type submenus.

Options (Keyboard Shortcut Alt-O)

e Clear Old Products (Purge): Allows you to delete files whose CRS message expiration time has
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passed. You will be prompted to remove products from both the Pending and Sent directories. This
feature can be quite helpful in eliminating dead products from an extensive file listing, but remember
that there may be instances when you may want to maintain an expired product for later retransmission.

e Update Expiration Time: Allows you to modify the expiration time of a product and retransmit it to
CRS. This option is enabled when you clicked on a product in the Sent list to select it.

¢ Auto Refresh: Auto updates the Pending and Sent list boxes (on by default).

o Set Refresh Interval: Allows you to change the refresh interval from the default of 30 seconds by
clicking on this menu item and entering a new number (in seconds) into the box.

¢ Highlight Warnings: Causes the NWRWAVES Browser list boxes to change briefly from a blue to a
purple/pink background color when a short-fuse warning has been issued (on by default).

NWRWAVES (Keyboard Shortcut Alt-N)
o NWRWAVES Setup (Purge): The NWRWAVES menu options, as shown in Exhibit 9.2.2-3, are

administratively restricted by AWIPS user accounts. Most NWRWAVES users will not have access to
the Setup Utility.

Exhibit 9.2.2-3. NWRWAVES Menu Options

Note 4: Only one version of the setup GUI can run on AWIPS at a time. If permitted to access the
setup GUI, you would be able to open the setup GUI on your workstation only if there are no
others open.

e View/Edit VTEC Summary File: If your system is configured to generate summary messages, you
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have the ability to edit/delete specific product summary messages manually if the automated VTEC
replacement method fails. The pop-up GUI appears when active hazards are being tracked for
summarization. You select the hazard you wish to modify from a list of buttons, and then you can either
clear all Listening Area Codes (LAC) at once or selected LACs through their individual radio buttons.
Your site will rarely (if ever) need to use this interface, because active hazards are tracked through
VTEC action codes in follow-up satements. This interface is useful if you track a non-VTEC hazard
such as a Flash Flood Warning (FFW) in the interim period before full VTEC implementation.

¢ Regenerate a CRS Message: Allows you to call an AWIPS PIL from the text database and reprocess
the product through the NWRWAVES formatter. When you select this option, you are prompted to
enter an AWIPS product identifier and then click OK. The latest version of the product will appear in
the Regenerate Product GUI. Sites can toggle between database versions of the product type by using
the Previous Version or Latest \ersion buttons. Once you have the product you wish to retransmit in
the viewer, click the Send to NWRWAVES button to re-process the product.

e HLS Subheadlines Selection: The Hurricane Local Statement (HLS) option is used to configure how
the HLS is formatted to make the text more radio friendly.

NWRWAVES Browser Control Buttons

The NWRWAVES Browser control buttons are located in the middle of the NWRWAVES Browser. They
include View, Refresh, Edit, Delete, Send, Purge, and Exit. Descriptions of each control button follow (refer
to Exhibit 9.2.2-2).

View: After selecting a product(s) from the Pending or Sent lists, clicking the View button brings up the
product in a viewer, as shown in Exhibit 9.2.2-4.

Exhibit 9.2.2-4. NWRWAVES Product Viewer

Page 402



CAVE-D2D User's Manual AWIPS |1 Operational Build 13.4.1 - 31 July 2013

WARNING: If you view or edit a product, you disable the automatic transmission. You must send it
manually via the NWRWAVES Browser. If the product was in the Sent list, you need to select the Send
button to retransmit the edited Product to CRS.

Refresh: Forces a manual auto-refresh of the NWRWAVES Browser.

Edit: Lets you edit a transmitted product and modify the CRS message header properties, as shown in
Exhibit 9.2.2-5. After editing, you can then save the edited product to the Pending list, or send to CRS.

Exhibit 9.2.2-5. NOAA Weather Radio Editor

Delete: After selecting a product(s) from the Pending or Sent lists, clicking the Delete button opens a pop-up
confirmation window prompting you to comfirm your decision to delete the product. Once confirmed, the
product is removed from the browser.

Send: After selecting a product(s) from the Pending or Sent lists, clicking the Send button sends the product
to CRS.

Purge: Deletes files whose CRS message expiration time has passed.

Exit: Exits the NWRWAVES Browser.
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9.2.3 Automatic Execution of the HWR NWWS Application

The Hourly Weather Roundup (HWR) NOAA Weather Wire Service (NWWS) application performs
calculations on hourly land and marine weather data, constructs the product, and stores the resultant text files

into a temporary target directory. From the temporary directory, the product is automatically sent to the
NWWS.
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9.2.4 Manual Execution of the HWR NWR Application

The Hourly Weather Roundup (HWR) NOAA Weather Radio (NWR) application can be run manually.
» To run the HWR NWR application manually
= From the System Control Menu:

1. Select Background WFO Apps > Hourly Weather Roundup. The Hourly Weather
Roundup window, as shown in Exhibit 9.2.4-1, appears.

2. Select NWR from the Product Maker section. In this manner, the program executes without
switches.

Exhibit 9.2.4-1. Hourly Weather Roundup Options Window - Select NWR
= From the Terminal Window:
1. Type the following command: hwrnwr [-t] [product]

2. The output file will be sent to the correct directory for transmission to the CRS even without
the options. The optional "-t" switch is for subsequent transmission to the CRS after the
number of minutes specified in the review period of the configuration file expires. The
"product" argument permits the user to specify individual products to be created. The default
is that all products specified in the nwr.config files will be created.
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9.2.5 Manual Execution of the HWR NWWS Application

The Hourly Weather Roundup (HWR) NOAA Weather Wire Service (NWWS) application normally runs
unattended via a cron. However, it can be run manually.

» To run the HWR NWWS application manually
= From the System Control Menu:

1. Select Background WFO Apps > Hourly Weather Roundup. The Hourly Weather
Roundup window, as shown in Exhibit 9.2.5-1, appears.

2. Select NWWS from the Product Maker section. In this manner, the program executes
without switches.

Exhibit 9.2.5-1. Hourly Weather Roundup Options Window - Select NWWS
= From the Terminal Window:
1. Type the following command: hwrnwws [-t] [product]

2. The output file will be sent to the correct directory for transmission to the CRS even without
the options. The optional "-t" switch is for subsequent transmission to the CRS after the
number of minutes specified in the review period of the configuration file expires. The
"product" argument permits the user to specify individual products to be created. The default
is that all products specified in the nwws.config files will be created.
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9.3 The Monitoring Controller
The Monitoring Controller dialog box, as shown in Exhibit 9.3-1 automatically starts when a user logs into

the AWIPS text display. It alerts the forecaster whenever a background applications product is ready for
review or editing.

Exhibit 9.3-1. Monitoring Controller Dialog Box

The Monitoring Controller menu bar has three choices: File, Windows, and Options.

File

The File menu provides access to the Exit menu option.
Windows

The Windows menu provides the following options:
e The Hourly Weather Roundup option provides access to the NWRWAVES browser.
e The Daily Climate Data option provides access to the Display Station Daily Climate Values dialog box.

e The Daily Climate Product option provides access to the NWR browser.

Options

The Options menu provides the following options:
e The Climate On button turns Climate notification on or off.

e The HWR On button turns the HWR notification on or off.

Notification Messages and Monitoring Controller Dialog Box Buttons

Notification messages may be received for one of several different monitoring applications. When a
notification message is received for a particular application, the text "New" will appear beside its button in
the Monitoring Controller.
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Note: The user may turn the different types of notifications on and off by selecting the Options menu on
the Monitoring Controller. The two monitoring notifications are turned on by default.

For the HWR, the normal mode of operation is via cron, and the user is notified only if a review value greater
than "0" is specified in the hwrnwr.conf file.

If a review value greater than "0" is specified ("New" appears next to the Hourly Weather Roundup
button), the NWR will cause a notification, but the NOAA Weather Wire Service (NWWS) will not. When
the user is notified and presses the Hourly Weather Roundup button, the NWRWAVES Browser appears.
The NWRWAVES Browser permits the forecaster to view, edit, or transmit the HWR products.

For the Climate application, two notifications will occur in normal processing:

1. When the create_climate program is run, the user is notified ("New" appears next to the Edit Climate
Data button). When the Edit Climate Data button is pressed, the Display Station Daily Climate Values
dialog box appears with the new climate data. The user my edit the values before the execution goes
forward.

2. After the format_climate program runs, the user is again notified ("New" appears next to the Edit
Climate Product button) and presses the Edit Climate Product button. The NWR browser appears,
which allows the user to view and edit the daily climate product. Once the user is satisfied with the
product, it may be transmitted.
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10.0 Local Data Acquisition and Dissemination

The function of the Local Data Acquisition and Dissemination (LDAD) system is threefold:
1. Acquire local data sets of varying types and communication means.
2. Perform quality control on the incoming data.

3. Disseminate weather data and information to external users including emergency managers of local and
State Government agencies.

The LDAD system was built upon the Office of Hydrology's (OH) RFC Gateway and the NWS Central
Region's PC-Remote Observing System Automation (ROSA) system.

The LDAD system is a set of software components, both of which reside on the internal AWIPS network and
the LDAD server, which is the external server. Due to security concerns, the LDAD external server and the
AWIPS internal network are separated by a security firewall.

The user interface, data processing, and control are accessed by WFO personnel via the AWIPS workstation.
The actual components that perform the dial-out and other communications activities reside on the external
LDAD server.

This chapter includes the following sections:

e Section 10.1: LDAD Scheduler

e Section 10.2: Using the Local Data Acquisition and Dissemination Scheduler
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10.1 LDAD Scheduler

The LDAD Scheduler allows you to specify up to 1 year of automatic continuous non-routine data requests
from either Local Automatic Remote Collector (LARC), Campbell, or Sutron gauges, or external cooperative
users. Refer to Section 10.2, Module 29 for details on generating a LARC gauge request.

You can access the LDAD Scheduler from CAVE by selecting Obs > Collection/Dissemination, as shown in
Exhibit 10.1-1.

Exhibit 10.1-1. Accessing LDAD Scheduler from CAVE

The LDAD Scheduler provides access to the LDAD Gateway, which is a set of software components that
links and allows communication between the internal and external sides of the AWIPS security firewall.
Through this interface, you can incorporate new data sources into the system and set up collection and
dissemination scripts for external users.

The LDAD Scheduler dialog box, as shown in Exhibit 10.1-2, is divided into two parts: Existing Requests
and Active Requests.

Page 410



CAVE-D2D User's Manual AWIPS |1 Operational Build 13.4.1 - 31 July 2013

Exhibit 10.1-2. LDAD Scheduler Dialog Box
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10.1.1 Existing Requests

Once products have been requested, this area of the LDAD Scheduler dialog box contains a tree-view listing
of the existing requests. (It is empty if no gauges or users have been chosen.) The request name is denoted
with a book symbol. Click on the "+" symbol next to the request name to expand the tree view and view the
contents of the request. A request with a red "X" through the book symbol is poorly formed; i.e., the request
is missing either a gauge 1D or a user, making it unusable.

Each gauge within a request is signified by a blue rain gauge symbol, while a yellow face identifies external
users.

Click on the "-" symbol next to each request name to close the expanded tree-view listings.

The Existing Requests section of the LDAD Scheduler dialog box also contains the following options. Refer
to Exhibit 10.1-1.

e New Request...: This menu button opens the New Request dialog box, as shown in Exhibit 10.1.1-1,
which contains options for selecting and requesting data from one or more gauges or collecting or
disseminating data from external users.

Exhibit 10.1.1-1. New Request Dialog Box
This dialog box has the following options:
o Name: Use this entry line to type a unique name to identify your request.

o Single Request: This check button limits the request to one retrieval of gauge or external user
data.

o Multiple Request: Choose this check button if you want to repeat a request.

o Repeat every: You can choose the update frequency of your request by using the
minute(s)/hour(s) option menus, and by typing the time interval in the entry boxes.
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o Duration: With these entry boxes you can choose how many times to re-issue the request with
"indefinitely" as one of the choices.

o Start time (DDMMHH): If this button is selected, this request will start up at the time defined in
the input entry box.

o Gauges: You can select one or more gauges from the list.
o Users: You can choose one or more users from the list.

o OK: This menu button acknowledges the entries you have made and closes the New Request
dialog box.

o Cancel: This menu button closes the New Request dialog box without creating new requests.

e Copy Request...: This menu button opens the Copy Request dialog box, as shown in Exhibit 10.1.1-2.
This option allows you to copy the existing highlighted request and give this request a new name in the
entry line provided. This button is disabled if nothing is currently selected in the tree view.

Exhibit 10.1.1-2. Copy Request Dialog Box

o Edit Request...: This button opens the Edit Request dialog box, as shown in Exhibit 10.1.1-3. You
need to select one of the existing requests (or one of the gauge or user IDs in that request) in the tree
view before you can edit it. The Edit Request dialog box has the same options as the New Request
dialog box.
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Exhibit 10.1.1-3. Edit Request Dialog Box

e Delete...: This menu button is context sensitive. What it deletes depends on what is highlighted in the
Existing Requests list.

o If a request is highlighted and you select the Delete button, the request is removed. A
confirmation dialog box asks you to verify your deletion.

o If a gauge or user ID within the request is highlighted when you select the Delete button, the
gauge ID is deleted from the request. No confirmation box will appear to request verification.

e Modify Gauges: This menu button opens the Modify Gauges dialog box. It is described in Subsection
10.1.3 and shown in Exhibit 10.1.3-1.

e Modify Users: This button opens the Modify Users dialog box, which provides options to
create/modify table entries for external users. External users are outside persons/groups that send or
receive LDAD data. You need to have site information for external users, such as the Internet Protocol
(IP) address, site login and password, as well as relevant file names. The Modify Users dialog box
contains all the options needed to set up an external user. Your System Administrator is responsible for
setting up external users. If you opened the Modify Users dialog box and don't wish to make any
changes, click the Close button.

e Submit: This button sends a highlighted request to the LDAD Server, which processes your request.
The button is enabled only if a request containing at least one ID is highlighted in the Existing
Requests list. The status of your request appears automatically in the Status: window. The results of
your gauge request appear in the Result: window.

Page 414



CAVE-D2D User's Manual AWIPS |1 Operational Build 13.4.1 - 31 July 2013

10.1.2 Active Requests

The Active Requests area is similar to the Existing Requests area of the LDAD Scheduler dialog box (refer
to Exhibit 10.1-2) in that it lists requests in a tree view layout. However, this section contains requests that are

currently running.

Note: A one-time request will never appear in the active request area. Only multiple requests appear as

active requests.

e The Active Requests area of the LDAD Scheduler has the following options:

o Cancel: This button deactivates the highlighted active request. This button is disabled if a
request is not selected in the Active Requests tree view.

o LDAD Queue: This section of the window contains color indicators showing the LDAD Queue
status and two percentage readouts that display the capacity at which the LDAD queue is
currently running.

If the LDAD Queue is overloaded, the indicator is red. Currently active requests may not
be fulfilled in a timely manner and a backlog may occur.

If it is flashing red, that means a request was just added and the LDAD Queue is
overloaded. The light flashes red for a few seconds before changing to a steady red.

If it is green, the LDAD Queue is not overloaded.

The percentage readouts indicate the capacity at which the LDAD Queue is operating. For
the gauges, the operating capacity is determined by calculating how many gauges have to
be contacted for each request. This calculated number is expressed as a percentage of the
safe maximum gauge capacity, i.e., the maximum number that can be used without
creating a backlog. If the calculated number exceeds the safe maximum, the percentage is
over 100 percent. Otherwise, the percentage is at or under this amount. The same
calculations apply to the user percentage readout.

The percentage readouts allow users to see at a glance whether gauge or user (or both)
requests can end up being backlogged. If either is over 100 percent, the colored indicator
will be red instead of green. To bring the percentages down to the safe maximum of 100
percent, cancel one or more requests in the Active Requests tree view. You will notice how
the percentages decrease as requests are canceled.

e The menu buttons at the bottom of the LDAD Scheduler dialog box apply to both areas:

o Close: This menu button closes the LDAD Scheduler dialog box.

o Help: This menu button opens the online help for information contained in the LDAD Scheduler.
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10.1.3 Modify Gauges Dialog Box

Selecting the Modify Gauges... button in the LDAD Scheduler (refer to Exhibit 10.1-2) will cause the
Modify Gauges dialog box to launch, as shown in Exhibit 10.1.3-1.

Exhibit 10.1.3-1. Modify Gauges Dialog Box

Allow a few moments for the Modify Gauges dialog box to open as it is a large file. Within this dialog
box, you can create or modify entries for gauges with the following options:

e New: This menu button opens the New Gauge dialog box, which is shown in Exhibit 10.1.3-2.

e Edit: This menu button opens the Edit Session File dialog box, which allows you to modify
information for a selected gauge. All of the options are the same as in the New Gauge dialog box.

e Delete: Use this Modify Gauges dialog box button to delete a selected entry from the gauge list. A
confirmation dialog box appears to verify your deletion.

e Close: This button closes the Modify Gauges dialog box.

Discussions of the dialog boxes reached by pressing the "New" and "Edit" menu buttons follow.
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Exhibit 10.1.3-2. New Gauge Dialog Box
New: New Gauge Dialog Box
The New Guage (refer to Exhibit 10.1.3-2 has the following options:
e ID: This entry box is for the five-character gauge ID.
e Non-NWS ID (if any): This entry box is for entering a non-NWS ID.
e Description: This entry box is for the location (or other helpful) information of a gauge.

e Phone: This entry box is for the dial-in phone number. You should check all gauges to verify their
complete local or long distance numbers, including area codes. Be sure to include any required
external access codes (i.e., some offices require a "9" to be dialed before an external phone
number).

e Terminal Server: This entry box is for the terminal server name. The terminal server connects
your machine to the modems that dial into the gauges.

e Gauge Model: This option menu specifies the type of gauge. As an example for the information
that follows, using Handar (for LARC gauges), Campbell, or Sutron. Depending on which of these
options is selected, you will need to provide more information specific to the gauge model.

o Handar Specific Information: These elements will appear when you select Handar from
the Gauge Model option menu.

m Collected Data: This option menu specifies which data the gauge collects. The value
is used to determine which session file is used. This option has no effect if you choose
an alternate session file (the menu will display Unspecified). If the session file is
being selected automatically, using the value Unspecified has the same effect as using
the value River Stage.

o Campbell Specific Information: These elements, which are shown in Exhibit 10.1.3-3,
will appear when you select Campbell from the Gauge Model option menu.
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Exhibit 10.1.3-3. Campbell Specific Information

m Time Zone: This option menu specifies the time zone used in data reported by the
gauge.

» Datalogger Format:

m Setup...: These menu buttons will open an Edit Storage Area Reporting
Format dialog box.

m Has Second Storage Area: If the gauge is equipped with a second storage area,
select this option.

o Sutron Specific Information: These elements, which are shown in Exhibit 10.1.3-4, will
appear when you select Sutron from the Gauge Model option menu.

Exhibit 10.1.3-4. Sutron Specific Information

m Time Zone: This option menu specifies the time zone used in the data reported by the
gauge.

m Datalogger Format: The Setup... button found in this field will open an Edit
Storage Area Reporting Format dialog box. This dialog box is discussed later in the
section. This dialog box is discussed later in the section.

e Automatically Select Session File: When this radio button is selected, the scheduler will
determine which session file should be used. A session file is a text-based script that is used to
collect data from an external user or disseminate data to an external user. Typically, the script is
written in a UNIX or Linux scripting language.

e Use Alternate Session File: When this radio button is selected it allows you to choose a specific
session file. There are also options for creating and modifying session files. After you select this
button, the Choose button appears. The Choose button opens the Choose Session File dialog box,
as shown in Exhibit 10.1.3-5.
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Exhibit 10.1.3-5. Choose Session File Dialog Box

The Choose Session File dialog box has the following options:
o Entry Box:You can enter a session file name in this entry box.

o List of Sessions: This is a list of session files. The list may not contain all valid session
files, in which case you may simply enter the name in the Entry box.

o OK: Once you have selected a session file, this menu button closes the dialog box.
o Cancel: This menu button closes the dialog box without any changes.

When a session filename is entered, and the Use Alternate Session File radio button is selected,
an Edit button appears, which opens the Edit Session File dialog box. This option is used to create
or modify a session file to acquire gauge data. See your System Administrator is responsible for
creating and modifying session files.

Edit: Edit Storage Area Reporting Format Dialog Box

This dialog box specifies the data reported by a Campbell or Sutron gauge. It is shown in Exhibit
10.1.3-6, and has the following options:

e Array ID: This entry box specifies the array ID associated with the storage area. This option is
present only for Campbell gauges.

Exhibit 10.1.3-6. Edit Storage Area Reporting Format Dialog Box

e Reported Data: This list contains the data elements reported by the gauge. The order of elements
in this list must match the order of the reported data. At most, the list may contain eight elements.
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e Add...: This menu button will open a menu of data elements that can be reported by gauges.
Select an item from the menu to add an element to the Reported Data list. Select the last item on
the menu if you do not want to include it in the collected data.

e Remove: This menu button will remove the selected element from the Reported Data list.
e Move up: This menu button will move a selected list element up one position.

e Move down: This menu button will move a selected list element down one position.

e OK: This menu button acknowledges the changes you have made and closes the dialog box.

e Cancel: This menu button closes the dialog box without any changes.
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10.2 Using the Local Data Acquisition and Dissemination Scheduler
Module 29: Using the Local Data Acquisition and Dissemination Scheduler

This module provides practice using the Local Data Acquisition and Dissemination (LDAD) Scheduler. The
LDAD Scheduler enables you to obtain data in succession from one or several gauges with one request.

Objective 29.1 - Creating an LDAD Gauge Multi-request

1. From the CAVE-D2D Perspective, select the Obs pull-down menu (refer to Subsection 2.2.6.7) and
select the Collection/Dissemination option in the Local data section of the Obs menu. The LDAD
Scheduler dialog box will appear in a few seconds.

2. Inthe LDAD Scheduler dialog box, click on the New Request button. The New Request dialog box
opens.

3. In the New Request dialog box, type a unique name in the Name entry box, and make sure that the
Multiple request check button is selected.

4. Also in the New Request dialog box, set the Repeat every count to 1 hour, and Duration to 1 day.

5. In the New Request dialog box, under the Gauges list, select one gauge ID. Notice that as you select
it, the five-character ID appears along the bottom edge of the Gauges list for your convenience.

6. Select the OK button to close the New Request dialog box. Observe that your request name appears
in the Existing Requests list.

7. Click on the "+" icon next to your request to view the contents of your request.

8. Highlight the name of your new request (if not already highlighted) and select the Submit button to
activate your request. Now you should see your request in the Active Request portion of the LDAD
Scheduler dialog box. (You may need to resize the window to view the new request.)

9. The LDAD Queue shows the capacity percentage of the active requests.

10. Once the gauge and user data are received by the system, you can display the data from the Obs
pull-down menu under Local data-Other Local Plots-Precip Plots. The requested data should have
an updated valid time within the menu. However, there is no way to initially know the exact time
interval that precipitation was recorded in gauges.

Note: A precipitation plot with an "A" preceding the precipitation value (for example A1.25") indicates
an accumulated precipitation amount over an indefinite time period. LARC, Campbell, and Sutron
gauges report in this manner. However, the first receipt of gauge information can be used as a baseline
and subsequent data acquisitions at regular time intervals will indicate an approximate precipitation rate.
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11.0 AWIPS Quality Control and Monitoring System

The AWIPS Quality Control and Monitoring System (QCMS) supplies forecasters with readily available
quality control (QC) information and statistics. Two types of QC checks are considered: static checks, which
are single-station and single-time checks, such as internal consistency checks and validity checks; and
dynamic checks, which take advantage of other hydrometeorological information, such as temporal and
spatial consistency checks.

Other features of for the QCMS include the use of "data descriptors," which give an overall rating of the
quality of each observation, development of a QC database for storage of QC results, and the ability of
forecasters to override objective QC decisions.

Note: The AWIPS QCMS deals with both SBN and LDAD System data.

This chapter includes the following sections:

e Section 11.1: Overview of QCMS

e Section 11.2: QCMS Text Output and Displays

e Section 11.3: QCMS LDAD Mesonet Displays

e Section 11.4: Using the Quality Control and Monitoring System
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11.1 Overview of QCMS

The QCMS for AWIPS is a partial implementation of the requirements for AWIPS quality control
procedures. The implementation includes both subhourly and hourly QC processing. The subhourly
processing consists of the application of validity, internal consistency, and temporal consistency checks to
LDAD mesonet observations of sea-level pressure, temperature, dewpoint temperature, wind, station
pressure, altimeter setting, pressure change, relative humidity, visibility, and precipitation observations. The
hourly processing consists of the application of validity, internal consistency, temporal consistency, and
spatial consistency checks to LDAD mesonet and NOAAPORT observations of sea-level pressure,
temperature, wind, and dewpoint temperature.

With the subhourly processing, the QCMS checks every 5 minutes for newly arrived observations.
Observations not previously checked are then immediately quality controlled. The QCMS also calculates
hourly, daily, weekly, and monthly statistics on the frequency and magnitude of the observational errors
encountered for sea-level pressure, temperature, dewpoint, and surface winds.

This section discusses the following topics:

e QCMS Automated Checks - Subsection 11.1.1

e QCMS Subijective Intervention - Subsection 11.1.2

e QCMS Observation Files - Subsection 11.1.3

For more details on the QCMS, go to the QCMS website.
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11.1.1 QCMS Automated Checks

QCMS automated quality control procedures consist of validity, temporal consistency, internal consistency,
and spatial consistency checks.

The validity checks restrict each observation to a specified set of tolerance limits. The temporal consistency
checks restrict the temporal rate-of-change of observations at each station to another set of tolerance limits.
In both cases, observations not falling within the limits are flagged as failing the respective QC check.

The internal consistency checks enforce reasonable, meteorological relationships among observations
measured at a single station. For example, a dewpoint temperature observation must not exceed the
temperature observation made at the same station. If it does, both the dewpoint and the temperature
observation are flagged as failing the internal consistency check. Pressure internal consistency checks include
a comparison of pressure change observations at each station with the difference of the current station
pressure and the station pressure 3 hours previous, and a comparison of the reported sea-level pressure with a
sea-level pressure estimated from the station pressure and the 12-hour mean surface temperature. In the
former check, if the reported 3-hour pressure change observation does not match the calculated observation,
then only the reported observation is flagged as bad. In the latter check, however, if the reported sea-level
pressure does not match the calculated observation, then both the sea-level and the station pressure
observation are flagged as "failing."

The spatial consistency checks compare observations to values estimated from neighboring data using
meteorological analysis techniques. The error threshold, to which the absolute value of the difference
between estimated and observed values is compared, is a function of the expected analysis error. This helps
account for differences in observed and estimated values, which may be acceptable due to estimation errors.
The threshold also takes into account the distance of the surrounding stations, as well as the differences in
elevation.
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11.1.2 QCMS Subjective Intervention

Two text files, a "reject" list and an "accept" list, are provided to allow the site to override the results of the
automated QC checks. The reject list is a list of stations and associated input observations that are labeled as
bad, regardless of the outcome of the QC checks; the accept list is the corresponding list for stations that are
labeled as good, regardless of the outcome of the QC checks. Applications reading the lists (e.g., MSAS)
reject or accept the stations specified. In both cases, observations associated with the stations in the lists can
be either flagged individually or in groups.

The QCMS statistical procedures (and summary files) are not affected by the intervention lists. This allows
you to continue to monitor the performance of the stations contained in the reject and accept lists. For
example, you may notice a station with wind observations that fail the QC checks a large percentage of the
time, and choose to have that station added to the reject list. However, once the observation failure rate at the
station falls back to near zero (possibly due to an anemometer repair), you can recommend that the station be
deleted from the reject list.

The Science and Operations Officer (SOO), Electronic Systems Analyst (ESA), or other focal point can
change entries in the reject and accept lists. Information on how to edit these lists is contained in the AWIPS
System Manager's Manual.

Page 425



CAVE-D2D User's Manual AWIPS |1 Operational Build 13.4.1 - 31 July 2013

11.1.3 QCMS Observation Files

In addition to the output described in Section 11.2, the QCMS writes netCDF and comma-separated value
(CSV) observation files for use by AWIPS applications programs. The netCDF files contain raw observations
and the results of the automated and subjective QC procedures. Also included are single-character data
descriptors. These are data structures are intended to define an overall opinion of the quality of each
observation by combining the information from the various QC checks.

Table 11.1.3-1 provides a complete list of the netCDF data descriptors.

Table 11.1.3-1. Data Descriptor Definitions

‘Preliminary ’6 |N0 QC Applied

‘Coarse Pass ’6 |Passed stage 1

‘Screened ®|Passed stages 1 and 2

‘Veriﬁed W|Passed stages 1, 2, and 3

’Erroneous @ |Failed stage 1

‘Questionable @ |Passed stage 1, but failed stages 2 or 3
‘Subjective Good ’6 |Included in accept list

‘Subj ective Bad ’E |lncluded in reject list

Stage 1 QC consists of observation validity checks; stage 2, temporal and internal consistency checks; and
stage 3, spatial consistency checks.

Raw observations and data descriptors are also included in the CSV files, which are used as input to the
LDAD SHEF encoder. Table 11.1.3-2 provides a mapping between netCDF and SHEF data descriptor
definitions.

Table 11.1.3-2. netCDF-SHEF Data Descriptor Mapping

’ netCDF ’ Description ] SHEF
‘ Z ‘no QC ‘ Z
’ X ’failed stage 1 ’ R
‘ Q ‘passed stage 1, failed 2 or 3 ‘ Q
‘ C ‘passed stage 1 ‘ S
‘ S ‘passed stages 1 and 2 ‘ v
‘ A" ‘passed stages 1, 2, and 3 ‘ P
’ G ’subjective override - good ’ G
‘ B ‘subjective override - bad ‘ B
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11.2 QCMS Text Output and Displays

This section provides a basic understanding and usage of the Quality Control Monitoring System (QCMS)
message format.

This section discusses the following topics:

e Accessing QCMS Summary Files - Subsection 11.2.1

e OCMS Summary File Descriptions - Subsection 11.2.2
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11.2.1 Accessing QCMS Summary Files

You can access the text QCMS files via the Text Display (refer to Chapter 4 for information about using the
Text Display). The nine-character descriptor name for QC messages is on the CCCNNNXXX-based format.

Here, CCC is the number assigned to the data provider. For example, the first five numbers are assigned to
national data sets:

001 SAO (METAR manual)

002 Buoy

003 NPN (NOAA Profiler Network)
004 AUTO (automated, non-ASOS)
005 ASOS

Slots 006 - 020 are assigned to local data networks, ingested into the LDAD system. For example, the NWS
office in Boulder currently has two local data sets:

006 Colorado Department of Transportation
007 ALERT Weather

The "NNN" identifies the desired QC summary file, for example:

QCH hourly

QCD daily

QCW weekly

QCM monthly (4 week)

Finally, the XXX is the three-character NWS field office name, such as SLC, SEA, DEN, and OKC. For
example, in the entry box in a Text Window, the descriptor 003QCDSLC generates a daily summary of NPN
quality control statistics.

QC statistics for national data sets such as the NPN are generated at each WFO, as are the local data sets.
Statistics are maintained separately for each given network, such as ASOS, METARs, or buoy. In addition,
Automated Surface Observing System (ASOS) network statistics are subdivided by individual NWS Regions.
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11.2.2 QCMS Summary File Descriptions

The QCMS collects statistics on observational errors of sea-level pressure, potential temperature, dewpoint,
surface wind, and altimeter setting. The system provides the total number of observations for each variable,
the number that failed the QC checks, the station names of the failed observations, and the error and
threshold values for each of the failed observations. Then statistics are calculated and hourly, daily, weekly,
and monthly summaries are then made available.

Note: Daily, weekly, and monthly summaries include only those stations with observations that have
failed more than 25% of the time.

A QCMS Summary includes data for the following parameters:
e Date/Time: Time interval of summary data, shown in upper left corner of page.
e Variables:

o SLP (MB) - Mean sea level pressure, in millibars.

o

POT TEMP (DEG F) - Potential temperature, in degrees Fahrenheit.

o

DEW PNT (DEG F) - Dewpoint temperature, in degrees Fahrenheit.

(e]

DD (DEG) - Wind direction, in degrees.

o

FF (KNTS) - Wind speed, in knots.
o ALT (MB) - Altimeter setting, in megabytes.

e Total OBS: Number of observations for each variable for the period covered by the report. Statistics
are calculated for the entire country, but are grouped by region.

QST OBS: Number of questionable (failed) observations for each variable.

Percent QST: Percentage of failure for each variable.

Station ID: Name of failed stations, given in column 1. These names vary depending on the data set.

OB Error: Amount of error (defined as QC estimation minus observation) for each variable.

Error Threshold: The difference allowed between the estimated and observed values, given in
parentheses.

e RMS Error: Root-mean-square error of failed observations for each station during the prescribed time
period (not shown in Exhibits).

e Mean Error: Mean error of failed observations for each station during the prescribed time period (not
shown in Exhibits).
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e Percent QST:

o Percentage of failed observations, or failure rate, for each station for the prescribed time period
(not shown in Exhibits).

o Daily, weekly, and monthly summaries include only those stations with observations that have
failed more than 25% of the time.
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11.3 QCMS LDAD Mesonet Displays

In addition to the text QC output, AWIPS has the ability to display LDAD QC information along with the raw
Mesonet observations. (Mesonet data include observations from the Department of Transportation, Alert
Weather, RAWS, cooperative schools, and other cooperative participants. These observations will vary
among forecast offices.) The QC displays consist of color-coded station plots. Stations with observations
found bad by the QCMS are distinctly colored to indicate possible problems with their reported data. Pointing
and clicking on any station invokes the display of a small QC table indicating which QC checks have been
applied at the time of the display, which ones have been passed, and which ones have been failed. Plots are
automatically updated as new data arrives and is quality controlled.

An example of a QC table is shown in Exhibit 11.3-1.

Exhibit 11.3-1. Example of a QC Table

Blanks in the table indicate that the associated QC check was not applied. In cases where the check was
applied, the observation either passed (P) or failed (F) the automated checks, or was labeled good (G) or bad
(B) through the subjective intervention procedures.

To access the QC plots from CAVE, you can be on any scale. Then select the MSAS cascading menu in the
Other section of the NCEP/Hydro pull-down menu.
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11.4 Using the Quality Control and Monitoring System
Module 30: Using the Quality Control and Monitoring System

This module provides practice working with the Quality Control and Monitoring System (QCMS) Summary
Files.

Objective 30.1 - Retrieving a Weekly QC Summary File of METAR Manual Data from a Local
WFO

This objective describes how to display a weekly summary of QC statistics from METAR manual data.

1. In a Text window, type "001QCWXXX," where XXX is your local site ID. Observe the
statistical summary as it is displayed.

2. Determine the overall failure rate for each of the five variables. These are located in the
"PERCENT QST" row.

3. Examine the stations in the report and identify the RMS error, mean error, and failure rate for
different variables.

4. Familiarize yourself with the other statistics in this report.

5. Try loading other monthly, weekly, daily, or hourly reports.
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12.0 AWIPS System Monitor

This chapter describes the tools for monitoring the AWIPS system (System Monitor). The AWIPS System
Monitor provides statuses of products and/or processes for DATA and LDAD Data Sets. It also enables you to
monitor SCAN and FFMP data; check the workstation's disk usage; and monitor and display the workstation's
CPU utilization.

The HTML online User's Manual and the PDF version of the System Manager's Manual, as well as links to
other important forecasting information, are accessible from the System Monitor.

This chapter includes the following sections:

e Section 12.1: The AWIPS System Monitor

e Section 12.2: Extras - Online Documentation

e Section 12.3: Practice Modules (Tutorials) for AWIPS System Monitor
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12.1 The AWIPS System Monitor

The AWIPS System Monitor, as shown in Exhibit 12.1-1, is accessed via the Internet, which is invoked from
the AWIPS Start Menu by selecting Firefox Web Browser, as shown in Exhibit 12.1-2. Refer to Subsection
3.3.1 for information about accessing the AWIPS Start Menu.

Exhibit 12.1-1. AWIPS System Monitor Home Page - DATA Monitor

Exhibit 12.1-2. AWIPS Start Menu - Firefox Web Browser

When the Internet is up and running, enter the URL: http://px1/ to open the AWIPS System Monitor.

The AWIPS System Monitor is a software-based system used to monitor resources and performance for
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DATA, LDAD, SCAN, and FFMP. When left running, the AWIPS System Monitor automatically updates the
status of the monitored products and processes for the selected monitor.

All the individual Data Sets, which contain products and/or processes associated with the monitored Data Set
(DATA and LDAD), can be expanded by clicking Expand All. If you only want to expand a single Data Set,
you can do that by clicking the Plus sign (+) iconified button on the far right of the Data Set row. When a
Data Set is expanded, it lists the statuses of the products and/or processes applicable to the selected Data Set.
When a Data Set is contracted, it displays the lowest-level product or process status within that Data Set.
Subsection 12.1.1, Monitoring Status Indicators, explains statuses in detail.

Note: Because the AWIPS System Monitor is continually updating the state of the system, information
displayed on the captured screens in this document for a particular Data Set, or product and/or process
of a particular Data Set, will not always consistently display the same status or information.
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12.1.1 Monitoring Status Indicators

The AWIPS System Monitor reports on the timeliness and/or completeness of a given Data Set. Each Data Set
has been given threshold values for both timeliness and completeness depending on the typical update
frequency and volume of the incoming data.

The symbols, shown in Exhibit 12.1.1-1, are used to indicate the status of the data.

Exhibit 12.1.1-1. Status Symbols

e Green checkmark indicates that data is being received in a complete and timely manner. For grid data,
the percentage of current completeness is also provided. For data disk usage, a green check mark
indicates that the disks are running at acceptable levels of use.

¢ Yellow triangle indicates that data is somewhat late. For data disk usage, the yellow triangle indicates
that the disks are running at a somewhat high level. A change from a "green” to a "yellow" state is
noteworthy and a message is sent to the NCF. Green-to-yellow state changes are logged but do not
appear on the NCF controller's screen.

¢ Red circle indicates that data are very late and/or very incomplete. For data disk usage, a red circle
indicates that the disks are exceeding acceptable levels of usage. A change from a "yellow" to a "red"
state is an indicator of a more serious problem and a message is sent to the NCF. Yellow-to-red state
changes are logged and appear on the NCF controller's screen.

The example shown below in Exhibit 12.1.1-2 displays all possible statuses for the Satellite Data Set. Notice
that the Minus sign (=) iconified button on the far right of the Data Set row now displays a "minus" sign,
whereas before expanding it displayed a "plus” sign. Clicking this button will contract the Data Set, closing
the list of products and/or processes.

Note 1: Although Rapid Refresh (RAP), the next-generation version of the 1-h cycle system, replaced
Rapid Update Cycle (RUC) as of OB12.6.1, the System Monitor still displays RUC, as shown in Exhibit
12.1.1-2. All screens that still display RUC will be updated in a future release.
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Exhibit 12.1.1-2. Example Showing System Monitor Status Symbols

Note 2: The status of the Data Set represents the statuses of the products or processes within that Data
Set. The Data Set displays the status of the product or process within the Data Set that is showing the
lowest-level status. For example, if the products or processes have all green checkmarks, the Data Set
will show the same. However, if any of the products or processes show anything other than a green
checkmark, the Data Set for those products will display that status showing the lowest level. In Exhibit
12.1.1-2, the Satellite Data Set is displaying a red circle because one of the satellite products (West
CONUS Imager 12 micron IR) listed under that Data Set has that status.
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12.1.2 Monitored Data Sets and Application Data

This subsection displays and describes the contracted and expanded monitoring pages for the DATA and
LDAD Data Sets and the SCAN and FFMP Application Data pages.
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12.1.2.1 DATA Data Sets

The Data Sets of products under DATA monitoring are shown in Exhibit 12.1.2.1-1. The status column for
each contracted Data Set summarizes the status of that Data Set. Use the Contract (-) / Expand (+) button,
located on the right side of the Data Set status symbol, to expand the Data Set. When expanded, a status is
supplied for each product listed within the Data Set.

Exhibit 12.1.2.1-1. DATA Data Sets - Contracted

Exhibits 12.1.2.1-2 through 12.1.2.1-9 illustrate the individual pages for monitoring the products within each
DATA Data Set, as well as Disk Usage and CPU Utilization.
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Exhibit 12.1.2.1-2. Satellite Data Set Products - Expanded
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Exhibit 12.1.2.1-3. Radar Data Set Products - Expanded
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Exhibit 12.1.2.1-4. Point Data Set Products - Expanded

Page 442



CAVE-D2D User's Manual AWIPS |1 Operational Build 13.4.1 - 31 July 2013

Exhibit 12.1.2.1-5. Grid Data Set Products - Expanded
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Exhibit 12.1.2.1-6. Redbook Data Set Products - Expanded
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Exhibit 12.1.2.1-7. Disk Usage Monitoring - Expanded
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Exhibit 12.1.2.1-8. CPU Utilization Monitoring - Expanded

The DATA and LDAD monitoring pages include Disk Usage Monitoring, as shown above, and CPU
Utilization Monitoring. Expand CPU Utilization Monitoring to view the CPU Usage for the System. Then click
mouse Button 1 on the statement, "'Click here to display CPU Usage for the system' to open the CPU
Utilization display, as shown in Exhibits 12.1.2.1-9.
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Exhibit 12.1.2.1-9. CPU Usage Display for the System
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12.1.2.2 LDAD System Data Sets

The Data Sets of processes and products under LDAD System monitoring are shown in Exhibit 12.1.2.2-1.
The status column for each contracted Data Set summarizes the statuses of the processes or products
associated with that Data Set, with the Data Set status showing the lowest-level status of a process or product
within that set. When expanded, a status is supplied for each process or product listed within the Data Set.

Exhibit 12.1.2.2-1. LDAD System Data Sets - Contracted

When expanded, the LDAD Processes are listed under the LDAD Processes Data Set, as shown Exhibit
12.1.2.2-2.
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Exhibit 12.1.2.2-2. LDAD Data Set Processes - Expanded

When expanded, the LDAD Acquisition Data (Products) are listed under the LDAD Acquisition Data Set, as
shown Exhibit 12.1.2.2-3.
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Exhibit 12.1.2.2-3. LDAD Acquisition Data Set Products - Expanded

When expanded, the LDAD Dissemination Data (Products) are listed under the LDAD Dissemination Data
Set, as shown Exhibit 12.1.2.2-4.

Exhibit 12.1.2.2-4. LDAD Dissemination Data Set Products - Expanded
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Note: Disk Usage Monitoring and CPU Utilization Monitoring are also accessible from the LDAD
System monitoring page.
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12.1.2.3 SCAN Application Data Monitoring

The SCAN Application Data Monitoring System page, shown in Exhibit 12.1.2.3-1, refreshes every 2
minutes, displaying the most recent data for the radars and systems monitored by SCAN.

Note 1: Although Rapid Refresh (RAP), the next-generation version of the 1-h cycle system, replaced
Rapid Update Cycle (RUC) as of OB12.6.1, the System Monitor still displays RUC, as shown in Exhibit
12.1.2.3-1. All screens that still display RUC will be updated in a future release.

Exhibit 12.1.2.3-1. SCAN Application Data
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12.1.2.4 FFMP Application Data Monitoring

The FFMP Application Data Monitoring System page, shown in Exhibit 12.1.2.4-1, refreshes every 2
minutes, displaying the most recent QPE and Non-QPE data for the radars operating within the FFMP

system.

Exhibit 12.1.2.4-1. FFMP Application Data

Page 453



CAVE-D2D User's Manual AWIPS |1 Operational Build 13.4.1 - 31 July 2013

12.2 Extras - Online Documentation

Another selection on the AWIPS System Monitor, which is not a system monitoring function, is the Extras
option, as shown in Exhibit 12.2-1. The Extras page enables the user to access current Online
Documentation, including the HTML online User's Manual (User's Guide) and the PDF version of the AWIPS
System Manager's Manual, as well as links to Other Sites for accessing important forecaster information.

Exhibit 12.2-1. AWIPS System Monitor Extras Page - Online Documents

Other online AWIPS documents and site URLs can be added to the server as they become available. They
would be listed and accessed here on the Extras page.
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12.3 Practice Modules (Tutorials) for AWIPS System Monitor

This section gets you started (hands-on) working with the AWIPS System Monitor.
This section includes the following practice modules:

e Using the AWIPS System Monitor - Subsection 12.3.1

e Accessing the AWIPS Online Documentation - Subsection 12.3.2
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12.3.1 Using the AWIPS System Monitor
Module 31: Using the AWIPS System Monitor

This module illustrates the steps required to display system monitoring information on either a graphics
screen or a text display screen.

Objective 31.1 - Opening the AWIPS System Monitor

This objective includes the steps required to open the AWIPS System Monitor.
1. Log into AWIPS.

2. From the root screen (text or graphics display screen), open the AWIPS Start Menu and select the
Firefox Web Browser to access the Internet.

3. Enter the URL address.
Objective 31.2 - Displaying the Statuses of a Product Data Set

This objective includes the steps required to display the statuses of the products for a Product Data Set.

1. With the AWIPS System Monitor displayed, click mouse Button 1 to highlight the DATA or LDAD
monitor to list the high-level Product Data Sets.

2. Expand the Product Data Sets to display the list of products for that Data Set and their associated
statuses.

Objective 31.3 - Displaying the Statuses of a Process Data Set

This objective includes the steps required to display the statuses of the processes for a Process Data Set.

1. With the AWIPS System Monitor displayed, click mouse Button 1 to highlight the LDAD monitor to
list the high-level Process Data Set.

2. Expand the Process Data Set to display the list of processes for that Data Set and their associated
statuses.

Objective 31.4 - Displaying the CPU Usage Display

This objective includes the steps required to display the CPU Usage Display.

1. With the AWIPS System Monitor displayed, click mouse Button 1 to highlight the DATA or LDAD
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monitor to list the high-level Data Set, including Disk Usage Monitoring and CPU Utilization
Monitoring.

2. Expand CPU Utilization Monitoring.

3. Using mouse Button 1, click the statement, ""Click here to display CPU Usage for the system",
which opens a separate window displaying CPU usage.

Objective 31.5 - Displaying SCAN and FFMP Application Information

This objective includes the steps required to display SCAN and FFMP application information.

1. With the AWIPS System Monitor displayed, click mouse Button 1 to highlight the SCAN or FFMP
application monitor to open the respective page.

Note: SCAN and FFMP data is updated every 2 minutes.

2. Note the information displayed on the page. Then wait at least 2 minutes for an update to occur, and
look for a change of information (if any).
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12.3.2 Accessing the AWIPS Online Documentation
Module 32: Accessing the AWIPS Online Documentation

This module illustrates the two methods for accessing the online AWIPS documentation (AWIPS CAVE-D2D
User's Manual and AWIPS System Manager's Manual).

Note: Refer to Exhibit 12.1-1 and Exhibit 12.2-1 when performing the objectives included in this
practice module.

Objective 32.1 - Accessing the AWIPS Online Documentation from the AWIPS System Monitor

This objective includes the steps required to access the AWIPS online documentation from the AWIPS
Workstation - AWIPS System Monitor.

1. Log into AWIPS.

2. From the root screen (text or graphics display screen), open the AWIPS Start Menu and select the
Firefox Web Browser to access the Internet.

3. Enter the System Monitor URL address: http://px1/index.php to open the AWIPS System Monitor.

4. With the AWIPS System Monitor displayed, click mouse Button 1 to highlight the EXTRAS option
to open the documentation page. From this page you can access the online documentation: User's
Guide, which is the HTML version of the AWIPS CAVE-D2D User's Manual, and the PDF version of
the AWIPS System Manager's Manual.

5. Open either document by clicking mouse Button 1 over the title.

6. When finished, close the System Monitor and end your session on the AWIPS Workstation.
Objective 32.2 - Accessing the AWIPS Online Documentation from the AWIPS OneStop Page

This objective includes the steps required to access the AWIPS online documentation from the AWIPS
OneStop page. The AWIPS OneStop page can be accessed from any Internet-connected PC, including an
AWIPS Workstation.

Note 1: The AWIPS CAVE-D2D User's Manual can be opened using any Internet browser.
However, Mozilla Firefox best supports the structure of this manual and is the recommended
browser for viewing it.
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1. Open any Internet browser and enter the AWIPS OneStop URL address:
http://onestop.noaa3a.awips.noaa.gov. An Authentication Required dialog box opens.

2. Enter your NOAA email "User Name" and "Password" in the appropriate fields. Then click "OK" to
open the AWIPS OneStop page.

3. In the far left column, click mouse Button 1 on "AWIPS II Documents" to open a complete list of
current AWIPS documents, as well as several archived releases. Click mouse Button 1 on any
document's title to open that document.

Note 2: From the AWIPS OneStop page you can access both the HTML version and the PDF
version of the AWIPS CAVE-D2D User's Manual and all PDF versions of the AWIPS System
Manager's Manual.

4. When finished, exit the OneStop page.
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13.0 MDL and OHD Applications

This chapter describes the applications developed by the NWS Meteorological Development Laboratory
(MDL) and NWS Office of Hydrologic Development (OHD), and how to access these applications from
within the AWIPS environment. Although access to these applications is via the AWIPS CAVE interface, the
AWIPS CAVE-D2D User's Manual does not discuss them in detail. Separate manuals support these
NWS-developed applications. Links to the manuals are supplied in this chapter.

You can also access the NWS-developed application manuals, as well as other useful AWIPS information
from Appendix D. AWIPS Applications / Interfaces.

This chapter includes the following sections:

o Section 13.1: NWS Meteorological Development Laboratory (MDL) Applications

o Section 13.2: NWS Office of Hydrologic Development (OHD) Applications
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13.1 NWS Meteorological Development Laboratory (MDL) Applications

The Meteorological Development Laboratory (MDL) develops forecast applications for use at Weather
Forecast Offices (WFO). The following MDL applications are accessible within AWIPS:

e Aviation Forecast Preparation System (AVNFPS)

System for Convection Analysis & Nowcasting (SCAN)

Digital Mesocyclone Detection (DMD)

Flash Flood Monitoring Prediction: Advanced (FFMPA)

Forced Flash Flood Guidance (FFFG)

System on AWIPS for Forecasting & Evaluation of Seas & Lakes (SAFESEAS)

e Fog Monitor

e Four Dimensional Storm Investigator (FSI)

e System for Nowcasting of Winter Weather (SNOW)

Each application is supported by its own manual, as listed below.

Refer to the separate AVNFPS User Guide for more information by clicking on the book symbol.
Refer to the separate SCAN Guide for Users for more information by clicking on the book symbol.
Refer to the separate DMD Guide for Users for more information by clicking on the book symbol.
Refer to the separate FFMPA Guide for Users for more information by clicking on the book symbol.
Refer to the separate FFFG Guide for Users for more information by clicking on the book symbol.
Refer to the separate SAFESEAS User's Guide for more information by clicking on the book symbol.
Refer to the separate Fog Monitor User's Guide for more information by clicking on the book symbol.
Refer to the separate FSI Guide for Users for more information by clicking on the book symbol.

Refer to the separate SNOW Users' Guide for more information by clicking on the book symbol.

Refer to NWS Meteorological Development Laboratory (MDL) website for additional information and useful
links.
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13.1.1 Accessing the Aviation Forecast Preparation System (AvnFPS)

The Aviation Forecast Preparation System (AvnFPS) is an AWIPS application that helps forecasters monitor
weather conditions and prepare their aviation forecasts. AvnFPS monitoring capability gives forecasters
quick and continuous feedback on Terminal Aerodrome Forecasts (TAF) as well as associated observations.
This monitoring capability uses a site-configurable, color-coded scheme. AvnFPS includes specialized editors
to aid the production of TAFs. These editors can display TAFs, guidance products, and current observations
as both text and graphics. AvnFPS also includes tools that help forecasters assess the quality of each forecast
before it is issued. These Quality Control tools can assess the syntax of the forecast and compare its
meteorological content with a database of historical observational data.

AvnFPS is a WFO application. It is accessible from both the CAVE menu and the AWIPS Start menu.
CAVE Menu

To open the AnvFPS Menu, shown in Exhibit 13.1.1-1, from the CAVE menu, shown in Exhibit 13.1.1-2,
select New > Aviation > AvnFPS Menu.

Exhibit 13.1.1-1. AvnFPS Menu

Note: Your "Log-in User ID" is already selected when you log into the workstation.
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Exhibit 13.1.1-2. Starting AvnFPS via the CAVE Menu

AWIPS Start Menu

To open the AvnFPS Menu, shown in Exhibit 13.1.1-1, from the AWIPS Start menu, shown in Exhibit
13.1.1-3, select AWIPS start-up menu > Start AvnFPS > AvnWatch GUI.

Exhibit 13.1.1-3. Starting AvnFPS via the AWIPS Start Menu

You can perform three functions from the AvnFPS Menu (refer to Exhibit 13.1.1-1).

1. Launch the TAF Monitor by pressing the TAFSs button.
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2. Launch the Climatology Viewer by pressing the Climate button.
3. Close the AvnFPS Menu by pressing the Cancel button.

For a detailed discussion of AvnFPS, refer to the AvnFPS User Guide.
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13.1.2 System for Convection Analysis and Nowcasting (SCAN)

The System for Convection Analysis and Nowcasting (SCAN) is an integrated suite of multi-sensor
applications that detect, analyze, and monitor convection, and automatically generate short-term, probabilistic
forecast and warning guidance for severe weather. SCAN provides forecasters with severe weather guidance
and supplements forecaster event monitoring with multi-sensor, automated event monitoring.

The intended benefits are:
e Longer lead times on warned events,
e Fewer missed events,
e Increased forecaster situational awareness, and
e Reduced forecaster fatigue during warning situations.

The SCAN menu shown in Exhibit 13.1.2-1, is accessible from the CAVE-D2D Menu Bar.

Exhibit 13.1.2-1. SCAN Dropdown Menu

Refer to Section 13.1 for a link to access the manual discussing this application in detail.
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13.1.2.1 Digital Mesocyclone Detection (DMD)

The Digital Mesocyclone Detection (DMD) display is very similar to SCAN's Storm Cell display. The DMD is
accessed from the SCAN Menu, as shown in Exhibit 13.1.2.1-1.

Exhibit 13.1.2.1-1. Accessing the DMD Display

Refer to Section 13.1 for a link to access the manual discussing this application in detail.
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13.1.3 Flash Flood Monitoring and Prediction: Advanced (FFMPA)

The Flash Flood Monitoring and Prediction: Advanced (FFMPA) system (formerly FFMP), is an integrated
suite of multi-sensor applications that detect, analyze, and monitor precipitation, and automatically generate
short-term warning guidance for flash flooding. FFMPA provides forecasters with accurate, timely, and
consistent guidance. The suite of applications also supplements forecaster event monitoring with its multi-
sensor, automated event monitoring.

The intended benefits are:
e Longer lead times on warned events,
e Fewer missed events,
¢ Increased forecaster situational awareness, and
¢ Reduced forecaster fatigue during warning situations.

Refer to the SCAN menu shown in Exhibit 13.1.3-1 for FFMP options.

Exhibit 13.1.3-1. SCAN Dropdown Menu with FFMP Options

Note: County values are calculated by determining the maximum value of all of the basins within that
county, except for Flash Flood Guidance (FFG), which is averaged for all basins within that county.

Refer to Section 13.1 for a link to access the manual discussing this application in detail.
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13.1.3.1 Forced Flash Flood Guidance (FFFG) Graphical User Interface

One of the basic inputs to Flash Flood Monitoring and Prediction (FFMP) is Flash Flood Guidance (FFG),
which is issued by the nation's River Forecast Centers (RFC). Unfortunately, in some instances the FFG
issued by the RFC is not valid, or it is no longer representative of true conditions for a particular county
warning area (CWA). In addition, there are also areas of the country for which no RFC issues FFGs.

The Forced Flash Flood Guidance (FFFG) GUI provides NWS forecasters with a method for obtaining their
own FFG values (hence the word "Forced") for use in FFMP. Whether used for the purposes of filling a void
left by the RFC, accommodating urban areas or fire scars, or perhaps handling antecedent precipitation, FFFG
will enhance FFMP's ability to monitor your CWA for flash flood potential. The FFFG GUI is an option under
the FFMP section of the SCAN menu, as shown in Exhibit 13.1.3.1-1.

Exhibit 13.1.3.1-1. Accessing the FFFG GUI

Refer to Section 13.1 for a link to access the manual discussing this application in detail.

Page 468



CAVE-D2D User's Manual AWIPS |1 Operational Build 13.4.1 - 31 July 2013

13.1.4 System on AWIPS for Forecasting & Evaluation of Seas & Lakes (SAFESEAS)

The WFO faces a stream of observations spread over a large area of water and land, and highly clustered in
time. It must be constantly aware not only of current conditions within its area of responsibility (AOR), but
also of what is moving into and out of its AOR, and how conditions are changing within its AOR.

SAFESEAS is an AWIPS decision assistance tool engineered to continuously monitor marine and adjacent
overland conditions for specific marine weather hazards. It automatically alerts the WFO whenever such
conditions are detected. It also helps the WFO maintain awareness of how conditions are changing within its
AOR by providing time trend plots of marine observations. Thus SAFESEAS assists the WFO in making
faster, earlier, and higher-quality decisions regarding marine watches and warnings, and contributes to "no
surprises” marine watch/warning service.

SAFESEAS provides capabilities to:

¢ Display observed marine conditions in ways that help the WFO focus on what it considers most
important,

o Facilitate awareness of conditions moving into and out of its area of responsibility (AOR),
e Customize which station's observations are monitored for each zone in its AOR, and
e Customize the thresholds at which conditions will be considered threatening.

The SAFESEAS application can be launched from either the CAVE-D2D OBs menu, shown in Exhibit
13.1.4-1, or from the Start-up menu, shown in Exhibit 13.1.4-2.
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Exhibit 13.1.4-1. Launching SAFESEAS from OBs Menu

Exhibit 13.1.4-2. Launching SAFESEAS from Start-up Menu

Refer to Section 13.1 for a link to access the manual discussing this application in detail.
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13.1.5 Fog Monitor

The Fog Monitor alerts forecasters to visibility hazards using station observations and satellite data. The
station information is displayed in an interactive table and on the D2D map. Operating during the daytime
and at night, adjustable algorithms are applied to visible and infrared satellite images in order to identify
potential areas of fog. Filters help to distinguish fog from possible false signal features, such as snow cover
and mid-level clouds. The Fog Monitor's display table and configuration tools were based on the SAFESEAS
design, so forecasters who use SAFESEAS or SNOW will find this application's operation familiar.

The Fog Monitor application can be launched from either the CAVE-D2D OBs menu, shown in Exhibit
13.1.5-1, or from the Start-up menu, shown in Exhibit 13.1.5-2.

Exhibit 13.1.5-1. Launching Fog Monitor from OBs Menu
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Exhibit 13.1.5-2. Launching Fog Monitor from Start-up Menu

Refer to Section 13.1 for a link to access the manual discussing this application in detail.
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13.1.6 Four-dimensional Stormcell Investigator (FSI)

The Four-dimensional Stormcell Investigator (FSI) is an innovative base radar data display application that is
based on the National Severe Storms Laboratory (NSSL) Warning Decision Support System — Integrated
Information (WDSSII) graphical user interface. This technology enables users to create and manipulate
dynamic cross-sections (both vertical and at constant altitude), making it possible to “slice and dice” storms
and view this cross-section data in three dimensions and across time. The FSI is a 4-panel display depicting
base radar data from a variety of linked two- and three-dimensional representations. An AWIPS extension is
used to launch this application into an independent window. The extension is accessible from the CAVE-D2D
Tools menu and Radar Tools submenu, as shown in Exhibit 13.1.6-1.

Exhibit 13.1.6-1. FSI Menu Option Located on Tools Menu and Radar Tools Submenu

Note 1: In Exhibit 13.1.6-1 the Tools menu has been torn away from the CAVE Menu Bar.

The FSI extension must be loaded in the D2D Perspective before the main display can be launched.
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* To load the FSI extension, from the main CAVE-D2D menu
= From the Tools menu or Radar Tools submenu, select 4-D Storm Investigator (FSI).

Once the extension is loaded, the legend will list that extension and automatically make it editable, as shown
in Exhibit 13.1.6-2.

Exhibit 13.1.6-2. CAVE-D2D Display of Loaded FSI Extension
Now that the FSI extension has been loaded, you can launch FSI.

¥ To launch FSI

= In the main CAVE-D2D display pane, center your cursor over the storm of interest, and then
click the left mouse Button 1.

= [f your WFO uses more than one dedicated radar, or your backup radars are turned on for
SCAN, a radar selection GUI will open, as shown in Exhibit 13.1.6-3. Choose which radar's
data you want to use, and click the "OK" button.

Exhibit 13.1.6-3. Choosing Which Radar to Use for FSI
If your WFO only has one dedicated radar, the FSI window will automatically open, with the data already

centered on your storm of interest, using the radar data matching your WFO’s dedicated radar, as shown in
Exhibit 13.1.6-4.
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Exhibit 13.1.6-4. FSI: Four Dimensional Storecell Investigator Main Window

The following FSI display initial conditions will be reset to the values shown each time you launch or
re-launch the FSI from the D2D Perspective:

e Product = Reflectivity at 0.5° at the latest time

e Location = centered in latitude/longitude of mouse click on the CAVE-D2D Main Display
e Zoom Altitude = 50 meters (about the size of a large supercell storm)

e CAPPI Altitude = 2 km (~6.5 kft)

e Vertical Cross-Section Altitude = 20 km (~65 kft)

¢ 3D Rotate = 360° (pointing north)

e 3D tilt = 0.75 (slightly tilted off the vertical)

e Storm Motion Vector = as set by Radar Product Controls

All other display preferences (e.g., loop parameters) will be retained from the previous FSI session. These
preferences are unique to each individual username.

Note 2: The Graphic Workstations (LX) are equipped with two video graphics cards; one supports 2D
applications, and the other supports 3D applications such as the FSI. The FSI cannot be launched on the
2D display, and a pop-up window will appear to remind users if this is attempted.
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Note 3: Only one FSI display is designed to run at any one time per workstation. If you attempt to
launch another FSI display using another mouse click to the D2D pane, the original FSI window will
reposition to a new storm location.

Refer to Section 13.1 for a link to access the manual discussing this application in detail.
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13.1.7 System for Nowcasting Of Winter Weather (SNOW)

The System for Nowcasting Of Winter Weather (SNOW) is an AWIPS application suite that continuously
monitors surface observations for winter weather hazards and automatically alerts the forecasters whenever
such conditions are detected. SNOW provides capabilities to display observed winter weather threats in ways
that help forecasters focus on what they consider most important. This application’s design was based on the
SAFESEAS tool running at maritime WFOs, so users of SAFESEAS will find SNOW familiar.

SNOW contains the following monitoring/display components:
e SNOW Monitor
e SNOW CAVE Plan-view Plots
e SNOW Tabular Displays: Zone/Station and Trend Plot

The editor for the SNOW monitoring area is launched from the AWIPS start-up menu. At the bottom of the
AWIPS start-up menu, click SNOW Apps to configure the SNOW application, by selecting Configure
Monitor Area or Configure Thresholds for Guardian Monitoring, as shown in Exhibit 13.1.7-1.

Exhibit 13.1.7-1. Accessing SNOW Application from AWIPS Start-up Menu

The Configure Monitor Area option starts the editor for the SNOW monitoring area. There are two modes for
editing the monitoring area: Zone mode and Station mode. In the Zone mode, you specify which
zones/counties are in the monitoring area, and then associate observing stations with the zones/counties. In
the Station mode, you specify which stations are in the monitoring area and then associate zones and counties
with the stations. The edit mode is selected via the Zone and Station buttons in the Configure area, which is
near the upper left corner of the SNOW Configure Monitor Area Set Up Data window.

The Configure Thresholds for Guardian Monitoring option starts the editor for the SNOW monitoring area
thresholds. The SNOW monitor compares observation values (within the user-specific time window) against
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thresholds for alert levels to determine a single, overall threat level for the entire monitoring area. The most
severe individual observation value threat level becomes the threat level for the entire monitoring area. The
thresholds for the alert levels are both variable- and zone/county-specific. The editor for the monitor
thresholds allows each site to customize the thresholds. The thresholds include wind speed, gust speed, peak
wind, temperature, visibility, and snow depth. The Meteo tab is useful in the display thresholds interface but
has no function in this monitor interface.

The SNOW application is accessed from Obs Menu on the CAVE-D2D Perspective, as shown in Exhibit
13.1.7-2. You can also configure SNOW from the Obs menu. The SNOW Monitor is a clock-driven process
that automatically monitors observations in the WFO-configured monitoring area for hazardous conditions,
as defined through the configuration. It regularly evaluates and updates a single, overall threat level for the
monitoring area and generate SNOW CAVE Plan-view Plots.

The SNOW CAVE Plan-view Plot consists of two AWIPS CAVE station plots packaged together, and nearly
identical to their CAVE counterparts: a “METAR” plot and a “Mesonet” plot. The SNOW plots differ from
the CAVE plots only in that SNOW plots record only those reports that are within the office’s monitoring
area, as defined by the monitoring area station setup.

Exhibit 13.1.7-2. Accessing SNOW Application from the CAVE-D2D - Obs Menu
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The SNOW Tabular Display consists of two types of display GUIs: the configurable zone/county and station
tables, and the trend plot. In both configuration tables, individual columns of the table display the current
threat level for each product, and both the observed value and the threat level for each variable. In the zone
configuration, each row of the table shows these threat levels for a zone or a county, for all zones and
counties in the monitoring area. In the station configuration, each row of the table shows these threat levels
for the stations within (or related to) a single user-selected zone or county. Trend plots display a meteogram
of a selected variable, or a composite meteogram of the values of the variables comprising a selected product,
for single stations. The trend covers the most recent 24 hours.

To access Zone/County table

e From the Obs menu, select SNOW.

Note 1: The SNOW Threat Level Zone/County table will display after the D2D loads the SNOW
plot.

To access the Station table

e With the Zone/County table displayed, from the Area Id column, click a zone identifier.

Note 2: The SNOW Threat Level Zone/County table will close and the Snow Threat Level Station
table will display.

To access the Trend plot

e With the Station table displayed, right-click the cell containing the data for which you want to see
plotted for trend analysis.

Note 3: The Trend Plot window for the specific station and variable or product of interest will
display.

Refer to Section 13.1 for a link to access the manual discussing this application in detail.
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13.2 NWS Office of Hydrologic Development (OHD) Applications

Applications developed by the NWS OHD are accessible from both the CAVE-Hydro Perspective, shown in
Exhibit 13.2-1, and from the AWIPS Start-up menu, shown in Exhibit 13.2-2.

Exhibit 13.2-1. List of Hydro Apps from CAVE-Hydro Perspective Hydro Menu

Exhibit 13.2-2. List of Hydro Apps from AWIPS Start-up Menu

Not all the OHD applications are accessible from both locations. However, the following can be accessed
from either location:

e Dam Catalog

HydroGen Manager

Hydro Time Series

Riverpro

Site Specific
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e River Monitor

Note: The HydroView option opens the CAVE-Hydro Perspective window, if you don't already have that
perspective open. The MPE Editor option opens the MPE Editor, which is also accessible from the
CAVE-MPE Perspective.

Refer to NWS Office of Hydrologic Development (OHD) website for additional information and useful links.
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14.0 Thin Client Remote Access

The Thin Client component supports the NWS enterprise requirements for remote access to baseline AWIPS
capabilities. The Thin Client can take advantage of new and enhanced AWIPS capabilities in a seamless
manner as they are deployed to the baseline. There are two versions of the Thin Client: the Windows version
(Windows OS); and the Linux version (Linux OS).

Windows Version: The Windows version makes it possible to access baseline AWIPS capabilities on a
laptop computer. The Windows version has a number of target users, including Incident Meteorologists
(IMET) dispatched to remote locations to gather localized weather information in support of hazardous
situations.

Linux Version: The Linux version is installed on a dual monitor AWIPS Remote Display (ARD) at a Center
Weather Service Unit (CWSU).

The Thin Client targets the following users:

e CWSU

Weather Service Offices (WSO)

Incident Support Specialists (ISS), including IMETs

National Centers for Environmental Prediction (NCEP), in partial support of their
Continuity of Operations Planning (COOP) requirements and remote access requirements

River Forecast Centers (RFC), in partial support of their backup requirements.

Note: The Thin Client can also be used to brief state and local emergency managers during incident
operations.

The Thin Client component adds the following features to CAVE/AlertViz:

e Support for access to EDEX via a single well-known port (e.g., http port 80). This allows
CAVE to run on firewall-restricted networks.

e Support for compression of data sent to/from EDEX.
e Local caching of localization, map, and weather data.
e Timed refresh of data.

This chapter includes the following sections:

e Section 14.1: Starting Thin Client

e Section 14.2: Thin Client Configuration
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e Section 14.3: Thin Client Versions - Specifications, Capabilities, and Limitations
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14.1 Starting Thin Client

Prior to starting the Thin Client, obtain the following information from your System Administrator:
e Localization Server: http://<hostname>/services (Example: http://px1f/services)
e Site: <three-character localization site ID>
e Services Proxy Address: http://<hostname>/services (Example: http://px1{/services)
e PyPies Proxy Address: http://<hostname>/pypies (Example: http://px1{/pypies).

Thin Client Process

Thin Client uses the same code installation as CAVE. You start Thin Client by providing the appropriate
options to CAVE at CAVE startup.

Thin Client (and CAVE) really consists of two processes:

e AlertViz: The error and alert message client

e CAVE: The Common AWIPS Visualization Environment.
AlertViz must be up and running before CAVE is started.

Starting AlertViz

In ordinary usage AlertViz will automatically start on the workstation when you log in.

Note 1: Ordinarily the command for automatically starting AlertViz will be put into the file /etc/xdg
/autostart/awips2-alertviz.desktop so that the command will be executed when logging into the
workstation.

However, if AlertViz does not start automatically, you will need to start it manually. The method for starting
it manually depends on your operating system (Windows or Linux).

e Starting AlertViz manually from Windows: Double-click on the AlertViz icon on your desktop.

e Starting AlertViz manually from Linux: Open a terminal window and start Thin Client AlertViz (aka
thinalertviz) by entering on the command line:

/awips2/alertviz/alertviz.sh -component thinalertviz.
It can also be started in the background and redirected:
/awips2/alertviz/alertviz.sh -component thinalertviz > av.out 2>&1 &.

When AlertViz starts, the AlertViz notification bar shown in Exhibit 14.1-1 appears on your screen.
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Exhibit 14.1-1. AlertViz Notification Bar

When AlertViz starts it attempts to connect to a localization server. It gets the localization server address
from a file in ~/caveData. If there is no caveData directory in the home directory or if AlertViz cannot contact
a localization server at the address it gets from caveData, the AlertViz will open the Connectivity Preferences
dialog box and highlight the fields in red that need to have information entered, as shown in Exhibit 14.1-2.
This situation will most frequently occur after updates of the AWIPS software on the workstation. It is a good
practice to delete ~/caveData when updating the AWIPS software.

Exhibit 14.1-2. Connectivity Preferences Dialog Box When Unable to Connect to Localization Server

Connecting to a Localization Server

1. In the Connectivity Preferences dialog box, shown in Exhibit 14.1-2, enter the information you
obtained from your System Administrator. You should also check the "Use Proxy Servers" checkbox.

For ARD users at CWSUs, the <hostname> in the addresses will almost always be <px1f>, making the
Localization Server address http://px1{/services. IMETs will typically use an IP address provided by
support personnel at their WFO. For users inside the firewall, the compression proxy server supporting
the Thin Client will listen on port 80, the standard port for the http protocol. For users outside the
firewall, the Thin Client will use port 443. Therefore, in both cases there is no need to add an explicit
port number to the address.

2. Click the Validate button after completing all the required fields. All the fields on the Connectivity
Preferences dialog box should turn white, as shown in Exhibit 14.1-3.

Exhibit 14.1-3. Connectivity Preferences Dialog Box When All Fields Are Valid

3. Click the OK button. The AlertViz notification bar shown in Exhibit 14.1-1 will appear on the screen.
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Once AlertViz is running, Thin Client CAVE can be started.

Authentication for Users Outside the Firewall When AlertViz Is Launched:

A user running Thin Client on an untrusted network outside of the firewall will receive the pop-up
authentication "Log in" dialog box shown in Exhibit 14.1-4 when AlertViz is launched. The user will enter
his or her NOAA Login (email address without (@noaa.gov) and password. After selecting the OK button, the
Connectivity Preferences dialog box shown in Exhibit 14.1-3 will appear.

Exhibit 14.1-4. Authentication Log In Dialog Box

Starting Thin Client CAVE

The method for starting Thin Client CAVE depends on your operating system (Windows or Linux).

e Starting CAVE from Windows: To start CAVE on a Windows OS, double-click on the CAVE icon on
your desktop.

e Starting CAVE from Linux: To start CAVE on a Linux OS, open a terminal window and start Thin
Client CAVE (aka thinclient) by entering the following on the command line:

/awips2/cave/cave.sh -component thinclient.
It can also be started in the background and redirected with the following command:
/awips2/cave/cave.sh -component thinclient > tc.out 2>&1 &.

Wait until the system is fully up and running and initial maps are displayed before proceeding.

Note 2: The Thin Client generally performs as described in this User's Manual. The primary exception
is that if you are running CAVE from an untrusted network connection, CAVE and AlertViz will not be
able to make the connection needed for push data. Push data includes all non-workstation-local
notifications and warnings via AlertViz and automatic updates to data as new data arrives.

Authentication for Users Outside the Firewall When CAVE Is Launched:

A user running Thin Client on an untrusted network outside of the firewall will receive the pop-up
Authentication Log in dialog box shown in Exhibit 14.1-4 when CAVE is launched. The user will enter his
or her NOAA Login (email address without (@noaa.gov) and password. After selecting the OK button, CAVE
will load and display.
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14.2 Thin Client Configuration

When starting the Thin Client from the CAVE command line or launcher, an additional set of options is
visible in the Preferences dialog box (CAVE > Preferences). These options open preferences dialog windows
for configuring the Thin Client.

Note: It is not possible to set these options unless CAVE has been started with "-component thinclient.”

Subsections 14.2.1, 14.2.2, and 14.2.3 describe the preferences dialog windows for configuring the Thin
Client. Subsection 14.2.4 provides recommended settings for Thin Client operating systems.
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14.2.1 Thin Client Caches Preferences Dialog Window

The Thin Client Caches Preferences dialog window, shown in Exhibit 14.2.1-1, controls the caching features
of the Thin Client.

Exhibit 14.2.1-1. Thin Client Caches Preferences Dialog Window

The available options are:

e Cache Directory: This sets the directory on the local workstation to be used for all of the
caching files. This should be set to a user-specified directory — a subdirectory of your
user caveData is a good choice.

e Cache Weather Data: When checked, most weather data is cached after retrieval from the
PyPies server. Note that Point Data (e.g., from the "Obs" menu) is never cached. This
caching persists between CAVE sessions.

e Cache Localization Files: When checked, localization data is cached after retrieval from
the localization server. Data from the cache is used in preference to those on the server, but
files that do not exist on the local workstation are fetched from the server on demand.
However, server updates to files already cached are not retrieved. This caching persists
between CAVE sessions.

e Use Only Cached Localization Files: When checked, the Thin Client assumes all
localization files exist on the local workstation. If a file is not found locally, CAVE gives
an error. When you first check this option, the dialog box shown in Exhibit 14.2.1-2
appears to prompt you to upload all localization files.
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Exhibit 14.2.1-2. Synchronization Dialog Box

e Sync Files Button: When pressed, this button initiates a localization file synchronization.
This action should be performed if you change localization or need to acquire any
localization updates from the server.

e Cache Map Data: When checked, map data is cached after retrieval from the map server.
Changes to the map database on the server are seen if the same data is already cached
locally. This caching persists between CAVE sessions.
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14.2.2 Thin Client Connections Preferences Dialog Window

The Thin Client Connections Preferences dialog window shown in Exhibit 14.2.2-1 controls the Thin Client
connections to the EDEX server. The primary component of this connection is the Java Messaging System
(JMS).

Exhibit 14.2.2-1. Thin Client Connections Preferences Dialog Window

The available options are:
e Disable JMS: If this box is checked:
o the client will not attempt to make a connection to the server, and

o the Menu Time Update Interval and Data Update Interval selections become
available.

e Disable Menu Times: If this box is checked:
o the menu times will not update, and
o the Menu Time Update Interval selection becomes unavailable.

e Menu Time Update Interval (min): This determines the frequency with which the client
will query the server for menu data times. This is only available if Disable JMS is
checked.
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e Data Update Interval (min): This determines the frequency with which the client will
query the server for updates to displayed data. This is only available if Disable JIMS is
checked.

Java Messaging System

When CAVE is used in its "non-Thin Client" mode of operation (at WFOs, for example), EDEX uses the
JMS to notify CAVE that new data is available. CAVE then updates its menu times and data displays
accordingly.

When CAVE is used in its "Thin Client" mode (by IMETs and at CWSUs, for example), the JMS connection
may not be available. Even if the JMS connection is available, Thin Client users may choose to turn it off to
save bandwidth.

Typically JMS messaging is available for ARDs at CWSUs (no firewall between CWSU and WFO), but not
for IMETs (IMETs connect from the open Internet, where the server will probably be protected by a firewall
passing only port 80 and blocking JMS).

When JMS is not used (either because it is disabled via the Thin Client Connections Preferences dialog box

or because it is blocked by firewalls), the Thin Client must request updates for menu times, displayed data, or
both.
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14.2.3 Thin Client Servers Preferences Dialog Window

The Thin Client Servers Preferences dialog window, shown in Exhibit 14.2.3-1, allows you to change the
proxy server configuration. The Thin Client uses http proxies to implement compression and allow tunneling
over a single port.

Exhibit 14.2.3-1. Thin Client Servers Preferences Dialog Window

The available options are:

e Use Proxy Servers: When checked, the two proxy servers (Services and PyPies) are used
instead of dynamically assigned servers. Proxy servers are required to support data
compression and remote access.

e Services Address (sample format: http://remote-edex/services).
e PyPies Address (sample format: http://remote-edex/pypies).

e Server Data Dir: This is the location for shared files used by non-D2D localizations. For
the Windows version, this option is not used. For the Linux version, it should be set to the
appropriate directory as specified by your System Administrator.
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14.2.4 Recommended Settings for Thin Client Operating Systems

Table 14.2.4-1 and Table 14.2.4-2 list the recommended settings for "Windows" common use cases. Table
14.2.4-3 and Table 14.2.4-4 list the recommended settings for "Linux" common use cases.

Windows OS

Table 14.2.4-1. IMET Windows Laptop Using BGAN Satellite Link (Minimal Bandwidth)

| Setting | Recommended Value
’Cache Directory ‘C:\Users\username\caveData\ViZCache

‘Cache Weather Data ‘Checked

‘Cache Localization Files ‘Checked

Use Only Cached Localization Files

Checked - ideally the localization files should be synced before deployment while you
have a fast connection.

‘Cache Map Data ‘Checked
‘Disable Menu Times ‘Checked

’Menu Time Update Interval ‘Off or infrequent
‘Data Update Interval ‘As needed
‘Disable IMS ‘Checked

’Use Proxy Servers ‘Checked

Table 14.2.4-2. IMET Windows Laptop With 3G Connection (Moderate Bandwidth Usage)

] Setting ’ Recommended Value
‘Cache Directory ‘C:\Users\username\caveData\vizCache
‘Cache Weather Data ‘Checked

’Cache Localization Files ‘Checked

‘Use Only Cached Localization Files ‘Checked (Unchecked if performance lags)
‘Cache Map Data ‘Checked

’Disable Menu Times ‘Unchecked

‘Menu Time Update Interval ‘As needed

‘Data Update Interval ‘As needed

Disable JMS Checked

‘Use Proxy Servers ‘Checked
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Linux OS

Table 14.2.4-3. CWSU Linux Workstation With T1 (Moderate Bandwidth Usage)

| Setting | Recommended Value
‘Cache Directory ’/home/username/caveData/cache

’Cache Weather Data ‘Checked

‘Cache Localization Files ‘Checked

‘Use Only Cached Localization Files ’Checked (Unchecked if performance lags)

’Cache Map Data ‘Checked

‘Disable Menu Times ‘Unchecked

‘Menu Time Update Interval ’Off (dynamic updates)
’Data Update Interval ‘Off (dynamic updates)
‘Disable IMS ‘Unchecked

‘Use Proxy Servers ’Checked

Table 14.2.4-4. Compression Only Settings (i.e., Allow All Server File Updates)

| Setting | Recommended Value
’Cache Directory ‘/home/username/caveData/cache

‘Cache Weather Data ‘Unchecked

‘Cache Localization Files ’Unchecked

’Use Only Cached Localization Files ‘Checked (Unchecked if performance lags)

‘Cache Map Data ‘Unchecked

‘Disable Menu Times ’Unchecked

’Menu Time Update Interval ‘Off (dynamic updates)
‘Data Update Interval ‘Off (dynamic updates)
‘Disable IMS ’Unchecked

’Use Proxy Servers ‘Checked
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14.3 Thin Client Versions - Specifications, Capabilities, and Limitations

This section describes the specifications (hardware and software), and the known capabilities and limitations
of the Windows and Linux versions of the Thin Client.

See Subsection 14.3.1 for the hardware and software specifications of the Thin Client, and Subsection 14.3.2
for a summary of its capabilities and limitations.
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14.3.1 Thin Client Hardware and Software Specifications

Windows OS

Table 14.3.1-1 lists the required and recommended hardware and software specifications for the laptop that
will host the Thin Client at remote locations on the Windows OS.

Table 14.3.1-1. Thin Client Windows Version Hardware/Software Specifications

| Specification ‘ Hardware/Software Requirements

’ Recommended/Comments

‘Processor ‘ZGHZ Intel Core Duo ‘Z.SGHZ Intel 17 or better

4GB (CAVE's 32-bit application can only
Memory 2GB access 2GB of memory)
‘Disk Space ‘Approx. 1GB for program and data caches ’N/A

Windows XP (Windows XP only supports
OpenGL 2.0 or better if implemented in a
3rd party video driver)

Operating System

Vista 32-bit, Windows 7 32-bit, Windows 7
64-bit

‘Video Card OpenGL 2.0 capable

Nvidia discrete graphics

Linux OS

Table 14.3.1-2 lists the required and recommended hardware and software specifications for the ARD
workstations at the CWSUs that will host the Thin Client on the Linux OS.

Table 14.3.1-2. Thin Client Linux Version Hardware/Software Specifications

| Specification \ Hardware/Software Requirements | Recommended/Comments
‘Processor ‘Intel Xeon E5620 ’
‘Memory ‘6GB ‘
At least 1.5GB on the partition holding
/awips2 (for the software installation); and
Disk Space at least 1GB per user on the partition that

holds the user cache directories, which
would usually be /home

Operating System ‘Linux

Nvidia, OpenGL 2.0 or better, 512MB or
more

Video Card

Nvidia GPU Quadro FX 580 512MB GDDR3.
Two graphic adapters, each capable of
managing two screens (same as used in LX
workstations)
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14.3.2 Thin Client Capabilities and Limitations

Both the Thin Client Windows version and the Thin Client Linux version support all the features of CAVE
and AlertViz except for the following:

e Non-D2D perspectives, i.e., GFE, Hydro, MPE, National Centers, and Localization

o WarnGen

AvnFPS

4D Storm Cell Investigator (FSI)

LAPS tools

Radar applications and radar tools

Data dissemination and upload.

Note: The Windows version has less available memory than the Linux version (refer to Subsection
14.3.1). Therefore, some operations involving multiple large data sets may cause an out-of-memory
error with the Windows version.
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15.0 Alert Visualization

This chapter describes the tools for alerting the user to any malfunctions, such as data and signal loss. Alert
Visualization (AlertViz) is the communicator between the AWIPS software and the AWIPS forecaster, and is
a continuously running process on each workstation.

This chapter includes the following sections:

e Section 15.1: The Alert Visualization (AlertViz) Interface

e Section 15.2: Configuring the Alert Visualization Preferences
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15.1 The Alert Visualization (AlertViz) Interface

The AWIPS AlertViz communication utility is an independent, centralized tool for displaying AWIPS alerts
and status. AlertViz must be active for CAVE to open. Refer to Subsection 3.3.1. When AlertViz is activated,
the AlertViz symbol is displayed on the panel above the Red Hat icon and the AlertViz Status Bar appears at
the bottom of the CAVE screen, as shown in Exhibit 15.1-1.

Exhibit 15.1-1. AlertViz Active Symbol and Status Bar

The AlertViz Status Bar can be hidden by opening the AlertViz Menu and unchecking Show Alert Dialog,
which in the default state is checked. Placing the cursor over the AlertViz Symbol and clicking mouse Button
3 opens the AlertViz Menu, shown in Exhibit 15.1-2.

Exhibit 15.1-2. AlertViz Menu

Note 1: Unchecking Show Alert Dialog only hides the AlertViz Status Bar. The Alert Visualization
Popup Message Dialog window will still appear on the screen when an alert occurs.

Alert Visualization Configuration

The Alert Visualization Configuration dialog box controls the configuration of the AlertViz Status Bar.
Selecting the Configuration option on the AlertViz menu opens the Alert Visualization Configuration dialog
box, shown in Exhibit 15.1-3.
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Exhibit 15.1-3. Alert Visualization Configuration Dialog Box

Note 2: The Alert Visualization Configuration dialog box is Workstation independent, meaning it only
controls the diaplay of alerts for that particular Workstation.

The Alert Visualization Configuration dialog box is divided into three sections. A description of each section
follows:

1. Layout: In this section the AlertViz Status Bar "Cell #" configuration is defined. The components of
this section are:

o Layout: This component defines the number and layout of the cells. The options are Q4, H1, H2,
V2, V3, V4, and MO. The "Q" yields a 2 x 2 arrangement, "H" a horizontal arrangement, and "V"
a vertical arrangement. Selecting "MQO" yields no cells. You can also remove the layout and yield
the same result as selecting "MO" by clicking on the "Remove Selection" button. An example of
a V3 layout is shown in Exhibit 15.1-4, which also shows how the AlertViz Status Bar would

look.
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Exhibit 15.1-4. Configuring a Vertical 3-Cell Layout

o Category: This column provides a default list of alert categories.

Note 3: You cannot delete any default categories. When a default category is selected, the
Delete button is grayed out.

You can add a new category by selecting the "New" button and providing a name and description
of the category. Refer to Exhibit 15.1-4.

Note 4: You can only delete categories that you have added, which is indicated by the
Delete button being active. You can also restore the original default list of categories
(assuming the default configuration hasn't been modified) by clicking the "Retrieve" button
at the bottom of the Alert Visualization Configuration dialog box and selecting "Default"
from the list. You can also save the new AlertViz configuration for the Workstation by
clicking the "Save As" button at the bottom of the dialog box and supplying a name for the
new custom configuration.

o Cell #: This column lists the cell # where the alert for the selected category will appear on the
Status Bar. "None" indicates that no alerts for that category will be displayed. You can clear all
categories to "None" by clicking the "Clear All Layouts" button. The "Click cell to add to
category:" label, as shown in Exhibit 15.1-4, means that clicking a Cell # in the Message Text
Layout: window will add that Cell # in the Cell # column for the highlighted Category.

2. Source and Priorities: In this section the attributes of the alert are defined. A list of default Sources
for alerts is shown on the left.
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Note 5: You cannot delete any default sources. When a default source is selected, the Delete
button is grayed out.

You can add a new source by selecting the "New" button and providing a name and description of the
source. Refer to Exhibit 15.1-4.

Note 6: You can only delete added sources (non-default), which is indicated by the Delete button
being active. You can also restore the original default list of sources (assuming the default
configuration hasn't been modified) by clicking the "Retrieve" button at the bottom of the Alert
Visualization Configuration dialog box and selecting "Default" from the list. You can also save the
new AlertViz configuration for the Workstation by clicking the "Save As" button at the bottom of
the dialog box and supplying a name for the new custom configuration.

From this section you configure the attributes associated with the alert type (Source). For example, you
can configure the priority of the alert based on its source and then configure the font and background
color as it will appear on the AlertViz Status Bar for each priority level. You can also configure how
you want the alert message to be indicated (blinking, audio, action, etc.) to make you aware of the alert.
Refer to Exhibit 15.1-3 to view all the attributes for each priority. Select the Source, then set its
attributes.

3. Common Settings: In this section you define the amount of information (Priority, Source, and
Category) you want to include on the Alert Visualization Popup Message Dialog. Also in this section
you define other attributes associated with the Alert Visualization Popup Message Dialog Message Log,
which is an extension of the Popup Message Dialog. Refer to Exhibit 15.1-3.

When finished, you can save the new configuration as the default or as a new configuration (Save As).
The AlertViz: Default Config Action pop-up verification window, shown in Exhibit 15.1-5, appears
when saving the configuration, suggesting the default settings be changed only by the AlertViz
Manager.

Exhibit 15.1-5. AlertViz: Default Config Action Pop-up Window

When an Alert Occurs

The following actions take place when an alert occurs.
1. The AlertViz symbol changes to a blinking red X.
2. The alert message is displayed in the window of the AlertViz Status Bar.
3. The Alert Visualization Popup Message Dialog window appears in the middle of the main display

pane, again telling you what caused the alert.
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The Alert Visualization Popup Message Dialog, as shown in Exhibit 15.1-6, displays AWIPS system
and product monitor messages. When an alert occurs, the Alert Visualization Popup Message Dialog
window appears only in the display pane where the AlertViz Status Bar is running. It is from this dialog
window that you would acknowledge the alert and access the stored alerts.

Exhibit 15.1-6. Alert Visualization Popup Message Dialog

Selecting the Show Log button extends the Alert Visualization Popup Message Dialog window, as
shown in Exhibit 15.1-7, showing the stored messages in descending order with the latest message
appearing at the top of the list. If the "Expand Popup Information" checkbox is checked, you can
double-click on the message to display more information concerning the alert.

Exhibit 15.1-7. Alert Visualization Popup Message Dialog Message Log

Note 7: The amount of information displayed in the Alert Visualization Popup Message Dialog is
controlled by the "Common Settings" section of the Alert Visualization Configuration dialog box.
In the case of Exhibit 15.1-6, all options under "Text Message" are unchecked; in Exhibit 15.1-7,
all options are checked.

If you want to view the Error Log and the Alert Visualization Popup Message Dialog is not open, you
can display the log by clicking on the Error Log iconified button located on the AlertViz Status Bar
(refer to Exhibit 15.1-1).

AlertViz Tips

To access basic tips on how to use AlertViz and information concerning the different priorities, click on
the AlertViz Tips iconified button located on the AlertViz Status Bar (refer to Exhibit 15.1-1). The
AlertViz Tips window opens, as shown in Exhibit 15.1-8.
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Exhibit 15.1-8. AlertViz Tips Window
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15.2 Configuring the Alert Visualization Preferences

Module 33: Configuring the Alert Visualization Preferences

This module illustrates how to set up the Alert Visualization (AlertViz) preferences using the Alert
Visualization Configuration dialog box. The configuration defines how alerts will be displayed on the
AlertViz Status Bar and the Alert Visualization Popup Message Dialog window.

Note: Refer to Section 15.1 and Exhibit 15.1-5 when performing the objectives included in this practice
module.

Objective 33.1 - Using the Layout Section to Configure the Number and Arrangement of Cells

This objective gives you practice configuring the number and arrangement of the AlertViz Status Bar
cells.

1.

From the Panel on the left side of the CAVE GUI, position the cursor over the AlertViz symbol and
click mouse Button 3 to open the AlertViz menu.

Select Configuration to open the Alert Visualization Configuration dialog box.

Go to the right side of the Layout section of the Alert Visualization Configuration dialog box.
Notice in the Layout field the current layout and below it in the Message Text Layout window the
cell arrangement.

Note 1: H2 (two cells arranged horizontally) is AWIPS default layout.

The Layout field is comprised of a layout window and Up/Down Arrow iconified button. Select the
button to open the list of layouts.

Select a layout, other than the current layout, and observe the arrangment change in the Message Text
Layout window. Also notice the change to the AlertViz Status Bar.

Repeat the previous step and observe the different arrangements of the AlertViz Status Bar cells.

Assign V4 as the final layout for this objective. The Message Text Layout: window should display
four cells vertically arranged.

Go to the bottom of the dialog box and click the Save As button and enter "your name" for the new
custom configuration. The AlertViz Status Bar should now show the custom arrangement of four cells
vertically arranged.
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Note 2: V4 (four cells arranged vertically) is the current arrangement.

Objective 33.2 - Using the Layout Section to Assign Alert Categories to Cells

This objective gives you practice assigning alert categories to cells.

1. Reopen the Alert Visualization Configuration dialog box, if not already opened.

Note 1: In the Layout section, observe that each Category has an assigned Cell #. For example,
"Default" is assigned to Cell #1. Those categories that are not assigned a Cell # are designed as
"None."

2. Clear all layouts by clicking the Clear All Layouts button. Notice that the Cell # column now shows
"None" for all categories. You are now ready to assign cell to category.

3. Select (highlight) a category under the Category column.

4. From the Message Text Layout: window, which should now display four cells vertically arranged,
click on the numbered cell to assign that Cell # to the selected category.

5. Assign a Cell # to each category.

Note 2: In the lower-right corner of the Alert Visualization Configuration dialog box you can
find the configuration you are working in.

6. Make sure you are working in your custom configuration. Check the "Current Configuration." If you
are in the "Default" configuration, click the "Save As" button at the bottom of the dialog box and
select the custom configuration that you set up in Objective 33.1. If you are already in the custom
configuration, click the "Save" button.

Objective 33.3 - Using the Source and Priorities Section to Configure Appearance of Alerts

This objective illustrates using the Source & Priorities section of the Alert Visualization Configuration
dialog box to prioritize alerts by their source and configuring how they will appear on the AlertViz Status
Bar.

1. Reopen the Alert Visualization Configuration dialog box, if not already opened.
2. Make sure you are working in your custom configuration. Refer to Objective 33.2 - Note 2.

3. If you are not working in your custom configuration, click the Retrieve button at the bottom of the
dialog box and select your custom configuration from the list. Then check the lower-right corner of
the dialog box to make sure you are working in the correct configuration.
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4. From the Sources & Priorities section of the dialog box, locate the default list of Sources and select
the AVNFPS source.

Note 1: All alerts originating from the AVNFPS source will be affected by the configuration.

5. As you can see from Exhibit 15.1-5, there are many attributes for defining the indication for alerts
orginating from the selected source. Randomly make your attribute selections.

6. Randomly select another source from the Source list and configure the attributes for alerts originating
from that source. Continue selecting sources and configuring the attributes.

7. When finished, click the Save button at the bottom of the dialog box.

Objective 33.4 - Using the Common Setting Section to Control Information Displayed

This objective illustrates using the Alert Visualization Configuration dialog box to configure the
information displayed on the Alert Visualization Popup Message Dialog and ...Message Dialog Log.

1. Reopen the Alert Visualization Configuration dialog box, if not already opened.
2. Make sure you are working in your custom configuration. Refer to Objective 33.2 - Note 2.

3. If you are not working in your custom configuration, click the Retrieve button at the bottom of the
dialog box and select your custom configuration from the list. Then check the lower-right corner of
the dialog box to make sure you are working in the correct configuration.

4. By checking all three Text Message "Show..." boxes (default is unchecked) you can add three
additional information fields to the Alert Visualization Popup Message Dialog. Refer to Exhibit
15.1-6 for unchecked boxes and Exhibit 15.1-7 for all three "Show..." boxes checked.

Note 1: In addition to the "Show..." boxes, there is another checkbox for expanding the
information displayed on the Alert Visualization Popup Message Dialog. Also, you can control
the length of the message log and the duration (in seconds) for the blink and audio alert
attributes.

5. When finished, click the Save button at the bottom of the dialog box.

6. Close the Alert Visualization Configuration dialog box by clicking the Close button.
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16.0 Applications Within CAVE

The following applications are accessed under the CAVE menu:
e Data Delivery
e Collaboration
e AWIPS Statistics
e (IS Data

As shown in Exhibit 16.0-1, the first three applications are options listed directly under the CAVE menu. The
fourth, GIS Data, is accessed under the CAVE menu via the Import option.

Exhibit 16.0-1. Applications within CAVE

Note: Data Delivery is the only application within CAVE that has a submenu for accessing the Data
Delivery options (shown detached from CAVE menu in Exhibit 16.0-1).
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This chapter includes the following sections:

e Section 16.1: Data Delivery

e Section 16.2: Collaboration

e Section 16.3: AWIPS Statistics

e Section 16.4: GIS Data
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16.1 Data Delivery

As of the release of this edition of the User's Manual, the Data Delivery application was not operational.

Data Delivery is a permission-based application, meaning that the System Manager or User Administrator
controls the user's access to the Data Delivery functionalities (see System Manager's Manual - Chapter 30). If
granted permission to access this application, Data Delivery allows a user to subscribe to a data source or
create an ad hoc request and have the data delivered in near real time. Whether delivered by subscription or in
response to an ad hoc request, the data can be tailored to a user's specific temporal, geographic, and
parameter needs.

Data Delivery is an option under the CAVE menu and is comprised of the six components shown in Exhibit
16.1-1.

Exhibit 16.1-1. Data Delivery Components

This section discusses the following topics:

e Dataset Discovery Browser - Creating Subscriptions and Ad Hoc Requests - Subsection 16.1.1

Viewing Subscriptions and Ad Hoc Requests - Subsection 16.1.2

Subscription Manager - Subsection 16.1.3

Notification Center - Subsection 16.1.4

System Management - Subsection 16.1.5
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e Bandwidth Utilization Graph - Subsection 16.1.6
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16.1.1 Dataset Discovery Browser - Creating Subscriptions and Ad Hoc Requests

Before you can create subscriptions and ad hoc requests, you must find a dataset. The Dataset Discovery
Browser is used to retrieve datasets and to create subscriptions and ad hoc requests.

Note: Subscriptions can also be created via the Subscription Manager.

The Dataset Discovery Browser dialog box is accessed by selecting the Dataset Discovery Browser option
from the Data Delivery dropdown list box, as shown in Exhibit 16.1.1-1.

Exhibit 16.1.1-1. Accessing the Dataset Discovery Browser Dialog Box

The Dataset Discovery Browser dialog box is divided into two sections. The upper section addresses the
retrieval of a desired dataset, and the lower section displays available datasets based on the filtering
performed in the upper section. The upper section is further divided into three parts: Areal Coverage, Data
Type, and Filters. Every time you change information in the upper section, you can update the information
contained in the lower section by clicking the Update Results button.

The subsections that follow describe how to retrieve a desired dataset and how to work within the dataset to
create a subscription.
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16.1.1.1 Retrieving a Desired Dataset

Note 1: The steps that follow for retrieving a desired dataset do not follow the order in which the
components are arranged on the Dataset Discovery Browser dialog box shown in Exhibit 16.1.1-1.
Instead of starting your selection from the top (Areal Coverage), you start your selection from Data
Types. Then you narrow your search with filtering.

To retrieve a desired dataset, perform the following actions in the order presented.

1. Data Type: Select a data type from the Available window and move it to the Selected window using
the single arrow button. You would use the double arrow button to move all items listed in the
Available window to the Selected window. Once you've selected the data type, you can start to narrow
your dataset search results using the other filters.

Note 2: As soon as a data type is selected, the Update Results button changes from being grayed
out to active. You can update the list of available datasets at any time. The available datasets will
be listed in the window at the bottom of the dialog.

2. Areal Coverage: Set the areal coverage to a desired area of interest. Click the Set Area button to open
the Area Filter Section dialog box shown in Exhibit 16.1.1.1-1.

Exhibit 16.1.1.1-1. Areal Filter Selection Dialog Box
There are three methods of selecting your desired area of interest.

o Manual Lat/Lon Edit: This radio button enables you to enter latitude and longitude values in
the upper and lower latitude and longitude data fields. Clicking the OK button sets the areal
coverage component for the dataset and returns you to the Dataset Discovery Browser with the
latitude and longitude values displayed in the Areal Coverage - Area data field.

o Pre-defined Regions: This radio button is preset, by default, to Pre-defined with WFO scale.
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The latitude and longitude values displayed in the upper and lower latitude and longitude data
fields reflect the pre-defined area. The latitude and longitude values update accordingly if a
different pre-defined scale is selected. Besides selecting Pre-defined, you could select My
Region and choose a region that you had previously saved. Clicking the OK button sets the areal
coverage component for the dataset and returns you to the Dataset Discovery Browser dialog
with the latitude and longitude values displayed in the Areal Coverage - Area data field.

o Draw Bounding Box: This radio button opens the Subset dialog box where you select an area
by holding down mouse Button 1 and dragging your cursor to draw a "Bounding Box" around
the desired area on the map displayed inside the Subset by Space window, as shown in Exhibit
16.1.1.1-2. The Upper Left and Lower Right data fields display the latitude and longitude
values.

Exhibit 16.1.1.1-2. Subset Dialog Box - Draw Bounding Box

Clicking the OK button saves the selected area and closes the Subset dialog box, returning you
to the Area Filter Selection dialog box. Then clicking the OK button in this dialog sets the areal
coverage component for the dataset and returns you to the Dataset Discovery Browser with the
latitude and longitude values displayed in the Areal Coverage - Area data field.

3. Filters: The four filters under the Filters section of the Data Discovery Browser dialog shown in
Exhibit 16.1.1.1-3 can be used to further narrow your search for the desired dataset. A description of
each filter follows.
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Exhibit 16.1.1.1-3. Dataset Discovery Browser - Filters

o Data Provider: Selecting the arrow next to this filter expands the filter, as shown in Exhibit
16.1.1.1-4.

Exhibit 16.1.1.1-4. Dataset Discovery Browser - Data Provider Filter

Available data providers are listed in the Available Providers window. Select a provider(s) and
use the single or double arrow button to move the provider(s) to the Selected Providers window.
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Once a provider is selected, the LED next to the Data Provider label turns Green. The Match
Any and Match All radio buttons also help in filtering the search.

o Data Set: Selecting the arrow next to this filter expands the filter, as shown in Exhibit
16.1.1.1-5.

Exhibit 16.1.1.1-5. Dataset Discovery Browser - Data Set Filter

Available datasets are listed in the Available Data Sets window. Select a dataset(s) and use the
single or double arrow button to move the dataset(s) to the Selected Data Sets window. Once a
dataset is selected, the LED next to the Data Set label turns Green. Datasets can be filtered by
using the Search text field above the Available Data Sets window. As shown in Exhibit
16.1.1.1-5, there is a Case Sensitive checkbox and an Exclude checkbox These boxes can be
activated to help narrow the search.

o Level: Selecting the arrow next to this filter expands the filter, as shown in Exhibit 16.1.1.1-6.
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Exhibit 16.1.1.1-6. Dataset Discovery Browser - Level Filter

Available levels are listed in the Available Levels window. Select a level(s) and use the single or
double arrow button to move the level(s) to the Selected Levels window. Once a level is
selected, the LED next to the Level label turns Green. Levels can be filtered by using the
Search text field above the Available Levels window. The Case Sensitive and Exclude
checkboxes can be activated to help narrow the search. The Match Any and Match All radio
buttons also help in filtering the search.

o Parameter: Selecting the arrow next to this filter expands the filter, as shown in Exhibit
16.1.1.1-7.
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Exhibit 16.1.1.1-7. Dataset Discovery Browser - Parameter Filter

Available parameters are listed in the Available Parameters window. Select a parameter(s) and
use the single or double arrow button to move the parameter(s) to the Selected Parameters
window. Once a parameter is selected, the LED next to the Parameter label turns Green.
Parameters can be filtered by using the Search text field above the Available Parameters
window. The Case Sensitive and Exclude checkboxes can be activated to help narrow the
search. The Match Any and Match All radio buttons also help in filtering the search.

The four filter control buttons located under the Filters section of the Data Discovery Browser dialog
box shown in Exhibit 16.1.1.1-3 enable you to expand (+) or collapse (-) all filters, enable or disable a
particular filter (gray radio button), or clear (white radio button) the data you entered into all filters.
Selecting the gray button opens the Enable Filters dialog box shown in Exhibit 16.1.1.1-8. Selecting
the white button to clear all filters opens a pop-up dialog box asking you to verify the clearing of all
data.
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Exhibit 16.1.1.1-8. Enable Filters Dialog Box

You do not have to apply all the filters that you set up when narrowing your search for a desired
dataset. When a filter is disabled, the color of the LED next to the Filters label turns gray (either from
white to gray or from green to gray). A white LED indicates the filter is enabled but not set up to filter.
A green LED indicates the filter is enabled and set up to filter.

Update Results: This button updates the results of your search for a desired dataset, applying all the
filters you've set up to help in narrowing the search. Based on your search information, all available

datasets matching the applied filters will populate the window below the Update Results button, as

shown in Exhibit 16.1.1.1-9.

Exhibit 16.1.1.1-9. Available Datasets - Names by Provider
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Note 3: As shown in Exhibit 16.1.1.1-9, only the Data Provider filter (Green LED) is being
applied.

Results populate in three columns:
o Name: The names of the datasets are listed in this column.

o Subscription: Each row within this column contains either an "N" or a "Y." "N" signifies that
there is no existing subscription against the dataset at the local site. "Y" identifies datasets from

which one or more subscriptions have been created.
o Provider: The names of the dataset providers are listed in this column.

You have now found, through extensive filtering, the datasets in which you are interested. Now you are
ready to select a dataset and proceed to the next level.

Note 4: In some cases, instead of sequencing through the extensive filtering process, you may
want to see all datasets from a provider, and then filter on the dataset name and select the desired
dataset. In these cases, once you activate the Update Results button, you can select the Data
Provider radio button, and click Update Results to list the names of all available datasets.

Page 520



CAVE-D2D User's Manual AWIPS |1 Operational Build 13.4.1 - 31 July 2013

16.1.1.2 Working within a Dataset to Create a Subscription

From the list shown in Exhibit 16.1.1.1-9, select a dataset by highlighting its name and clicking the Subset
button. The Data Delivery Subset Manager dialog box, shown in Exhibit 16.1.1.2-1, opens.

Exhibit 16.1.1.2-1. Data Delivery Subset Manager Dialog Box

The Data Delivery Subset Manager includes four tabs for narrowing your search within the dataset. A
description of each tab follows.

o \ertical Levels/Parameters: Selecting the Vertical Levels/Parameters tab shown in Exhibit 16.1.1.2-2
displays one or more available vertical levels/parameters for the selected dataset. Each of these levels or
parameters can be expanded. For example, Exhibit 16.1.1.2-2 shows the Surface level expanded, listing
all available surface parameters in the Available Parameters window. You can then select one or
multiple parameters by using the single arrow button to move the selected item over to the Selected
Parameters window. The double arrow moves all the available parameters over to the Selected
Parameters window. Once the parameters have been selected, the selected level's (Surface) LED and the
Vertical Levels/Parameters tab's LED change from white to green.

Page 521



CAVE-D2D User's Manual AWIPS |1 Operational Build 13.4.1 - 31 July 2013

Exhibit 16.1.1.2-2. Selecting from Vertical Levels/Parameters Tab

e Forecast Hours: Selecting the Forecast Hours tab shown in Exhibit 16.1.1.2-3 displays all available
forecast hours for the selected dataset in the Available Hours window. You can select one or multiple
hours by using the single arrow button to move the selected item over to the Selected Hours window, as
shown in Exhibit 16.1.1.2-3. The double arrow moves all the available forecast hours over to the

Selected Hours window.

Exhibit 16.1.1.2-3. Forecast Hours Tab

e Spatial: Selecting the Spatial tab shown in Exhibit 16.1.1.2-4 enables you to define the area you would
like to request. Note that the second radio button, Pre-defined Regions, is the default selection. There
are several customization options within the Spatial tab as described here.

o Use Dataset Boundary: When the Use Dataset Boundary checkbox is checked, all radio buttons
in the Subset by Area section are grayed out. The latitude and longitude boundaries for the dataset
are automatically applied to the upper and lower latitude and longitude data fields, as shown in
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Exhibit 16.1.1.2-4.

Exhibit 16.1.1.2-4. Spatial Tab - Use Dataset Boundary
o Subset by Area: Descriptions of the three radio buttons in this section follow.

= Manual Lat/Lon Edit: This option allows the upper and lower latitude and longitude data
fields to become editable. You can manually enter your desired latitude and longitude values
for your area of interest within the dataset boundaries.

m Pre-defined Regions: Selecting this radio button activates two dropdown lists. The
dropdown on the left offers two options: Pre-defined and My Regions. When Pre-defined
is selected, the dropdown list on the right displays the D2D scales, as shown in Exhibit
16.1.1.2-5. The upper and lower latitude and longitude data fields will update accordingly
with the scale boundaries.
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Exhibit 16.1.1.2-5. Spatial Tab - Subset by Area (Pre-defined Regions)

m Draw Bounding Box: Selecting this radio button opens the Subset dialog box. The map
displayed in the Subset by Space window is the areal domain of the selected dataset. Hold
down mouse Button 1 to activate the drawing tool and drag a box over a desired area of the
map, as shown in Exhibit 16.1.1.2-6. After you click the OK button the upper and lower
latitude and longitude data fields will update accordingly with the values of the bounded
area.

Exhibit 16.1.1.2-6. Spatial Tab - Subset by Area (Subset Dialog Box - Draw Boundary Box)

o Save Boundary as Region: This option gives you the capability to create your own customized
region for future use. When you decide to create an area by dragging a bounding box on the map
or by manually entering latitude and longitude values in the text fields below the map, that area
can be saved by entering a name for the region in the Saved Region Name text field. After
clicking the OK button the name given to the region will appear in the right dropdown list for the
My Regions option of the Pre-defined Regions radio button.

e Saved Subsets: Under this tab is listed all the subsets that you have saved. Once all the filters for the
dataset have been selected, you must enter a Subset Name. Once saved, this name will appear under
your Saved Subsets tab. If none have been saved, then there will be nothing listed, and nothing available
to select. If you have at least one saved subset, then you have two options available for that subset,
Query and Subscribe. Descriptions of both options follow.

o Query: Selecting the Query button runs an ad hoc request against the selected dataset and subset
parameters. Upon selecting the Query button, the Select Data/Cycle dialog box opens, as shown
in Exhibit 16.1.1.2-7.

Page 524



CAVE-D2D User's Manual AWIPS |1 Operational Build 13.4.1 - 31 July 2013

Exhibit 16.1.1.2-7. Select Data/Cycle Dialog Box

By default, the Get Latest Data checkbox is checked, which will retrieve the latest available
model run. Also by default, the Priority dropdown list box is set to "Normal," and "115" is entered
into the Latency (Minutes) text field, as defined by the "Latency Rules." If the Get Latest Data
checkbox is unchecked, a list of available model runs will be listed in the window for selection.

Note: Only one model run can be selected at a time.

The Priority dropdown list box offers "High," "Normal," and "Low" priorities that will determine
download rank among other queries and subscriptions. The Latency (Minutes) setting is a
window of opportunity to download the requested dataset. It is the maximum time, in minutes, that
the subscripted data is allowed to be scheduled to download from its time of availability.

When OK is selected, the Query Scheduled notification pop-up window shown in Exhibit
16.1.1.2-8 appears; this window notifies you that the query was successfully stored and provides
an estimated completion time.

Exhibit 16.1.1.2-8. Query Scheduled Pop-up Window

o Subscribe: Selecting the Subscribe button opens the Create Subscription dialog box shown in
Exhibit 16.1.1.2-9.
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Exhibit 16.1.1.2-9. Create Subscription Dialog Box

The Create Subscription dialog box contains seven sections. All the sections in this dialog box
must be finalized in order to create a subscription. Some sections include fields that are optional.
Descriptions of these sections - fields follow.

= Subscription Information - Name: The name you entered into the Subset Name text field
on the Data Delivery Subset Manager dialog box appears here.

m Subscription Information - Description: This field is optional. If you desire, you may use
it to add a description of your subscription.

= Group Information - Group Name: A group name can only be selected from a name on
the dropdown list.

m Subscription Delivery Options - Deliver: The Deliver dropdown list offers two choices:
Notify when data is available and Deliver data when available.

= Subscription Duration - No Expiration Date: Checking the checkbox will apply no
expiration date on the subscription. Unchecking the checkbox will activate the Start Date
and Expiration Date data fields and the Select Date buttons. Click on the Select Date
button to open the Calendar shown in Exhibit 16.1.1.2-10.
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Exhibit 16.1.1.2-10. Calendar

Subscription Active Period - Always Active: By default, this checkbox is checked.
However, you can uncheck the box and select an Active Period Start date and an Active
Period End date. Unchecking the button activates these fields and the Select Date buttons.
Click on the Select Date button to open the Calendar shown in Exhibit 16.1.1.2-10.

Priority/Latency - Priority: This dropdown list offers "High," "Normal," and "Low"
priorities that will determine download rank among other ad hoc requests and subscriptions.

Priority/Latency - Latency (Minutes): This setting is a window of opportunity to
download the requested dataset. It is the maximum time, in minutes, that the subscripted
data is allowed to be scheduled for download from its time of availability. If the data is
unavailable during that time period it is skipped and the next available data will be
downloaded.

Model Cycle Times: All available model run times for the dataset will be listed in this
section with a checkbox. You can individually check the model run times of interest or select
the Select All button to check all model run times.

Click the OK button when all selections have been made in the Create Subscription dialog box.
The Subscription Created pop-up window shown in Exhibit 16.1.1.2-11 appears to inform you
that the subscription has been created. Click the OK button to acknowledge receipt.

Exhibit 16.1.1.2-11. Subscription Created Pop-up Window
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16.1.2 Viewing Subscriptions and Ad Hoc Requests

All retrieved subscriptions and ad hoc requests are viewable through the D2D Product Browser, accessed
via the CAVE menu. Select Data Browsers and pick Product Browser. Expanding Grid in the Product
Browser window will list all stored grid data. Subscriptions and ad hoc requests will be listed under Grid by
its given name. For example, refer to Exhibit 16.1.2-1 to view UM-Test-Subscription expanded in the
Product Browser window.

Exhibit 16.1.2-1. Subscription in Product Browser

All UM-Test-Subscription products listed in the Product Browser have been downloaded from the Data
Provider and are available for viewing. For example, refer to Exhibit 16.1.2-2, which displays the selected
subscription in the Main Display Pane (refer to the Legend at bottom of display).
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Exhibit 16.1.2-2. Subscription Product Selected from Product Browser and Displayed on Screen
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16.1.3 Subscription Manager

The Data Delivery Subscription Manager dialog box, shown in Exhibit 16.1.3-1, is accessed by selecting
Subscription Manager from the Data Delivery option under the CAVE menu. The Data Delivery
Subscription Manager lists all the subscriptions created by users at the local site, and allows any user to
"create," "edit," "copy," "view," "delete," "activate," "deactivate," and "group" data delivery subscriptions.

Exhibit 16.1.3-1. Accessing the Data Delivery Subscription Manager Dialog Box with File Dropdown Menu
Open

Descriptions of the Data Delivery Subscription Manager dialog box menus follow.

File

The options under the File menu follow.

e New Subscription: This option opens the Dataset Discovery Browser dialog box, which allows you
to find datasets using filtering options and create a subscription or ad hoc request (refer to Sections A
and B).

e New Group: This option opens the Create Group dialog box shown in Exhibit 16.1.3-2, which
allows you to select subscriptions from a list of all available subscriptions and apply a subscription
delivery option, duration, active period, and areal coverage to the selected subscription(s) within that

group.
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Exhibit 16.1.3-2. Create Group Dialog Box

The Create Group dialog box contains six sections with one or more fields per section. Descriptions
of these sections - fields follow.

o Group Information - Group Name: It is here that you would enter in the text field a desired
group name that will apply to a group of subscriptions.

o Subscription Delivery Options - Deliver: The Deliver dropdown list offers two choices: Notify
when data is available and Deliver data when available.

o Subscription Duration - No Expiration Date: By default, this checkbox is checked to indicate
No Expiration Date. Unchecking the checkbox will activate the Start Date and Expiration
Date data fields and the Select Date buttons. Click on the Select Date button to open the
Calendar (refer to Exhibit 16.1.1.2-10). The Subscription Duration assigned to a group will
override the original subscription duration of each subscription when added to the group.

o Subscription Active Period - Always Active: By default, this checkbox is checked to indicate
Always Active. Subscriptions can be set so the data is retrieved year-round, or set for a specific
time period within the year. You can uncheck the box and select an Active Period Start date and
an Active Period End date. Unchecking the button activates these fields and activates the Select
Date buttons. Click on the Select Date button to open the Calendar (refer to Exhibit
16.1.1.2-10).

o Areal Coverage - No Areal Coverage: By default, this checkbox is checked to indicate No
Areal Coverage. Unchecking the checkbox activates the Set Area button, which when selected
opens the Area Filter Selection dialog box shown in Exhibit 16.1.3-3.
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Exhibit 16.1.3-3. Area Filter Selection Dialog Box with Scales Dropdown List Open

The Area Filter Selection dialog box includes three radio button-controlled methods of selecting
your desired area of interest. Descriptions of each follow. Note that the second radio button,
Pre-defined Regions, is the default selection.

m» Manual Lat/Lon Edit: This radio button enables you to enter latitude and longitude
values in the upper and lower latitude and longitude data fields. Clicking the OK button
sets the areal coverage component for the dataset and returns you to the Dataset Discovery
Browser with the latitude and longitude values displayed in the Areal Coverage - Area
data field.

m Pre-defined Regions: This radio button is preset, by default, to Pre-defined with WFO
scale. The latitude and longitude values displayed in the upper and lower latitude and
longitude data fields reflect the pre-defined area. The latitude and longitude values update
accordingly if a different pre-defined scale is selected. Besides selecting Pre-defined, you
could select My Region and choose a region that you had previously saved. Clicking the
OK button sets the areal coverage component for the dataset and returns you to the
Dataset Discovery Browser dialog with the latitude and longitude values displayed in the
Areal Coverage - Area data field.

» Draw Bounding Box: This radio button opens the Subset dialog box where you select an
area by holding down mouse Button 1 and dragging your cursor to draw a "Bounding
Box" around the desired area on the map displayed inside the Subset by Space window
(refer to Exhibit 16.1.1.1-2). The Upper Left and Lower Right data fields display the
latitude and longitude values.

Clicking the OK button saves the selected area and closes the Subset dialog box, returning
you to the Area Filter Selection dialog box. Then clicking the OK button in this dialog
sets the areal coverage component for the group and returns you to the Create Group with
the latitude and longitude values displayed in the Areal Coverage - Area data field.

o User Information: Select a User ID from the User dropdown list box. The Available
Subscriptions window and Selected Subscriptions window list all the subscriptions for the
selected user ID. To apply subscriptions to the group, select a subscription from the Available
Subscriptions window and use the single arrow button to move the subscription to the Selected
Subscriptions window. Use the double arrow button to move over all the subscriptions listed in
the Available Subscriptions window.
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Click the OK button when all selections have been made in the Create Group dialog box. The
dialog will close and return you to the Data Delivery Subscription Manager.

e Refresh Table: This option refreshes the information contained in the Data Delivery Subscription
Manager dialog box.

e Approved Pending Subscriptions: This option of requiring created subscriptions to go through an
approval process is dependent on site-specific rules and permissions. If a site sets up this process, the
Data Delivery Subscription Manager dialog box will list user created subscriptions that are pending -
waiting for approval.

e Exit: This option closes the Data Delivery Subscription Manager dialog box.
Edit

The options under the Edit menu shown in Exhibit 16.1.3-4 follow.

Exhibit 16.1.3-4. Data Delivery Subscription Manager Dialog Box with Edit Dropdown Menu Open

e Edit Subscription: This option opens the Data Delivery Subset Manager dialog box shown in
Exhibit 16.1.3-5.

Exhibit 16.1.3-5. Data Delivery Subset Manager Dialog Box - Edit
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The Data Delivery Subset Manager contains the same four tabs that you encountered on this dialog
box when working with datasets (refer to Exhibit 16.1.1.1-9 and Exhibit 16.1.1.2-1). When editing,
these four tabs have the same filtering functions of narrowing your search to a desired subscription.
The four tabs and the Query button for retrieving an ad hoc request function in much the same way as
when you were working with datasets. However, this is not the same dialog box. A Continue button
replaces the Subscribe button at the bottom of the dialog. Clicking the Continue button opens the Edit
Subscription dialog shown in Exhibit 16.1.3-6.

Exhibit 16.1.3-6. Edit Subscription Dialog Box

The Edit Subscription dialog box functions the same as the Create Subscription dialog box (see
Exhibit 16.1.1.2-9). However, the Edit Subscription dialog box includes an additional section, labeled
Reason for Change, at the bottom of the dialog. In the Reason for Requesting Change text box you
would enter the reason why you are editing the subscription.

Clicking OK closes both the Edit Subscription and the Data Delivery Subset Manager dialog boxes.

Note 6: The Continue button at the bottom of the Data Delivery Subset Manager dialog box
indicated that the Edit Subscription dialog box was essentially the second page of the Subset
Manager dialog. Therefore, clicking the OK button closed both dialogs.

e Copy Subscription: This option opens the Copy Subscription dialog box shown in Exhibit 16.1.3-7.
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Exhibit 16.1.3-7. Copy Subscription Dialog Box

The subscription to be copied must be selected in the Data Delivery Subscription Manager dialog
box. In the Copy Subscription dialog box you would enter a "new name" in the New Subscription
Name text field. After clicking OK the newly copied subscription name would be listed in the Data
Delivery Subscription Manager dialog box.

e Delete Subscription: Subscriptions can be deleted from the Data Delivery Subscription Manager
dialog box. You would first select this option by highlighting the subscription you want to delete. A
Delete Confirmation dialog box would then pop up to confirm your decision to delete the
subscription.

e Edit Group: This option opens the Edit Group dialog box shown in Exhibit 16.1.3-8. The Edit
Group dialog box functions in the same way as the Create Group dialog box shown in Exhibit
16.1.3-2. Here you would make edits to the existing group information, and save the changes by
clicking the button.

Exhibit 16.1.3-8. Edit Group Dialog Box

e Delete Group: This option opens the Delete Group dialog box listing all available named groups. To
delete a group, you would simply select the group by highlighting the name and clicking the Delete
button. A Delete Group Confirmation pop-up box will appear to confirm your decision to delete the

group.
Settings

The options under the Settings menu shown in Exhibit 16.1.3-9 follow.
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Exhibit 16.1.3-9. Data Delivery Subscription Manager Dialog Box with Settings Dropdown Menu Open

e Configure Table: This option opens the Subscription Manager Configuration dialog box shown in
Exhibit 16.1.3-10. The Data Delivery Subscription Manager dialog box shown in Exhibit 16.1.3-9
arranges information in the style of a table with columns and headings. The Configure Table option
allows you to set up different table configurations, with each customized configuration defining
whether a column is hidden or visible. You decide what information you want to see.

Exhibit 16.1.3-10. Subscription Manager Configuation Dialog Box

e Tooltips: Activating the tooltip option turns on Tooltip text within the Data Delivery Subscription
Manager dialog box. This affects all dialogs that are launched within the Data Delivery Subscription

Manager dialog.

Help

The Help pull-down menu contains an About Subscription Manager selection, which provides a brief
overview of the menu options within the Data Delivery Subscription Manager dialog box.
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16.1.4 Notification Center

The Notification Center dialog box is accessed by selecting Notification Center from the Data Delivery
option under the CAVE menu, as shown in Exhibit 16.1.4-1. The Notification Center dialog box is arranged
in the style of a table. It lists all notifications received by Data Delivery.

Exhibit 16.1.4-1. Accessing the Notification Center Dialog Box

In addition to opening the Notification Center dialog box, a small DD icon appears on your desktop as
shown in Exhibit 16.1.4-2. The DD icon is meant to inform you that the Notification Center dialog is still
open when the Notification Center dialog is not in view. A click of mouse Button 1 on the DD icon opens a
small pop-up with checkbox, as shown in Exhibit 16.1.4-2. When the checkbox is checked the Notification
Center dialog will remain open and visible. When unchecked, the Notification Center dialog will remain
open but not visible and the DD icon will remain active. When closed the DD icon will disappear.

Exhibit 16.1.4-2. DD Icon and DD Icon Pop-up

Descriptions of the Notification Center dialog box menus follow.
File

The Notification Center dialog box File menu is shown in Exhibit 16.1.4-3.
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Exhibit 16.1.4-3. Notification Center Dialog Box with File Dropdown Menu Open

The options under the File menu follow.

e Set as Default: This option sets the current arrangement of information displayed on the Notification
Center dialog box as the default settings. When the Notification Center dialog box is opened, the
saved default settings are applied.

e | oad Configuration: This option opens the Load Configuration dialog box shown in Exhibit
16.1.4-4. All available configurations are listed as "xml" files.

Exhibit 16.1.4-4. Load Configuration Dialog Box

Before loading the configuration file, you can select and preview the "xml" file by the Preview button,
which opens the Preview window shown in Exhibit 16.1.4-5. To edit the configuration, you would go
to the Configure Table option under the Settings menu. Select the configuration by clicking the Load
button.
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Exhibit 16.1.4-5. Load Configuration Dialog Box with Preview of "xmI"" File Window

e Save Configuration: This option opens the Save Configuration dialog box shown in Exhibit
16.1.4-6, which saves the current notification center configuration settings to one of the available
configuration files listed in the Save Configuration dialog box.

Exhibit 16.1.4-6. Save Configuration Dialog Box

Note 6: The Save Configuration dialog box will only pop up if you have made changes to the
Notification Center dialog configuration settings. Changes are made via the Configuration
Table dialog, accessed under the Settings menu.

e Save Configuration As: This option allows you to save the current configuration setttings at the site or
user level to a named file that may be loaded in the future. Configurations can be adjusted from the
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Configure Table option under the Settings menu.

e Delete Configuration: This option allows you to delete a configuration. To delete a configuration, you
would select the configuration by highlighting the name and clicking the Delete button on your
keyboard. A Delete Configuration Confirmation pop-up box will appear to confirm your decision to
delete the configuration.

e Exit: This option exits and closes the Notification Center dialog box.
Edit

The Notification Center dialog box Edit menu is shown in Exhibit 16.1.4-7.

Exhibit 16.1.4-7. Notification Center Dialog Box with Edit Dropdown Menu Open

The options under the Edit menu follow.

e Find: This option acts as a search function within the Notification Center dialog box. Selecting this
option opens the Find dialog box where you would enter a text search and add filtering as desired.

e Delete by Priority: This option actually hides rather than deletes. Selecting the option opens a
submenu listing Priority 1 - 5 where you can select to hide all notifications listed in the Notification
Center dialog box of that priority.

e Delete Older Than Selected: By highlighting any given notification message in the Notification
Center dialog, you can select this option and "all" notifications older than the highlighted message will
be deleted from the Notification Center dialog box.

e Delete Notification(s): This option actually hides rather than deletes. A single notification can be
hidden from the Notification Center dialog by highlighting a selection from the dialog and selecting
this option.

Settings

The Notification Center dialog box Settings menu is shown in Exhibit 16.1.4-8.
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Exhibit 16.1.4-8. Notification Center Dialog Box with Settings Dropdown Menu Open

The options under the Settings menu follow.

e Configure Table: This option opens the Notification Configuration dialog box shown in Exhibit
16.1.4-9, which allows you to change how the Notification Center dialog box loads its content.

Exhibit 16.1.4-9. Notification Configuration Dialog Box

The Notification Configuration dialog box contains two sections with one or more fields per section.
Descriptions of these sections - fields follow.

o Initial Startup Configuration - Load All Messages: When this checkbox is checked all
available messages across the site will be loaded into the Notification Center dialog box.
Checking this checkbox also grays out the Load Last text field/list box, the Messages radio
button, and the Hours of Messages radio button.

o Initial Startup Configuration - Load Last: This text field/list box is active when the Load All
Messages checkbox is unchecked. You can enter a number, either manually or by using the up
and down arrow buttons. The value entered depends on which radio button (Messages or Hours

of Messages) is selected.

m Messages: This radio button is active when the Load All Messages checkbox is
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unchecked. When this radio button is selected, the value entered into the Load Last field
represents the number of messages that were last loaded into the Notification Center
dialog box.

m Hours of Messages: This radio button is active when the Load All Messages checkbox is
unchecked. When this radio button is selected, the value entered into the Load Last field
represents the number of hours of messages that were last loaded into the Notification
Center dialog box.

o Initial Startup Configuration - Initial Sort Column: This dropdown list box allows you to
select a column ‘Time, Priority, Category, User, or Message’ for initially sorting in the order
defined by selecting one of the radio buttons (Sort Ascending or Sort Descending).

o Display Configuration Settings - Rows Per Page: This dropdown list box offers values ranging
from 20 to 5000. The value selected can be saved in the configuration under the Settings menu.

o Display Configuration Settings - Priority Symbols: A symbol for priority is listed under the
Priority column in the Notification Center dialog box. The five radio buttons allow you to
customize the priority symbol.

o Display Configuration Settings - Hidden Columns and Visible Columns: Using the single
arrow buttons you can move the Notification Center column heading to have the column either
visible or hidden. Use the double arrow button to move all column headings to either window.

o OK: Clicking this button applies all settings to the Notification Center dialog box. Once the
settings are applied, you can go back to the File menu and save the configuration or even set it as
the default configuration.

o Filter Table: This option opens the Notification Filter Settings dialog box shown in Exhibit
16.1.4-10. There are three sections within this dialog: "Filter by User," "Filter by Subscription," and
"Filter by Priority."

Exhibit 16.1.4-10. Notification Filter Settings Dialog Box
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The Notification Filter Settings dialog box contains three sections with one or more fields per section.
Descriptions of these sections - fields follow.

o Filter by User - Always include my notifications: When this checkbox is checked, your
username will be listed in the Selected Users window. You can also select any other user's
notifications that you wish to see by using the single arrow button to move the user's username
from the Available Users window to the Selected Users window. Use the double arrow button to
move over all users listed in the Available Users window.

o Filter by Subscription: This section allows you to select subscriptions you want to receive
notifications from by using the single arrow button to move the subscription from the Available
Subscriptions window to the Selected Subscriptions window. Use the double arrow button to
move over all subscriptions listed in the Available Subscriptions window.

o Filter by Priority: This section lists all priorities, 1 through 5, with a checkbox beside each one.
1 - Crit is grayed out because users will always receive Critical 1 priority notifications. All
other priorities are selectable by checking or unchecking the checkbox.

o OK: Clicking the OK button applies the filter settings. Once the settings are applied, you can go
back to the File menu and save the configuration or even set it as the default configuration.
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16.1.5 System Management

The System Management dialog box is accessed by selecting System Management from the Data Delivery
option under the CAVE menu, as shown in Exhibit 16.1.5-1.

Exhibit 16.1.5-1. Accessing the Data Delivery System Management Dialog Box
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16.1.6 Bandwidth Utilization

The Bandwidth Utilization dialog box is accessed by selecting Bandwidth Utilization Graph from the
Data Delivery option under the CAVE menu, as shown in Exhibit 16.1.6-1. The graph illustrates all
subscriptions and download time windows for each subscription over time, starting at the current time. By
default the graph updates every minute.

Exhibit 16.1.6-1. Accessing the Bandwidth Utilization Dialog Box with Graph Dropdown Menu Open

On the left side of the graph is a list of all subscriptions. Beside each subscription is a small box that turns
blue when a subscription is selected. To view more information on the selected subscriptions, click mouse
Button 2 anywhere within the subscription list to open the Subscriptions dialog box shown in Exhibit
16.1.6-2.

Exhibit 16.1.6-2. Subscriptions Dialog Box

Descriptions of the components that comprise the Bandwidth Utilization dialog box follow.

Graph

Time in UTC (Coordinated Universal Time) is listed along the bottom axis starting with the current time
listed at the far left. Within the graph are colored bars representing the download time window for each
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subscription. The colors of the bars illustrate the priority of the subsciption, which is defined at the top of the
graph.

e Red = High priority
e Green = Normal priority
e Blue = Low priority
Menu Bar
e File: This dropdown menu includes two options. Descriptions of each follow.
o Save: This option saves an image of the graph to a directory selected by the user.
o Exit: This option closes the Bandwidth Utilization dialog box.

e Graph: This dropdown menu, as shown in Exhibit 16.1.6-1, includes three checkboxes. Descriptions
of each follow.

o Live Update: By default, this checkbox is checked in order to update the graph time every
minute. When this checkbox is unchecked, the graph time will not update.

o Color By Priority: By default, this checkbox is checked in order to indicate the priority of each
subscription. The color of the bar indicates the priority. When this checkbox is unchecked all the

bars are colored blue.

o Show Subscription Lines: By default, this checkbox is checked to show visible horizontal lines
running from the subscription name through the color bars for easier viewing. When unchecked
the lines are hidden.

The Close button closes the Bandwidth Utilization dialog box.

Page 546



CAVE-D2D User's Manual AWIPS |1 Operational Build 13.4.1 - 31 July 2013

16.2 Collaboration

Collaboration is an option under the CAVE menu. It is a component within CAVE that offers two main
functions: chatting; and sharing displays. "Chat" allows users to instant message or text chat in real time with
fellow forecasters and offices in a chat room. "Sharing displays" adds onto the chat room capabilities and
allows the room's creator to show a CAVE Map display to other pariticpants in the chat room.

This section provides an introduction to Collaboration and explains how to set up "Collaboration Sessions"
with other users/offices. The following topics are discussed:

e Starting the Collaboration Application - Subsection 16.2.1

Creating a Chat Session - Subsection 16.2.2

Configuring Your Collaboration Experience - Subsection 16.2.3

Creating a Shared Display Session - Subsection 16.2.4

Other Session Leader Capabilities - Subsection 16.2.5
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16.2.1 Starting the Collaboration Application

The Collaboration application is accessed through the CAVE menu and starts when you log into the
Collaboration server, as shown in Exhibit 16.2.1-1.

Exhibit 16.2.1-1. Starting Collaboration

Once logged in, a Collaboration Information pane opens to the right of the Main Display pane, as shown in
Exhibit 16.2.1-2.
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Exhibit 16.2.1-2. Collaboration Information Pane

The Collaboration Information pane contains one row of iconified toolbar buttons, as shown in Exhibit
16.2.1-3.

Exhibit 16.2.1-3. Collaboration Information Toolbar

Descriptions of the Collaboration Information toolbar buttons shown in Exhibit 16.2.1-3 follow.

e Float: Detaches the Collaboration Information pane from the main window and allows you to drag the
pane to a different location, or to minimize/maximize the pane as desired.

e Create Session: Opens a Create Session dialog box that allows you to create an invitation to a
Collaboration Session.
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e Display Feed: Opens the NWS Collaboration Chat Room.
e Collapse All: Collapses all expanded groups in the Collaboration Information window.
¢ Link Map Editor to Chat Session: Links the Collaboration Session to the respective Map Editor.

e View Menu: Opens the pop-up menu, shown in Exhibit 16.2.1-4. that provides the options described
below.

Exhibit 16.2.1-4. Collaboration View Menu

o Create Group: Enables each user to create a personalized group that will be added to the list of
groups in the Collaboration Information window. System groups are indicated by a blue group
symbol. Personalized groups are indicated by a green group symbol.

o User Search...: Opens a Search dialog box, which you can use to search for someone who may
not be listed in one of your existing groups.

o Change Font...: Opens a dialog box that allows you to select a font (family, style, and/or size) in
which the text will be displayed in all chat windows.

o Change Status: Opens a dropdown list that allows you to change your Status to "Available,"
"Do Not Disturb,” or "Away."

o Change Status Message...: Allows you to update your status Message.
o Change Password...: Allows you to change your own individual Password.

o Change Role: Opens a dropdown list that allows you to change your Role to "Short Term
Forecaster," "Long Term Forecaster," or "None."

o Change Site: Opens a dropdown list that allows you to change the Site (e.g., OAX to DMX).
Depending on the site's configuration settings, changing the site may change the list of users
within the Participants list and the users' messages visible within the NWS Collaboration chat
room. For example, a site may be configured to view only messages from
surrounding/neighboring sites. In this case, a forecaster at OAX who is backing up site DMX,
would no longer see messages from GID because GID does not neighbor DMX.
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o View Log...: Opens a Log that lists all the user's sessions and chat logs.

o Logout: Allows you to log out of Collaboration.

Note 1: You must select the Logout button on the Collaboration View menu to log out of
Collaboration. Simply clicking the "X" on the Collaboration Information tab to close the
Collaboration Information pane will not log you out of the Collaboration server. If the
Collaboration Information pane is closed before you log out, reopen the pane by selecting
Collaboration from the CAVE menu.
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16.2.2 Creating a Chat Session

To view all users associated with a group or site, click the ">" next to the group or site name (see Exhibit
16.2.1-2). This will expand the group or site and list all available users of that group or site. The Status of a
user is identified by the icon next to the user's name. The appearance of the icon indicates the current status,
as described below.

e Offline: The icon is dithered out and light gray.
e Available: The icon is bright gray.
e Do Not Disturb: The Available icon is indicated, but with a red dot.

e Away: The Available icon is indicated, but with a clock symbol.

Note 1: You can also mouse over the user to view a pop-up text indicating the current status. ‘

Chat with Individual User

To start a Chat Session with an individual user, double click on the name of a user who is logged into
Collaboration.

Note 2: Chat sessions cannot be started with any user who is not logged into Collaboration. ‘

After double-clicking on the user's name, a Conversation window to display the text messages associated
with the user will open, and a Compose section for entering the text messages will open beneath it. A new tab
with the user's name as the title in the tab will also be added to the Collaboration Information pane, as shown

in Exhibit 16.2.2-1.
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Exhibit 16.2.2-1. Chat Session with Individual User

The real-time text chatting begins by entering a text message in the Compose section and submitting it by
pressing the Enter key. When the first text message is sent by the initial user, a new tab will open within the
selected user's Collaboration Information pane. The new tab will be titled with the initial user's name and the
transmitted text will appear in the Conversation window adjacent to the user's name.

Note 3: To return to the Collaboration Information window, select the Collaboration Information tab.

Chat with NWS Community

The Collaboration toolbar includes a Display Feed button (see Exhibit 16.2.1-3) that will allow you to chat
with the NWS community.

Note 4: You will only see messages from the sites that your office subscribes to; this has been set up by
your System Manager via a configuration file (see Chapter 27 in the System Manager's Manual).

Clicking the Display Feed iconified button opens the NWS Collaboration chat room. A tab opens with the
"NWS Collaboration Room" as the tab's title. A list of participants is displayed (when expanded) in the
Participants window, above the Conversation window, as shown in Exhibit 16.2.2-2.
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Exhibit 16.2.2-2. Chat with NWS Community
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16.2.3 Configuring Your Collaboration Experience

The NWS Collaboration chat room can be set to open upon logging into Collaboration. This can be set by
checking the Join Discussion On Login checkbox under Collaboration in the Preferences dialog box, as
shown in Exhibit 16.2.3-1. Preferences is an option under the CAVE menu.

Exhibit 16.2.3-1. Preferences Dialog Box for Setting the Collaboration User Interface Preferences

If you are logged into the Collaboration application but are not currently viewing the chat window, you can
be notified if someone sends you a chat message. When the Show Notifications checkbox (see Exhibit
16.2.3-1) is checked (active), a pop-up message will appear in the lower right corner of the monitor indicating
you just received a chat message.

To enhance the collaboration experience, you can make specific words in the chat message stand out from the
normal text. Selecting Significant Words under Collaboration in the Preferences dialog box opens the
Significant Words dialog window, as shown in Exhibit 16.2.3-2. You can add one or more words and then set
up attributes for making the words catch the eye when mentioned during the chat. For example, you might
make the word "tornado" appear in a large red font.
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Exhibit 16.2.3-2. Preferences Dialog Box for Configuring Significant Words
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16.2.4 Creating a Shared Display Session

A Shared Display Session can be created when a user wants to share a CAVE display and collaborate with
another user or group of users. The Session Leader (also known as the Data Provider) of the Collaboration
session is the individual who creates the Shared Display Session, and has initial control over what is shared
and with whom.

Note 1: Shared Display Sessions can be started from any perspective. However, displays can only be
shared when sessions are created in perspectives containing Map Editor tabs (e.g., D2D, GFE, Hydro,
MPE, and National Centers perspectives).

Invitation to Session

All clients (invited participants) invited to a Shared Display Session will receive an invitation to the session,
as shown in Exhibit 16.2.4-1, no matter what perspective is displayed on the client's workstation. For Shared
Display Sessions created in perspectives with Map Editor tabs displayed, a new Map Editor tab will display
on the client's Main Display pane upon acceptance of the invitation. If a Shared Display Session is created in
perspectives without Map Editor tabs (e.g., Localization or XML), a chat session will be opened with the
invited guests (clients), but they will not be able to share displays (refer to Note 6).

Exhibit 16.2.4-1. Session Invitation Dialog Box

Invitees to the Collaboration Session can either "Accept" the invitation by clicking the Join button or
"Reject" the invitation by clicking the Cancel button.

Multiple Shared Display Sessions

Users may create multiple Shared Display Sessions across multiple (different) Map Editor tabs or
perspectives. A single Map Editor tab cannot be used to create more than one Shared Display Session. For
example, in D2D, User "A" can create a Shared Display Session in one Map Editor tab with Users "B," "C,"
and "D." User "A" can create a second Shared Display Session from a second Map Editor tab with Users "E,"
"F," and "G," as long as the second Map Editor tab is not already involved in another Shared Display Session.
Similarly, User "A" can open another perspective and create another Shared Display Session with any user.
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A user within a Shared Display Session can also create his or her own Shared Display Session from another
Map Editor tab or perspective. The user can be a client of one Shared Display Session, and be the Session
Leader of another Shared Display Session. For example, in D2D, if User "B" is a client of a Shared Display
Session led by User "A," User "B" may invite Users "C," "D," and "E" (and even User "A") to his or her
Shared Display Session. Similarly, User "B" can open another perspective and create a Shared Display
Session with any user.

Rules When Sharing Displays

e X-Y displays cannot be shared (e.g., Nsharp/soundings, Cross Sections, Time Height). A chat session
will be created if a Shared Display Session is created with an X-Y display in the Main Display pane.

e 4-panel displays cannot be shared. A chat session will be created if a Shared Display Session is created
with a 4-panel display in the Main Display pane. If a single frame is converted into a 4-panel layout,
only the single frame will be shared. The Rotate Panels functionality will not share data in the other 3
panels.

e Dialogs and windows are not shared across workstations.

e Users cannot create Shared Data Displays with the Localization and XML perspectives. A chat session
will be created when attempting to create a session with one of these perspectives.

e The cursor is not shared (although the sampled values adjacent to the cursor are visible across
workstations).

e PGEN (Product Generation) objects can only be generated within the National Centers Perspective.
e Session Leader privileges cannot be transferred to a client during a Collaboration session.
Procedure for Creating a Shared Display Session

To create a Shared Display Session the Session Leader must perform the following steps, in the order listed
below.

1. Have the Collaboration Information pane open and any perspective's Map Display (i.e., D2D Map tab)
active.

2. Select the clients to be invited to the session by highlighting the individual's name from the list in the
Collaboration window.

Note 2: For multiple users, hold down the Ctrl key while selecting usernames. This will highlight
more than one user.

3. Click on the Create Session button on the Collaboration Information toolbar. A Create Session dialog
box opens, as shown in Exhibit 16.2.4-2.
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Exhibit 16.2.4-2. Create Session Dialog Box
4. In the Create Session dialog box, enter the desired "Name," "Subject," and "Message" for the session.

5. Make sure both the Create Shared Display Session and the Invite Selected Users checkboxes are
checked.

6. Click the Create button to initiate the Collaboration. A new tab will open with the desired "Session
Name" as the title on the tab and the CAVE window will be transformed into a Shared Display Session.

The Session Leader's screen should now look like that shown in Exhibit 16.2.4-3.

Exhibit 16.2.4-3. Session Leader's Collaboration Screen for a Shared Display Session

A Shared Display Session screen has the following features:

e The Main Display pane Map tab adds the "Session Name" in parentheses.
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e A colored border ONLY appears around the Session Leader's Main Display pane when the Session
Leader's display is being shared. Invitees will not have the colored border around their Main Display

pane.

Note 3: The colored border around the Main Display pane indicates control of the Shared Display
Session and control of the display that is being shared. Only the Session Leader has this control.
Absence of a colored border around the Session Leader's Main Display pane indicates the display
is not being shared.

e Clients (Participants) that have joined the Shared Display Session will have a new tab open on the
Collaboration Information pane, with the session name shown as the title on the tab.

e The Collaboration Information toolbar is modified to accommodate the tools needed for the Shared
Display Session. The drawing tools added are shown in Exhibit 16.2.4-4.

Exhibit 16.2.4-4. Shared Display Session Toolbar

The modified Collaboration Information toolbar for a Shared Display Session includes the following
nine tools; the first six are drawing tools.

e}

Draw: The Draw button looks like a pencil. When activated, the user is able to draw on the
display.

Undo: The Undo button removes the user's most recent drawing.
Redo: The Redo button restores the previous edit or drawing.

Clear: The red X clears all of the user's drawings from the display. The Clear button will not
clear other users' drawings.

Erase: The eraser allows the user to click and drag over his or her own drawings to erase
sections of the drawing. The Erase button will not erase other users' drawings.

Lock Collaborators: The Session Leader is the only person who can activate this button. It is
used to disable the drawing tools of all participants. When the button is activated, the iconified
drawing buttons will be grayed out to indicate they are disabled.

Float: The Float button detaches the Collaboration Information pane from the main window and
allows you to drag the pane to a different location, or to minimize/maximize the pane as desired.

Print Log: The Print Log button allows the user to print the text messages logged in the
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Conversation window.

o Search: The Search button allows the user to perform a word search within the Conversation
window.

Note 4: Each user will be assigned a different color, which will match up with the color of the
user's drawings. The assigned color can also be identified within the Participant's window.
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16.2.5 Other Session Leader Capabilities

Collaboration Display Sharing

In a Shared Display Session, the Session Leader is able to display and share data with all guests invited to
the session. All data types (OBs, Radar, Satellite, grib, etc.) may be shared within a session, including data
that may be foreign to other sites (e.g., local models and mesonets). A border (the same color as that around
the Session Leader's Main Display pane) appears around the Main Display pane of all participants sharing the
Session Leader's display.

Only the Session Leader can pan and zoom within the shared display. These actions are duplicated
simultaneously on the each participant's workstation in view-only mode.

Swapping Panes

The Session Leader may swap the shared Main Display pane with one of the side display panes. The display
pane swapped into the side pane maintains the colored border, indicating the display pane was previously
shared. The display pane swapped into the Main Display pane inherits a colored border to indicate the display
pane is now being shared. The map and data displayed in the Main Display pane on the Session Leader's
workstation is also displayed on the participant's workstation.

Warning Icon

As noted in Subsection 16.2.4, the absence of a colored border around the Session Leader's Main Display
pane indicates the displayed pane is not being shared. Such instances occur when the Session Leader has
multiple Map tabs open, indicating multiple maps are in editing mode, and one of the maps has been initially
opened on the Session Leader's Main Display pane, but he or she is not sharing the display. A white/blank
pane displays in the Main Display pane on the client workstations with the following statement, "The session
leader is not viewing a shared display." A Warning icon (triangle symbol) also appears on the Drawing
toolbar on all the Collaboration participants' workstations (Session Leader and clients), visually informing all
collaborators that the display is not being shared. Refer to Exhibit 16.2.5-1.
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Exhibit 16.2.5-1. Unshared Display (Participant's Screen)

For the Session Leader to share the display in the Map Editor, he or she must right click (Mouse Button 1) on
the Map tab and select from the pop-up menu, Shared with > "*Session Name™'. A border will then appear
around the Session Leader's Main Display pane, indicating the Map/data is being shared with all clients, and
the warning icon disappears from the Drawing toolbar.

Unsharing Displays

When the Session Leader determines that a shared display is no longer needed, he or she will right click
(Mouse Button 1) on the Map tab and select Unshare from the pop-up menu. The colored border will then
disappear from the Session Leader's display, and a gray screen will appear on all participants' screens with the
message that the Session Leader is no longer viewing a shared display. The Warning icon (triangle symbol)
reappears on the Drawing toolbar on all collaborators' screens as a visual cue that the active display is no
longer shared.
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16.3 AWIPS Statistics

AWIPS Statistics is an option under the CAVE menu. It is a component within CAVE that offers two main
functions: capturing system performance statistics; and analyzing system performance statistics. The captured
data is viewable via a graph or a .csv file.

This section introduces the AWIPS Statistics application and describes how to navigate through the dialogs
for data analysis. The following topics are discussed:

e Starting the AWIPS Statistics Application - Subsection 16.3.1

e Graphing Statistics - Subsection 16.3.2

e Statistics Graph Manipulation - Subsection 16.3.3

Page 564



CAVE-D2D User's Manual AWIPS |1 Operational Build 13.4.1 - 31 July 2013

16.3.1 Starting the AWIPS Statistics Application

The AWIPS Statistics application is accessed through the CAVE menu by selecting AWIPS Statistics.
Selecting this option opens the Statistics Display Control dialog box, shown in Exhibit 16.3.1-1.

Exhibit 16.3.1-1. Starting AWIPS Statistics - Statistics Display Control Dialog Box

The Statistics Display Control dialog box includes the following options for displaying event attributes on a
graph.

e Date/Time - Select Date/Time: Clicking the Select Date/Time button opens the Calendar dialog box,
shown in Exhibit 16.3.1-2. The Calendar dialog box allows you to select a date and hour from which
to display data.

Exhibit 16.3.1-2. Calendar Dialog Box
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Note 1: The calendar defaults to a date/time 24 hours in the past from the current time.

e Graph Range: Graphs can display data on a selected range value that extends from 1 hour up to 1
month, as selected through the Graph Range dropdown menu. There are two other options associated
with Graph Range — Start and Split (refer to Exhibit 16.3.1-3).

o Start: Selecting the Start radio button starts the graph at the selected Date/Time and extends the
selected range to the right.

o Split: Selecting the Split radio button splits the selected range into two equal parts, starting the
selected Date/Time in the center of the graph. Space to the left of the midpoint displays the range
prior to the the selected Date/Time; space to the right displays the range after the selected
Date/Time.

Exhibit 16.3.1-3. Start and Split Graph Range Options

e Graph Data: Use this to select the specific data to display on a graph. Select entries from the
following groups:

o Category: Data Ingest Events is the only Category option available.
o Event Type: Processing Events is the only Event Type option available.

o Event Attribute: There are two options for Event Attribute: Processing Time and Processing
Latency. Both options are displayed on the graph's "Y" axis. The selected Event Attribute is also
displayed as the graph's title. For example, Exhibit 16.3.1-3 indicates that Processing Time is the
selected Event Attribute.

Note 2: Processing Time (default) is the time it takes to decode the data. Processing
Latency is the time the file sits in the queue before being processed.

e Groups: Select one or more groups listed in the Available Groups column and move the selected
group(s) into the Selected Groups column. Once the Selected Groups column is populated, the Display
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button becomes active.
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16.3.2 Graphing Statistics

Once the graph event and attributes have been configured in the Statistics Display Control dialog box,
clicking the Display button displays the graph based on these selections. The graph is displayed within the
Processing Events window. Exhibit 16.3.2-1 is an example of a Start - Processing Latency graph; Exhibit
15.3.2-2 is an example of a Split - Processing Time graph.

Exhibit 16.3.2-1. Processing Events Window - Example of a Start Range with Processing Latency Event
Attribute
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Exhibit 16.3.2-2. Processing Events Window - Example of a Split Range with Processing Time Event Attribute
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16.3.3 Statistics Graph Manipulation

There are several ways to display alternate data on the graph within the Processing Events window. You can
display the event attributes as an Average, Minimum, Maximum, Sum, or Count by selecting an option from
the Graph dropdown list box at the lower left corner of the Processing Events window, as shown in Exhibit

16.3.3-1.

Exhibit 16.3.3-1. Options Available from the Graph Dropdown List Box

The arrow buttons below the graph (refer to Exhibit 16.3.2-2) will move the chart one half or one whole
period, where the period is determined by the Graph Range value set in the Statistics Display Control dialog
box.

The graph can be further manipulated by displaying or removing grid lines and/or data lines. To access this
function, select the Graph menu and check or uncheck the appropriate checkboxes, as shown in Exhibit
16.3.3-2. Unchecking both checkboxes will remove the grid lines and data lines, leaving only the data points
on the graph.

Exhibit 16.3.3-2. Graph Dropdown Menu with Grid Lines and Data Lines Displayed

The color-coded data types are listed in the Groups panel on the right side of the Processing Events window,
as shown in Exhibit 16.3.3-3. The data types, represented by the data points on the graph, can also be
displayed or removed by checking or unchecking the checkbox adjacent to the data type.
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Exhibit 16.3.3-3. Groups Panel Listing Color-coded Data Types

Note 3: There are many more data type checkboxes checked in Exhibit 18.3.3-3 than data points
displayed on the graph. This indicates either that the data for those data types has not been ingested or
that the data has been ingested but is not yet decoded. The 12 hr graph range of Exhibit 16.3.2-2 shows

many more data types displayed on the graph.

The data types can also be checked or unchecked from the Selection Manager dialog box shown in Exhibit
16.3.3-4. This dialog box is opened by clicking on the Selection Manager button at the bottom of the Groups

panel.
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Exhibit 16.3.3-4. Selection Manager Dialog Box

The Selection Manager dialog box enables you to organize the data types into a specific group and then either
contract the list or expand it to reveal all items within the group. This is a convenient way to select all, select
none, or select individual items to display on the graph. Clicking the Apply button will apply the selections
to the graph. Clicking the OK button will apply the selections to the graph while closing the Selection
Manager dialog box. The Cancel button simply closes the Selection Manager window without applying any
modifications made.

To save all graphs displayed in the Processing Events window, select the Save option under the File menu, as
shown in Exhibit 16.3.3-5. A dialog will appear, allowing you to enter a "Name" for the saved file and to
select the "Location" for the file to be saved. Then clicking the OK button will save the file to the selected
location.

Exhibit 16.3.3-5. Processing Events Window File Dropdown Menu Options

The Processing Events window can be closed by clicking on the "Close" iconified button (X) at the top right
corner of the window, or by selecting the Quit option under the File menu, as shown in Exhibit 16.3.3-5, or
by using the keyboard shortcut Ctrl + Q.
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16.4 GIS Data

The Geographic Information System (GIS) application enables users to import geospatial data from varying
GIS data sources for display in CAVE. CAVE currently only supports shape data in WGS84 unprojected
latitude/longitude.

This section describes how to start the GIS application, configure the display attributes, and navigate through
the various dialogs for importing map/map product shapefiles for display within CAVE. The following topics
are discussed:

e Starting the GIS Application and Displaying a GIS Data Image - Subsection 16.4.1

Setting the Attribute Values for Displaying GIS Data from within CAVE - Subsection 16.4.2

Customizing and Using the GIS Application's Attributes Dialog Box - Subsection 16.4.3

Displaying a Sample of GIS Data Attribute Values on the Main Display Pane - Subsection 16.4.4

GIS Data and Display Customization from within the GIS Application - Subsection 16.4.5
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16.4.1 Starting the GIS Application and Displaying a GIS Data Image

The GIS application is accessed through the CAVE menu by first selecting the Import option, and then
choosing GIS Data from the Import submenu. The GIS DataStore Parameters dialog box, shown in Exhibit

16.4.1-1, opens.

Exhibit 16.4.1-1. Starting the GIS Application - GIS DataStore Parameters Dialog Box

The GIS DataStore Parameters dialog box is comprised of four sections. The process for browsing for a
particular directory and selecting a Map shapefile is illustrated in Exhibit 16.4.1-2.
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Exhibit 16.4.1-2. Process for Locating Connection Parameters and Selecting Available Map Shapefile
Descriptions of the the four sections follow.
e DataStore Type: This section contains a data field where you select a file type from the dropdown list.

e Connection Parameters: This section contains a Directory data field where you can either select from
a dropdown list or browse to a directory containing a set of map shapefiles. Clicking the Browse button
opens the directory navigating/browser dialog box, which allows you to navigate easily to the desired
directory. After locating the desired directory, clicking the Connect button lists the available
shapefiles.

e Load As: In this section the shapefiles can be loaded as a Map or as a Product. Descriptions of both
follow.

o Map: When this radio button is selected, the selected shapefile (refer to Exhibit 16.4.1-2)
displays as a map in the Main Display Pane, as shown in Exhibit 16.4.1-3. Click and hold B3 on
the Main Display Pane to open a pop-up menu and select Show Map Legend to display the Map
ID in the Legend area at the bottom of the display (see Exhibit 16.4.1-3).
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Exhibit 16.4.1-3. GIS Data Displayed as a Map and Displaying Map ID in Legend

Note 1: The map displayed in Exhibit 16.4.1-3 shows the GIS data displayed as contoured
boundaries.

o Product: When this radio button is selected, the start and end date/time data fields become
enabled. You can select a start and end date/time from the Calendar dialog box shown in
Exhibit 16.4.1-4. Clicking on the Calendar icon opens the Calendar dialog.
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Exhibit 16.4.1-4. GIS DataStore Parameters Dialog Box with Calendar Open

Loading a shapefile with the Product radio button selected will return a shaded (color-filled)
image of the Map Product in the Main Display Pane, as shown in Exhibit 16.4.1-5. The

Product ID will appear in the Legend area at the bottom of the display after selecting Show
Product Legend from the B3 pop-up menu.

Exhibit 16.4.1-5. GIS Data Displayed as a Map Product Image

In Exhibit 16.4.1-6 GIS data is displayed as a Product overlaid on top of model data. The map
product displays with the model data when the valid time of the model data falls within the
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start/end time range selected for the map product in the GIS DataStore Parameters dialog box.
When the valid time of the model data falls outside the start/end time of the map product, the
map product image does not display, as shown in Exhibit 16.4.1-7.

Exhibit 16.4.1-6. GIS Data Map Product Image with Model Data Within Valid Time Range

Exhibit 16.4.1-7. GIS Data Map Product Image with Model Data Outside Valid Time Range

e Table: In this section you can select one of the shapefiles listed in the window for display (refer to
Exhibit 16.4.1-2). Click mouse Button 1 (B1) on the selected file name. The selected file will be
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highlighted and the OK button at the bottom of the dialog box will be enabled. Clicking the OK button
closes the GIS DataStore Parameters dialog box and displays the selected map or map product image
in the Main Display Pane.
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16.4.2 Setting the Attribute Values for Displayed GIS Data from within CAVE

Certain GIS display attributes can be modified in CAVE, without having the GIS application open, via the
Preferences dialog box. Access the GIS Viewer via CAVE > Preferences > GIS Viewer, as shown in
Exhibit 16.4.2-1.

Exhibit 16.4.2-1. Accessing the Preferences Dialog Box - GIS Viewer

Note: Exhibit 16.4.2-1 shows the default values for these four attributes.

The attributes that can be modified within CAVE apply to the map/map product image displayed on the Main
Display Pane. They are: color of the highlights; highlight line style; highlight line width; and map product
opacity. The button next to the name of the attribute displays a swatch of the current value. Selecting this
button opens a dialog for modifying that attribute and redefining the default value, as shown in Exhibit
16.4.2-2.
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Exhibit 16.4.2-2. Modifying GIS Viewer Preferences

A description of each attribute follows.

Highlight Color: This button opens a dialog box that includes a color wheel and a color palette.
Clicking the OK button after changing the color sets the new color for the highlight that appears
around a selected area (via the Attributes dialog), and closes the dialog box. The new color is then
displayed on the swatch.

Highlight Style: This button opens a menu displaying a set of lines of differing styles. Double-clicking
on the desired line style sets the new style for the highlight that appears around a selected area (via the
Attributes dialog), and closes the menu. The new line style is then displayed on the swatch.

Highlight Width: This button opens a menu displaying a set of lines of differing widths. Double-
clicking on the desired line width sets the new width for the highlight that appears around a selected
area (via the Attributes dialog), and closes the menu. The new line width is then displayed on the
swatch.

e Product Opacity: This button opens the Set Opacity dialog box for setting the default opacity level

for GIS map product images. The dialog includes a swatch and a slider. Moving the slider increases or
decreases the opacity level. Clicking the OK button sets the default level and closes the dialog box.

Beneath the four attributes are two buttons: Restore Defaults on the left and Apply on the right. The
function of the Restore Defaults button is to restore "all" the attributes to their initial (default) values. Click
this button only if you want to restore all attributes to their default values. [Caution: If you accidentally click
the Restore Defaults button, you will need to return to the attribute dialog box(es) and redefine your desired

values.]

Use the Apply button to save any changes you make to the default attribute settings. Wait until you are
satisfied with all the values you have set, and then click the Apply button once to save all the changes. The
values you set here for the attributes will then be applied to the GIS application as the new defaults.
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16.4.3 Customizing and Using the GIS Application's Attribute Dialog Box

You have the ability to highlight specific areas of the displayed map or map product image, and to hide other
areas. These functionalities are executed through the Attributes dialog box, commonly referred to as the
"Attributes Table" because of its tabular style. To access the Attributes dialog box, click and hold mouse
Button 3 (B3) on the Map ID in the Legend area to open the pop-up menu shown in Exhibit 16.4.3-1. From
the pop-up menu select the Display Attributes option to open the Attributes dialog box.

Exhibit 16.4.3-1. Pop-up Menu to Open the Attributes Dialog Box (Attributes Table)

The Attributes dialog box includes two menus, Annotation and Data, which allow you to control
highlighting and visibility for both the displayed images and the information contained in the Attributes
dialog box. For each row of information on the Attributes dialog box there is an associated map/map product
image displayed on the Main Display Pane.

e Highlighting

o Highlighting Selected Areas: To place a highlight around a selected area of the GIS display
image and highlight the corresponding row on the Attributes dialog box, click and hold B3 on
the row you want to select. This opens the pop-up menu shown in Exhibit 16.4.3-2. Check the
Highlighted checkbox in the pop-up menu to activate highlighting. Multiple rows can be
selected using Ctrl + B1 to select each row, which will highlight the selected row in blue. Then
click and hold B3 on one of the selected rows; this will turn all selected blue rows dark gray
(refer to Exhibit 16.4.3-2) and open the pop-up menu. After checking the Highlighted checkbox
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all selected rows will be highlighted yellow and a highlighted border surrounding all the areas on

the map corresponding to those selected rows will be highlighted with the color setup in the
Preferences dialog box.

Exhibit 16.4.3-2. Attributes Dialog Box for Visibility Control

Note 1: The highlight bordering the corresponding areas on the Main Display Pane shown
in Exhibit 16.4.3-2 is purple, which is the color set up in the Preferences dialog box within
CAVE. The highlighted rows of the Attributes dialog box corresponding to those areas will
always be yellow.

o Unhighlighting Selected Areas: To unhighlight selected rows and associated highlighted
borders around the areas of the image, click and hold B3 on the row or select multiple rows via
Ctrl + B1 and then click and hold B3 to open the pop-up menu and uncheck the Highlighted
checkbox.

o Unhighlighting All Areas: To remove all highlighted borders around the areas of the image and
remove all yellow highlighted rows on the Attributes dialog box, select the Clear Highlights
option under the Annotation menu.
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Note 2: If you are interested in a particular area but don't know the Feature ID, which is
listed in the Attributes dialog box, double-click on the area of interest on the image in the
Main Display Pane and the corresponding row will be highlighted. Conversely, double-
clicking on a particular row will place a highlighted border around the corresponding area
on the image.

e Controlling Visibility of Image Areas

o Hiding Selected Areas: To hide an area of the image displayed on the Main Display Pane,
simply click and hold B3 on the row in the Attributes dialog box corresponding to the area of
interest. This will open a pop-up menu where you will uncheck the Visible checkbox to
deactivate visibility for the selected area. If you want to hide multiple areas of the image,
preselect the rows using Ctrl + B1 to highlight in blue the multiple selections; then click and
hold B3 on one of the rows to open the pop-up menu. The deactivation of visibility will affect all
areas corresponding to the selected rows. The areas of the image will disappear from the display
and the selected row(s) on the Attributes dialog box will be shaded light gray (refer to Exhibit
16.4.3-2).

o Unhiding Selected Areas: To return the hidden area(s) of the image to their original visible
state, click and hold B3 on the corresponding gray-highlighted row to open the pop-up menu. On
the pop-up menu, check the Visible checkbox. To return multiple areas to their original visual
state, use Ctrl + B1 to select all corresponding gray-highlighted rows; and then click and hold
B3 on one of the rows to open the pop-up menu. Checking the Visible checkbox will affect all
the selected rows and corresponding areas of the image. The previously gray highlighted rows
will return to their orginal nonhighlighted state.

o Unhiding All Areas: The Make All Visible option under the Annotation menu enables you to
return "all" hidden areas to their original visible state. All gray highlighted rows on the
Attributes dialog box will be returned to their original nonhighlighted state.

e Configuring Attributes Table

In the Attributes dialog box ("Attributes Table"), the options under the Data menu allow you to
customize the table based on which columns to display and how the table is to be sorted.

o Selecting Columns to Display: To select which columns to display, select Data > Select
Columns... to open the Select Columns dialog box shown in Exhibit 16.4.3-3.
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Exhibit 16.4.3-3. Accessing the Select Columns Dialog Box

Note 3: By default, all available columns are displayed.

Within the Select Columns dialog box, you can select the column(s) you don't want displayed by
first selecting the individual item(s) and then using the single arrow button to move the item(s)
from the Displayed window to the Available window. Clicking the OK button saves the change
and removes the columns from the Attributes dialog box. Use the double arrow button to move
all the items listed in the Displayed window to the Available window.

o Sorting Column Information: Selecting the Sort option opens the Sort Order dialog box
shown in Exhibit 16.4.3-4.

Exhibit 16.4.3-4. Accessing the Sort Order Dialog Box
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Note 4: By default, all displayed columns are sorted in ascending order.

Within the Sort Order dialog box, you can select a column from the dropdown list of displayed
columns and select how you want the information in that column sorted. The other columns will
adjust accordingly. Clicking the OK button (hidden in the Exhibit under the dropdown list)
closes the Sort Order dialog box and saves the change according to your selection. Clicking the
Cancel button closes the dialog box without making any changes to the Attributes Table.
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16.4.4 Displaying a Sample of GIS Data Attribute Values on the Main Display Pane

Note: This feature is only available for a Map Product image. You cannot sample GIS data displayed
as a Map.

You can view a sample of a selected GIS data attribute directly on the Main Display Pane, as shown in
Exhibit 16.4.4-1, without having to open the Attributes dialog box.

To open the Select Sample Attribute submenu, click and hold B3 on the Map Product ID in the Legend
area to open a pop-up menu and select the Select Sample Attribute option. On the Select Sample Attribute
submenu select the value you want displayed and then click the OK button. Click and hold B3 anywhere on
the Main Display Pane to open a pop-up menu and check the Sample checkbox to activate the sampling
functionality. Then, hovering your cursor over any area of the Map Product image will display the sample for
the selected attribute.

Exhibit 16.4.4-1. Example of the Sampling Functionality
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16.4.5 GIS Data and Display Customization from within the GIS Application

Once the GIS data is displayed, there are several ways to customize the displayed data from within the GIS
application. All customizations originate by selecting from the pop-up menu shown in Exhibit 16.4.5-1. To
open the pop-up menu, click and hold mouse Button B3 (B3) on the GIS displayed image or on the
Map/Map Product ID in the Legend area and move the cursor to the option you want to modify.

Exhibit 16.4.5-1. Pop-up Menu for GIS Data and Display Customization

Note 1: Numbers on Exhibit 16.4.5-1 reference the descriptions that follow.

A description of each customization follows.

1. Change Color: This option opens the Color Selection submenu shown in Exhibit 16.4.5-2, which
allows you to modify the color of the area borders for the map or the shading for the map product

image, and map labels.

Exhibit 16.4.5-2. Color Selection Submenu

You can select one of the set colors in the Color Selection submenu, or select the Choose Color option
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to open a dialog box containing a color wheel and color palette (refer to Exhibit 16.4.2-2). The
selected color will also change the Map/Map Product ID in the Legend to the same color as the map
labels, as shown in Exhibit 16.4.5-3. Once you select a color, the color is applied to the display and the
submenu closes automatically after selection.

Exhibit 16.4.5-3. Results from Selecting a Color from the Color Selection Submenu

2. Rename: This option opens the Rename dialog box shown in Exhibit 16.4.5-4, which allows you to
change the Map/Map Product ID name in Legend. Enter the new name into the Enter new name text
field and click the OK button to update the ID name in the Legend. Clicking the Cancel button will

restore the initial (or last saved) name.

Exhibit 16.4.5-4. Changing Map/Map Product ID in Legend Using Rename Dialog Box

3. Crop Shape: This option enables you to crop those areas of the display that you only want to view, and
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remove all other areas from view. After selecting this option, a Drag to select message appears
adjacent to the cursor. Click and hold B1 at the corner of your area of interest and drag on the map to
create a green square across the desired area. Once you release the mouse button, the map updates to
display the areas encompassed by the green square. Notice that areas partially encompassed by the
green square will continue to display. Only areas completely outside the green square will be removed,
as shown in Exhibit 16.4.5-5.

Exhibit 16.4.5-5. Cropping the Displayed Image

Note 2: As of the release of this edition of the Manual, the Crop Shape function was still being
enhanced. The following two functionalities will be available in a future release: (1) Once you
crop an area, the rows on the Attributes dialog corresponding to the cropped out area will no
longer be listed on the table; and (2) when sampling a cropped image, the sampled values will
only be returned for data displayed on the Main Display Pane.

4. Line Style: This option opens the Line Style submenu shown in Exhibit 16.4.5-6, which allows you to
change the line style of the borders surrounding each area. A single-click on your choice changes the
line style and closes the submenu.

Exhibit 16.4.5-6. Line Style Submenu

5. Line Width: This option opens the Line Width submenu shown in Exhibit 16.4.5-7, which allows
you to change the line width of the borders surrounding each area. A single-click on your choice
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changes the line width and closes the submenu.

Exhibit 16.4.5-7. Line Width Submenu

6. Label: This option opens the Labels submenu shown in Exhibit 16.4.5-8. The Labels submenu lists
all the labels available. Select the desired label by clicking the radio button (as shown for
"FIRE_NAME"). Once a label is selected via the radio button, the label will appear within the Main
Display Pane (refer to Exhibit 16.4.5-3). Once you select a label, the label is applied to the display and
the submenu closes automatically after selection.

Exhibit 16.4.5-8. Labels Submenu

7. Label Offset: This option opens the Map Label Offset dialog box shown in Exhibit 16.4.5-9, which
allows you to change the label position on the display. The default is X=0 and Y=0. To change the X
and Y values, click the up or down arrows, or manually type a value into the X and Y text fields. The
label shown on the display repositions automatically with each increment or change in the X or Y
value. Clicking the OK button closes the dialog box. Clicking the Cancel button closes the dialog box,
returning the label to its last updated X and Y position.

Exhibit 16.4.5-9. Map Label Offset Dialog Box with Default Values

8. Shade: This option opens the Shade submenu shown in Exhibit 16.4.5-10, which, as you can see, is
almost identical to the Label submenu. However, the Shade submenu is for Map Products, since it
includes the Set Opacity (XX%b) value at the bottom of the submenu. When GIS data is displayed as a
product, you have the option to change the opacity value of the displayed map product image. The
default opacity, which was set via the Preferences dialog box, is listed at the bottom of the Shade

submenu.
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Exhibit 16.4.5-10. Shade Submenu for Map Product Image with Default Opacity Value Shown

Clicking the Set Opacity (XX%0) option at the bottom of the Shade submenu opens the Set Opacity
dialog box shown in Exhibit 16.4.5-11. Use the Set Opacity dialog box to change the desired opacity
percentage. The actual opacity percentage on your screen will match the default opacity set in the
Preferences dialog box within CAVE.

Exhibit 16.4.5-11. Set Opacity Dialog Box with Default Setting Shown

You can increase or decrease the opacity value using the slider and watching the corresponding shading
of the GIS map product change in the Main Display Pane. Clicking the OK button will close the
submenu and set the opacity value with the new value shown at the bottom of the Shade submenu.
Clicking the Cancel button will close the submenu and revert the opacity value to its initial setting
(default or last saved value).

9. Magnification: This option opens the Magnification submenu shown in Exhibit 16.4.5-12, which
allows you to change the size of the labels displayed in the Main Display Pane. You can choose one of
the seven preset magnifications, which will update as soon as the radio button is selected, allowing you
to determine which magnification level is best. Once you select a magnification, the magnification
setting is applied to the display and the submenu closes automatically after selection.

Exhibit 16.4.5-12. Magnification Submenu

10. Density: This option opens the Density submenu shown in Exhibit 16.4.5-13.
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Note 10: The Density option does not appear on the pop-up menu until after you have selected a
label from the Labels submenu. Once a label is activated, you can select the Density option.

Exhibit 16.4.5-13. Density Submenu

How Density Works: The density values listed on the Density submenu change the number of labels
displayed in D2D. For example, in Exhibit 16.4.5-8, the "Fire-Name" label was selected. If your
display area contains 100 Fire Names, and you have selected a density of "1," it may be that about 45
of the 100 Fire Names will display in D2D. If you change the density to "0.5," it is likely that only
about half of those 45 Fire Names will be displayed. If you change the density to "2," about 90 of the
100 Fire Names will be displayed. The "Max" option will display all the Fire Names, and "0" will
display no Fire Names.

Once you select a density, the density setting is applied to the display and the submenu closes
automatically after selection.
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Appendix A. Glossary

Aviation Weather Center (AWC) - One of NOAA's National Centers for Environmental Prediction. AWC
provides aviation warnings and forecasts of hazardous flight conditions at all levels within domestic and
international air space.

AWIPS - Advanced Weather Interactive Processing System.

AWIPS Statistics - An option under the CAVE menu for capturing, graphically displaying, and analyzing
system performance statistics.

Button - A button on a mouse pointing device; Mouse buttons can be mapped to the keyboard. Also, a
graphical component on a window frame or in a dialog box that works by pressing it.

Cascading Menu - A submenu of related menu options that is invoked when a menu item is selected from a
parent menu. Usually, a cascading menu is designated by an arrow to the right of the menu item.

CAVE - Common AWIPS Visualization Environment.

Collaborative Convective Forecast Product (CCFP) - A strategic forecast of convection to guide traffic
managers in their system-wide approach to managing traffic.

Click - To quickly press and release the left mouse button. The term comes from the fact that pressing and
releasing most Mouse buttons makes a clicking sound.

Close - A label given to a Push button in some dialog boxes that performs the action of closing the dialog
box. Close is also used as a selection in Menus to close the window associated with the Menu.

Coordinated Universal Time (UTC) - The primary time standard by which the world regulates clocks and
time. It is the successor of Greenwich Mean Time (GMT).

COTS - Commercial off-the-shelf.

Cursor - A graphical image, usually a pipe (|) or block, that shows the location where text appears on the
screen when keys on the keyboard are pressed or where a selection can be made.

D2D - Display 2 Dimensions.

Depictable - A method to retrieve data and display it using AWIPS and the D2D.

Desktop - See "Workspace."

Dialog Box - A secondary window that the user can display. It contains application components.
Dimmed Selection - A selection that is not currently available.

Double-Click - To press and release a mouse button twice in rapid succession.
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Extension - A depictable that allows user interaction with the D2D displays.

Focus - A state of the system that indicates which component receives keyboard events. A component is said
to have the focus if keyboard events are sent to that component.

Geographic Information Systems (GIS) - An application that accepts many of the National Weather
Service data set formats, including downloadable shapefiles, web services, and even KML files.

Help - A label given to a Push button in some dialog boxes that performs the action of providing help for the
dialog box.

Highlight - A graphic technique used to provide a visual cue to the current selection or to the current location
of the input focus. Highlighting is frequently accomplished by reversing the video of the selection.

Icon - A small graphical image used to represent a window. Windows can be turned into icons or minimized
to save room or unclutter the workspace (see "Workspace").

Insertion Cursor - The graphical symbol that provides the visual cue to the location of the insertion point.
Isobar - A line of equal or constant pressure on a graph, plot, or map.
K Desktop Environment (KDE) - A GUI primarily for Unix and Linux machines.

Keyboard - An input device consisting of various keys that allows the user to input data, control cursor and
pointer locations, and control the dialog with the workstation.

Keyboard Focus - Indicates the window or component within a window that receives keyboard input. It is
sometimes called the "Input Focus."

Keyhole Markup Language (KML) - The KML file, when compressed forms a KMZ file that can be used
in applications such as Google Earth. It is used by a variety of GIS and mapping applications.

KMZ - File format when KML is zipped (compressed). Used in applications such as Google Earth.
Label - The text part of an icon or graphical component.

Legend - A line at the lower right corner of a graphical display window that notes the product ID and valid
time. One legend is included for an image or combined image and one for each graphic overlay. The color of
the latter matches that of the graphic.

Left-click - To quickly press and release the left button (Button 1 as defined in Subsection 2.1.1) on the
mouse. (See also Middle-click and Right-click.)

Location Cursor - A graphical symbol that marks the current location of the keyboard input focus for
selection. Typically, this symbol is a box that surrounds the current object.

Maximize - To enlarge a window to its maximum size.
Menu - A list of available selections from which a user may choose.

Message Box - The generic name for any dialog box that provides information, gives the current state of a
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work in progress, asks a question, issues a warning, or draws attention to an error.

Middle-click - To quickly press and release the middle button or clickable scroll wheel (Button 2 as defined
in Subsection 2.1.1) on the mouse. (See also Left-click and Right-click.)

Minimize (Iconify) - To turn a window into an icon.

Mouse - A pointing device commonly used in conjunction with a keyboard in point-and-click object-oriented
user interfaces.

Mouse Button - A button on a mouse pointing device. Mouse buttons can be pressed, released, moved,
clicked, and double-clicked.

Mouse Button 2 (or B2) - The center button on a three-button mouse or the scroll wheel on a two-button
mouse with a clickable scroll wheel.

National Polar-orbiting Partnership (NPP) - NPP, more precisely named Suomi NPP, is a polar-orbiting
environmental NASA satellite that orbits the Earth every 102 minutes, capturing data from the Earth's land,
oceans, and atmosphere. Formerly known as the National Polar-orbiting Environmental Satellite System
(NPOESS) Preparatory Project, the satellite was renamed Suomi NPP in January 2012, after Verner E.
Suomi, a meteorologist at the University of Wisconsin.

Open - To start an action or begin working with a text, data, or graphics file.

Pointer - The graphical image that appears on the workspace and represents the current location of a mouse
or other pointing device. Also referred to as "Mouse Pointer."

Pointing Device - A device such as a mouse, trackball, or graphics tablet that allows users to move a pointer
about on the workspace and point to graphical objects.

Pop-up Menu - A menu that provides no visual cue to its presence, but simply pops up when a user performs
a particular action. Pop-up menus are associated with a particular area of the workspace, such as the client
area of an application, and a user must memorize where these areas are.

Press - To hold down a mouse button or a key.
Pull-Down Menu - A menu that extends downward from a client application's Title Bar.

Push Button - A graphic component that simulates a real-life push button. When a user pushes the Push
button, by pressing a key or a Mouse button, an action takes place.

Radio Button - A graphic component that simulates the buttons on a real-life car radio. Each button
represents a mutually exclusive selection. Radio buttons are typically used for setting states or modes.

Release - To let up on a Mouse button or key that has been pressed. Sometimes it is the press that initiates the
action; sometimes it is the release.

Resize - To change the height or width of a window.

Restore - To return an icon or maximized window to its normal size.

Page 596



CAVE-D2D User's Manual AWIPS |1 Operational Build 13.4.1 - 31 July 2013

Right-click - To quickly press and release the right button (Button 2 as defined in Subsection 2.1.1) on the
mouse. (See also Left-click and Middle-click.)

Save - To write changes to a data file to a storage device for safekeeping.

Scroll Bar - A graphical device used to change a user's view of the contents of a window. A scroll bar
consists of a slider, a trough, and scroll arrows. A user changes the view by sliding the slider up or down in
the scroll area or by pressing one of the scroll arrows. These actions cause the view to scroll up or down in
the window adjacent to the scroll bar.

Secondary Window - A child window of a primary window.
Select - To choose an object to be acted upon or an action to be performed.

Selection - The object or action that is selected. Menus are composed of selection items. Dialog boxes
contain components, each of which represents a selection.

Shapefile - A geospatial vector data format for geographic information systems software. Shapefiles spatially
describe points, lines and polygons.

Single Selection - A selection model that allows selection of a single element.

Slider - One of the graphical components of a scroll bar or scale. The slider is the object that is dragged along
the scroll area to cause a change.

Submenu - A "cascading menu."
Suomi NPP - See "National Polar-orbiting Partnership (NPP)."
System Menu - See "Window Menu."

Tear-off Menu - A menu that can be undocked from the location on the screen where it first opened, and
manually moved around the workstation screen.

Text Cursor - See "Insertion Cursor."

Thin Client - The Thin Client component enables Incident Meteorologists to access baseline AWIPS
capabilities on laptops in remote locations for gathering and analyzing localized weather information.
Available in Windows and Linux versions.

Title Area - The area at the top of the window frame immediately beneath the resize border. The Title Area
has two functions: it contains a title or name that identifies the window, and it can be grabbed and dragged to
relocate the window.

Title Bar - The bar across the top of a window manager window that consists of the Window menu button,
the Title Bar, and the Window-Control buttons.

Window - A data structure that represents all or part of the display screen. Visually, a window is represented
as a sub-area of the display screen.

Window Frame - The area surrounding a window. A window frame can consist of a resize border, the
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Window menu button, the Title Bar, and the Window-Control buttons.

Window Menu - The menu that appears when the Window menu button is pressed. The Window Menu
typically contains selections for restoring, moving, sizing, minimizing, maximizing, and closing the window.

Window Menu Button - The Graphical Control button that appears at the left side of the Title Bar in the
window frame.

Workspace - The LCD -- the area on which the windows of a user's environment appear. The workspace is
sometimes called the desk, desktop, or root window.
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Appendix B. AWIPS Acronyms and Abbreviations

0-9
2D - Two Dimensions or 2 Dimensions

A

ACT - Attribute Color Threshold

ADA - Urgent Administrative Message

ADM - Routine Administrative Message

AEV - AFOS-Era Verification

AFOS - Automation of Field Operations and Services
AGL - above ground level

Al - AWIPS Identifier

AMSU - Advanced Microwave Sounding Unit
ARD - AWIPS Remote Display

ASL - Above Sea Level

ASOS - Automated Surface Observing System
ASR - Airport Surveillance Radar

ATMS - Advanced Technology Microwave Sounder
AvnFPS - Aviation Forecast Preparation System
AVP - AWIPS Verification Program

AWC - Aviation Weather Center

AWIPS - Advanced Weather Interactive Processing System

B

B1 - mouse Button 1
B2 - mouse Button 2
B3 - mouse Button 3
BGAN - Broadboand Global Area Network
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BUFR - Binary Universal Form for the Representation of meteorological data

C

CAPE - Convective Available Potential Energy
CAVE - Common AWIPS Visualization Environment
CC - Correlation Coefficient

CCF - Coded Cities Forecast

CCFP - Collaborative Convective Forecast Product
CCL - Convective Condensation Level

CDP - Cell Display Parameters
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CFC - Clutter Filter Control

CGI - Common Gateway Interface

CIN - Convective Inhibition

CITR - Commerce Information Technology Requirement
CONUS - Conterminous/Contiguous/Continental United States
COOQOP - Continuity Of Operations Planning

COTS - commercial off-the-shelf

CPU - central processing unit

CRS - Console Replacement System

CRT - cathode ray tube

CrIMSS - Cross-track Infrared and Microwave Sounder Suite
CrIS - Cross-track Infrared Sounder

CSU - computer software unit

CSV - comma-separated value

CWA - County Warning Area

CWSU - Center Weather Service Unit

CZ - Composite Reflectivity

D

D2D - Display 2 Dimensions
DAT - digital audio tape

DB - database

DCP - Data Collection Platform
DEEF - Default

DFM - Digital Forecast Matrix
DMD - Digital Mesocyclone Display
DMS - Data Monitoring System
DOC - Department of Commerce
DPA - Digital Precipitation Array
DS - Data Server

E

ECMWEF - European Centre for Medium-Range Forecasts
EDEX - Enterprise Data EXchange

EMC - Environmental Modeling Center

EL - Equilibrium Level

ESA - Electronic Systems Analyst

ESRL - Earth System Research Laboratory

ETA - estimated time of arrival

F

FFG - Flash Flood Guidance

FFFG - Forced Flash Flood Guidance

FFMP - Flash Flood Monitoring and Prediction

FFMPA - Flash Flood Monitoring and Prediction: Advanced
FFTI - Flash Flood Threat Index

Page 600



CAVE-D2D User's Manual

FFW - Flash Flood Warning

FM - Functional Manager

FSL - Forecast Systems Laboratory
FTP - File Transfer Protocol

G

GE - GOES East

GFE - Graphical Forecast Editor

GFS - Global Forecasting Systems

GHG - Graphical Hazards Generator

GIS - Geographic Information Systems

GMT - Greenwich Mean Time

GOES - Geostationary Operational Environmental Satellite
GSD - Global System Division

GUI - Graphical User Interface

GW - GOES West

H

HC - Hydrometeor Classification

HI - Hail Index

HM - Hydromet

HP - Hewlett-Packard

HPC - Hydrologic Precipitation Center
HSB - Hue, Saturation, and Brightness
HWR - Hourly Weather Roundup

ICAO - International Civil Aviation Organization

IFP - Interactive Forecast Program

IFPS - Interactive Forecast Preparation System

IHFS - Integrated Hydrologic Forecast System

IMET - Incident Meteorologist

IP - Internet Protocol

IR - infrared

ISS - Incident Support Specialist IST - Interactive Skew-T

J
JMS - Java Messaging System
K

KDE - K Desktop Environment
KDP - Specific Differential Phase
KML - Keyhole Markup Language
KMZ - KML zipped (compressed).
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L

LAC - Listening Area Code

LAMP - Localized Aviation MOS Program
LAN - Local Area Network

LAPS - Local Analysis and Prediction System
LARC - Local Automatic Remote Collector
Lat - Latitude

LCL - Lifting Condensation Level

LDAD - Local Data Acquisition and Dissemination
LFC - Level of Free Convection

Lon or Long - Longitude

LSR - Local Storm Report

M

MAPS - Mesoscale Analysis and Prediction System
mb - millibar; pressure

MDCRS - Meteorological Data Collection and Receiving System
MDL - Meteorological Development Laboratory
MDP - Mesocyclone Display Parameters

MDPI - Microburst-Day Potential Index

MEF - Manually Entered Forecast

METAR - Meteorological Aviation Report

MHS - message handling system

ML - Melting Layer

MND - Mass News Dissemination

MOS - Model Output Statistics

MPC - Marine Prediction Center

MPE - Multisensor Precipitation Estimator

MRD - Message Reference Descriptor

MRU - Meso Rapid Update

MSAS - MAPS Surface Assimilation System

MSL - Mean Sea Level

N

NA - not applicable; North American

NAM - North American Mesoscale model

NCEP - National Centers for Environmental Prediction
NCF - Network Control Facility

NDEFD - National Digital Forecast Database

NE-PAC - Northeastern Pacific
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NESDIS - National Environmental Satellite, Data and Information Service

NH - Northern Hemisphere

nMi - nautical miles

NOAA - National Oceanic and Atmospheric Administration
NPN - NOAA Profiler Network

NPP - Suomi National Polar-orbiting Partnership
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NUCAPS - NOAA Unique CrIS/ATMS Processing Systems

NWP - Numerical Weather Prediction
NWR - NOAA Weather Radio
NWS - National Weather Service
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NWRWAVES - NOAA Weather Radio With All-Hazards VTEC Enhanced Software

NWSREFS - National Weather Service River Forecast System

NWWS - NOAA Weather Wire Service
@]

OCP - Ocean Prediction Center

OH - Office of Hydrology

OPC - Ocean Prediction Center

ORPG - Open Radar Products Generator
OSD - One Hour Snow Depth

OSW - One Hour Snow Water

OTR - One Time Request

P

PID - Product Identification

PIL - Product Inventory List

PIREP - Pilot Weather Report

POES - Polar Operational Environmental Satellite
POSH - Probability of Severe Hail

POH - Probability of Hail

POP - Probability of Precipitation

PQPF - Probabilistic QPF

Precip - Precipitation

PRF - Pulse Repetition Frequency

Q

QC - quality control

QCMS - Quality Control and Monitoring System
QPE - Quantitative Precipitation Estimator

QPF - Quantitative Precipitation Forecast

QPS - Quantitative Precipitation Summary

R

RAOB - Radiosonde Observation
RAP - Rapid Refresh (Replaced RUC)
RCM - Radar Coded Message

RER - Record Report

RFC - River Forecast Center

RGB - Red, Green, Blue

RHI - Range Height Indicator

RMR - Radar Multiple Request
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RMS - root-mean square

ROSA - Remote Observing System Automation
RPG - Radar Product Generator

RPN - Reverse Polish Notation

RPS - routine product set

RTD - Requirements Traceability Document; Routine, Delayed

RTMA - Real Time Mesoscale Analysts
RUC - Rapid Update Cycle (Replaced by RAP)

S
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SAFESEAS - System on AWIPS for Forecasting and Evaluation of Seas and Lakes

SBN - Satellite Broadcast Network

SCAN - System for Convection Analysis and Nowcasting
SCD - Supplementary Climatological Data

SCID - Storm Cell Identification Display

SCP - Satellite Cloud Product

SCTI - SCAN CWA Threat Index

SDC - State Distribution Circuit

SNOW - System for Nowcasting Of Winter Weather
SOO - Science and Operations Officer

SPC - Storm Prediction Center

SPE - Satellite Precipitation Estimate

SREF - Short Range Ensemble Forecast

SRG - Supplemental Product Generator

SRM - Storm Relative Motion

SS - Storm Structure

SSD - Storm-Total Snow Depth

SSM/I - Special Sensor Microwave/Imager

SSW - Storm-Total Snow Water

STI - Storm Track Information

Suomi NPP - Suomi National Polar-orbiting Partnership
SW - Spectrum Width

SWEAT Index - Severe Weather Threat Index

SWP - Severe Weather Probability

T

TAF - Terminal Aerodrome Forecast (international code)
TAFB - Tropical Analysis and Forecast Branch
TCM - Marine/Tropical Cyclone Advisory
TCP - Public Tropical Cyclone Advisory
TDWR - Terminal Doppler Weather Radio
TE-PAC - Tropical Pacific

TMI - Text Message Intercept

TRU - TVS Rapid Update

TT - Total Totals

TVS - Tornado Vortex Signature

TWB - Transcribed Weather Broadcasts
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U

UGC - Universal Geographic Code

ULR - User Selectable Layer Reflectivity
URL - Universal Resource Locator

USD - User Selectable Snow Depth
USW - User Selectable Snow Water
UTC - Coordinated Universal Time

\%

VAD - Velocity Azimuth Display

VCP - volume coverage pattern

VIIR - Visible Infrared Imager Radiometer Suite
VIL - Vertically Integrated Liquid

VTEC - Valid Time and Event Code

VWP - VAD Wind Profile

W

W-ATL - Western Atlantic

WAN - wide area network

WFO - Weather Forecast Office

WINDEX - Wind Index

Win32 - Common 32-bit Microsoft Windows platform
WMO - World Meteorological Organization

WS - Workstation

WSFO - Weather Service Forecast Office

WSO - Weather Service Office

WSOM - Weather Service Operations Manual
WSR-88D - Weather Surveillance Radar-1988 Doppler
WWA - Watch Warning Advisory

WYV - water vapor

X
Y
Z

Z - Reflectivity
ZDR - Differential Reflectivity

Page 605



CAVE-D2D User's Manual AWIPS |1 Operational Build 13.4.1 - 31 July 2013

Appendix C. Managing Your AWIPS User Account

Each AWIPS user must have an individual Linux account to use the AWIPS application. The System
Administrator creates the individual accounts for AWIPS users. Issues related to management of those
accounts are discussed in this appendix.

Password Management

The Department of Commerce (DOC) policy requires that passwords be changed at least every 90 days. You
must never share your password with other users, and you must change it immediately when you know or
suspect your password has been compromised. The incident should also be reported to your System
Administrator.

Note 1: For detailed Password Management information, refer to the DOC Policy CITR-021 Password
Management (September 21, 2012), which replaced Appendix G: Password Management of the 2005
U.S. Department of Commerce IT Security Program Policy and Minimum Implementation Standards,
and CITR-009, Password Requirements Version 1.1.

Password Criteria

Passwords must meet the following policy criteria:
e Passwords for user accounts must have a least twelve (12) non-blank characters.
e Passwords must contain characters from at least three (3) of the following four (4) categories:
o English upper case characters (A ... 2);
o English lower case characters (a ... z);
o Base 10 digits (0 ... 9); and
o Non-alphanumeric characters (e.g., $#%).

e Passwords must not contain common words, nouns, pronouns, acronyms, contractions, and geographic
locations (i.e., dictionary words).

e Passwords must not be reused for two (2) years, nor can any of the last eight (8) passwords used, be
reused.

Changing Your Password

Because the Network Information Service (NIS) utility is used to manage AWIPS accounts, you cannot use
the usual Linux "passwd" command to change your password. Instead, use the ""yppasswd™ command. For
changing passwords, it has the same syntax and semantics as **‘passwd."
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Note 2: Users can also log into DX1 and run the *"chage -l [username]™ command to find out when
they last changed their password and when their current password will expire.

To change your password:
1. Log into your account on any workstation.
2. Open a terminal window by clicking the terminal icon.
3. In the window that appears, enter the command ""yppasswd."*
4. Follow the prompts.
There may be a delay of a few minutes before NIS updates the password files on all hosts.

Recovering from a Screensaver Lockout

If a locking screensaver is running on a workstation and the password holder is not available, there are two
ways to bring the workstation back into service:

o Kill the X server and thereby force a logout, or
¢ Kill the screensaver.

To Kill the X Server:

CAUTION: The method below for killing the X Server should not be used for routine logouts because
it may cause problems with the AWIPS application software (undeleted temporary files, open socket
connections, etc.).

e Type ctrl-alt-backspace.

o The X server and all its clients (e.g., D2D) will be killed. In a few seconds you will have a new
login screen.

To Kill the Screensaver:

CAUTION: The locking screensaver is meant to serve a security purpose. Killing the xscreensaver
process defeats the purpose of the locking screensaver. A locked screensaver should not be killed except
in cases of operational necessity.

o |f a locking screensaver is running on an AWIPS workstation, there will be one or more processes
called xscreensaver running. If you log in to the locked workstation from another workstation as the
root user and kill those processes, the screensavers will disappear and you will be able to shut down the
login session that was previously locked.
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Appendix D. AWIPS Applications / Interfaces

Table D-1 lists the AWIPS applications and interfaces that support AWIPS. Underlined highlighted text indicates a link to a
user's quide or additional information.

Table D-1. AWIPS Applications/Interfaces

‘ AWIPS Applications/Interfaces ‘

Description

Aviation Forecast Preparation

System (AvnFPS)

AvVNFPS is designed to ease monitoring, improve production, and facilitate Quality Control (QC) of Terminal Aerodrome
Forecasts (TAF). The AvnFPS monitoring capability gives forecasters quick and continuous feedback on TAFs as well as
associated observations. This monitoring capability consists of a color-coded scheme and is site configurable. The TAFs, surface
observations, and guidance are easily accessible in either text or graphical form and can be enhanced to alert forecasters to
weather significant to aviation operations.

AWIPS Decision Assistance and
Production Preparation Tools
(ADAAPT)

ADAPPT foundation software is composed of the foundation routines that support the IFPS, LAMPS, Pre-LAMPS, and SCAN.

CLIMATE

The CLIMATE software provides the capability to automatically initiate (three times daily) daily, monthly, seasonal, and annual
climate reports. It also formats these reports for dissemination (similar to HWR).

Additionally, it provides review and edit capability for products prior to dissemination.

Dam Catalog Reviewer and
Estimating Tool (DamCREST)

DamCREST is a Graphical User Interface (GUI) application available on both Linux and Windows operating platforms.

Distributed Hydrologic Modeling
(DHM)

DHM is the set of features integrated into NWSRFS for distributed hydrologic modeling.

Flash Flood Monitor and
Prediction: Advanced (FFMPA)

The FFMPA system is an integrated suite of multi-sensor applications which detects, analyzes, and monitors precipitation and
generates short-term warning guidance for flash flooding automatically within AWIPS.

Fog Monitor (FM)

The FM is an AWIPS application which applies various algorithms to visible and infrared satellite images in order to identify
potential areas of fog. At night, the application primarily uses the well-known infrared "Fog Product” (the difference of the 10.7
micron and 3.9 micron brightness temps) to highlight potential fog areas. During the daytime, several algorithms attempt to
discern fog areas by brightness, shape and other characteristics. Also applied are filters which help to distinguish fog from
possible false signal features such as snow cover and mid-level clouds.

Four-dimensional Stormcell
Investigator (FSI

FSI is an innovative base radar data 4-panel display application that is based on the National Severe Storms Laboratory Warning
Decision Support System - Integrated Information GUI. This technology allows users to create and manipulate dynamic cross-
sections (both vertical and at constant altitude), so that one can "slice and dice" storms and view cross-section data in three-
dimensions and across time.

Alert Visualization

Alert Visualization is an AWIPS utility that works as a communicator, primarily from software to human. All communication
traffic that used to funnel through the Announcer (Alert Visualization Popup Message Dialog and text messages in the D2D)
and that used to funnel through the D2D Decision Assistance Monitor Buttons now goes through Alert Visualization. And, via
Alert Visualization's powerful and flexible configurations, users can now decide how they want Alert Visualization to
communicate to them.

Gridded Forecast Environment

Suite (GFE Suite)

The GFE Suite is a series of programs that provide an interactive gridded forecast preparation capability. Components derive
surface sensible weather elements from model data, manage the forecast data and metadata in a database, and generate forecast
products in a variety of formats.

Hourly Weather Roundup (HWR)

The HWR automatically receives and processes METAR surface observations, Satellite Cloud Products (SCP), Supplementary
Climatological Data (SCD), and marine observations. Additionally, it formats a text portion of the data for dissemination over
NWR, formats a text portion for the Console Replacement System (CRS), and formats a tabular product for dissemination over
NWWS. Furthermore, the HR CSCI provides review and edit capability for products prior to dissemination.

Hydro Database Manager
(HydroBase)

HydroBase is the component of the AWIPS system which permits the management of the reference portion of the database.
Adding, deleting, and editing of hydrometeorological data collection and river forecast data locations are handled within
HydroBase. HydroBase consists of a series of pull-down menus which allow for interacting with the information within the
reference database.

HydroGen

HydroGen is a suite of software programs that collect data from the Integrated Hydrologic Forecast System (IHFS) database and
prepare eXtensible Markup Language (XML) files and hydrograph graphics (or simply "hydrographs") for the web.

HydroView

MPE_Editor

The Hydroview/MPE application is the result of an effort to consolidate the Hydroview and Multi-sensor Precipitation
Estimator (MPE) programs into a single, versatile utility that can be used at both RFCs and WFOs. Hydroview's focus is
primarily the display of point hydrometeorological data such as river and stream gage readings, precipitation amounts, and
similar environmental information that is typically observed and forecast for a specific location. It assists in the preparation of
hydrologic forecasts by allowing the user to display and edit this data as well as station reference information such as river
action and flood stages, historic river crests, emergency contracts, river crests, emergency contacts, river rating curves, and dam
catalogs. In AWIPS Release 7.1, the Hydroview/MPE application was split into two separate applications, HydroView and MPE

Editor.
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Interactive Forecast Preparation

IFPS enables the forecaster to generate and manipulate a digital database of observed and forecasted meteorological variables,

System (IFPS) which then can be used to automatically generate various products with different formats.
Localized Aviation MOS Proaram LAMP is a statistical system which provides forecast guidance for sensible weather elements. The GFS-LAMP guidance is
LAMP Y currently running operationally at NCEP. Guidance is available from the following cycles: 0000, 0300, 0600, 0900, 1200, 1500,

1800, and 2100 UTC. Effective September 26, 2007, the following cycles were added: 0400, 0500, 100, and 1100 UTC.

Local Analysis and Prediction
System (LAPS)

The LAPS reads METAR, mesonet, satellite, radar, and profiler data stored at the WFO, and performs an analysis and generates
forecasts.

Local Data Acquisition and
Dissemination (LDAD)

The LDAD software system acquires and integrates data available from automated systems and human observers in the local
WEFO area. It also disseminates critical and non-critical AWIPS weather information to local users, particularly state and local
government emergency management agencies.

Local Storm Report (LSR)

The LSR GUI is a standalone AWIPS application designed to provide forecasters with an easy and quick way to create, manage,
and send the LSR public text product. This text product contains noteworthy weather events for which the forecaster has either
received or sought real-time observations.

NOAA Weather Radio With
All-Hazards VTEC Enhanced
Software (NWRWAVES)

NWRWAVES was developed to replace all the existing formatter capabilities in WWA and CAFE. NWRWAVES utilizes VTEC
coding found in an increasing suite of NWS products to better identify, produce, and manage outbound CRS weather messages.

NWS River Forecast System
(NWSRFS)

NWSREFS is a comprehensive set of hydrologic techniques used by the National Weather Service River Forecast Centers to
perform their forecast functions.

River Product Formatter
(RiverPro)

The RiverPro application generates text products for the National Weather Service Hydrology program.

RiverMonitor

The RiverMonitor application is used for providing automatically updated tabular information summarizing river conditions.
This initial version is delivered in part for RiverPro VTEC monitoring, and provides general monitoring of river data.

System for Convection Analysis
and Nowcasting (SCAN)

SCAN is an integrated suite of multi-sensor applications which detects, analyzes, and monitors convection and generates
short-term probabilistic forecast and warning guidance for severe weather automatically within AWIPS.

System for Nowcasting of Winter

Weather (SNOW)

SNOW is an AWIPS application suite which continuously monitors surface observations for winter weather hazards. It
automatically alerts the forecasters whenever such conditions are detected. SNOW provides capabilities to display observed
winter weather threats in ways that help forecasters focus on what they consider most important.

System on AWIPS for Forecasting

and Evaluation of Seas and Lakes

(SAFESEAS)

SAFESEAS is a set of AWIPS applications which continuously monitor marine and adjacent overland conditions for specific
marine weather hazards. It automatically alerts the forecasters whenever such conditions are detected. SAFESEAS provides
capabilities to display observed marine threats in ways that help forecasters focus on what they consider most important.

Warning Generation (WarnGen)

WarnGen enables you to issue flash flood, severe thunderstorm, tornado, and other short-term warnings for a single storm or a
line of storms. In addition, you can issue text products (follow-up statements) that update the progress of the storm, cancel the
warning if conditions change, reissue another warning on the same storm, or note the expiration of the warning. WarnGen also
enables you to provide warning backup support to neighboring sites.

WFO Archive Server (WAX)

The WAX CSCI is a member of the Data Server (DS) family, but is a standalone Linux PC at the WFOs. It has Level 1V
archiving functionality and supports the Weather element Simulator at the WFOs.

NMAP

NMAP displays and animates different types of meteorological data on a geographic background. The current version supports
overlay of satellite, radar, model, METAR, ship, MOS, and upper-air data. A Motif GUI controls the program functions.

Site Specific Hydrologic
Prediction System (SSHPS)

SSHPS is a local hydrologic model provided to allow the WFO forecaster to supplement RFC river forecast guidance by
generating forecast river stages for fast-response headwater and river basins.

Hydro Time Series

A subset of data within an Arc Hydro geodatabase which includes measurement values and the time they were collected. Also
includes a description of the properties for a particular type of time series. Tools for visualizing time series have been
developed. The tools allow the user to query the Arc Hydro database for time series records related to a particular feature, and
plot one or more types of time series related to one or more spatial feature.

Precipitation Processing (PP)

PP is an OHD "systems" application. Many (WFO Hydrologic Forecast System) WHFS applications compute precipitation
totals. It is one of the prime considerations used in forecasting river stage. It is also a key indicator of flash flood potential. The
WHFS applications which ingest and process precipitation reports need to have consistent algorithms for tallying precipitation
accumulator (PC) and precipitation actual increment (PP) quantities. The PP and PC data also must be stored in the Integrated
Hydrologic Forecast System (IHFS) database in such a way as to avoid performance bottlenecks, especially in those
applications which must compute precipitation amounts on the fly for many stations over long intervals of time. They include
10+ applications that are non-interactive.

WFO Hydrologic Forecast System
(WHES) and Integrated
Hydrologic Forecast System

(IHES) Database

WHFS/IHFS is an OHD "systems" application. The WHFS/IHFS applications incorporate a comprehensive set of data quality
operations. Associated with each observed and forecast value in the database is a quality control code which indicates the
quality of the value based on external and internal tests of the value. Depending on the value of the quality code, the data are
handled in different ways within the IHFS data flow and applications may or may not use the data. They contain 10+
applications that are non-interactive.

High-resolution Precipitation
Estimator (HPE)

HPE provides frequent (by default) every 5-minutes) high-resolution (~1km x 1km) rain rate and 1-hour rain accumulations
covering a Weather Forecast Office's (WFO) or River Forecast Center's (RFC) area of responsibility. These gridded datasets can
then be used by the Flash Flood Monitoring and Prediction Advanced (FFMPA) system or can be displayed on D-2D. The
mosaic uses data from multiple radars minimizing the distance from each radar. As a result, HPE reduces the need to run
multiple instances of FFMPA when convection covers more than one radar. HPE is an entirely separate program from the Multi-
sensor Precipitation Estimator (MPE) and will not replace it. HPE uses different data, produces different output grids more
frequently and at high-resolution, and runs with little user interaction.
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